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What's New in 4.3.0
The following is a summary of the new features and updates in Camtasia Relay 4.3.0.

Youmay want to review the current known issues for Camtasia Relay 4.3.0. You can find the
list of known issues in the TechSmith Support Center.

Release Overview
Camtasia Relay 4.3 provides an updated dashboard for the system administrator. The new dashboard is
designed to provide information about server usage which can help the system administrator better plan for
their future needs. Additional updates weremade to allow for sorting and searching of videos on the history
page as well as providing additional information about an individual presenter’s usage.

New Server Features
An encoding usage graph that shows the server encoding capacity and usage percentages for a par-
ticular date or date range. This allows a system administrator the ability to easily see peak use times
and to see if there are times when presentations are queued up for encoding.
A graph showing the average size of a recording by file type. This shows a system administrator actual
data which can be used to plan for storage needs.
A graph showing the average encoding time for a particular profile and by a simple click of themouse
each encoding type within that profile.
Added the ability to search for presentations on the Presentation History page by date range.
Added the ability to search for presentations on the Job Status page and the Presentation List page
Added usage information for individual users including client machines used, presenter accounts and
total presentations.

Fixes and Updates
Corrected an issue that caused a failed publish to YouTube when the title was too long.
Fixed an issue with publishing to Kaltura wheremobile formats were not published their mobile play-
back formats.
Updated the Smart Player output to properly scale a video when the video is larger than the browser
window.
Corrected an issue within the file system output authentication test that could cause errors if variables
were used.

http://support.techsmith.com/
http://support.techsmith.com/
http://support.techsmith.com/
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What's New in 4.2.1
The following is a summary of the new features and updates in Camtasia Relay 4.2.1.

Youmay want to review the current known issues for Camtasia Relay 4.2.1. You can find the
list of known issues in the TechSmith Support Center.

System
Camtasia Relay 4.2.1 is amaintenance release that fixes several publishing related issues. The following
specific issues have been fixed:

Publishing to an FTP site resulted in an incorrect link to the published video.
CertainWebDAV publishing destinations resulted in unsuccessful publishing of presentations.
The FTP URL schemewas not selectable when Drupal was installed.
Resubmitting a Flash presentation which had previously failed continually failed.
Forward slash characters were not supported in FTP append paths.

http://support.techsmith.com/
http://support.techsmith.com/
http://support.techsmith.com/
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What's New in 4.2.0
The following is a summary of the new features and updates in Camtasia Relay 4.2.0.

Youmay want to review the current known issues for Camtasia Relay 4.2.0. You can find the
list of known issues in the TechSmith Support Center:

4.2.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3600

System
The general updates to Camtasia Relay include:

Videos recorded using Snagit can be sent to a Camtasia Relay server for encoding and publishing
using a newly available Snagit output for Camtasia Relay. The Snagit output is available on the Tech-
Smith website.This process requires Snagit onWindows 11 or later, Snagit onMac 2.0 or later, and
Camtasia Relay 4.0.2 or later.
The TechSmith Smart Player, an upgraded Flash video player, is now available in Camtasia Relay.
This is the recommended encoding type (listed as Flash encoding on the Camtasia Relay website).
Any previous profiles using the Flash encoding type will automatically use the Smart Player.

The Smart Player plays video on any device that supports H.264MP4 videos including current web
browsers, iPhone, iPad, Windows Phones andmost Android devices.

Added support for new iTunesU variables.
RTMP andMMS protocols are now supported in our publishing destinations.
Version 7.7.3 of QuickTime is now required for Camtasia Relay 4.2.0. This change is to correct an
issue processing TechSmith Fuse for Camtasia Relay videos.
Fixed an issue where speech to text transcription fails if no audio is detected.
Improvedmessaging when issues arise during activation.

Server Website
The Copy Profile process has been improved and simplified.

Recorder
Updates to the recorder include:

TheWindows recorder has been updated to support Windows 8.
If the audio input is lost during a presentation Camtasia Relay provides the presenter with a notification
and potential solutions. This feature can also be disabled by the system administrator.

http://techsmith.custhelp.com/app/answers/detail/a_id/3600
http://techsmith.custhelp.com/app/answers/detail/a_id/3600
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What's New in 4.1.2
The following is a summary of the new features and updates in Camtasia Relay 4.1.2.

Youmay want to review the current known issues for Camtasia Relay 4.1.2. You can find the
list of known issues in the TechSmith Support Center:

4.1.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3562

4.1.1: There are no known issues specific to version 4.1.1 at the time of publication.

4.1.0: There are no known issues specific to version 4.1.0 at the time of publication.

4.0.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3433

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

Various updates to the encoder process.

Server Website
There are no updates to the server website with this release.

Recorder
Updates to the recorder include:

TheMac recorder now works with OS X 10.8.

http://techsmith.custhelp.com/app/answers/detail/a_id/3562
http://techsmith.custhelp.com/app/answers/detail/a_id/3562
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.1.1
The following is a summary of the new features and updates in Camtasia Relay 4.1.1.

Youmay want to review the current known issues for Camtasia Relay 4.1.1. You can find the
list of known issues in the TechSmith Support Center:

4.1.1: There are no known issues specific to version 4.1.1 at the time of publication.

4.1.0: There are no known issues specific to version 4.1.0 at the time of publication.

4.0.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3433

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

Fixed an issue where upgrades failed if Camtasia Relay was installed to a custom location.
Added support for Microsoft SQL Server 2012.

Server Website
There are no updates to the server website with this release.

Recorder
Updates to the recorder include:

TheMac recorder can now record system audio (the sound from an user's speakers). This option is ena-
bled by default.

http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.1.0
The following is a summary of the new features and updates in Camtasia Relay 4.1.0.

Youmay want to review the current known issues for Camtasia Relay 4.1.0. You can find the
list of known issues in the TechSmith Support Center:

4.1.0: There are no known issues specific to version 4.1.0 at the time of publication.

4.0.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3433

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

ID3 tags have been added toMP3 encoding output 
Updated the Autonomy library for speech to text captioning

Server Website
Updates to the server and website include:

Added a new encoding type for Camtasia Studio 8 and later CAMREC files
Added the ability to adjust the number of profiles shown on the profile list page

Recorder
Updates to the recorder include:

The recorder now uses SHA512 for security
The PC recorder can now record system audio (the sound from an user's speakers). This option is ena-
bled by default.
BothMac and PC recorders display a notification to users when a new version of the client is available
from the Camtasia Relay website

http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.0.3
The following is a summary of the new features and updates in Camtasia Relay 4.0.3.

Youmay want to review the current known issues for Camtasia Relay 4.0.3. You can find the
list of known issues in the TechSmith Support Center:

4.0.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3433

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

Critical fix for a potential server crash introduced in 4.0.2

Server Website
Updates to the server and website include:

Direct link to download the Android version of TechSmith Fuse for Camtasia Relay on the website
download page

Replaced theMP3Radio andMP3 Phone encodings with a single, higher quality MP3 encoding

Added ID3 tags toMP4 encodings - sets tags like Name, Artist, Year, Grouping, andGenre

Fix for Camtasia for Mac recording encoding type that resulted in CMPROJ files being larger than they
should be. (This bug was introduced in version 4.0.1)

Recorder
Updates to the recorder include:

TheMac recorder has changes that allow it to be able to check for upgrades in future releases. The
server changes to control those updates and the PC recorder updates will come in a future release.

http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.0.2
The following is a summary of the new features and updates in Camtasia Relay 4.0.2.

Youmay want to review the current known issues for Camtasia Relay 4.0.2. You can find the
list of known issues in the TechSmith Support Center:

4.0.2: http://techsmith.custhelp.com/app/answers/detail/a_id/3433

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

System updates to accommodate a future release of TechSmith Fuse for Camtasia Relay for the
Android platform

Server Website
Updates to the server and website include:

Publishing notification for Moodle 2.x

Webcam picture-in-picture has been added toWMV, MP4, iPad and iPod encoding formats

Corrected an issue with installing the PowerPoint add-in for Camtasia Relay

Recorder
Updates to the recorder include:

Addressed issues associated with removing an audio device with the recorder open

Addressed issues associated with adding a webcam while on the Select a Camera preview showing

Dropped support for OS X 10.5

http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3433
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.0.1
The following is a summary of the new features and updates in Camtasia Relay 4.0.1.

Youmay want to review the current known issues for Camtasia Relay 4.0.1. You can find the
list of known issues in the TechSmith Support Center:

4.0.1: http://techsmith.custhelp.com/app/answers/detail/a_id/3368

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

When recording a webcam and using the CAMREC (Camtasia Studio recording file format) encoding,
the CAMREC now includes two video streams: one for the recorded display and one for the webcam

Server Website
Updates to the server and website include:

Direct publishing output to Amazon S3
YouTube encoding for the YouTube publish destination now includes webcam picture-in-picture
YouTube encoding for the YouTube publish destination now includes captions
Ability to produce an original sizeMP4 recording
Corrected an issue with the use of semi-colon (;) in the presentation title causing a broken URL
Corrected an issue that changed the webcam dimensions on long recordings

Recorder
Updates to the recorder include:

When recording a PowerPoint presentation, the presentation title is auto-populated in Camtasia Relay
recorder

http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3368
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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What's New in 4.0.0
The following is a summary of the new features and updates in Camtasia Relay 4.0.0.

Youmay want to review the current known issues for Camtasia Relay 4.0.0. You can find the
list of known issues in the TechSmith Support Center:

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

System
The general updates to Camtasia Relay include:

Ability to record webcam video as part of your presentation
Webcam is embedded as a picture in picture in presentations produced in Adobe Flash or Micro-
soft Silverlight encodings

Server Website
Updates to the server and website include:

Direct publishing to YouTube from Camtasia Relay
Global caption editor role added to Camtasia Relay server

A user can be set up as a dedicated caption editor able to edit any presentation that has been
captioned on the server

Sever recognizes when a new version is available and notifies the system administrator
Direct link to download TechSmith Fuse from the Apple App Store from the Camtasia Relay website
download page
Addressed a Silverlight encoding error after upgrading to Relay 3.1
Addressed an issue that allowed system administrators to delete a profile when a presentation was in
process
Updated the date system variable to always display day andmonth with 2 digits, even if it is a single
digit date
Corrected an error where system generated e-mail notifications were pulling information from the wrong
location
Updated the LDAP integration capabilities to allow for the import of a user with no email address

Recorder
Updates to the recorder include:

The ability to include webcam video in a presentation
Refined user interface
Support for Microsoft Office 2010 onMicrosoft Windows
Support for Microsoft Office 2011 on Apple OS X
Addressed an issue where profile selection and presentation namewere not saved after performing a
test presentation

http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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Help and Support Resources
There are several different ways to get help for using Camtasia Relay.

Camtasia Relay Website and Recorder Help
For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website
Help. This help is available after logging into the Camtasia Relay website as an administrator.
Just click a Help link, available on each web page, to open the Camtasia Relay Administrator
Help.

For help with the Camtasia Relay recorder, please install and open the Camtasia Relay recorder
or open the portable recorder to access presenter help.

Camtasia Relay Learning Center

In the Camtasia Relay section of the TechSmith.com Learning Center, you can find themost up to
date tutorials and product documentation.

The following PDF documents are available for download in the Camtasia Relay Learning Center:

Camtasia Relay Installation Guide

Learn how to install the Camtasia Relay server.

Camtasia Relay Upgrade Guide

Learn how to upgrade Camtasia Relay.

Camtasia Relay Administrator Website Help

Walk through configuration and administration information to help you keep Camtasia Relay
running smoothly.

Camtasia Relay Presenter Website Help

Help presenters understand how to interact with the website and server

Camtasia Relay Technical Reference Guide

Access an in-depth examination of Camtasia Relay, including the overall architecture, planning
information, sizing and performance considerations, security principles, tips on integrating
Camtasia Relay with other products, and general best practices.

Camtasia Relay Server Security Administrator Guide

Learn about ways to help secure your Camtasia Relay server.

Camtasia Relay Recorder Help (Windows and Mac)

PDF versions of the recorder help for presenters.

TechSmith Support Center

http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.2&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.2&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.2&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.2&os=NA
http://support.techsmith.com/
http://support.techsmith.com/
http://support.techsmith.com/


Camtasia Relay Installation Guide

www.techsmith.com - 7 -

The Camtasia Relay Tech Support team is ready and waiting for your questions. Should you have
problems that you cannot solve using the resources provided, please contact us wewill be happy to
assist.

Search the Knowledge Base on the Support Center page: http://support.techsmith.com. It is
possible that the issue is a known issue and there is already an answer available.
Submit a question to Technical Support. Click Ask aQuestion on the Support Center page:
http://support.techsmith.com
Call Technical Support

Phone: +1.517.381.2300 (ext. 784)
Toll Free in the U.S. & Canada: 800.517.3001 (ext. 784)
Tech Support Website: http://support.techsmith.com

Feedback

If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia
Relay documentation, please send an email to relayhelp@techsmith.com.

http://support.techsmith.com/
http://support.techsmith.com/
http://support.techsmith.com/
mailto:relayhelp@techsmith.com
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Installation Introduction
This document will help you to install the Camtasia Relay server software. When you run the installation
application, the installer walks you through the installation steps on your server. This document is meant to
provide supporting information to help you get through the installer and provide support with any installation
tasks that are not covered in the installer.

While you are prompted to install most of the prerequisites during installation, depending on your actual
server, the process to install these items may vary. This document contains links to resources that will assist
you with various server configurations.

Topics Included in This Document
Getting the Server Ready for Installation
Server Planning
Prerequisites for Installation
Security Considerations for Installation
Installation
Server Configuration
Presenter Computer Planning
Related Documentation

Setup Options
The installer program will install the Camtasia Relay server software, which includes the website interface
and the Camtasia Relay database. Camtasia Relay offers the following installation options:

Express setup

Use this option to set up the Camtasia Relay server, website, and database on this server. Express
setup creates and uses a local SQL Server instance named “Relay.”

Advanced setup

Use this option to:

Connect to a remote SQL Server instance to install the Camtasia Relay database.

If Camtasia Relay is installed on a different server than SQL Server, the security policies on
both servers must match. If the security policy differs between the two servers, youmay
encounter problems with installation.

Add an additional server to an existing Camtasia Relay server team.
Havemore control over the setup process.
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Getting the Server Ready for Installation
This section will help you plan for your Camtasia Relay installation. Read and consider the following prior to
running the Camtasia Relay installer:

Server Planning

Server Hardware
Important Server Considerations
Server Operating System
Administrator Website Access

Prerequisites for Installation
Security Considerations for Installation

Required Ports
Conditional Ports
Local SQL Server
Remote SQL Server Ports
Firewall Rules Resources
Passwords
General Server Security Resources

Server Planning
To install and run the Camtasia Relay server software, you will need a computer that meets the following
requirements.

Camtasia Relay may be run in a virtualized environment with the understanding that the CPU-
intensive nature of transcodings makes it a good fit for a dedicated server. If given the
necessary resources in a properly configured VM instance, it will work well. Running the
Camtasia Relay server on an underpowered or multi-purpose VM is not recommended and will
result in poor performance.

Server Hardware
The server specifications are based on the number of simultaneous encodings the server is licensed to
process. See the Camtasia Relay Pricing page (http://www.techsmith.com/camtasia-relay-pricing.html)
for more information.

Minimum Server Specifications

1 Encoding 3 Encodings 7 Encodings

Core: 2 CPUs 4CPUs 8CPUs

CPU: 2.0 GHz Pentium or 2.0 GHz Pentium or 2.0 GHz Pentium or

http://www.techsmith.com/camtasia-relay-pricing.html
http://www.techsmith.com/camtasia-relay-pricing.html
http://www.techsmith.com/camtasia-relay-pricing.html
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1 Encoding 3 Encodings 7 Encodings

equivalent equivalent equivalent

RAM: 2GB 4GB 8GB

HD Space
Free: 150GB 250GB 500GB

Camtasia Relay reserves one core for overhead processes which yields faster encodings and
publishing overall. For example, if you use a quad-core server, Camtasia Relay can encode
three simultaneous recordings. This achieves the fastest performance and is faster than if all
four cores were dedicated to encoding recordings.

Recommended Server Specifications

3 Encodings 7 Encodings

OS: Windows Server 2008 64-bit with
SP2

Windows Server 2008 64-bit with
SP1

CPU: 2.4 GHz Pentium or equivalent 2.4 GHz Pentium or equivalent

RAM: 8GB 16GB

HD Space
Free: 500GB 1 TB

HD Config: RAID-1 (mirrored) RAID-1 (mirrored)

Important Server Considerations
The following items are important when you are planning your server hardware:

You should begin with a fresh install of Windows Server, install all relatedWindows patches from
http://update.microsoft.com and then install the Camtasia Relay server.
Camtasia Relay is designed to run on a stand-alone server and not as an application on amulti-purpose
server.

Other SQL Server installations or instances, additional websites, or other non-standard software or
web applications installed on the server may cause problems with the communications between the
Camtasia Relay recorder and server.

Youmust have 150GB + of hard disk space.

As a rough guideline, a one hour recording requires between 1-2 GB of space.

http://update.microsoft.com/
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Unprocessed recordings consume disk space until they are published. After the final presentation is
published, the original recording is deleted.

Presentations waiting for user interaction, such as presentations in the Held for Captioning or Needs
Attention states, continue to consume space on the server until the presenter or an administrator
releases the presentation and it is published.

More processing cores meanmore simultaneous encoding potential, and therefore, faster encoding
and publishing; this potential is also dependent on the number of simultaneous encodings your server
is licensed to process.

Server Operating System
The following server operating systems are supported:

Camtasia Relay requires an English version of the server operating system.

Recommended

Dedicated server runningWindows Server 2008 64-bit (SP1 recommended)

Supported
Windows Server 2003 (32-bit, Service Pack 2 or later)

Camtasia Relay Server is not compatible with the 64-bit version of Windows Server 2003.

Windows Server 2008 (32-bit or 64-bit, Service Pack 1 or later)
Windows Server 2008 R2 (Full install, WOW64 required)
Windows Server 2012

Administrator Website Access
To access the Camtasia Relay website and interact with the Camtasia Relay server, administrators need one
of the following web browsers:

Internet Explorer 7 or higher
Firefox 3.x or higher
Safari 3.x or higher
The current version of Chrome

Supported Versions for Plug-Ins
Camtasia Relay uses plug-ins to integrate with various publish destinations and notification servers. The
following versions are currently supported:

Notification servers:
Blackboard Learn™ 9.1
Moodle 1.9
Moodle 2.0
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Publish destinations:
Mediasite 5.5
Drupal 6.1
Microsoft® Windows® SharePoint™ 2010

Prerequisites for Installation
To save time during installation, install the following prerequisites prior to running the Camtasia Relay
installer. Server prerequisites include the following:

IIS
SSL Certificate
QuickTime
Desktop Experience Feature on Windows Server 2008/2008 R2

If you do not set up these items before starting the Camtasia Relay installer, you are notified
that they are not installed.

Resources for Prerequisites
Use the following links if you need assistance on installing a prerequisite:

IIS

For Server 2003 (IIS 6.0): http://ww-
w.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-
b6c7-5f370d7f26cd.mspx?mfr=true
For Server 2008 or Server 2008 R2 (IIS 7.0 or 7.5): http://learn.iis.net/page.aspx/29/installing-iis-7-
on-windows-server-2008-or-windows-server-2008-r2/
TheOfficial Microsoft IIS Site: http://www.iis.net/

SSL Certificate

The Camtasia Relay installer attempts to communicate with IIS over HTTPS to verify the
certificate is properly installed. HTTPS bindings need to be set for the website you select in
the installer. If HTTPS bindings are not set to use your SSL certificate, the installer does not
allow you to install Camtasia Relay to that website.

http://support.microsoft.com/kb/299875
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7

QuickTime

You need to install QuickTime 7.7.3 (the latest at the time of this publication) or greater to process
presentations recorded onMacintosh-based computers. Camtasia Relay does not provide the QuickTime
codec.

http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://www.microsoft.com/technet/prodtechnol/WindowsServer2003/Library/IIS/750d3137-462c-491d-b6c7-5f370d7f26cd.mspx?mfr=true
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://learn.iis.net/page.aspx/29/installing-iis-7-on-windows-server-2008-or-windows-server-2008-r2/
http://www.iis.net/
http://support.microsoft.com/kb/299875
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
http://learn.iis.net/page.aspx/144/how-to-setup-ssl-on-iis-7
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If QuickTime version 7.7.3 (or later) is not detected, the installer prompts you to download and install
QuickTime. We recommend that you do not allow automatic updating of QuickTime on the Camtasia Relay
server.

You can downloadQuickTime at http://www.apple.com/quicktime/download/.

Desktop Experience Feature on Windows Server 2008/2008 R2

For information fromMicrosoft on the Desktop experience feature, which gives Windows Server 2008many of
the applications and features that are available in theWindows 7 operating system, see
http://technet.microsoft.com/en-us/library/cc772567.aspx.

http://www.apple.com/quicktime/download/
http://technet.microsoft.com/en-us/library/cc772567.aspx
http://technet.microsoft.com/en-us/library/cc772567.aspx
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Security Considerations for Installation
When installing Camtasia Relay, if security considerations are configured incorrectly, they could cause
issues during installation.

It is very important to consider the security of the environment hosting Camtasia Relay. You want to make
sure that the Camtasia Relay server is as secure as possible against attacks. The following information is
provided only to help avoid issues during installation.

More in-depth information on securing your Camtasia Relay server is available in theCamtasia Relay Server
Security Administrator Guide. For information on where to locate this document, seeRelated
Documentation and Support.

Required Ports
The following ports are always required for Camtasia Relay to work properly.

Component Protocol Ports Direction

Camtasia Relay Web Application and Service TCP 80, 443 Incoming

DNS TCP/UDP 53 Outgoing

NTP UDP 123 Outgoing

Additional ports may also be required by the operating system or other software (for example, port 1663 for
Windows KMS activation.)

Conditional Ports
Depending upon the configuration of Camtasia Relay and the features enabled, youmay need to open the
following ports.

Feature Protocol Ports Direction

Email Notification
/ SMTP TCP 25 (default SMTP port) or Specified SMTP port Outgoing

LDAP Authen-
tication TCP 389 (default LDAP port) or 636 (default LDAP

SSL) or Specified LDAP port Outgoing

If email notification is enabled, the SMTP port specified in the SMTP configurationmust be open (out-
going) between all Camtasia Relay servers and the designated SMTP server.
If LDAP authentication is enabled, the LDAP port specified in LDAP configurationmust be open (out-
going) between all Camtasia Relay servers and the designated LDAP server.

Local SQL Server
You do not need to open ports if Camtasia Relay uses an instance installed on the samemachine. However,
by default, Camtasia Relay attempts to connect using TCP/IP. If the appropriate firewall ports are not open



Camtasia Relay Installation Guide

www.techsmith.com - 8 -

(see Remote SQL Server Ports then this connection fails.

To enable Camtasia Relay with restrictive firewall rules, change the Camtasia Relay server’s configuration
files:

data.config (located in theManager directory of Camtasia Relay’s installation directory, typically C:\P-
rogram Files\TechSmith\Relay Server\Manager\)
web.config (located in theWeb directory of Camtasia Relay’s installation directory, typically C:\P-

rogram Files\TechSmith\Relay Server\Web\)
For each of these files, do the following:

1. Open CONFIG in a text editor.
2. Find the connection string for the relay instance. For example:

<add name="RelayConnectionString" connectionString="Data

Source=<servername>\RELAY; Initial Catalog=Relay; User

Id=relay; Password=<password>; Pooling=True;" />

3. Change the server name to “(local)” and save the file.

Remote SQL Server Ports
If you are installing Camtasia Relay in a teaming configuration or need to use a remote SQL server, the
security policies on the database server and Camtasia Relay server must match or there will be issues with
installing and running Camtasia Relay.

To add a new Camtasia Relay server to a team or need to install Camtasia Relay to use a remote SQL server
youmust choose to either:

Use Dynamic Ports / List SQL Server as an Exception (Recommended)
Configure the database engine to use specific TCP/IP ports and open these ports on servers hosting
Camtasia Relay and SQL server.

Use Dynamic Ports / List SQL Server as an
Exception
By default, Camtasia Relay uses dynamic ports to access the named ‘relay’ instance. To continue to use
dynamic ports you can list the SQL Server executable (Sqlservr.exe) and SQL Browser as exceptions to
the blocked programs on the server hosting the database. Note that only one instance of SQL Server can be
accessed in this way.

For information on how to add aWindows Firewall Exception and allow access to the SQL Server and SQL
browser through theWindows firewall, see the followingMicrosoft support articles:

Remote server ports: http://msdn.microsoft.com/en-us/library/ms175043(v=SQL.105).aspx
Define specific ports: http://msdn.microsoft.com/en-us/library/ms177440(v=SQL.105).aspx

Firewall Rules Resources
Service overview and network port requirements for theWindows Server system

http://support.microsoft.com/kb/832017

http://msdn.microsoft.com/en-us/library/ms175043(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms175043(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms175043(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms177440(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms177440(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms177440(v=SQL.105).aspx
http://support.microsoft.com/kb/832017
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Windows 2003 -Windows Firewall Technical Reference

http://technet.microsoft.com/en-us/library/cc779199.aspx

Windows Firewall Center

http://technet.microsoft.com/en-us/network/bb545423.aspx

Passwords
Many of the components involved in hosting Camtasia Relay (includingWindows Server accounts, SQL
Server users, and Camtasia Relay accounts) rely on passwords for distinguishing authorized users from
everyone else.

Camtasia Relay Administrator Account Password
This password is used for the “relayadmin” account (master user in the database) as well as the Relay
instance in the SQL database.

Remember this password! If you forget it and do not have other user accounts with
administrator access to Camtasia Relay, youmay have to uninstall and then reinstall
Camtasia Relay. Delete the database when prompted by the server installer. You will lose all
information including user accounts and profiles. If you are in this situation, please contact
http://support.techsmith.com.

General Password Complexity Guidelines
All passwords, including those used in the installer, need tomeet your organizations password complexity
rules. Attackers commonly attempt to guess passwords to gain access to these systems as an authorized
user. Furthermore these attacks are typically executed using automated scripts that try thousands of
passwords, including common passwords, dictionary words, and random combinations of characters. One of
the best defenses against password guessing attacks is the use of strong, or hard-to-guess, passwords.
Strong passwords should:

Be eight characters in length or more.
Combine letters, numbers, and symbols.
Not include words from the dictionary.
Be different than your username or account name.
Be different than passwords used for other systems.

For more suggestions and information on strong passwords, please see the article "Strong Passwords and
Password Security" at http://www.microsoft.com/protect/yourself/password/create.mspx.

General Server Security Resources
Windows Server 2003

http://technet.microsoft.com/en-us/library/cc706993.aspx

Windows Server 2008

http://technet.microsoft.com/en-us/library/dd349801.aspx

http://technet.microsoft.com/en-us/library/cc779199.aspx
http://technet.microsoft.com/en-us/library/cc779199.aspx
http://technet.microsoft.com/en-us/network/bb545423.aspx
http://technet.microsoft.com/en-us/network/bb545423.aspx
http://support.techsmith.com/
http://www.microsoft.com/protect/yourself/password/create.mspx
http://technet.microsoft.com/en-us/library/cc706993.aspx
http://technet.microsoft.com/en-us/library/cc706993.aspx
http://technet.microsoft.com/en-us/library/dd349801.aspx
http://technet.microsoft.com/en-us/library/dd349801.aspx
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Windows Server 2003 Security Guide

http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-
521ea6c7b4db&DisplayLang=en

Windows Server 2008 Security Guide
http://technet.microsoft.com/en-us/library/cc264463.aspx
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-
A44B-B115696A80AC&displaylang=en

Windows Server 2003 Security ComplianceManagement Toolkit

http://technet.microsoft.com/en-us/library/cc163140.aspx

Windows Server 2008 Security ComplianceManagement Toolkit

http://technet.microsoft.com/en-us/library/cc514539.aspx

http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://technet.microsoft.com/en-us/library/cc264463.aspx
http://technet.microsoft.com/en-us/library/cc264463.aspx
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://technet.microsoft.com/en-us/library/cc163140.aspx
http://technet.microsoft.com/en-us/library/cc163140.aspx
http://technet.microsoft.com/en-us/library/cc514539.aspx
http://technet.microsoft.com/en-us/library/cc514539.aspx
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Installation
Once all the prerequisite software is installed and set up on the server, you can install Camtasia Relay.

After you complete installation, youmay want to review the current known issues for
Camtasia Relay 4.1. You can find the list of known issues in the TechSmith Support Center.
At the time of publication, there are no known issues for Camtasia Relay 4.1.

See Also:

Install the Camtasia Relay Server
Add a Server to the Team
Server Configuration
Presenter Computer Planning

Install the Camtasia Relay Server
To install the server (or the first server in a team), use the following process. To add an additional server to a
team, seeAdd a Server to the Team.

1. Download the correct installer for your server:
For 32-bit servers, use the Camtasia Relay 32-bit installer (CamtasiaRelayServer.exe)
For 64-bit server, use the Camtasia Relay 64-bit installer (CamtasiaRelayServer_
x64.exe)

2. Copy the Camtasia Relay installer file to your server.
3. Run the Camtasia Relay server installer.
4. Follow the instructions in the installation wizard.

The installer scans for prerequisite components and indicates which components you need to install.
SeePrerequisites for Installation for links to information about each item.

For more information about adding the server to an existing team of Camtasia Relay servers,
seeAdd a Server to the Team.

5. When installation is complete, the Camtasia Relay website opens in a web browser. Log in as an
administrator and completeServer Configuration.

6. If you are going to install and team additional servers to the one you just installed, create The Team
Exported Settings File.

If you have any issues during installation, you canContact TechSmith Tech Support for
assistance.
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Add a Server to the Team

When adding a server to the team, security policies on all teamed servers (and the server
running SQL Server, if applicable) must match. If the security policy differs between the
servers, youmay encounter problems with installation.

In Camtasia Relay, you can team servers together to add power and flexibility to Camtasia Relay. Teaming
servers means that they all accept presentations based on load and other variables. Once teamed, you work
with the teamed servers as if they are one server. They all run from a single database, so all information is
available on each of the teamed servers.

On any of the servers, go toSystem > Servers to view all teamed servers’ status and job
counts.

After you install the first Camtasia Relay server and database, to add another server to the team use the
following process:

1. If you are using a network firewall and have not yet done so, open TCP port 1433 and UDP port 1434 to
connect to the database. If using a host-based firewall such as Windows firewall then add exceptions
for the SQL Server and SQL Browser executables. For more information, seeRemote SQL Server
Ports.

2. Double-click the Camtasia Relay server installer.
3. When you get to the Select Setup Type page of the wizard, select Advanced setup and click Next.
4. On the Select Advanced Installation Type page, select Add this server to an existing Camtasia

Relay team and click Next.
5. Install prerequisites and click Next.
6. On the SQL Server Connection page, enter or browse to the SQL instance name in use for Camtasia

Relay. Enter the “Relay” user password and click Next.
7. On the Camtasia Relay Team Exported Setting File page, browse to the Camtasia Relay Team

Exported Settings file and click Next. See The Team Exported Settings File for information on how
to create this file.

8. Complete the wizard and click Install.
9. When installation is complete, the website opens in a web browser. Log in as an administrator and com-

pleteServer Configuration.

The Team Exported Settings File
When adding a new Camtasia Relay server to a team, the installer prompts for a Camtasia Relay Team
Exported Settings file.

The Camtasia Relay Team Exported Settings file is an XML file containing the private encryption key used by
the existing teammembers. This XML file can be created using the Camtasia Relay Configuration Protection
Tool.

To create and use the Camtasia Relay Team Exported Settings file:
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1. Access an existing teammember that has the correct encryption key installed.

The configuration protection tool (ConfigurationProtectionTool.exe) is located in the
Manager directory of the Camtasia Relay installation directory (C:\Program
Files\TechSmith\Relay Server\Manager by default.)

2. Launch the configuration protection tool by double-clicking
ConfigurationProtectionTool.exe.

The configuration protection tool (CPT) attempts to find Camtasia Relay’s CONFIG files in the
specified installation directory (initially based on where the tool was launched from.)

The status window shows an error message if CPT is unable to find the .CONFIG files. If this
happens, the installation directory must be corrected before any other action can be taken.

3. If needed, type in or browse to the correct install location.

4. Click Load Current Server Settings.

The CPT checks the registry and several database values to determine whether or not the server has
the correct encryption key. The status icons are updated and should all change to green.

5. Click the Import / Export tab and click Export Settings to File. Choose a location and filename for
the file.
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6. Copy the file onto the new server you want to add to the team.
7. Browse to the XML file when prompted during the install process on the Camtasia Relay Team

Exported Settings File page of the installer.
You can find additional information about the Team Exported Settings File in theCamtasia Relay Server
Security Administrator Guide. For information on where to locate this document, seeRelated
Documentation and Support.
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Server Configuration
When the install completes, log in to the Camtasia Relay website with the “relayadmin” account. You now
need to configure the server.

Email Server Configuration
When you first log in, you are directed to a page to configure the email server. Camtasia Relay can send two
types of email notifications:

Notifications for published presentations

These notifications are sent to presenters, administrators, and/or viewers when presentations are
published. These need to be set up and then included in the profile used to process the presentation.

Notifications from the Camtasia Relay system

These administrativemessages are sent from the system and notify Camtasia Relay presenters of
server and presentation problems, such as: presentations needing attention, password changes, etc.

The email server configuration includes:

The SMTP email server address.
The SMTP email server port.
The email address that appears in the Reply To field of email notifications.
The email address of the Camtasia Relay administrator. This email address receives notifications from
the server when action is needed from an administrator.

Skip Email Server Configuration
If you do not know the email server address during initial configuration, uncheck the Enable Email
Notifications option to skip this step.

To enter the email server information later, go to: Profiles > Notification Server Configuration > Email Server
tab. This allows notifications for published presentations to be sent.

To turn on system notifications, go to System > System Options > Email Notifications, check the Enable
email notifications option, and click Save.

Configuration Steps
Next, you see the Important Configuration Steps:

1. Define publish destinations
2. Set up notifications
3. Create profiles

You can findmore information about all of these steps in the help on the Camtasia Relay website and click the
Configuration of Camtasia Relay link on the System page.
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Presenter Computer Planning
To interact with Camtasia Relay as a presenter, a computer that meets the following requirements is required.

Windows-Based Computers
To run the Camtasia Relay recorder, Windows-based computers need to have the following:

One of the following supported operating system versions:
Windows XP (32-bit, Service Pack 2 or Service Pack 3)
Windows Vista (32-bit)
Windows 7 (32-bit and 64-bit)

Microsoft Office 2003 or later is required to use the Camtasia Relay Add-In for Microsoft Office Pow-
erPoint
A microphone (both internal and external microphones are supported)
Most recent versions of audio and video drivers.
To avoid possible compatibility issues, make sure the computer has themost up-to-date audio and
video drivers.
A fast processor is important if recording a great deal of screen activity, but not as critical for recording
things like PowerPoint presentations
Physical computer requirements

Minimum Recommended

CPU: 1.0 GHz Pentium or equivalent 2.0 GHz Pentium or equivalent

RAM: 1GB 2GB

HD Space Free: 2GB/hr 2 GB/hr

Install Space: 25MB 25MB
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Deploy Camtasia Relay Recorder
In a locked-down or controlled environment, the administrator can choose to deploy the Camtasia Relay
recorder forWindow operating systems, instead of having the users download it from the Relay website.

TheWindows Installer client can be found on the server at:

[INSTALLDIR]_installhelper\CamtasiaRelayRecorder.msi

This MSI can be distributed via the usual methods; creating aWindows Installer Transform file or using the
command line switches. The "Properties" that need to be assigned values are as follows.

Critical Properties
PRIMARYENDPOINT: Camtasia Relay server URL.
TEAMID: TeamingGUID. This property should be only used when teamingmultiple servers together.

Optional Properties
INSTALLDIR: Main destination folder.
TSC_PP_ADDIN: Set to 0 to disable the Camtasia Relay recorder Add-in for Microsoft PowerPoint.
TSC_START_NOW: Set to 0 to keep Camtasia Relay recorder from launching after installation.
TSC_DESKTOP_LINK: Set to 0 to not create a shortcut to Camtasia Relay recorder on the Desktop.

Example

msiexec.exe /i “\\Apps_server\CamtasiaRelayRecorder.msi”

PRIMARYENDPOINT="https://relaydev01.techsmith.com/relay/rest.ashx"

TEAMID="FE47DE98-9E88-414b-A99F-C24F26951D7F" TSC_DESKTOP_LINK=0

/qb-!

Macintosh-Based Computers
To run the Camtasia Relay recorder, Macintosh-based computers needOS X 10.6.4 and later

A microphone

Macintosh laptops usually do not have powered audio-in ports; a poweredmicrophone (such as a USB
microphone) is required if you do not want to use the computer’s built-in microphone

A fast processor is important if recording a great deal of screen activity, but not as critical for recording
things like PowerPoint or Keynote presentations

Physical computer requirements
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Minimum Recommended

CPU: Intel-based processor Intel-based processor

RAM: 1GB 2GB

HD Space Free: 2GB/hour 2 GB/hour

Install Space: 25MB 25MB

Presenter Website Access
To access the Camtasia Relay website and interact with the Camtasia Relay server, presenters need one of
the following web browsers:

Internet Explorer 7 or higher
Firefox 3.x or higher
Safari 3.x or higher
Themost current version of Chrome

To edit captions, presenters need theMicrosoft Silverlight plug-in for their selected web browser.
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Related Documentation and Support
Wehope you have found this Installation Guide helpful, but it is only one of many resources available to you
as a user of Camtasia Relay. The following are some additional resources for Camtasia Relay.

Feedback
If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia Relay
documentation, please send an email to relayhelp@techsmith.com.

mailto:relayhelp@techsmith.com
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Camtasia Relay Website and Recorder
Help
For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website Help. This help is
available after logging into the Camtasia Relay website as an administrator. Just click a Help link, available
on each web page, to open the Camtasia Relay Administrator Help.

For help with the Camtasia Relay recorder, please install and open the Camtasia Relay recorder or open the
portable recorder to access help for the recorder.
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Related Documentation
The following PDF documents are available for download from theCamtasia Relay documentation page on
the TechSmith.com website:

Camtasia Relay Upgrade Guide

Learn how to upgrade Camtasia Relay.

Camtasia Relay Administrator Website Help

Walk through the configuration of Camtasia Relay and find administration information to help you keep
Camtasia Relay running smoothly

Camtasia Relay Server Security Administrator Guide

Learn about ways to help secure your Camtasia Relay server.

Camtasia Relay Release Notes

See a summary of the new features and updates. Learn about how those features affect current users.

Camtasia Relay Technical Reference Guide

An in-depth examination of Camtasia Relay, including the overall architecture, planning information,
sizing and performance considerations, security principles, tips on integrating Camtasia Relay with
other products, and general best practices.

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
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TechSmith Learning Center
The TechSmith Learning Center contains a wealth of free resources for each one of TechSmith’s products,
including Camtasia Relay. We encourage you to visit the site, choose the section that most interests you and
then watch a video or read an article.

The Camtasia Relay Learning Center is available at:

http://www.techsmith.com/tutorial-camtasia-relay.html

http://www.techsmith.com/tutorial-camtasia-relay.html
http://www.techsmith.com/tutorial-camtasia-relay.html
http://www.techsmith.com/tutorial-camtasia-relay.html
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Contact TechSmith Tech Support
In the event you have an installation issue that cannot be answered with the Camtasia Relay Help and
documentation, please follow the steps below to receive assistance from TechSmith Tech Support.

Submit a Question
Problems with installation? Send a question to Tech Support.

1. On the Support Center page (http://support.techsmith.com), click Ask a Question.
2. Log in or register.
3. Fill in the requested information, making sure to include as much information regarding the nature of the

problem as possible.
4. Select Other under Problem Type.
5. In the Attach Documents field, click Browse and locate the %TEMP%\Relay_Setup.
6. Attach all .log files located in the folder to your question.

Call Tech Support
The Camtasia Relay Tech Support team is ready and waiting for your questions. Should you have problems
that you cannot solve using the resources provided, please give us a call and wewill be happy to assist.

The following information is available on the TechSmith website by clicking Company >
Contact Us. Always refer to that location for latest, most accurate information.

Phone:+1.517.381.2300 (ext. 784)

Toll Free in the U.S. & Canada: 800.517.3001 (ext. 784)

Tech Support Website: http://support.techsmith.com

http://support.techsmith.com/
http://support.techsmith.com/
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3rd Party Legal Notices
MP3 Codec

Supply of this product does not convey a license nor imply any right to distribute content created with this
product in revenue-generating broadcast systems (terrestrial, satellite, cable and/or distribution channels),
streaming applications (via internet, intranets and/or other networks), other content distribution systems (pay-
audio or audio-on-demand applications and the like) or physical media (compact discs, digital versatile discs,
semiconductor chips, hard drives, memory cards and the like). An independent license for such use is
required. For details, please visit http://mp3licensing.com

Apache License

Copyright 2008 TechSmith Incorporated, All Rights Reserved Licensed under the Apache License, Version
2.0 (the "License"); youmay not use this file except in compliance with the License. Youmay obtain a copy of
the License at

http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or
implied. See the License for the specific language governing permissions and limitations under the License.

RealNetworks

RealNetworks® technology is provided under license from RealNetworks, Inc., copyright © 1995-2003
RealNetworks, Inc. and/or its suppliers. P.O. Box 91123, Seattle, Washington 98111-9223, U.S.A. Patents
Pending. All rights reserved. RealNetworks is a registered trademark of RealNetworks, Inc.
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All rights reserved

This manual, as well as the software described in it, is furnished under license andmay be used or copied only
in accordance with the terms of such license. The content of this manual is furnished for informational use
only, is subject to change without notice and should not be construed as a commitment by TechSmith
Corporation. TechSmith Corporation assumes no responsibility or liability for any errors or inaccuracies that
may appear in this manual.

Trademarks

All-in-One Capture, Camtasia, Camtasia Relay, Camtasia Studio, Coach's Eye, DubIt, EnSharpen,
EnterpriseWide, Expressshow, Jing, Morae, Rich Recording Technology (RRT), Screencast.com,
ScreenChomp, Show TheWorld, SmartFocus, Snagit, TechSmith, TechSmith Fuse, TSCC and UserVue are
either registeredmarks or marks of TechSmith Corporation in the U.S. and/or other countries. This list is not a
comprehensive list of all TechSmith Corporationmarks. The absence of a name/mark or logo in this notice
does not constitute a waiver of any intellectual property rights that TechSmith Corporation has established in
any of its product, feature or service names/marks or logos. All other marks are the property of their respective
owners.
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Upgrade to a New Release
This document covers two specific upgrade cases:

Upgrade from 1.x to the Current Version
Upgrade from 2.0 and Later to the Current Version

The installer detects your current setup and will present you with different screens depending on what release
you are upgrading from.

It is strongly recommend that you backup your current database before starting any upgrade.

Installers
There are two Camtasia Relay installers available:

CamtasiaRelayServer.exe

Use this installer for upgrading Camtasia Relay on a 32-bit server operating system.

CamtasiaRelayServer_x64.exe

Use this installer for upgrading Camtasia Relay on a 64-bit server operating system.

If you need additional assistance, you can contact TechSmith Technical Support at
http://support.techsmith.com/. Additional contact information is provided at
http://www.techsmith.com/contact.asp.

After you complete an upgrade, youmay want to review the current known issues for
Camtasia Relay 4.0. You can find the list of known issues in the TechSmith Support Center:

4.0.0: http://techsmith.custhelp.com/app/answers/detail/a_id/3317

Camtasia Relay Recorders
For information about upgrading Camtasia Relay recorders, please seeUpgrade Recorders.

http://support.techsmith.com/
http://www.techsmith.com/contact.asp
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
http://techsmith.custhelp.com/app/answers/detail/a_id/3317
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Upgrade from 1.x to the Current Version

If you are currently running Camtasia Relay version 1.0 and want to upgrade to themost
current version of Camtasia Relay, it is important to know that this is a two step upgrade.
There is NOT a direct upgrade option from Camtasia Relay version 1 to the current version of
Camtasia Relay.

Before you start, you will need one of the available Camtasia Relay installers:

Relay_Server_Setup_2.0.exe

Use this installer for upgrading Camtasia Relay on a 32-bit server operating system.

Relay_Server_Setup_2.0_x64.exe

Use this installer for upgrading Camtasia Relay on a 64-bit server operating system.

If you need assistance locating these installers, see the TechSmith Support Center:
http://techsmith.custhelp.com/app/answers/detail/a_id/2845/kw/camtasia%20relay.

Upgrade from 1.0 to the Current Version
1. Upgrade the Camtasia Relay server to version 2.0 by running the 2.0 installer. Follow the instructions

in the installer to complete the upgrade.
2. If it is not already installed, you are prompted to install .NET Framework 3.5 with Service Pack 1. This

is likely to be the longest part of the installation.

The installation of .NET Framework 3.5 with Service Pack 1 requires a server reboot,
so tominimize downtime for the Camtasia Relay server, youmay wish to schedule the
upgrade during off-peak hours.

After the .NET Framework has been installed, the Camtasia Relay server upgrade continues.

3. The installer prompts for the password for the “RelayAdmin” user which is used as the default admin
account for the Camtasia Relay website. If using the Express setup installation path, this password is
also used as the password for the “Relay” SQL user for the database.

4. Continue withUpgrade from 2.0 and Later to the Current Version.

Considerations

All server settings are preserved during the upgrade.
All user information is preserved.
All profiles and publish settings are preserved, but some concepts changed with version 2.0. Please
log into the Camtasia Relay website as an administrator and review the online help.
Job information (i.e. presentations) ARE NOT preserved.

http://techsmith.custhelp.com/app/answers/detail/a_id/2845/kw/camtasia relay
http://techsmith.custhelp.com/app/answers/detail/a_id/2845/kw/camtasia relay
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1.0.x recorders do not work with a current server.
Presenters running on theWindows operating system are able to record and submit pre-
sentations, but they cannot upload to the server. The recorder appears offline and run as not con-
nected to the server. Once presenters install the new version, any submitted presentations will
then upload to the server.
Presenters running onMac operating systems receive amessage to download a new recorder,
but there is a known bug that crashes the recorder when you click the button to download the
upgrade. These presenters need to download and install themost recent recorder to do any fur-
ther recording.

When the user installs a current recorder and has jobs from version 1.0 pending on their computer, the
1.0 jobs are converted to current version jobs and submitted automatically. The titles and descriptions
are preserved, but the user and profile ARE NOT preserved. The presentation is uploaded to the server
using the Upload and Decide Later profile with a guest user that has the original presenter’s email
address. This allows the administrator to push through or delete the jobs, and it also allows the
presenters to log in and see their old jobs.

A result of this is that jobs in a pending state (Needs Attention or Error) before upgrade are uploaded
again. Depending on the server settings, the presenter and administrator may get an email saying a
guest has uploaded a presentation on the presenter’s behalf.

All installations of Camtasia Relay 1.0, 1.1, and 1.2 used the same encryption key. If you installed
Camtasia Relay 2.0 as an upgrade to Camtasia Relay version 1.0, 1.1, or 1.2 then your server/team
uses this same key.

For security reasons, youmay wish to change your server/team to use a random encryption key. You
can accomplish this using the Camtasia Relay Configuration Protection Tool. You can find the
instructions for using this tool in theCamtasia Relay Server Security Administrator Guide, found in
the Camtasia Relay Learning Center on TechSmith website: www.techsmith.com/learn/relay.

http://www.techsmith.com/learn/relay
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Upgrade from 2.0 and Later to the Cur-
rent Version
All server settings, users, profiles, publish settings, and presentations are preserved during an upgrade.

We recommend that you backup your current database before starting any upgrade.

1. Log in to the Camtasia Relay website as an administrator.

2. Go to System > Servers.

3. Select each server and click Take Server Offline. This lets the servers continue to process all existing
presentations but not accept any additional presentations.

4. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. After Camtasia Relay is
upgraded and the server brought back online, all canceled jobs are automatically retried.

5. Run the installer and follow the instructions in the installer to complete the upgrade.

6. When the upgrade is complete, repeat the upgrade on all teamed servers. The upgrade process
automatically restarts the Camtasia Relay servers.

Youmust upgrade all teamed servers to the same version.

While upgrading a server team, if you fail to upgrade a server in the team, it is possible to bring
the server still running the older version online. If this happens, this server connects to the old
version database and appears to be working correctly but it cannot interact with the upgraded
current servers.
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Upgrade Recorders
Following the upgrade of the server, you can notify the presenters that a new version of the Camtasia Relay
recorder is available. Presenters are also notified through the recorder that there is a new version available for
download and installation.

The recorder is available from the homepage after a presenter logs into the Camtasia Relay server.

To deploy the recorder in aWindows enterprise environment, theMSI file can be used. Log in to your
Camtasia Relay website as an administrator and open the help for more information.

Presenters should close the Camtasia Relay recorder if it is open and then run the new recorder installer. The
previous recorder is uninstalled and the new version is installed. They do not lose any saved recordings and
any submitted recordings will upload after the upgrade.

For recorder clients downloaded from a 4.1.0 or later server, an upgrade notification is
displayed in the toolbar of the recorder when a new version of the Camtasia Relay recorder is
available.

Server Certificate Errors
By default, Camtasia Relay recorders fail to connect to a Camtasia Relay Server with an invalid
server certificate.

If your organization is using a self-signed server certificate on the Camtasia Relay server, then you have the
following options to allow recorders to connect to the server:

Add the self-signed server certificate to clients’ trusted certificate stores
If self-signed server certificate is added to a client’s trusted certificate store, users on that client
machine should be able to use a web browser to connect to the Camtasia Relay server website without
having to click through a server certificate warning.
Modify the recorder’s configuration to ignore all server certificate errors

By default, the configuration option to Ignore Server Certificate Errors is not enabled.
If you need to allow Camtasia Relay recorders to connect to a Camtasia Relay server with an
invalid server certificate, youmust enable this option. When enabled, recorders ignore all server
(SSL) certificate errors when connecting to the Camtasia Relay server.
When you change this option, Camtasia Relay's Manager Servicemust be restarted on all
teamed servers for it to take effect. Any recorders installed before changing this optionmust be
updated or they will fail to connect to the Camtasia Relay server.
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Migrate Camtasia Relay to a New Server
The following procedures cover the three different scenarios for migration of Camtasia Relay components to a
new server:

Migrate the Camtasia Relay Application and Database to a New Server
Migrate Only the Camtasia Relay Database to a New Server
Migrate Only the Camtasia Relay Application to a New Server

Important Information
These procedures are necessary only if you wish tomaintain your Camtasia Relay database
informationmoving forward. The database includes information such as users, profiles, publishing
destinations, and historical presentation information.

If you do not wish tomaintain this data and would rather start with a fresh installation on the new
server, first deactivate your current server and then follow the process in the Camtasia Relay
Installation Guide, which is available in the Camtasia Relay Learning Center:
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html

These procedures require taking your Camtasia Relay server offline and then into a shutdownmode. It
is recommended that you read through the whole procedure prior to actual migration. You should famil-
iarize yourself with the procedures and understand how the proceduremay impact presentation proc-
essing for Camtasia Relay presenters.
Prior to using the procedures in this document, the following prerequisites must bemet:

Camtasia Relay 2.0 or above installed on the current server.

If the version of Camtasia Relay is lower than 2.0, seeUpgrade from 1.x to the Current
Version for more information.

SQL Server Management Studio installed on amachine that can access the databases of both
the current SQL server and the new server.
SQL Server installed with an instance called Relay installed on both servers.

It is recommended that you install SQL Server 2008 R2 Express Edition of SQL Server. To
download the installer, go to http://www.microsoft.com/sqlserver/2008/en/us/express.aspx.

If you have upgraded Camtasia Relay on your current server, youmay havemultiple databases, with
different names, in your Relay SQL instance. Make sure you choose themost recent Camtasia Relay
database. The names for the Camtasia Relay databases are:

Camtasia Relay Version Database Name

2.0 Relay20

3.0.0 Relay300

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.microsoft.com/sqlserver/2008/en/us/express.aspx
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Camtasia Relay Version Database Name

3.0.1 Relay301

3.0.2 Relay302

3.0.3 Relay303

3.1.0 Relay310

4.0.0 Relay400

4.0.1 Relay401

4.0.2 Relay402

4.0.3 Relay403

4.1.0 Relay410

4.1.1 Relay411

4.1.2 Relay412

4.2.0 Relay420

4.2.1 Relay421

4.3.0 Relay430

Migrate the Camtasia Relay Application and
Database to a New Server

1. Log in to the Camtasia Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

The server continues to process all existing presentations but does not accept any additional
presentations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. (After the database is moved and the
Camtasia Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Go to System > Activation.
5. Click Deactivate.
6. Please back up the Camtasia Relay database using instructions found inBack Up the Database.
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7. Copy the database backup file to the target server.
8. Using the same path and name of themedia directory on the source server, create amedia directory on

the target server.

Themedia directory location was set during the initial installation of Camtasia Relay.

The location of themedia directory on the target server must be exactly the same as the
source server. To find this information, open a web browser and go to https://
(RelayWebsiteName)/Relay/relayconfig.aspx. The path is located in the
MediaDirectory row.

9. Copy the contents of themedia directory from the source server to the target server.
10. On the source server, navigate to [install directory]/Utilities and open the Con-

figuration Protection Tool (ConfigurationProtectionTool.exe).
11. Click Load Current Server Settings.

Later in this procedure, you will need the SQL username and password for Camtasia
Relay. If you do not already have this information, click the SQLConnection tab. The
username and password are listed.

12. Go to the Import/Export tab.
13. Click Export Settings to File to export the server encryption settings.
14. Move the resulting XML file to the target server.
15. If you want currently installed Camtasia Relay recorders to be able to connect to the target server, the

server must keep the same endpoint (often the Fully Qualified Domain Name) as the source server. If
the endpoint is not kept the same, presenters must download and install new recorders from the target
server in order to connect.

To keep the same endpoint on the target server, perform one of the following procedures:

If the Camtasia Relay recorders address the server by host name only (e.g. https://relay):
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.
Change the target server to the original name of the source server.
Reboot the target server.

If the Camtasia Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server name is different than the DNS host
name:

Name the target server as desired.
Modify the DNS record for the Camtasia Relay endpoint to point to the IP address of the
target server.

If the Camtasia Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server namematches the DNS host name:

Confirm that the Camtasia Relay endpoint DNS name is the result of dynamic DNS reg-
istration. Your Active Directory or DNS administrator should be able to provide this

http://support.microsoft.com/kb/295017
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information.
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.
Change the target server to the original name of the source server.
Reboot the target server.
Verify that the DNS record for the Relay endpoint reflects the IP address of the target
server.

16. Restore the database on the target server using the instructions found inRestore the Camtasia Relay
Database.

17. In the Object Explorer pane of SQL Server Management Studio, go to Relay Database Instance >
Security > Logins.

18. Right-click Logins and select New Login.

The following assumes that Relay is used as the database user. If you chose to use a
different database user during initial installation of Camtasia Relay, substitute that user
name for the user named Relay in the following process.

19. Enter Relay (or your selected database user) for the Login name.
20. Enable the SQL Server authentication option and enter the same password used on the source server.

(See tip in step 11.)
21. Disable the User must change password at next login option.
22. Right-click Logins and select New Login.
23. Enter RelayCache (use RelayCache even if you selected a different name for the database user)

for the Login name.
24. Enable the SQL Server authentication option and enter the same password used on the source server.
25. Disable the User must change password at next login option.
26. Replacing RelayDbName with your Camtasia Relay database name, run the following query against

the Relay instance on the target SQL server:

The following SQL statement assumes that Relay is used as the database user. If
you chose to use a different database user during initial installation of Camtasia Relay,
substitute that user name for the user named Relay in the following process.

USE RelayDbName

ALTER USER Relay WITH LOGIN = Relay

ALTER USER RelayCache WITH LOGIN = RelayCache

USE master

ALTER DATABASE RelayDbName SET SINGLE_USER WITH ROLLBACK

IMMEDIATE

ALTER DATABASE RelayDbName SET ENABLE_BROKER

http://support.microsoft.com/kb/295017
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ALTER DATABASE RelayDbName SET MULTI_USER

27. Run the Camtasia Relay installer on the target server, making sure to:

Select Keep your existing database.
Set themedia directory the same as what it was on the source server.
Use the sameRelay SQL user password as on the source server’s database.
The Camtasia Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.

28. Go to [install directory]/Utilities and open the Configuration Protection Tool (Con-
figurationProtectionTool.exe).

29. Go to the Import/Export tab.
30. Click Browse, locate the XML file that you created on the source server, and then click Open.
31. Click the SQLConnection tab. Change the Data Source to the instance name (e.g. your-

servername\Relay) on the target server.
32. Go to the Encryption tab.
33. Click Install New Key.
34. Log in to the server website as an administrator.
35. Go to System > Activation and enter your license key.
36. You can now uninstall Camtasia Relay from the source server.
37. If the target server was not updated to have the same endpoint as the source server (step 15), there is

still an entry for the source server’s endpoint in the database. Contact TechSmith Technical Support
(http://support.techsmith.com) for assistance removing the source endpoint.

Migrate Only the Camtasia Relay Database to
a New Server

1. Log in to the Camtasia Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

The server continues to process all existing presentations but will not accept any additional
presentations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. (After the database is moved and the
Camtasia Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Please back up the Camtasia Relay database using instructions found inBack Up the Database.
5. Copy the database backup file to the target (new) server.
6. Restore the database on the target server using the instructions found inRestore the Camtasia Relay

Database.
7. In the Object Explorer pane of SQL Server Management Studio, go to Relay Database Instance >

Security > Logins.
8. Right-click Logins and select New Login.

http://support.techsmith.com/
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The following assumes that Relay is used as the database user. If you chose to use a
different database user during initial installation of Camtasia Relay, substitute that user
name for the user named Relay in the following process.

9. Enter Relay (or your selected database user) for the Login name.
10. Enable the SQL Server authentication option and enter the same password used on the source server.
11. Disable the User must change password at next login option.
12. Right-click Logins and select New Login.
13. Enter RelayCache (use RelayCache even if you selected a different name for the database user)

for the Login name.
14. Enable the SQL Server authentication option and enter the same password used on the source server.
15. Disable the User must change password at next login option.
16. Replacing RelayDbName with your Camtasia Relay database name, run the following query against

the Relay instance on the target SQL server:

The following SQL statement assumes that Relay is used as the database user. If
you chose to use a different database user during initial installation of Camtasia Relay,
substitute that user name for the user named Relay in the following process.

USE RelayDbName

ALTER USER Relay WITH LOGIN = Relay

ALTER USER RelayCache WITH LOGIN = RelayCache

USE master

ALTER DATABASE RelayDbName SET SINGLE_USER WITH ROLLBACK

IMMEDIATE

ALTER DATABASE RelayDbName SET ENABLE_BROKER

ALTER DATABASE RelayDbName SET MULTI_USER

17. Uninstall the Camtasia Relay server software on the server. This allows a reinstall while pointing to a
different database server.

18. Run the Camtasia Relay installer on the server, making sure to:
Select the Advanced installation option.
When prompted for a SQL Server Connection, specify the target database server name (Tar-
getServerName\Relay) as the SQL Server name.
Select Keep your existing database.
Set themedia directory to the same directory that it was before the uninstall.
Use the sameRelay SQL user password as on the source server’s database.
The Camtasia Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.
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19. Log in to the server website as an administrator.

Migrate Only the Camtasia Relay Application
to a New Server
It is recommended that you let all existing presentations finish processing before performing themigration. To
do this youmust first take the server offline, which prevents it from further accepting presentation uploads,
and then lets it process those presentations. Instructions for performing those functions are listed below.

1. Log in to the Camtasia Relay website as an administrator on the source (current) server.
2. Go to System > Servers. Click Take Server Offline.

The server continues to process all existing presentations but will not accept any additional
presentations.

3. When all encoding and publishing jobs havemoved to Completed, click Shutdown.

Any presentations that are not completed are canceled. (After the database is moved and the
Camtasia Relay server is brought back online, all canceled jobs are automatically restarted.)

4. Go to System > Activation.
5. Click Deactivate.
6. Using the same path and name of themedia directory on the source server, create amedia directory on

the target server.

Themedia directory location was set during the initial installation of Camtasia Relay.

The location of themedia directory on the target server must be exactly the same as the
source server. To find this information, go to
yourservername/Relay/relayconfig.aspx. The path is located in the
MediaDirectory row.

7. Copy the contents of themedia directory from the source server to the target server.
8. On the source server, navigate to [install directory]/Utilities and open the Con-

figuration Protection Tool (ConfigurationProtectionTool.exe).
9. Click Load Current Server Setting.
10. Go to the Import/Export tab.
11. Click Export Settings to File to export the server encryption settings.
12. Move the resulting XML file to the target server.
13. If you want currently installed Camtasia Relay recorders to be able to connect to the target server, the

server must keep the same endpoint (often the Fully Qualified Domain Name) as the source server. If
the endpoint is not kept the same, presenters must download and install new recorders from the target
server in order to connect.

To keep the same endpoint on the target server, perform one of the following procedures:

If the Camtasia Relay recorders address the server by host name only (e.g. https://relay):
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.

http://support.microsoft.com/kb/295017
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Reboot the source server.
Change the target server to the original name of the source server.
Reboot the target server.

If the Camtasia Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server name is different than the DNS host
name:

Name the target server as desired.
Modify the DNS record for the Camtasia Relay endpoint to point to the IP address of the
target server.

If the Camtasia Relay recorders address the server by the fully-qualified domain name (e.g.
https://relay.university.edu) and the server namematches the DNS host name:

Confirm that the Camtasia Relay endpoint DNS name is the result of dynamic DNS reg-
istration. Your Active Directory or DNS administrator should be able to provide this infor-
mation.
Rename your source server to free the computer name. For information on how to do
this, see http://support.microsoft.com/kb/295017.
Reboot the source server.
Change the target server to the original name of the source server.
Reboot the target server.
Verify that the DNS record for the Relay endpoint reflects the IP address of the target
server.

14. Run the Camtasia Relay installer on the target server, making sure to:

Change the SQL Server name listed to the database server of your installation when prompted
for a SQL Server Connection.

Select Keep your existing database.
Set themedia directory the same as what it was on the source server.
Use the sameRelay SQL user password as on the source server’s database.

The Camtasia Relay website andmanager service will not be able to access the database
unless the Relay SQL password on the target server is the same password that was used on
the source server's database.

15. Go to [install directory]/Utilities and launch the Configuration Protection Tool.
16. Go to the Import/Export tab.
17. Click Browse, locate the XML file that you created on the source server, and click Open.
18. Go to the SQLConnection tab. Change the Data Source to the instance name (e.g. your-

servername\Relay) on the target server.
19. Go to the Encryption tab.
20. Click Install New Key.
21. Log in to the server website as an administrator.
22. Go to System > Activation and enter your license key.
23. You can now uninstall Camtasia Relay from the source server.

http://support.microsoft.com/kb/295017
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24. If the target server was not updated to have the same endpoint as the source server (step 15), there is
still an entry for the source server’s endpoint in the database. Contact TechSmith Technical Support
(http://support.techsmith.com) for assistance removing the source endpoint.

Back Up the Database
The following procedure covers how to back up the Camtasia Relay database using SQL Server Management
Studio. For additional information and other ways to perform a backup, see the following:

Camtasia Relay Technical ReferenceGuide (available in the Camtasia Relay Learning Center:
http://www.techsmith.com/learn/relay/3/documentation/)
How to: Back Up a Database (SQL Server Management Studio): http://msdn.microsoft.com/en-
us/library/ms187510(v=SQL.105).aspx

This procedure can be performed locally on the database server or from a remotemanagement workstation
with SQL Server Management Studio installed if remote access to the database server has been allowed.
However, disk locations denoted in the backup procedure will always be local to the database server.

1. Right-click the database to back up and select Tasks > Back Up.

http://support.techsmith.com/
http://www.techsmith.com/learn/relay/3/documentation/
http://msdn.microsoft.com/en-us/library/ms187510(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms187510(v=SQL.105).aspx
http://msdn.microsoft.com/en-us/library/ms187510(v=SQL.105).aspx
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2. On theGeneral tab, select backup type Full and set a location on disk for the backup file.

3. Choose to back up to an existing backup set or to append to a new backup set. Selecting Verify
backup when completed is recommended. Then, click OK.

The backup is complete.

Restore the Camtasia Relay Database
The following procedure covers how to restore the Camtasia Relay database using SQL Server Management
Studio. For additional information and other ways to perform a backup, see the following:



Camtasia Relay Release Notes

www.techsmith.com - 16 -

Camtasia Relay Technical ReferenceGuide (available in the Camtasia Relay Learning Center:
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html)
How to: Restore a Database Backup (SQL Server Management Studio): http://msd-
n.microsoft.com/en-us/library/ms177429.aspx

To restore a database backup file using SQL Server Management Studio:

1. Place the backup file in a folder on the database server that can be locally accessed by SQL Server.
2. Open SQL Server Management Studio.
3. Right-click the existing database or Databases (if restoring to a new database) and select Tasks >

Restore > Database.

4. Set the database name to restore. Select From Device and click … to select the backup file.

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms177429.aspx
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5. Click Add to select the location of your database backup file. Click OK.
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6. Set Restore options to overwrite the database (if applicable), restore files to correct path, and Leave
the database ready to use. Click OK.
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The database is now restored.
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Introduction
With Camtasia Relay, capture and publish your lecture or presentation anytime, anywhere--in the classroom,
in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video formats
allowing any lecture or presentation to be viewed by your audience onmultiple playback devices including port-
able media devices such as the Apple iPod and via iTunes U.

There are two parts to Camtasia Relay--the recorder which runs on your computer and the server which proc-
esses and publishes all presentations. Watch a short overview video on the TechSmith website.

Topics included in this help file include:

Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources
Presentations
Caption Editor
Profiles
Profile Setup
Publish Account Setup
Download Recorders
Camtasia Relay Portable Recorder

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Important Camtasia Relay Concepts
Before you start using Camtasia Relay, there are several concepts you should be familiar with. Please review
the following topics.

The Camtasia Relay Recorder
To record a presentation, you first need to download and install the Camtasia Relay recorder on your com-
puter. Click Download Recorders and then click the recorder download link for your operating system to
start the download.

The portable recorder can be installed on amobile storage device, such as a USB flash drive. This recorder
provides you with an option for recording when you:

Do not have permission to install applications.
Have limited or no network access.
Have several presentations and want to upload them collectively at a later time.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

For more information on the recorder, seeDownload Recorders.

Profiles
Profiles are the backbone of Camtasia Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profiles are created by the administrator and include settings that define how the presentation is recorded,
processed, and published. When selecting a profile in the Camtasia Relay recorder, only the profile title is
available to help presenters choose which one to use; the profile description is only visible on the website.

TheUpload and Decide Later Profile sends the recording to the Camtasia Relay server but does not process
the recording in any way. The presentation stays in theNeeds Attention state on the server until an admin-
istrator or the presenter selects a profile to use or deletes the presentation.

For more information, seeProfiles.

Accounts
After presentations are processed, they are sent to publish destinations for viewing. Publish destinations
include locations like iTunes, a Screencast.com account, a file server, etc. In many cases, account cre-
dentials are required to access publish destinations.

There are two ways that Camtasia Relay can handle credentials. Credentials can be supplied by an admin-
istrator, or a presenter may be required to enter his or her own account credentials.

In the case where a presenter is required to enter credentials, he or shemust log into the Camtasia Relay web-
site and add a publish account for a given publish destination.

Presentations submitted using a profile that needs a presenter to add a publish account are held in theNeeds
Attention state until a valid publish account is added.

For more information on how to add a publish account, seePublish Account Setup.



Camtasia Relay PresenterWebsite Help

www.techsmith.com - 3 -

See also

Introduction
Home
Account Settings
Help and Resources
Presentations
Caption Editor
Profiles
Profile Setup
Publish Account Setup
Download Recorders
Camtasia Relay Portable Recorder
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Home
The Home page gives presenters a quick peek into their Camtasia Relay account.

Actions Necessary:Any time a presenter needs to take some action to finish proc-
essing and publishing a presentation, there is amessage in this area. Actions needed
may include caption editing, assigning a profile to an uploaded presentation, and add-
ing or updating publish account information.

Recent Presentations: This area displays all recent presentations from the presenter.
Click a presentation name to see detailed information about a presentation’s status.

Camtasia Relay Recorders: This link takes a presenter directly to theDownload
Recorders page to locate and download the Camtasia Relay recorder.

Frequently Asked Questions: These questions and answers help a presenter find
some basic Camtasia Relay information. Click a question to reveal the answer. Click
View All to go to theHelp and Resources page to find additional FAQs and links to
training videos.

See also

Introduction
Important Camtasia Relay Concepts
Account Settings
Help and Resources
Presentations
Caption Editor
Profiles
Profile Setup
Publish Account Setup
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Download Recorders
Camtasia Relay Portable Recorder
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Account Settings
Depending on how your Camtasia Relay administrator sets up Camtasia Relay, youmay need or want to mod-
ify your Camtasia Relay account.

Presenters may not have the ability to modify their Camtasia Relay account information in
some cases. For example, if presenter login information in Camtasia Relay is bound to net-
work credentials presenters cannot edit username and password on the Camtasia Relay web-
site.

On the Change Account Information tab, presenters can access the following fields:

The Name field changes the name used in presentation notifications.
The Email Address field changes the email address to which email notifications, such as completed
presentations, are sent.

If the Change Password tab is available, presenters can change the password they use to log into the Cam-
tasia Relay website and recorder.

See also

Introduction
Important Camtasia Relay Concepts
Home
Help and Resources
Presentations
Caption Editor
Profiles
Profile Setup
Publish Account Setup
Download Recorders
Camtasia Relay Portable Recorder
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Help and Resources
The Help and Resources page assists presenters in answering questions or finding help for the Camtasia
Relay website.

Here presenters can view training videos, access frequently asked questions and answers, and link directly to
the Download Recorders page.
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Presentations
The Presentations page allows you to view presentations by state and take action to resolve issues.

Presentations in all states have the following information:

User name and email of presenter that submitted the presentation
Date and time the presentation was recorded
Presentation description, if entered by the presenter
Profile used, with link to view and edit profile
Duration of presentation
Resolution of presentation

You can view presentations on the server by the following states:

States Description

Needs
Attention

Use the information and options provided to resolve issues so the presentation
can process. Includes a list of presenters and a list of profiles to select from. You
can also delete presentations.

Processing
View the progress of a processing presentation. You can see the progress of
each job associated with the presentation, including transcription, encoding, pub-
lishing, and notifications.

Uploading View the upload progress and cancel upload, if needed.

Completed View the status of presentations that have completed processing. For some pub-
lish destinations, links are included to view the published presentation.

Deleted View information about any deleted presentations.

Failed Use the information provided to figure out why a presentation failed. Includes
status information to show you which part of processing failed.

Held for
Captioning

View the presentations held for caption editing. When caption editing is complete
or to skip caption editing, click Edit Captions to open the presentation in the cap-
tion editor orRelease Hold to continue processing the presentation.

See also

Introduction
Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources
Caption Editor
Profiles
Profile Setup
Publish Account Setup
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Download Recorders
Camtasia Relay Portable Recorder
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Caption Editor
The Caption Editor page allows presenters and global caption editors to review and edit captions that were
created automatically by Camtasia Relay. When a presentation is held for caption editing, all processing and
publishing is stopped until the presenter releases the presentation to complete processing and publishing.

Users can only access the Caption Editor page if they have a presentation that is being held for caption edit-
ing.

Microsoft Silverlight is required to edit captions. The website prompts you if installation of or an
update to Silverlight is required.

See also

Access the Caption Editor
Edit Presentation Captions
Caption Editing Tips

Access the Caption Editor
When a presenter has a presentation that is ready for caption editing, there are a few ways to get to the cap-
tion editor. Global caption editors can only have access to the third option, the Presentations page.
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From the notification email

Click theEdit the presentation captions link in the email you receive when a presentation is ready for
caption editing.

From the Home page

Click the name of a presentation shown under Presentations held for caption editing.

From the Presentations page

Select Held For Captioning from the Status dropdown list.

Click a presentation to select it.
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On the right side of the page, click Edit Captions.

See also

Edit Presentation Captions
Caption Editing Tips

Edit Presentation Captions
Once a presentation is open in on the Caption Editor page, use the following process for editing captions and
submitting the presentation for final processing and publishing:

1. On the Edit Captions tab, use the video controls review the automatic captions.

2. Edit existing captions by clicking inside a caption and editing the text.

3. Add , delete , and split captions as needed.
4. To save your work, click Save.



Camtasia Relay PresenterWebsite Help

www.techsmith.com - 13 -

Camtasia Relay automatically saves changes to the presentation captions every min-
ute.

5. When the captions are complete, click the Preview and Submit tab.

6. Review the presentation andmake any final adjustments to the text or timing of the captions.

7. When you are satisfied with the captions, click Publish.

The presentation continues processing and publishing.
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See also

Access the Caption Editor
Caption Editing Tips

Caption Editing Tips
Here are some tips to help you when editing captions:

To stop at the end of each caption, disable the Continuous Playback button .
While working in a caption, click Replay to repeat the text of the selected caption once. Repeatedly
click theReplay button until you are able to transcribe the entire caption.

The number in the lower right of a caption shows the remaining characters available to keep the caption
within compliancy guidelines. If a caption is too long, it turns yellow and shows a negative number of
characters available.
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Click theSplit button to separate a caption into two smaller captions.

Use the standard keyboard shortcuts for Undo (<CTRL+Z>, <Command+Z>) and Redo (<CTRL+Y>,
<Command+Y>) to undo or redo your actions in the caption editor.

See also

Access the Caption Editor
Edit Presentation Captions
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Profiles
A profile consists of settings that determine how a presentation is recorded, processed, and presented. Pro-
files are created by the Camtasia Relay administrator. If you do not have a profile that provides you with the
options that you need, seeCan I Change My Profiles?

To access information on profiles available to you:

1. Log in to the Camtasia Relay website.
2. Click Profiles
3. In the list of profiles, click a profile.
4. Click Overview. SeeProfile Setup for additional information.

Only Camtasia Relay administrators can create or modify profiles.

If you are not satisfied with existing profile options, you can select the Upload and Decide
Later Profile. This sends the recording to the server where it remains until you contact your
Camtasia Relay administrator to create or modify a profile.

Can I Change My Profiles?
Only Camtasia Relay administrators can create or modify profiles. If you are not satisfied with your existing
profile options, contact your Camtasia Relay administrator. Consider the following questions before con-
tacting your administrator.

What kind of recording do you want to make:
Will there be a lot of movement, such as video, in your presentations?
Are you going to record PowerPoint presentations?
Anything else the administrator should know about what you are recording?
Are you planning on editing presentations in Camtasia Studio?

What kind of files do you want to produce:
Do you needmultiple file types for the same presentation?
Is there a certain kind of file you need?
Do you want an audio-only file?
Should the produced presentations be certain dimensions?

Where do you want the produced files to end up:
Do you have a file folder location for the produced files?
Do you have an account on Screencast.com that you want to use?
Do you want to send your presentations to a website via an FTP server?
Do you want to send your presentations to iTunes U?

Some of the options mentioned abovemay not be available for your use.



Camtasia Relay PresenterWebsite Help

www.techsmith.com - 17 -

See also

Introduction
Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources
Presentations
Caption Editor
Profile Setup
Publish Account Setup
Download Recorders
Camtasia Relay Portable Recorder
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Profile Setup
On the Profile Setup page for a profile, presenters can select publish accounts to use for the profile and
access an overview of a profile.

Publish Accounts
Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

Select a publish account for each encode setting or select one publish account to use for all encodings within
a publish destination.

Profile Overview

Settings included in a profile:

Description:What should you use this profile for? The description is entered by an
administrator to help you to choose the correct profile for your needs.

Publish destinations:Where the produced files go. Presentations can be published to
one or more destinations. Examples include an FTP server, a network drive, Screen-
cast.com, or iTunes U.

Encode settings:What kinds of files are produced. The original recording is encoded
into one or more formats. Examples include an audio only (MP3) encoding, an iPod-
compatible encoding, orWindows Media format. Encoding can reduce the frame rate
and audio quality, but can never improve the original recording.

Publish accounts:How to access the publish destinations. These accounts contain
specific information used to place processed presentations in a publish destination,
such as authentication information, folder selection, etc.

Notifications:How people are informed when presentations are published. Noti-
fications are sent per profile and can include information about multiple encodings of the
same presentation.
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See also

Introduction
Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources
Presentations
Caption Editor
Profiles
Publish Account Setup
Download Recorders
Camtasia Relay Portable Recorder



Camtasia Relay PresenterWebsite Help

www.techsmith.com - 20 -

Publish Account Setup
On the Publish Account Setup page for a profile, presenters can select publish accounts to use for the profile
and access an overview of a profile.

For each available publish destination, you can define the accounts for Camtasia Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

To Create a Publish Account
1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-

tinations you have set up.
2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts
The following informationmight help you inmaking some decisions when creating your publish accounts.

Each publish destination can have a default account.

This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

YouTube publish accounts require verification to upload videos longer than the YouTubemax-
imum (15minutes as of November 2011). For more information on verifying your YouTube
account, visit YouTube.com.

See also

Introduction
Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources

http://www.youtube.com/


Camtasia Relay PresenterWebsite Help

www.techsmith.com - 21 -

Presentations
Caption Editor
Profiles
Profile Setup
Download Recorders
Camtasia Relay Portable Recorder
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Download Recorders
On the Download Recorders page, presenters can access and download the Camtasia Relay recorders.

As of version 4.1, when a new version of the Camtasia Relay server is installed, an update notification is sent
to Camtasia Relay recorder clients informing users of the availability of an update. Recorders downloaded
from versions of Camtasia Relay prior to 4.1 receive no update notifications.

When presenters download the recorder, any available plug-ins and add-ins are also installed on the pre-
senters’ computers.

Windows Operating Systems
Presenters are given the option in the Camtasia Relay recorder installer to install theCamtasia
Relay Add-In for Microsoft Office PowerPoint. This add-in allows a presenter to easily rec-
ord a PowerPoint slide show with Camtasia Relay from inside of PowerPoint. See the Cam-
tasia Relay recorder help for more information.
Presenters that are also running Camtasia Studio 5.1 and above are provided with a plug-in that
allows for sending a Camtasia Studio project to the Camtasia Relay server for production and
publishing. An option to produce with Camtasia Relay is added to the production process in
Camtasia Studio automatically when both programs are installed on the same computer.

Mac Operating Systems

Presenters that are also running Camtasia for Mac 1.2 and above are provided with a plug-in that
allows for sending a Camtasia for Mac project to the Camtasia Relay server for production and pub-
lishing. An option to share with Camtasia Relay is added to Camtasia for Mac automatically when both
programs are installed on the same computer.

TechSmith Fuse® for Camtasia Relay

In addition to recording a computer screen, live video footage taken with amobile device recorded with
TechSmith Fuse for Camtasia Relay can be sent to a Camtasia Relay server. TechSmith Fuse for
Camtasia Relay uses profiles to encode and publish your video just like the desktop application, but
with all the portability of your mobile device.

Existing videos on your mobile device can also be uploaded via TechSmith Fuse.

TechSmith Fuse for Camtasia Relay is available for iOS and Android devices.

See also

Camtasia Relay Portable Recorder
Introduction
Important Camtasia Relay Concepts
Home
Account Settings
Help and Resources
Presentations
Caption Editor
Profiles
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Profile Setup
Publish Account Setup

Camtasia Relay Portable Recorder
Download and use the Camtasia Relay portable recorder if there is any reason you cannot (or should not) rec-
ord and upload directly from the presentation computer.

Examples of When to Use the Portable Recorder

You need to record on a computer where you do not have permission to install applications.
You need to record on a computer with limited or no network access.
You want to record several presentations and upload them collectively at a later time.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

See also

Download the Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder

Download the Portable Recorder
If you need a portable version of Camtasia Relay, use the following process to install the portable recorder on
amobile storage device, such as a USB flash drive.

1. Plug in amobile storage device and format the device as FAT32.
2. If available on the Download Recorders page, click Download Portable Recorder and save the ZIP

file to your computer.

Youmay have to request the portable recorder. Click the button to send a request to your administrator.

3. Locate and open PortableCamtasiaRelay.zip.
4. Copy all files from the ZIP file onto themobile storage device. All files from the ZIP folder need to be

copied to the root of the device.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

See also

Camtasia Relay Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
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Record with the Portable Recorder
Upload Presentations from the Portable Recorder

Run the Portable Recorder
Depending on the operating system and security settings of a computer, you can start the portable recorder in
one of the following ways.

Windows Operating System with AutoPlay Enabled

Under certain conditions, when you connect amobile storage device that contains the portable recorder with a
computer, you are presented with the option to immediately start the application.

Click Start Camtasia Relay to run the portable recorder.

Windows Operating System with AutoPlay Disabled

If AutoPlay is disabled, to run recorder:

1. OpenWindows Explorer (Right-click Start and select Explore.)
2. Navigate to themobile storage device.
3. Double-click PC Camtasia Relay.exe.

Mac Operating System

1. Navigate to themobile storage device.
2. Double-click Mac Camtasia Relay.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder

Log In to the Portable Recorder
There are some considerations to keep inmind when you attempt to log in to the Camtasia Relay portable
recorder.

To log in on the portable recorder, youmust first run the portable recorder on a computer that can con-
nect to the Camtasia Relay server.

To do this, connect themobile storage device to a computer with the "regular" Camtasia Relay
recorder installed on it. Open the portable recorder and log in. This saves your presenter information on
the portable recorder and allows you to access your profiles when you are not connected to the server.

If you run the portable recorder without previously logging in while connected to the server, you are not
able to log in. Identify yourself as a guest to use the Upload and Decide Later profile.
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See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder

Record with the Portable Recorder
Youmay notice a few differences when running Camtasia Relay from amobile storage device, but generally,
the process of recording is the same.

Differences when Recording with Portable Recorder

Click theView Presentations button to see and upload the presentations saved to themobile
storage device.

In most cases, you will not be connected to the server. When you see this icon , you are not con-
nected to the server.
After you finish recording, youmust save your file to themobile storage device running the Camtasia
Relay portable recorder. You cannot submit it for upload from the computer you are using.
Youmay not be able to log in. See Log In to the Portable Recorder for more information.
When you finish your recording, click Save to save the presentation to themobile storage device.
If you are running the portable recorder on a computer with Camtasia Relay installed, you can choose
to save your presentation or submit it for upload to the server.
To upload saved presentations, connect themobile storage device to a computer with Camtasia Relay
installed on it. You can thenUpload Presentations from the Portable Recorder.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Upload Presentations from the Portable Recorder

Upload Presentations from the Portable Recorder
To upload saved presentations from amobile storage device, youmust connect themobile storage device to a
computer with Camtasia Relay recorder installed on it.

You can submit saved presentations at any time. If you are not connected to the internet, the
presentations upload to the server when your computer is next connected.

To submit saved presentations for upload:
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1. Click theView Saved Presentations button.

2. The Saved Presentations dialog opens.

3. Click Submit All to submit all of the presentations for upload or click to submit individual pre-
sentations.

If you are online and connected to the server, your presentation starts to upload.

If you are offline, your presentation is stored on the computer and automatically upload to the
server once you are online and connected.
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See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
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Introduction
This document introduces you to Camtasia Relay, walks you through configuring the system, and provides
you with administration information to help you to keep Camtasia Relay running smoothly.

Camtasia Relay Administration Help Topics

Camtasia Relay Overview
Important Camtasia Relay Concepts
Configuration of Camtasia Relay
Camtasia Relay Administration Reference
Need More Help
Working with Technical Support
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Camtasia Relay Overview
With Camtasia Relay, you can capture and publish your lecture or presentation anytime, anywhere -- in the
classroom, in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video
formats allowing any lecture or presentation to be viewed by your audience onmultiple playback devices
including portable media devices such as the Apple iPod and via iTunes U.

There are two parts to Camtasia Relay—the recorder, which runs on a presenter’s computer, and the server
which processes and publishes all presentations. Watch a short overview video on the TechSmith website.

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
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Important Camtasia Relay Concepts
Before you configure Camtasia Relay, there are several concepts you should be familiar with. Please review
the following topics. You can find additional information in theCamtasia Relay Administration Reference
part of this help.

Profiles
Profiles are the backbone of Camtasia Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profiles are created by the administrator and include settings that define how the presentation is recorded,
processed, and published. Careful consideration of how you want to set up your organization’s profiles helps
simplify maintenance of the profiles over time.

Things to consider:

Youmay want to first create a test profile to make sure that you understand the parts of the profile and
some of the options available to ease day to day maintenance, such as variables.
The profile title is the only thing presenters can see in the recorder. The profile description is only vis-
ible on the website. Consider carefully how you choose profile titles so that they convey their intended
use to presenters.

Good titles:BIO-101, Sales Dept Meetings, Weekly Status Reports, Personal Recordings
Not-so-good titles:MP4Output, John Presenter, 10142

TheUpload and Decide Later Profile sends the recording to the Camtasia Relay server but does not
process the recording in any way. The presentation stays in theNeeds Attention state on the server
until an administrator or the presenter selects a profile to use or deletes the presentation.

For more information, seeProfiles

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are administrator-defined and system-defined variables available:

Administrator-defined variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

For example, you can create a global variable for Semester, add it to a file system publish destination
path and use the publish destination for multiple profiles. When the semester is over, you change the
value once, and the publish destinations paths are automatically adjusted to reflect the change.

System-defined variables

These variables are included in the Camtasia Relay system and change based on the information for
the presentation that is being processed.

For example, you can use the system variable for the presenter’s username in a publish destination file
path such as \\media.company.com\presentations\{s:PresenterUserName}. When the pre-
sentation is published, the presenter’s username is substituted in the file path and places the pre-
sentation in that presenter’s network folder.
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For more information, seeVariables.

Administrators Cannot Record Presentations
Administrators cannot make recordings or log in to the Camtasia Relay recorder.

To record, youmust create a presenter account. The presenter account cannot have the same email address
as the administrator account.

If you are using LDAP, instead of creating a new user in LDAP, create a new user on the Camtasia Relay web-
site. SeeManually Add Users to Camtasia Relay for more information about how to create a new user.

Camtasia Relay Recorder
There are a few ways to access the recorder:

Administrators and presenters can download the Camtasia Relay recorder from the Camtasia Relay
website.
Administrators can also obtain the files at:

{base URL}/Relay/Downloads/WinCamtasiaRelay.exe (Windows)

{base URL}/Relay/Downloads/MacCamtasiaRelay.zip (Mac)

{base URL}/Relay/Downloads/PortableCamtasiaRelay.zip (Portable)

The server URL is hard coded into the recorder. If you havemultiple instances of Cam-
tasia Relay in your organization and are distributing the files to presenters make sure
presenters are installing recorders from the correct server instances.

In a locked-down or controlled environment, the administrator can choose to deploy the Camtasia
Relay recorder forWindow operating systems, instead of having the users download it from the Relay
website.
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Configuration of Camtasia Relay

Before starting configuration, please review Important Camtasia Relay Concepts.

After installation, you need to configure Camtasia Relay beforemaking it available to presenters. Use the fol-
lowing processes to configure your server properly.

1. Define Publish Destinations

2. Set Up Notifications

3. Create Profiles

4. Add Users to Camtasia Relay

Other things to do before you start using Camtasia Relay

Activate / Deactivate Camtasia Relay Server
Roll-Out Camtasia Relay
Deploy Camtasia Relay Recorder

1. Define Publish Destinations
Publish Destinations are the locations that presentations are placed when processing is complete.

Camtasia Relay can publish presentations tomany kinds of media servers. For more information on setting up
a specific type of publish destination, seePublish Destination Setup.

Completed presentations should not be published (hosted) on the Camtasia Relay server.

To Create a Publish Destination

1. Go to Profiles > Publish Destination Setup.
2. Click one of the publish destination types to create a new destination.

If the publish destination you would like to use is not available in the list of publish
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destinations, youmay have to install the appropriate plug-in before you can use it. See
Plug-Ins for more information.

3. Enter all required information. In many cases, you can use variables to help createmulti-purpose pub-
lish destination paths and URLs.

4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

Publish Account Setup
After you create a publish destination, you define the account for Camtasia Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
4. If not a default account, select if you want toUse account information from default account. This

allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.

You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.

This can be helpful in several ways:

You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.
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You can select different publish accounts for each publish destination/encode setting combination in a
profile.

2. Set Up Notifications
Notifications are the various ways that people are informed when presentations are published. They are sent
per profile and can include information about multiple processed presentations.

To set up notifications, you first configure the notification server and then create custom notifications. If you
want to use the email server you set up during installation, you can skip ahead toNotification Setup.

You can configure three types of notification servers:

BlackBoard:Posts notifications directly to BlackBoard
Email:Sends notifications through the email server.

You can only configure one email server.

Moodle:Posts notifications toMoodle.
For more information on setting up a specific type of notification server, seeNotification Server Setup.

Configure a Notification Server

1. Go toProfiles > Notification Server Setup.
2. Click one of the server types to create a new notification server.

If the notification server type you would like to use is not available in the list of noti-
fication servers, youmay have to install the appropriate plug-in before you can use it.
SeePlug-Ins for more information.

3. Enter all required information.
4. Click Save.
5. The notification server information is saved and you are presented with a link to theNotification Setup

for this server.
6. Click the link to continue withNotification Setup.

Notification Setup
After you configure a notification server, you create notifications to use with that server.
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You can select who receives notification and what kind of information they receive about published pre-
sentations.

For more information on a specific notification type, seeNotification Setup.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.

This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional pre-
sentation information, or left blank. You can use variables in this field.

5. Click Save.

Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.

When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a CAMREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the CAMREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email
notification. Any profile that uses that notification always sends an email to the email address of the
presenter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification
and havemultiple encodings set up in the selected profile, only the file path of last published encoding
is included in themessage.

Camtasia Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.
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For example, if in a profile you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

3. Create Profiles
After you have defined the publish destination and set up notifications, you are ready to create profiles.

To start creating a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

These tabs are:

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Tab Status Icons

As you are working through the tabs, each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.

Something on this tab is not quite right. Youmight want to verify that you are not missing
anything. This does not make a profile invalid.

Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this profile
can be used.

Example: There are publish destinations without encode settings selected.

Define Profiles Settings
In the Profile Settings tab, enter basic information about the profile.
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1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.
5. Click thePublish Destination tab to continue.

Select Publish Destinations
In the Publish Destinations tab, you select the publish destinations you want to use for presentations proc-
essed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.

2. Click Save.
3. Click theEncode Settings tab to continue.

Select Encode Settings
In the Encode Settings tab, you select what kinds of encodings you want going to each of the previously
selected publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Settings.

If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
is required and is enabled automatically.
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For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.
6. Click thePublish Accounts tab to continue.

Select Publish Accounts
In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account

Select another account

Select Use presenter account

This option allows presenters to enter their own credentials. Presenters will need to log in to the
Camtasia Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile proc-
essing. Youmay want to use this option if the default account information changes from time to
time.

If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.
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3. Repeat for each publish destination.
4. Click Save.
5. Click theNotification Selection tab to continue.

Select Notifications
In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or more notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way for a presenter or administrator to tell if a
presentation has finished processing is to go toPresentations page, locate the pre-
sentation, and view the status.

2. Click Save.
3. Click theNotification Assignment tab to continue.

Assign Notifications
In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
3. Select the encodings you want to assign to the notification.
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4. Repeat for each notification.
5. Click Save.
6. Click theVariable Definition tab to continue.

Define Profile Variables
In the Variable Definition tab, you define the value for any profile variables that are used in the profile. You
only need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.
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1. Enter a value for each profile variable used in this profile.

2. Click Save.
3. Click theAssociated Users tab to continue.

Associate Users
In the Associated Users tab, you select users to associate with the profile. This gives the selected presenters
access to the profile in the recorder.

1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)

To select multiple presenters, hold down eitherSHIFT orCTRL as you click.

2. Click Add to associate presenters with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to Camtasia Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.
5. Click theOverview tab to continue.

Review the Profile
In the Overview tab, you can see and review the setup of a profile.
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You can click the Information icon to access more information about one of the following:

Publish destinations
Publish accounts
Encode settings
Notifications

Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

When you have reviewed the profile setup, click theProfile Test tab to continue.

Test the Profile
In the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you expect.

Camtasia Relay provides a pre-recorded presentation so you can test the behavior of the profile without hav-
ing to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. Click Test Profile.

Camtasia Relay submits a sample presentation and processes it with the settings of the profile.

5. You are redirected to thePresentations page where you can follow the progress of the presentation’s
processing.
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4. Add Users to Camtasia Relay
There are different ways to add users to Camtasia Relay.

If your organization:

Uses LDAP, seeAdd LDAP Users to Camtasia Relay.
Does not use LDAP, seeManually Add Users to Camtasia Relay.

After adding presenters, global caption editors, and other administrators, you shouldSet User Account Secu-
rity Settings.

Use More than One Kind of User

Camtasia Relay allows you to use both LDAP users and Camtasia Relay created users.

Some examples of why youmay want to use both LDAP and Camtasia Relay managed users:

You use LDAP and need a temporary account for a visiting presenter.
You use LDAP and need a presenter account for someone already in the system as an administrator.

Add LDAP Users to Camtasia Relay
If your organization uses LDAP, first you need toConfigure Relay to Use LDAP. After LDAP is configured,
then you can either set up Camtasia Relay toAutomatically Import Users with LDAP or you canManually
Import Users with LDAP.

You can have both LDAP and Camtasia Relay created users.

RelayPresenter Service Account

Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, Camtasia Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. Camtasia Relay will cease
to function for all users if the password of the service account in LDAP is not the same as the
password stored in the Camtasia Relay database.

Configure Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
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3. Enter server information:
Server address
Port

Use secure authentication: Select if you want to connect to the LDAP server over SSL.
Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the Camtasia Relay Server for better security.
Authenticationmethod (Basic or Negotiate)

Username & password to authenticate
4. Click Next.
5. Select the returned base distinguished name or enter another.

Camtasia Relay returns the root of the LDAP directory, and pre-fills theBase distinguished name field.
Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter the
Base distinguished name.

6. Click Next.
7. Select a representative user with the following attributes:

Full name
Username
Email address

We suggest adding a “RelayPresenter” user to the LDAP directory prior to configuring
Camtasia Relay to work with LDAP. SeeRelayPresenter Service Account.

8. Click Next.
9. Map the attributes from the selected user to the fields Camtasia Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure Camtasia Relay toAutomatically Import Users with LDAP orManually
Import Users with LDAP.

Automatically Import Users with LDAP

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log into Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.
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Automatically Add Users with LDAP

1. Go toSystem > System Options > Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto
Associate Profiles, presenters can access the selected profiles immediately. This is a great way to reduce
the amount of administration work for getting new users started with Camtasia Relay.

Manually Import Users with LDAP

Camtasia Relay can reference an LDAP directory to populate the user database. There are two ways to
import users into the Camtasia Relay database.

At the end of the LDAP setup wizard, click Manually import Users to import users immediately.
When LDAP is enabled you can also import users from theUsers > LDAP Import page.

You can use search criteria, such as username, name, email, or LDAP attributes, to find users to add to Cam-
tasia Relay.

Manually Add Users to Camtasia Relay
If you do not use LDAP for authentication, you can create users manually in Camtasia Relay.

You can have both LDAP and Camtasia Relay created users. SeeMore than One Kind of
User.

Create a New User

1. Go to theUsers page.
2. Click theNew User link.

3. Enter a username.

This is the username the presenter uses to log in to the Camtasia Relay website and recorder.

4. Enter the name (given name) of the user.
5. Select Presenter orGlobal Caption Editor from the Access Level dropdown list.

NoAccess restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter the user’s email address.
7. Enter and confirm a password.
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8. Click Save, or you can click Save & Add to immediately add another user.

Set User Account Security Settings
To help secure Camtasia Relay, you can set the following:

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
Password Complexity

Activate / Deactivate Camtasia Relay Server
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding proc-
essors. It is important to deactivate Camtasia Relay server before you uninstall the server so you can install
Camtasia Relay on another server.

To communicate with the activation server through a firewall, port 80must be open.

Activate the Camtasia Relay Server

1. Click System > Activation.
2. Enter your license code and click Activate.

Obtaining More Activations

If you find that you need additional activations for your server, please contact a sales associate at 1-800-517-
3001 (US) or 1-517-381-2300 x636 (international) and wewill walk you through the process of updating your
license.
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Offline Activation/Deactivation

If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to deactivate
without connecting to the Internet.

Activate when offline

1. Log in to the Camtasia Relay website as an admin and go toSystem > Activation.
2. Click Offline Activation.
3. A window opens and contains an Installation ID number.
4. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
5. Provide the Installation ID and License code to the sales associate. The sales associate gives you an

Unlock Code.

Your license code was emailed in the Camtasia Relay purchase receipt.

6. Enter the code into the field provided. Camtasia Relay is now activated.

To deactivate when offline

1. Log in to the Camtasia Relay website as an admin and go toSystem > Activation.
2. Click Offline Activation.
3. A window opens. Click Deactivate to deactivate the server.
4. The window closes and you return to page. The server is now shown in an Expired state.
5. Contact a TechSmith sales associate at 1-800-517-3001 (US/Canada) or 1-517-381-2300 x636 (inter-

national).
6. Provide the Proof of Removal code and the Installation ID to the sales associate. This decrements the

number of activations on your license code in the event that you want to activate a different server.

Problems with Activation/Deactivation

In the event of hardware failure or problems, please contact TechSmith.

US and Canada: +1-800-517-3001

International: +1-517-381-2300 x636

Please be ready with your Installation ID, License code or (orProof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Verify Setup
The purpose of this step is to ensure everything is set up properly. It also helps you better understand the “big
picture” of Camtasia Relay and should help youmake better decisions when implementing Camtasia Relay
on a large scale.

Verify the Installation

1. Add yourself as a userwith presenter access. (Administrators cannot make recordings.)
2. Associate your presenter account to a profile.
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3. Download a recorder from System > Download Recorders and install. (It is recommended to not
install the Camtasia Relay recorder on the server as ameans of verifying your setup.)

4. Log in to the Camtasia Relay recorder. Enter the presenter account username and password created
on the Camtasia Relay website (e.g. don’t use the RelayAdmin username).

5. Select a profile.
6. Record your desktop activity for aminute or two. Stop the recording and click Submit.
7. Sign in to the Camtasia Relay website using the same username and password you entered into the

recorder. You can view the status of your recording and experience the website from a presenter point
of view.

8. Verify that the presentation processes and publishes correctly.

Roll-Out Camtasia Relay
Here’s a checklist of suggested steps when introducing Camtasia Relay to presenters.

Verify all presenters have valid profiles associated with their accounts.
Youmight wish to roll-out Camtasia Relay in stages. For example start with one department instead of
the whole company or campus.
What training do presenters require? You can direct presenters to the overview video launched from the
helpmenu of the recorder and the videos located in the help section of the Camtasia Relay website.
(Administrators see a different help page.)
Decide if you will install the Camtasia Relay recorder on user computers, if you will direct users to
obtain and install the recorder on their own, or if you will Deploy Camtasia Relay Recorder. The
recorder has the Camtasia Relay server URL “baked-in” based on the server from which it was down-
loaded. If you put a copy of the Camtasia Relay recorder on a website or network drivemake sure you
got it from the server you want people to use.
Establish a clear policy for how presenters should do things like request new profiles or profile changes
or request a new password.
Prepare an introduction email for presenters. We’ve created a few samples you canmodify.

See also

What Presenters Need to Know Most
Sample Emails Administrators Can Modify and Send to Presenters

What Presenters Need to Know Most
You need to communicate the following to presenters. You can use this information in an email introducing
Camtasia Relay to your presenters.

There are helpful videos

Get presenters to watch the overview accessible from the login screen of the recorder and in the Help section
on the Camtasia Relay website. Youmay want to send presenters directly to the video so they can review
Camtasia Relay before accessing the Recorder or having to sign in to the Camtasia Relay website.

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Make a test recording

There’s a blue TEST button in the Camtasia Relay recorder presenters can use to verify they are recording the
correct screen and that audio is recording properly. Nothing is worse than recording an hour presentation with
no audio.

How uploading works

As soon as the presenter clicks theSubmit button in the recorder, the recording gets ready to upload in the
background.

There is no visual indication of progress.
If the recorder is offline (or loses Internet access), the recording automatically uploads (or resumes
uploading) as soon as the computer gains Internet access.
Presenters receive an email when the presentation is published.
Presenters can check the upload, encoding and publishing progress if they log in to the Camtasia
Relay website.

Sample Emails Administrators Can Modify and Send to Presenters
Email examples for:

Presenters Integrated with Your LDAP System
Presenters Not Integrated with Your LDAP System
Presenters That Must Supply Publish Destination Account Information

Presenters Integrated with Your LDAP System

Subject: Your Camtasia Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with Cam-
tasia Relay. Use Camtasia Relay on your computer to record whatever is on your screen—PowerPoint, Key-
note, websites, etc. Once you submit the recording, our Camtasia Relay server will process the file and
publish the presentation in a variety of formats in convenient locations.

Where to start?

Watch this video: It’s very short and you’ll see the entire Camtasia Relay process.
Camtasia Relay requires a username and password. Good news! You don’t have to remember yet
another password. Use the same username and password you use to access our [work, school, uni-
versity] network.
Install Camtasia Relay [either direct users to the Camtasia Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Presenters Not Integrated with Your LDAP System

Subject: Your Camtasia Relay Account andGetting Started Information

Body: Greetings! This email contains everything you need to know to start recording presentations with Cam-
tasia Relay. Use Camtasia Relay on your computer to record whatever is on your screen—PowerPoint, Key-
note, websites, etc. Once you submit the recording, our Camtasia Relay server will process the file and
publish the presentation in a variety of formats in convenient locations.

Where to start?

Watch this video: It’s very short and you’ll see the entire Camtasia Relay process.
Camtasia Relay requires a username and password.

Your username is:
Your password is:
You can change your password by signing into the Camtasia Relay website [URL here] and
clicking theAccountsmenu.

Install Camtasia Relay [either direct users to the Camtasia Relay website or make the installer avail-
able in some other manner].

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

Presenters That Must Supply Publish Destination Account Information

For example, presenters need to enter usernames and passwords to a network drive, personal FTP site or
Screencast.com account.

Subject: Please supply account information for Camtasia Relay

Body: Your Camtasia Relay account is all set up and almost ready to go. There’s just one last step. In order to
publish your presentations, you need to enter your username and password for [publish destination].

To enter your account information:

Sign in to the Camtasia Relay website [URL].

You will immediately see a yellow “Action Required” banner with a link to the account with missing infor-
mation. Click the link and enter your information.

Questions? Problems?

Please direct all questions and feedback to the Camtasia Relay Administrator.

Name:

Email:

Phone:

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu
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Deploy Camtasia Relay Recorder
In a locked-down or controlled environment, the administrator can choose to deploy the Camtasia Relay
recorder forWindow operating systems, instead of having the users download it from the Relay website.

TheWindows Installer client can be found on the server at:

[INSTALLDIR]_installhelper\CamtasiaRelayRecorder.msi

This MSI can be distributed via the usual methods; creating aWindows Installer Transform file or using the
command line switches. The "Properties" that need to be assigned values are as follows.

Critical Properties

PRIMARYENDPOINT: Camtasia Relay server URL.
TEAMID: TeamingGUID. This property should be only used when teamingmultiple servers together.

Optional Properties

INSTALLDIR: Main destination folder.
TSC_PP_ADDIN: Set to 0 to disable the Camtasia Relay recorder Add-in for Microsoft PowerPoint.
TSC_START_NOW: Set to 0 to keep Camtasia Relay recorder from launching after installation.
TSC_DESKTOP_LINK: Set to 0 to not create a shortcut to Camtasia Relay recorder on the Desktop.

Example

msiexec.exe /i “\\Apps_server\CamtasiaRelayRecorder.msi” PRI-

MARYENDPOINT="https://relaydev01.techsmith.com/relay/rest.ashx" TEA-

MID="FE47DE98-9E88-414b-A99F-C24F26951D7F" TSC_DESKTOP_LINK=0 /qb-!
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Camtasia Relay Administration Reference
The following topics provide reference information for Camtasia Relay administrators. Use these topics to find
out information about specific Camtasia Relay pages.

System Menu
Presentations Menu
Profiles Menu
Users Menu

System Menu
The Systemmenu allows you tomanage the Camtasia Relay system and view related options. The following
pages are available in this menu:

System
Servers
System Options
Plug-Ins
Activation
Client Machines
Event Log
Download Recorders

System
The System page contains information to help you configure Camtasia Relay and a Dashboard to provide a
quick overview of the system status at a glance.

Important Configuration Steps

This component of the System page contains the threemost important steps for configuring the Camtasia
Relay system:

Define Publish Destinations
Set Up Notifications
Create Profiles

For more information on configuration, seeConfiguration of Camtasia Relay.

Dashboard

The Dashboard provides you with a quick look at what is going on with the Camtasia Relay system. On this
page, you can find the following:
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Presentation Actions Necessary / Recent Presentations

If there are any actions you need to take to allow presentations to process, they show
here. For example, a presentation is uploaded using the Upload and Decide Later pro-
file.

Click an item in the list to go to the page where you can take action for that item.
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If there are no presentations that need action, this area shows a list of the tenmost
recent presentations.

Click a link to view information about the completed presentation, including links to the
published presentations, when available.

System Messages / Servers

This area alerts you of any important issues that you need to address in the Camtasia
Relay system.

If there are no alerts, the current count of various system components is displayed.

If you have invalid profiles indicated in the list, go to theProfiles page where the invalid
profiles are shownwith an error status in the profile list.

Encoder Usage

The Encoder Usage graph displays the peak encoder usage and average encode capac-
ity of a Camtasia Relay server. Peak encoder usage is themaximum number of queued
and processing encode jobs during that time period, while average encode capacity is
how often the encoder was busy during the time period.

If the time period is less than a week, the data is displayed by the hour.

If the time period is more than a week, the graph displays peak and average usage by
day. The average displayed for a day is the highest hour of that day. The entire time it
takes to process an encoding is tracked (including any time the encoding job is waiting
in the queue), but time spent uploading and captioning the presentation is not.

Use this chart to track peak usage times, see when the encoding server is at its
busiest, or to find out if the encoding server is overloaded and unable to process all the
presentations it receives in a timely manner.

Average File Size by Encoding

The Average File Size chart shows the average file size (in megabytes) per minute of
video for each encoding type used during the time period. The graph shows averages
across each group of encoding types, grouped by encode format. Clicking an encoding
group shows the average of each specific encode type.

Encode Speed / Recorded Minute

The Encode Speed graph shows the average time a presentation processed with a spe-
cific profile takes to encode, in minutes of encode time per minute of presentation
video. Themain view is the time from when the first encoding type begins until the last
encode type ends. Click a specific profile to see a breakdown of the encode speed for
each encoding type included in that profile.

Only the 10most used profiles appear on the Encode Speed graph.

System Panel

This area shows the current number of presentations, servers, profiles, invalid profiles,
presenters, and administrators.
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Servers
The Servers page contains information about and lets you interact with servers running Camtasia Relay.

If you havemultiple servers to handle processing presentations, you have a “teamed” server
environment. On the Servers page of each teamed server, you can access the other servers in
the team.

Server Status Icons

Icon Status Description

Online Currently accepting and processing presentations.

Offline Currently not accepting new presentations, but still processing exist-
ing presentations.

Shutdown Currently not accepting or processing presentations.
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Change Server Status

Take a server offline

When you take a server offline, the server stops accepting new presentations, but continues to proc-
ess presentations it has already received.

Shutdown a server

If you need to completely stop a Camtasia Relay server (to upgrade, for example) take the server off-
line and then wait until all jobs are Completed and click Shutdown.

Verify all presentations have completed prior to shutdown. Any presentations that are
not completed will be canceled. When the server is brought back online, all canceled
jobs are automatically retried.

Bring a server back online

When you are ready to bring the server back into service, select it from the server list and click Bring
Server Online.

System Options
System Options include:

Auto Associate Profiles
Auto Import Users
Portable Recorder Options
Email Notifications

Auto Associate Profiles

To ease administration of Camtasia Relay, you can choose specific profiles to automatically assign to new
users. Use this option when you want all presenters to have a common profile or set of profiles.

Profiles are only assigned to users when they are first added to Camtasia Relay. Changes
made to the automatically assigned profiles list are not reflected on existing Camtasia Relay
users.

Automatically Associate Profiles

1. Go toSystem > System Options > Auto Associate Profiles tab.
2. If needed, enable the option toAutomatically associate selected profiles with new users. (This

option is enabled by default.)
3. Select a profile in the dropdown list and click Add. Repeat to add all required profiles to the list.
4. Click Save.

Manage Auto Associate Setting for Single Profile

1. Go toProfiles.
2. Click a profile.
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3. Click theAssociated Users tab.

4. At the bottom of the page, enable or disable theAutomatically associate this profile with new
users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > System
Options > Auto Associate Profiles and enable theAutomatically associate selected pro-
files with new users option. When you return to the Associated Users tab of a profile, you
will see the option.

Other System Options

Auto Import Users
Portable Recorder Options
Email Notifications

Auto Import Users

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log in to Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option with automatically assigning profiles for the easiest way to get Camtasia
Relay set up using LDAP authentication.

Automatically Add Users with LDAP

1. Go toSystem > System Options >Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto-
matically Assign Profiles, the presenters can access the selected profiles immediately.

Other System Options

Auto Associate Profiles
Portable Recorder Options
Email Notifications

Portable Recorder Options

Administrators can decide how they would like presenters to access the portable recorder. Choose from the
following:
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Option Description

Available
by down-
load only

The portable recorder is available on the website.

Presenters can log in to the website and download the portable recorder and
transfer it to amobile storage device, such as a USB drive.

Use this option if presenters are reasonably “technical” and understand down-
loading and unzipping files.

Available
by email
request
only

There is a button available on the website to request a portable recorder.

Presenters can log in to the website and click this link to send an email request to
the administrator. The administrator receives an email with the request.

Use this option if presenters are “not technical” andmay not understand down-
loading and unzipping files. You can put the portable recorder on amobile storage
device and give it to the presenter.

Not avail-
able

There is no way for a presenter to download or request a portable recorder.

Use this option if you will handle distributing all portable recorders or do not want
to use the portable recorder in your organization.

Even if they do not have access to the portable recorder, presenters are still able
to find information about it in the help and other locations.

For information about how to upload presentations from a portable recorder, seePortable Recorder.

Other System Options

Auto Associate Profiles
Auto Import Users
Email Notifications

Email Notifications

With installation and initial configuration of Camtasia Relay, you are asked to provide email server infor-
mation. You can also choose to enable or disable email notifications from Camtasia Relay.

These notifications includemessages directly from the system:

Password changes
Trial expiration
Server disk space warnings
Presentations needing attention
Presentations held for captioning

This option does not affect any profile notifications.

To update your email notification setting:
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1. Go toSystem > System Options > Email Notification tab.
2. Enable or disable theEnable email notifications option.
3. Click Save.

Other System Options

Auto Associate Profiles
Auto Import Users
Portable Recorder Options

Send Usage Data

By default, the Send Usage Data option is enabled. This means that anonymous information about your hard-
ware and the usage of Camtasia Relay is sent, securely, to TechSmith. No personal information about your
organization or presenters is sent.

To disable this option, uncheck Automatically sends usage data to TechSmith.

To see the actual data being collected, use the Information Gathering Application. The Information Gathering
Application is located here: C:\Program Files\TechSmith\Relay Server\Ma-
nager\InfoGathering.exe

Formore on the type of information collected, see the help file included in the Information Gathering Appli-
cation.

Plug-Ins
Plug-ins aremodules that you can install to add additional publish destinations or notification options to Cam-
tasia Relay. Camtasia Relay comes with various plug-ins available to install for both publish destinations and
notification servers:

Name Plug-In Type Installed by Default?

Blackboard Notification No

Email Notification Yes

Moodle Notification No

Amazon S3 Publish Destination No

Drupal Publish Destination No

File System Publish Destination Yes

FTP Server Publish Destination Yes

iTunes U Publish Destination No

Kaltura Publish Destination No

Mediasite Publish Destination No

Screencast.com Publish Destination Yes
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Name Plug-In Type Installed by Default?

Microsoft Windows SharePoint Publish Destination No

WebDav Publish Destination No

YouTube Publish Destination No

The list of plug-ins that are installed by default is for a new installation. When upgrading from a
previous version of Camtasia Relay, any plug-ins that were installed prior to the upgrade are
still available.

Additional plug-ins may periodically become available. Instructions to add a new plug-in to your server will be
provided with the plug-in.

See also

Install a Plug-In
Remove a Plug-In

Install a Plug-In

Before a plug-in is available to use, youmust first verify and install the plug-in.

1. Once a plug-in is available on your server, go toSystem > Plug-Ins.
2. Locate the plug-in in the list and click Verify.

The Camtasia Relay server verifies that it can load the plug-in. Once the plug-in is verified, an Install
button appears.

3. Click Install.

If the plug in installs correctly, the button disappears.

4. Complete setup for the newly added plug-in:

Go toProfiles > Publish Destination Setup to access publish destinations.

Go toProfiles > Notification Server Setup to access notification servers.

See also

Remove a Plug-In.

Remove a Plug-In

Before you can remove a plug-in, it cannot be in use.

1. Go toSystem > Plug-Ins.
2. Determine if the plug-in is in use.

If the plug-in is not in use, there is aRemove button available for the plug-in.
If theRemove button is not available, check the following pages to see where the plug-in is in
use and delete any dependencies:
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Profiles > Publish Destination Setup
Profiles > Publish Account Setup
Profiles > Notification Server Setup
Profiles > Notification Setup

3. Click Remove.

The plug-in is removed from use but is not removed from the server. All files related to the plug-in are
still available on the server. The plug-in stays in the list and can be installed again.

See also

Install a Plug-In.

Activation
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding proc-
essors.

Whenmoving to a new server, it is important to deactivate Camtasia Relay server before you
uninstall the server so you can install Camtasia Relay on another server.

Activate/Deactivate the Camtasia Relay Server

1. Go to System > Activation.
2. Enter your License code and click Activate (or Deactivate).

Offline Activation/Deactivation

If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to do so without
connecting to the Internet.

You can activate and deactivate Camtasia Relay server by contacting TechSmith by phone.

US and Canada please call: +1-800-517-3001
International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code (orProof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Assistance with Activation

In the event of hardware failure or problems, please contact TechSmith.

US and Canada please call: +1-800-517-3001
International please call: +1-517-381-2300 x636

Please be ready with your Installation ID, License code or (or Proof of removal code in the case of deac-
tivation). Your license code was emailed in the Camtasia Relay purchase receipt.

Client Machines
On the Client Machines page, you can view information about the client machines for the server. Use this infor-
mation to troubleshoot problems or verify that presenters download updated recorders, if needed.

You can view the following:
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Computer name
IP address
Client type (Windows or Mac)
Version of the Camtasia Relay recorder
Last connection
Last user to connect (with link to more information)
Last presentation information (with link to more information)
Diagnostic information (with link to download a log file)

Event Log
On the Event Log page, you can sort events to troubleshoot problems. Available information includes the fol-
lowing:

Type
Date/Time
Server
Source
Details

You can also filter the list based on:

Errors
Warnings
Messages
Sources

Download Recorders
Access and download all the Camtasia Relay recorders.

If you want to record a presentation, youmust have a presenter account. You cannot log in to
any of the Camtasia Relay recorders as an administrator.

When presenters download the recorder, any available plug-ins and add-ins are also installed on the pre-
senters’ computers:

Windows
Presenters are given the option in the Camtasia Relay recorder installer to install theCamtasia
Relay Add-In for Microsoft Office PowerPoint. This add-in allows a presenter to easily rec-
ord a PowerPoint slide show with Camtasia Relay from inside of PowerPoint. See the Cam-
tasia Relay recorder help for more information.
Presenters that are also running Camtasia Studio 5.1 and above are provided with a plug-in that
allows for sending a Camtasia Studio project to the Camtasia Relay server for production and
publishing. An option to produce with Camtasia Relay is added to the production process in
Camtasia Studio automatically when both programs are installed on the same computer.

Mac
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Presenters that are also running Camtasia for Mac 1.2 and above are provided with a plug-in that
allows for sending a Camtasia for Mac project to the Camtasia Relay server for production and pub-
lishing. An option to share with Camtasia Relay is added to Camtasia for Mac automatically when both
programs are installed on the same computer.

For information on the portable recorder, seePortable Recorder.

Portable Recorder

Provide the portable recorder to presenters if there is any reason that presenters cannot (or should not) record
and upload directly from the presentation computer. For example:

Presenters record on computers where they do not have permission to install applications.
Presenters record on computers that have limited or no network access.
You want to collect the presentations and upload them collectively at a later time.
You want to have presenters contact an administrator to receive a portable recorder.
You want to install the Camtasia Relay portable recorder on amobile storage device and distribute to
presenters.

You can select how you want presenters to access the portable recorder on theSystem Options page.

Create a Portable Recorder

Use the following process to install the portable recorder on amobile storage device, such as a USB flash
drive.

1. Plug in amobile storage device and format the device as FAT32.
2. Click Download Portable Recorder and save the ZIP file to your computer.
3. Locate and open PortableCamtasiaRelayRecorder.zip.
4. Copy all files from the ZIP file onto themobile storage device.

All files from the ZIP file need to be copied to the root of the device for the Camtasia Relay port-
able recorder to autorun onMicrosoft Windows operating systems.

Upload Presentations from a Portable Recorder

To upload presentations from a portable recorder:

1. Connect the portable recorder to a computer with the desktop version of the Camtasia Relay recorder
installed on it.

2. Make sure that the desktop Camtasia Relay recorder is not running and open the Camtasia Relay port-
able recorder.

3. Click theView Saved Presentations button.

4. The Saved Presentations dialog opens.
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5. Click Upload All to submit all of the presentations for upload or click to submit individual pre-
sentations.

You can submit saved presentations at any time.

If you are online and connected to the server, your presentations start to upload.
If you are offline, your presentations are stored on the computer and automatically upload to the server
once you are online and connected.

After you upload saved presentations, you cannot access or view your presentation or the
status of the upload in the Camtasia Relay recorder. You can check the status of the pre-
sentations on thePresentations page of the Camtasia Relay website.

Presentations Menu
The Presentations menu allows you to view andmanage presentations. The following pages are available in
this menu:
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Presentations
Job Status
History

Presentations
The Presentations page allows you to view presentations by state and take action to resolve issues.

Presentations in all states have the following information:

User name and email of presenter that submitted the presentation
Date and time the presentation was recorded
Computer name, with link to diagnostic information on theClient Machines page
Presentation description, if entered by the presenter
Profile used, with link to view and edit profile
Duration of presentation
Resolution of presentation

You can view presentations on the server by the following states:

States Description

Needs
Attention

Use the information and options provided to resolve issues so the presentation
can process. Includes a list of presenters and a list of profiles to select from. You
can also delete presentations.

Processing
View the progress of a processing presentation. You can see the progress of
each job associated with the presentation, including transcription, encoding, pub-
lishing, and notifications.

Uploading View the upload progress and cancel upload, if needed.

Completed View the status of presentations that have completed processing. For some pub-
lish destinations, links are included to view the published presentation.

Deleted View information about any deleted presentations.

Failed Use the information provided to figure out why a presentation failed. Includes
status information to show you which part of processing failed.

Held for
Captioning

View the presentations held for caption editing. When caption editing is complete
or to skip caption editing, click Release Hold to continue processing the pre-
sentation. Only presenters can edit captions; administrators can only release a
hold.

Job Status
The Job Status page allows you to view and sort jobs on the Camtasia Relay server or teamed servers. You
can filter jobs by the following:

Status
Queued
Processing
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Failed

For failed jobs, expand the presentation information to resubmit or delete the pre-
sentation.

Canceled
Pending

Type
Encoder
Publisher

Server
All servers
Specific server

History
The History page allows you to view the history of Camtasia Relay presentations. You can do the following
with the items on this page:

Item Description/Action

Presentation
Title

Click to expand and view more information on the presentation. Includes profile,
client machine, processing progress, andmore.

Presenter The username of presenter that recorded the presentation. Click the username
to view more information about the presenter.

Server The name of the server processing the presentation. Click to view the status of
the server.

Recording
Date/Time Date and time that the presentation was recorded

Presentation
Status

Icons show the status of the presentation.

Uploading

Processing

Complete

Needs Attention

Failed

Deleted

Jobs
Queued

Jobs Proc-
Icons show the status of jobs for the presentation.
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Item Description/Action

essing

Jobs Can-
celed

Uncover More Information

You can drill down to findmore information on the presentations by expanding the presentation information
and clicking available links.

For example, if you’d like to see information about the source recording files for a presentation, you could:

1. Click a presentation to expand the available information.
2. Click the down arrow to expand an encoding action from the list.
3. Click View Encoding Files.

4. A new browser tab or page opens to show you information about the source files and the files produced
during encoding. Use this information for testing or troubleshooting.
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Profiles Menu
The Profiles menu allows you to create andmaintain profiles and related items. The following pages are avail-
able in this menu:

Profiles
Publish Destination Setup
Publish Account Setup
Notification Server Setup
Notification Setup
Variables

Profiles
Profiles are the backbone of Camtasia Relay. They allow presenters to record without having tomake any
decisions about how the presentations are processed or where they are placed for viewing.

Profile setup involves settings and information found on the following tabs:

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Information about Profiles

Upload and Decide Later Profile

The Upload and Decide Later Profile uploads the recorded presentation to the Camtasia Relay server
but the recording is not encoded or published. An authorized presenter or Camtasia Relay administrator
must assign a different profile and submit the recording for publishing via the Camtasia Relay website.

Why use the Upload and Decide Later Profile?

For guest presenters, it is the only profile available.
Youmake a presentation in advance, but do not want it published until later.
You are not satisfied with existing profile options and wish to hold the recording on the server
until you can contact your Camtasia Relay administrator to create or modify a profile.

Tab Status Icons

Each tab shows its current status. The status icons are as follows:

Everything on this tab is valid and in working order.
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Something on this tab is not quite right. Youmight want to verify that you are not
missing anything. This does not make a profile invalid.

Example: There are no notifications selected.

There is an error on this tab. You will need to enter or correct information before this
profile can be used.

Example: There are publish destinations without encode settings selected.

Create a New Profile

To create a new profile:

1. Go toProfiles.
2. Click theNew Profile button.

The Profile Setup page opens.

3. Work through, from top to bottom, the tabs at the left side of the page.

Profile Settings

In the Profile Settings tab, you enter some basic information about the profile.

1. Enter a title for the profile.

Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

2. Enter a description.
3. Select the Transcription Settings.
4. Click Save.

See also

Transcription Options
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test
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Transcription Options

Camtasia Relay provides an optional transcription process that allows you to include a full audio search, cap-
tions, or both in presentations. The available options are:

No transcription

Presentation audio is not transcribed.

Captions and full audio search

Presentation audio is transcribed for captions and full audio search in Flash and Silverlight encodings.
Choose one of the web or Silverlight encoding options to make this available for viewers.

When audio transcription is complete, the presentation is put into a Held for Captioning state on the Pre-
sentations page. There the presenter can review and edit the transcribed audio and release the hold to
continue processing the presentation.

Full audio search only

Presentation audio is transcribed to provide a full audio search in Flash and Silverlight encodings, but
no captions are shown in the presentation.

If you want to publish a different encoding type, you can still gain some benefits from transcription. For
example, enable the XML file (when available) to make the transcribed audio available as metadata in
the file. You can use this metadata for other uses, such as searching within amedia server.

Can be captioned by Presenter only

Presentation captions can only be edited by the presenter who uploaded the presentation.

Can be captioned by Presenter and Global Caption Editors

Presentation captions can be edited by the presenter who uploaded the presentations or any
Global Caption Editor.

The transcription process adds time to presentation processing.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test
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Publish Destinations

On the Publish Destinations tab, you select the publish destinations you want to use for presentations proc-
essed with the profile.

1. Select one or more publish destinations from those available.

To create additional publish destinations, go toProfiles > Publish Destinations.

2. Click Save.

See also

Publish Destination Setup
Publish Account Setup
Profile Settings
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Encode Settings

On the Encode Settings tab, you select what kinds of encodings you want going to each of the previously
selected publish destinations.

1. Click to expand a publish destination, if needed.
2. Select the types of encodings you want to publish to that destination.

For information on the available encoding types, seeAvailable Encoding Formats.

If an encoding type has an XML file available to include, an XML symbol shows up after you enable the
encoding type.

3. Click XML to include an XML file with the processed presentation. For some publish destinations, XML
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is required and is enabled automatically.

For more information about this XML file, seePublish XML File with an Encoding.

4. Repeat for each publish destination.
5. Click Save.

Available Encoding Settings

The table below contains descriptions of the encoding formats available in Camtasia Relay. TheMP4
with Smart Player encoding is recommended for use inmost situations. This setting utilizes the TechSmith
Smart Player to create an output with a Flash player that includes an HTML5 fallback. The Smart Player plays
great on desktop browsers, on iPhones and iPads, and onmany other mobile devices that support MP4 video.
It supports Table of Contents, Speech to Text, and Closed Captioning.

If transcription is enabled on the Profile Settings tab, youmust include a Flash or Silverlight
encoding format or include an XML file with the encoding to utilize the transcribed audio.

Preset Format
Includes
Camera
PIP?

Description

AVI (Original
Size) AVI Yes

This encode setting produces a single AVI file
with the same resolution as the original record-
ing. Use this file if you want to perform your own
video processing and encoding. Note that AVI
files usually have a larger file size than pre-
sentations encoded in other formats.

Camtasia Studio
Recording

(Original size)
CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio versions 5.1 to
7.1. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
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Preset Format
Includes
Camera
PIP?

Description

with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia Studio
8.0 and Later
Recording

(Original size)

CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio version 8.0 and
later. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia for
Mac Recording

ZIP >
CMPROJ No

This encode setting generates a lossless video
file for editing within Camtasia for Mac. This
encoding should only be given to presenters
with access to Camtasia for Mac.

The resulting file is a ZIP file that, when opened
on aMac, automatically unzips into a directory.
The user can double-click that directory to
launch the CMPROJ in Camtasia for Mac.

iPad MP4 Yes

This encode setting creates video files with var-
ied final resolutions to provide the best viewing
experience for a given video on an iPad. The res-
olution is calculated to provide the best res-
olution to view the video at 10 frames per
second.

iPod and iPhone MP4 Yes

This encode setting works on all iPods and
iPhones that support video of any kind. The final
resolution of the video is fixed at 640 x 480.
Video looks good on all iPods and iPhones, but
does not look good if played in QuickTime on a
desktop computer.

MP3 MP3 No

This is an audio-only encode setting. The server
can process this encoding extremely fast, and
the resulting file size is small. This is a good
encode setting for those whomay want an
audio-only version of their presentation.
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Preset Format
Includes
Camera
PIP?

Description

MP4with Smart
Player

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

MP4 Yes

This encode setting creates anMP4 video file
that is displayed in a Flash controller file (SWF)
called the TechSmith Smart Player. Additional
files are created to provide an HTML5 fallback
player in cases where Flash is not available.

The Smart Player plays great on desktop
browsers, on iPhones and iPads, and onmany
other mobile devices that support MP4 video.
The Smart Player supports a table of contents
based on the titles of slides in a PowerPoint or
Keynote presentation, as well as slide text, full
audio search, and captions (if enabled).

MP4 (Original
Size) MP4 Yes

This encode setting creates anMP4 video file
with no additional files. The file is the same
dimensions as the original recording.

Original Record-
ing (Backup)

AVI (Win-
dows)

MOV (Mac-
intosh)

Recording
and cam-
era video
are save
as two
separate
files

This encode setting does not modify the original
recorded file in any way. The file size is enor-
mous and usually not considered viewer-
friendly. Use this setting if you need a copy of
original files for backup purposes or trou-
bleshooting.

Real Media

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

RMVB No
Generates a Real Media file. Can be used in
conjunction with Real Media servers, such as a
Helix Server.

Silverlight

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

XAP Yes

This encode setting creates video files that play
in Microsoft Silverlight. The controller supports
a table of contents based on the titles of slides
in a PowerPoint or Keynote presentation.

Also supports searching slide text, full audio
search, and captions, if enabled.
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Preset Format
Includes
Camera
PIP?

Description

(Original
Size)

Windows Media

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

WMV Yes

This encode setting creates video files that play
inWindows Media Player. The video files tend
to be larger than the Flash and Silverlight encod-
ings, but may be preferred by Windows users
with high speed internet access.

Windows Port-
able Media
Device

WMV No
This encoding is designed to provide the best
solution forWindows Mobile Devices (Pocket
PCs) and someWindows-based Smartphones.

YouTube MP4 Yes

This encoding is only available
for the YouTube publish des-
tination.

This is used for publishing directly to YouTube
using the YouTube publishing plug-in.

The video is subject to YouTube's restrictions.

Publish XML File with an Encoding

Camtasia Relay provides administrators with the option to generate XML files for published presentations. For
some publish destinations, XML is required and is enabled automatically.

The XML data contains information about the presentation such as the title, length, format, resolution, and
more. When you enable the transcription process inProfile Settings, the XML also contains the transcription
of the presentation audio.

Customers may use the XML file with existingmedia-hosting solutions, content delivery methods such as
RSS feeders, etc. TechSmith provides the XML data as a service, but does not support how the institution
uses the XML file.

XML data is available for all encode types and all supported publish destinations with the following excep-
tions:
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XML is not included with presentations published to iTunes U.
XML data is parsed into fields (as opposed to a single XML file) for presentations published to Screen-
cast.com. Themetadata can be found under Details when viewing a presentation on Screencast.com.

Information Included in the XML File

Presentation information: title, description, date, duration, and resolution
Profile used to create presentation
Presenter name
Client (computer used tomake the recording) IP address, and computer name
Server namewhere recording was processed
Encoding preset used
Length of time the presentation was in the queue for processing
Length of time it took to encode the presentation
Destination URL of published presentation

See also

Profile Settings
Publish Destinations
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Publish Accounts

In the Publish Accounts tab, you select the account to use for each publish destination/encoding combination.

1. Click to expand a publish destination, if needed.
2. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.

You can:

Keep the selected account
Select another account
Select Use presenter account

This option allows presenters to enter their own credentials. Presenters need to log in to the
Camtasia Relay website and enter their credentials.

Select Use default account

This option allows the profile to access the default account information at the time of profile proc-
essing. Youmay want to use this option if the default account information changes from time to
time.
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If you want to use the same account for all encodings under a publish destination, you
can use the top level dropdown box to select the account.

3. Repeat for each publish destination.
4. Click Save.

See also

Publish Account Setup
Publish Destination Setup
Profile Settings
Publish Destinations
Encode Settings
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Notification Selection

In the Notification Selection tab, you select which notifications you want to use in the profile.

1. Select one or notifications to use with the profile.

All configured notifications are shown for you to choose from.

You do not have to select a notification for the profile to be valid. If you choose to not
include notifications in the profile, the only way to tell if a presentation has finished proc-
essing is to go to Presentations page, locate the presentation, and view the status.

2. Click Save.
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See also

Notification Setup
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Assignment
Variable Definition
Associated Users
Overview
Profile Test

Notification Assignment

In the Notification Assignment tab, you select the encodings you want to associate with each previously
selected notification. Each notification only includes information about the encodings associated with it.

1. Click to expand a notification, if needed.
2. Under each notification, all publish destination/encoding combinations for the profile are shown.
3. Select the encodings you want to assign to the notification.

4. Repeat for each notification.
5. Click Save.
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See also

Notification Setup
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Variable Definition
Associated Users
Overview
Profile Test

Variable Definition

On the Variable Definition tab, you define the value for any profile variables that are used in the profile. You
only need to fill in values if you have previously created and used a profile variable in another part of the profile,
such as a file path or notification.

1. Enter a value for each profile variable used in this profile.

2. Click Save.

See also

Variables
Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
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Notification Assignment
Associated Users
Overview
Profile Test

Associated Users

On the Associated Users tab, you select users to associate with the profile. This gives the selected pre-
senters access to the profile in the recorder.

1. In the Available Users list, click to select a presenter.

Presenters are shown in the list in the following format: Display Name (username). For example: Mary
Smith (m.smith)

To select multiple presenters, hold down eitherSHIFT orCTRL as you click.

2. Click Add to associate the presenter with the profile.
3. If you would like to have this profile automatically associated with all new presenters as they are added

to Camtasia Relay, enable theAutomatically associate this profile with new users option.

If you do not see this option, you need to turn on this functionality. Go toSystem > Sys-
tem Options > Auto Associate Profiles and enable theAutomatically associate
selected profiles with new users option. When you return to the Associated Users
tab of a profile, you will see the option.

4. Click Save.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Overview
Profile Test

Overview

On theOverview tab, you can see and review the setup of a profile.

You can click the Information icon to access more information about one of the following:

Publish destinations
Publish accounts
Encode settings
Notifications
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Presenters that are associated with this profile are able to see this same overview when they
log in to the website.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Profile Test

Profile Test

On the Profile Test tab, you can process a sample presentation to verify that the profile behaves as you
expect.

Basically, Camtasia Relay provides a pre-recorded presentation so you can test the behavior of the profile
without having to install the recorder and record a presentation.

1. Select a presenter to test the profile. This presenter's information is used, if needed, for variables,
accounts, etc.

Youmay want to make sure the presenter knows that you are going to test the profile, or use your own
presenter account.

The presenters available in the list are the users associated with this profile.

2. Select whether or not you want to test the notifications associated with the profile.
3. Select whether or not you want to include theHold for caption editing process in the profile test.
4. If you choose not to send notifications, you can view the status of the sample presentation on thePre-

sentations page.
5. Click Test Profile.

Camtasia Relay submits a sample presentation and processes it with the settings of the profile.

6. You are redirected to thePresentations page where you can follow the progress of the presentation’s
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processing.

See also

Profile Settings
Publish Destinations
Encode Settings
Publish Accounts
Notification Selection
Notification Assignment
Variable Definition
Associated Users
Overview

Publish Destination Setup
Camtasia Relay can publish presentations to one or more of the following locations. Click the publish des-
tination type to learnmore.

File System (Network drives, etc)
FTP Server (FTP & sFTP)
Screencast.com (TechSmith’s media-hosting service)
WebDAV
Microsoft Windows SharePoint
iTunes U (Camtasia Relay formats supported by iTunes U includeMP4 andMP3)
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

If the publish destination you would like to use is not available in the list of publish
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destinations, youmay have to install the appropriate plug-in before you can use it. See Plug-
Ins for more information.

Publish to Amazon S3

To create an Amazon S3 publish destination:

1. Click Profiles > Publish Destinations.
2. Click Amazon S3 on the left to create a new destination.
3. Enter a title, the Amazon Access Key, and Amazon Secret Key.

The access key and secret key are provided by Amazon.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

AmazonWeb Services, the “Powered by AmazonWeb Services” logo, and Amazon S3 are trademarks of
Amazon.com, Inc. or its affiliates in the United States and/or other countries.

See also

File System
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube

Publish to Drupal

Camtasia Relay currently supports release 6.1 and 7 of Drupal. The Camtasia Relay Drupal
plug-in has been tested with version 6.1.9 and version 7.2.

1. Click Profiles > Publish Destinations.
2. Click Drupal on the left to create a new destination.
3. Enter all required information and select FTP and XMLRPC protocol options.
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4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
YouTube
Amazon S3

Publish to File System

To create a file system publish destination:

1. Go toProfiles > Publish Destination Setup.
2. Click File System on the left to create a new destination.
3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and

URLs, as needed.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

FTP Server
Screencast.com
WebDAV
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Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to FTP Server

To create an FTP (or sFTP) publish destination:

1. Click Profiles > Publish Destinations.
2. Click FTP Server on the left to create a new destination.
3. Enter all required information. Use variables to help createmulti-purpose publish destination paths and

URLs, as needed.
Use the dropdown to select from :

http
https
mms
rtmp
rtsp

Use the dropdown to select between FTP or sFTP protocol.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3
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Publish to iTunes U

1. Click Profiles > Publish Destinations.
2. Click iTunes U on the left to create a new destination.
3. Enter all required information.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

iTunes U Publishing Requirements

Camtasia Relay can publish presentations directly to iTunes U provided the following conditions are satisfied:

Your institution has an iTunes U account. TechSmith is not affiliated with iTunes U.
The published presentations are encoded into a file type supported by iTunes U. Camtasia Relay offers
MP4, andMP3. (iTunes U supports M4A, MP3, MP4, M4V, MOV, and PDF.)
You know the Shared Secret code provided to your school by Apple. This is a 32 character alpha-
numeric code.
You have access to desiredMedia Group ID codes. These are 10-digit numbers that direct the
producedmedia into a specific instructor’s class. Learn how to find your Media Group ID.
Viewers need iTunes on their computers.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to Kaltura

Camtasia Relay can automatically publish presentations to Kaltura and KalturaMediaSpace™.
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Custom Data in Kaltura

To allow Camtasia Relay to publish to Kaltura, your Kaltura account must have Custom Data enabled. To ver-
ify this option is enabled, log in to your Kaltura administrator account and go to Settings.

If you do not see a Custom Data tab under Settings, please contact Kaltura support.

Configure Camtasia Relay to Publish to Kaltura

1. Go toProfiles > Publish Destinations.
2. Click Kaltura on the left to create a new destination.
3. Enter a title for the publish destination.
4. Enter the Service URL.
5. Enter the Partner ID and Administrator Secret.

To locate this information, log in to the KalturaManagement Console and go toSettings > Integration
Settings.

6. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination. SeeKaltura Publish Accounts for additional information.

7. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Mediasite
Drupal
YouTube
Amazon S3

Publish to Mediasite

Camtasia Relay currently supports and has been tested with release 5.5 of Mediasite.

1. Click Profiles > Publish Destinations.
2. Click Mediasite on the left to create a new destination.
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3. Enter all required information and select the FTP protocol option.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Drupal
YouTube
Amazon S3

Publish to Screencast.com

To create a Screencast.com publish destination:

1. Click Profiles > Publish Destinations.
2. Click Screencast.com on the left to create a new destination.
3. Enter a default folder. You can use variables to help automatically personalize the folder name.
4. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

5. Click the link to continue withPublish Account Setup.

What is Screencast.com?

Screencast.com is the place to share your high-quality videos, documents, presentations, and images—
simply and professionally. We never compress or alter your content...so what you upload is what viewers
see. And with four levels of privacy controls, you get to decide who sees what.

Benefits of Publishing to Screencast.com

Presenters can easily manage, organize, and delete their presentations.
Presenters can attach additional materials to the video. For example, a viewer can download notes, the
actual presentation slides, etc.
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Screencast.com is hosted by TechSmith and is helpful for customers with limited bandwidth and
media storage space.
Presenters can exercise individual control over how their content is protected.
Presenters can allow viewers to comment on their presentations. See http://www.sc-
reencast.com/answers for more information.

Presenter Accounts for Screencast.com

When publishing to Screencast.com, set the Publish Accounts to Use presenter account.

Every Camtasia Relay presenter needs a Screencast.com account. To obtain Screencast.com accounts,
visit http://www.screencast.com. Accounts are not created via Camtasia Relay.

By default, presentations are stored in the Camtasia Relay folder on Screencast.com. Camtasia Relay Admin-
istrators can createmultiple Screencast.com destinations for organizational purposes, and can also create
multiple folders for presenters. Presenters may also create their own folders on Screencast.com and assign
them to their profile.

Inform Presenters

Presentations are not published until presenters sign in to the Camtasia Relay website and enter their account
information. Ideally, introduce presenters to the Camtasia Relay website and have them enter their Screen-
cast.com information beforemaking recordings.

Presenters that make a recording and upload a presentation before the information is entered receive an email
with a hyperlink and instructions to solve the problem.

See also

File System
FTP Server
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to Microsoft Windows SharePoint

Microsoft® Windows® SharePoint™websites allow users to share information, collaborated on documents,
andmanagemedia.

For additional information about Microsoft Windows SharePoint, see the training portal at:
http://www.microsoft.com/learning/en/us/training/sharepoint.aspx.

To create a SharePoint publish destination:

http://www.screencast.com/answers
http://www.screencast.com/answers
http://www.screencast.com/answers
http://www.screencast.com/
http://www.microsoft.com/learning/en/us/training/sharepoint.aspx
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1. Go toProfiles > Publish Destination Setup.
2. Click SharePoint on the left to create a new destination.
3. Enter the SharePoint URL.
4. If you have an invalid certificate on your SharePoint server that is not currently trusted by your Cam-

tasia Relay server, enable the option to Trust All Certificates. This allows Camtasia Relay to ignore
any certificate errors and publish to the SharePoint server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
for more information.

See also

File System
FTP Server
WebDAV
Screencast.com
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to WebDAV

WebDAV (Web-based Distributed Authoring and Versioning) provides a way tomanage files over HTTP. It
allows web server directories to display as folders on a local computer. WebDAV lets you use these folders
like any other folder on the local computer. The URL that you publish a presentation to is the same as the URL
you use to view the presentation.

For additional information about WebDAV, please seeWebDAV Resources online at www.we-
bdav.org.

To create aWebDAV publish destination:

1. Go toProfiles > Publish Destination Setup.
2. ClickWebDAV on the left to create a new destination.
3. Enter theWebDAV URL.

http://www.webdav.org/
http://www.webdav.org/
http://www.webdav.org/
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If you want to publish to a SharePoint server, youmust create a SharePoint publish
destination; you cannot use aWebDAV publish destination to send presentations to a
SharePoint server.

4. If you have an invalid certificate on yourWebDAV server that is not currently trusted by your Camtasia
Relay server, enable the option to Trust All Certificates. This allows Camtasia Relay to ignore any
certificate errors and publish to theWebDAV server.

5. Click Save.

The publish destination is saved and you are presented with a link to thePublish Account Setup for
this destination.

6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

File System
FTP Server
Screencast.com
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
YouTube
Amazon S3

Publish to YouTube

To create a YouTube publish destination:

1. Click Profiles > Publish Destinations.
2. Click YouTube on the left to create a new YouTube publish destination.
3. Enter a title and select a category that is applied to all videos published to this destination.
4. Click Save.
5. The publish destination is saved and you are presented with a link to thePublish Account Setup for

this destination.
6. Click the link to continue withPublish Account Setup.

If the publish destination you would like to use is not available in the list of publish des-
tinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins
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for more information.

Presenter Accounts for YouTube

YouTube accounts have a length limit for videos uploaded to unverified accounts. Be sure publish accounts
(either a default account or individual presenter accounts) are verified to ensure that videos uploaded through
Camtasia Relay will be accepted.

Videos that are longer than YouTube's length limit will be discarded by YouTube. To avoid losing videos that
YouTubemay reject, it is recommended that profiles publishing to YouTube also create a copy of the original
recording.

Before videos can be published to a YouTube account, that account must have a channel. For
more information on creating a channel for a YouTube account, see the documentation on You-
Tube.com.

See also

File System
FTP Server
Screencast.com
WebDAV
Microsoft Windows SharePoint
iTunes U
Kaltura
Mediasite
Drupal
Amazon S3

Publish Account Setup
For each publish destination, you can define the accounts for Camtasia Relay to use to access it.

Publish Accounts include the specific information used to place processed presentations in a publish des-
tination, such as user authentication information, folder selection, etc.

See additional account information for iTunes U Accounts andKaltura Publish Accounts.

To Create a Publish Account

1. On the Publish Account page (Profiles > Publish Accounts Setup), click one of the publish des-
tinations you have set up.

2. Enter information for the new account.
3. Select if you want to make the account the default account. See the tips below for information about

default accounts.
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4. If not a default account, select if you want toUse account information from default account. This
allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

5. Click Save.

Things to Consider About Publish Accounts

The following informationmight help you inmaking some decisions when creating your publish accounts.

You can let presenters enter their own information.

If you would like to use this option, you do not have to set up a publish account. Instead, you will select
toUse presenter accountwhen configuring a profile.

Each publish destination can have a default account.
This can be helpful in several ways:
You can set up a default account to hold the credentials used to access a publish destination,
and then use the other accounts to place presentations into various folders.
When you select a publish destination and encode setting in a profile, the default account is
selected automatically for the publish account.
If the default account for a publish destinationmay change from time to time, you can select
Use default accountwhen configuring a profile. You can then change which account is the
default account without having to change anything in the affected profiles. The profiles use the
currently selected default account for a given publish destination.

You can select different publish accounts for each publish destination/encode setting combination in a
profile.

iTunes U Accounts

Each iTunes U course requires aMedia Group ID. TheMedia Group ID is a 10-digit number supplied by Apple.
Each instructor usually has aMedia Group ID for each class.

1. Click the New account link.
2. Enter theMedia Group ID. The remaining fields are optional, but they can be helpful when assigning

iTunes U publish destinations to profiles.
3. Click Save. There is a delay as Camtasia Relay verifies the settings with iTunes U.
4. Add additional accounts as necessary. iTunes U will be available as a publish destination for encode

types supported by iTunes U.

What is My Media Group ID?

iTunes 11 and later

1. Log in to your iTunes U account in iTunes 11 or later as an administrator.
2. Click on the category you wish to retrieve theMedia Group ID from.
3. On the right side of the screen, click onUpload and Manage Files.
4. TheMedia Group ID is in the URL.
5. Paste the URL into a document. It will look similar to:
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https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

6. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).

iTunes 10 and earlier

1. Click on a class in iTunes U.

2. Right-click the Videos tab and select Copy iTunes Store URL.

3. Paste the URL into a document. It will look similar to:

https://deimos.apple.com/WebObjects/Core.woa/

BrowsePrivately/example.com.1927435401.01099125312

4. TheGroup ID is the last 10 digits in the URL, indicated in this example in bold (1099125312).

Kaltura Publish Accounts

Accounts for Kaltura publish destinations define how presentations are published to Kaltura and KalturaMedi-
aSpace™.

1. Enter a Title for the publish account.

This title is meant to help administrators understand what a specific account is meant for during profile
creation. Try to use descriptive naming conventions for easy identification.

2. Select if you want to make the account the default account. See Things to Consider about Publish
Accounts for information about default accounts.

If not a default account, select if you want toUse account information from default account. This
allows you to use the credentials from the default account andmodify other account information, such
as paths, folders, and URLs.

3. Enter the Creator for this account.

By default, the Creator field is filled in with the system variable PresenterUserName. This variable is
replaced with the presenter's user name associated with a presentation during publishing. This variable
is a great choice if user names are the same in both Camtasia Relay and Kaltura, as presentations will
automatically map to the correct Kaltura user.

4. Enter any Tags for this account, using commas to separate entries. Tags are searchable in Kaltura and
KalturaMediaSpace.

5. Enter any Categories associated with this account.Categories define where (which tab, hierarchy,
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etc.) a presentation is published on a KalturaMediaSpace site.
6. Click Save.

Notification Server Setup
You can configure notifications from three types of servers:

Email Server
Blackboard Server
Moodle Server

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

Email Server Configuration

You configure the email server when you first log into Camtasia Relay after installation.

If you need to later modify the email server information, go toProfiles > Notification Server Setup > Email
Server tab.

You can only have one email server configured in Camtasia Relay.

The configuration includes:

The SMTP email server address (Required)
The SMTP email server port (Required)
The name and email address that shows in the Reply To fields of email notifications

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. SeePlug-Ins for
more information.

See also

Blackboard Server
Moodle Server

Blackboard Server Configuration

Camtasia Relay can automatically post announcements on Blackboard. Configuring Blackboard announce-
ments is a two-step process. First, install the Camtasia Relay Building Block on Blackboard and establish the
Shared Secret. Next, configure Camtasia Relay to publish Blackboard announcements.
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The configuration steps vary depending on your version of Blackboard Learn™. Camtasia
Relay currently supports release 9.1. The Camtasia Relay Blackboard plug-in has been tested
with version 9.1.407.

Install Camtasia Relay Building Block

1. Locate the Camtasia Relay Building Block (RelayAnnounce.war) installed during the server instal-
lation at: C:\Program Files\Techsmith\Relay Server\Blackboard Building Block.

2. Go to your Blackboard site. E.g. http://blackboard.example.com.
3. Click User Login and sign in as a System Administrator.
4. Click theSystem Admin tab.
5. Click Building Blocks.

6. Click Installed Tools.
7. Click theUpload Building Blocks button.
8. Under Install Building Block, browse to RelayAnnounce.war. Click Open.
9. Click theSubmit button and verify the Building Block is available.

10. Click theSettings button. This displays the Shared Secret.
11. Choose and enter a secure Shared Secret, andmake a note of it as you need to enter the Shared

Secret into Camtasia Relay.

Configure a Blackboard Server

1. Go toProfiles > Notification Server Setup > Blackboard Server tab.

2. Enter a title (name) for the server.

3. Enter the Blackboard URL and Shared Secret.
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4. Click Save.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

Email Server
Moodle Server

Moodle Server Configuration

Camtasia Relay can automatically post notifications on aMoodle server. ConfiguringMoodle notifications is a
two-step process. First, configure theMoodle server to receive the notifications; next, configure Camtasia
Relay to publish notifications toMoodle.

Configure a Moodle 2.0 or Later Server to Receive Notifications
Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure Camtasia Relay to Send Notifications to Moodle
Troubleshooting Sending Notifications to Moodle

The configuration steps vary depending on your version of Moodle. Camtasia Relay currently
supports version 2.0 and later and 1.9. The Camtasia Relay Moodle plug-in has been tested
with Moodle versions 1.9.5, 1.9.6, 1.9.7, and 1.9.9. Version 2.x has been tested with up to ver-
sion 2.2.

If the notification server type you would like to use is not available in the list of notification
server, youmay have to install the appropriate plug-in before you can use it. See Plug-Ins for
more information.

See also

Email Server
Blackboard Server

Moodle 2.0 and Later Plug-In Setup

Enabling Camtasia Relay to send publish notifications to aMoodle 2.0 or later server requires two steps. This
topic covers the first, installing and configuring the plug-in on theMoodle server. The second is step is toCon-
figure Camtasia Relay to Send Notifications to Moodle.

Install the Camtasia Relay Plug-In on the Moodle Server
1. On your Camtasia Relay server, navigate to C:\Program Files\TechSmith\Relay

Server\Moodle Components\.
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2. Extract the camtasia_relay.zip file to your Moodle server in the {moodle_install_dir}
/server/moodle/local/ directory.

3. Log in to theMoodle website as an administrator and go to Home.
4. A prompt appears to upgrade the Camtasia Relay Notification plug-in. Click Update and then click

Continue to check for updates.
5. Go to Site Administration > Plugins > Web Services > External Services and verify the service shows

up in the Built-in Services List.

Configure the Camtasia Relay Plug-In on the Moodle Server
Log in to theMoodle site as an administrator. Next, Navigate to Site Administration > Plugins > Web Services
> Overview. The instructions in the overview describe how to configure the Camtasia Relay plug-in.

1. Enable web services.
2. Enable protocols. Enable XML-RPC andWeb Services Documentation.
3. Create a new user to act as the "Relay User." This user is used with the web service so Camtasia

Relay can access theMoodle server.
4. Check for user capability. The user should have appropriate capabilities according to the protocols

used. Use either an existing role or add a new Web Services role. To add a new role:
a. Go to Site Administration > Users > Permissions > Define Roles.
b. Add a new role.
c. Give the new role System and User context types.
d. Allow capabilities for this role.

i. Allow Web Service: XML-RPC protocol > Use XML-RPC protocol
ii. Allow Forum > Start New Discussions.

5. Add the new role to the "Relay User" account created earlier. Go to Site Administration > Users > Per-
missions > Assign User Roles

a. Click on theWeb Service or other role and assign to the "Relay User."
b. Go to Site Administration > Users > Permissions > Check System Permissions to verify that

the Relay User has the required capabilities.
6. Create a token for the Relay User.

a. Go to Site Administration > Plugins > Web Services > Manage Tokens.
b. Create a new token. Select "Relay User" and Camtasia Relay Notification Service and save

changes.
c. Record the newly created token string. This is the token used to set up a notification on the

Camtasia Relay website. It must be entered on the Camtasia Relay website when setting up
the publish notification.

To finish configuring the publish notification on the Camtasia Relay website, seeConfigure Camtasia Relay
to Send Notifications to Moodle.

See Also

Troubleshooting Sending Notifications to Moodle

Moodle 1.9.x Server Configuration

Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
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Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications

These steps may also work with Moodle versions prior to 1.9.5, but this has not been verified
by TechSmith Corporation.

To support Camtasia Relay notification integration, install a new PHP file, rpclib.php, on theMoodle
server as follows:

1. Locate and copy the following file:

C:\Program Files\TechSmith\Relay Server\Moodle Components\rpclib.php

2. Paste the file to theMoodle server at:

<IIS or apache-path>/htdocs/moodle/mod/forum/rpclib.php

3. Locate the following file on theMoodle server:

.../htdocs/moodle/lang/en_utf8/forum.php

4. Add the following lines to the forum.php:

$string['forum_add_discussion1_name'] = 'forum_add_dis-

cussion';

$string['forum_add_discussion1_description'] = 'calls forum_

add_discussion';

5. On theMoodle server, log in as an administrator.
6. Navigate toNetworking > XML-RPC hosts.
7. Enable theOn option and click Save changes.

8. Navigate toNetworking > XML-RPC hosts.
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9. Add the Camtasia Relay server IP address and, optionally, a network block to the list of trusted hosts.

Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
Moodle versions 1.9.7, 1.9.8, and 1.9.9 include several changes to the way networking and XML-RPC are han-
dled.

It is necessary tomakemanual updates to your Moodle database. This can be accomplished with phpMyAd-
min or MySQLCLI if you are usingMySQL; otherwise, use the appropriate utility for your database.

This procedure assumes you have a standard installation of Moodle.

1. Follow the steps used for 1.9.5 and 1.9.6.
2. Insert a new row intomdl_mnet_service to represent the forum announcement service.

id name description apiversion offer

The next highest value, for this
example, it is 4

forum
course announce-
ment service

1 1

3. Insert a new row intomdl_mnet_rpc to represent the forum announcement service.

Column Name Value

id The next highest value, for this example, it is 15

function_name forum_add_discussion_1
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Column Name Value

xmlrpc_path mod/forum/rpclib.php/forum_add_discussion1

parent_type forum

parent mnet

enabled 1

help Post amessage to a forum

profile blank

4. Insert a new row intomdl_mnet_service2rpc to link themdl_mnet_service record to themdl_mnet_
rpc record.

id serviced rpcid

The next highest value,
for this example, it is
15

The id entered into mdl_mnet_
service, for this example, it is
4

The id entered into mdl_
mnet_rpc, for this example, it
is 15

5. Insert a new row intomdl_mnet_host2service to link themdl_mnet_host record to themdl_mnet_serv-
ice record.

id hostid serviceid publish subscribe

The next
highest
value, for
this exam-
ple, it is 1

1 (This id comes frommdl_
mnet_host defining your
Moodle server having the
forum announcement service
plugin.)

The id entered
into mdl_mnet_
service, for this
example, it is 4

1 0

The next
highest
value, for
this exam-
ple, it is 2

0

The id entered
into mdl_mnet_
service, in this
example, it is 4

1 0

TheMySQL insert statements for the above:

insert into mdl_mnet_service (id,name,description,apiversion,

offer) values (4,'forum', 'course announcement service', 1,



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 75 -

1);

insert into mdl_mnet_rpc (id,function_name,xmlrpc_path,parent_

type,parent,enabled,help)

values (15, 'forum_add_discussion1',

'mod/forum/rpclib.php/forum_add_discussion1', 'forum', 'mnet',

1, 'Post a message to a forum');

insert into mdl_mnet_service2rpc (id, serviceid, rpcid) values

(15, 4, 15);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (1, 1, 4, 1, 0);

insert into mdl_mnet_host2service (id, hostid, serviceid, pub-

lish, subscribe) values (2, 0, 4, 1, 0);

Prior to using these statements, first verify the correct table ids in these insert state-
ments.

Configure Camtasia Relay to Send Notifications to Moodle

1. Go toProfiles > Notification Server Setup > Moodle Server tab.
2. Enter a title (name) for the server.
3. Enter MoodleServerURL.

For example: http://moodle.our-university.edu.

If theMoodle server is configured to use a port other than the default of 80, the URL you need to include
the port. For example, if you are runningMoodle on your own computer using port 8080, the URLwould
be http://localhost:8080.

4. Enter theServer path.

Typically this is mnet/xmlrpc/server.php or moodle/mnet/xmlrpc/server.php. This can
vary depending on your Moodle configuration.

5. Enter theService path.

Typically this is mod/forum/rpclib.php/forum_add_discussion1, if the rpclib.php is used as
provided by TechSmith.

If desired, youmay implement your own XML-RPC method using the same parameters as forum_
add_discussion1. The Service Path described above would need to be set appropriately.

6. Click Save.

See Also

Install the Camtasia Relay Plug-In on the Moodle Server
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Troubleshooting Sending Notifications to Moodle
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Troubleshooting Sending Notifications to Moodle

Below is a simple Python 3.x script that can be used to troubleshoot theMoodle course announcement plug-
in. To use it, you will need to:

1. Install Python 3.0+ on a client computer.
2. Copy the script below into a file on the client computer, e.g., xmlrpc-moodle.py.
3. Edit serverUrl and server to match your Moodle server configuration.
4. Run the script like something like this: C:\python31\python.exe xmlrpc-moodle.py

# For use with Python 3.x

import sys

import time

import xmlrpc.client

timestamp = time.strftime("%Y-%m-%dT%H:%M:%S") # iso_time

# Server settings

serverUrl = "http://localhost:80/"

server = "moodle199" # can be empty if the serverUrl identifies the

server

service = "forum_add_discussion1"

username="admin"

# format and mailnow are hardcoded for now

format=1

mailnow=1

# Announcement settings

courseshortname="CHEM101"

subject="python3 test's subject " + timestamp + ", <a

href=\"http://www.techsmith.com/\">TechSmith!</a>"

message="python3 \"test's\" msg " + timestamp

# RPC call and results

rpcServerUrl = serverUrl + server + "/mnet/xmlrpc/server.php"

service = "mod/forum/rpclib.php/" + service

xmlRpcServer = xmlrpc.client.Server(rpcServerUrl)

print("*** Calling XML-RPC service {0} on server URL {1}".format
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(service, rpcServerUrl))

try:

result = xmlRpcServer._ServerProxy__request(service,

(courseshortname, subject, message, format, username,

mailnow))

print("result =", result)

except Exception as e:

print("Unexpected error:", sys.exc_info())

raise

See also

Install the Camtasia Relay Plug-In on the Moodle Server
Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
Configure Camtasia Relay to Send Notifications to Moodle

Notification Setup
Set up notifications to let administrators, presenters, or viewers receive information about processed pre-
sentations.

You can set up notifications to be sent by email or posted on Blackboard or Moodle.

Create a Notification

1. On the Notification Setup page (Profiles > Notification Setup), click one of the notification servers.
2. Enter information for the notification. Depending on which server type you select, you will enter dif-

ferent types of information.

You can use variables to allow one notification to be used inmultiple cases. For more information, see
Variables.

3. Select aDetails Template to use.

Click Samples to preview what information each template includes.

This template defines what information to include in the notification. A notification contains information
for each encoding you select to include in this notification in the profile.

ChooseMessage only if you only want to specify amessage and not include additional details.

4. Enter amessage to include in the notification. This can be a personalized greeting, additional pre-
sentation information, or left blank. You can use variables in this field.

5. Click Save.

Things to Consider About Notifications

The following informationmight help you inmaking some decisions when creating notifications.
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When you set up a profile, you can choose which encodings you want to include in each notification.

For example, you could create a profile that contains both aWeb video and a CAMREC file. You can
include theWeb video information in a notification that goes straight to viewers and include information
on the CAMREC file in a notification that goes only to the presenter.

You can preview the information included in each of the details templates by clicking the Samples link.
For more information on the details templates, seeDetails Templates.
You can use variables to allow for a single notification to be used for multiple uses.

For example, use the system variable {s:PresenterEmailAddress} in the To field of an email noti-
fication. Any profile that uses that notification always sends an email to the email address of the pre-
senter associated with the presentation.

If you use variables in themessage of a notification, some variables only receive information from the
last processed encoding in a presentation.

For example, if you use the system variable {s:PublishFilePath} in themessage of a notification and
havemultiple encodings set up in the selected profile, only the file path of last published encoding are
included in themessage.

Camtasia Relay does not send separate notifications for each encoding selected in a profile, but
instead rolls information for each encoding into a single notification.

For example, if in a profile, you select to include three encoding types in a notification, the recipient
receives one notification including information about all three encodings rather than three separate noti-
fications.

Details Templates

The following details templates are available to use in your notifications. These samples contain example infor-
mation to demonstrate what information is included in notifications that use each template.

If you do not want to include any details, select theMessage Only template. This template will
only include the text you enter in themessage field.
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Administrator

Presenter
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Viewer

Variables
Variables can help simplify themanagement of profiles, publish destinations, publish accounts, and noti-
fications. These “placeholders” have a value applied to them at the time a presentation processes.

There are three different types of variables available:

System Variables

Select from variables included in the Camtasia Relay system and that change their value based on the
information for the presentation that is being processed.

Global Variables

Create a variable, use the variable in multiple places, andmanage the value in central location.

Profile Variables

Create a variable, use the variable in multiple places, and define the value per profile.

Where and How to Use Variables

Variables are available in multiple fields on the Camtasia Relay website, but you use the same interface to
access them in all locations.

Where Can I Use Variables?

Variables are available in publish destinations, publish accounts, and notifications. You can use them
to reuse file paths, URLs, folder names, email recipients, notificationmessages, andmore

Next to each field that can accept variables, you will see the Variable button.
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How Do Add a Variable to a Field?

To use a variable:

Click theVariable button to open theVariable Selectionwindow.
Select a Variable type (Global, System, or Profile).
Select a variable from the list of variables of the selected type.
Click Add. The variable is added at the cursor location.

Repeat as needed. You can use the window to add variables and to edit the content of the field.
When you are done, click OK to close the window.

System Variables

System variables have dynamic values that change based on the presentation that is being processed. These
variables are included with the Camtasia Relay system and include the following:

Variable Name Variable Value

{s:EncodeSettingTitle} Title of the encode setting used to process a presentation.

{s:PresentationDescription} Description of the presentation.

{s:PresentationDuration} Duration, in milliseconds, of the presentation.

{s:PresentationResolution} Maximum resolution in the presentation.

{s:PresentationTitle} Title of the presentation.

{s:PresenterEmailAddress} Email address of the presenter associated with the pre-
sentation.



Camtasia Relay AdministratorWebsite Help

www.techsmith.com - 82 -

Variable Name Variable Value

{s:PresenterName} Name of the presenter associated with the presentation.

{s:PresenterUserName} Username of the presenter associated with the presentation.

{s:ProfileDescription} Description of the profile used to process the presentation.

{s:ProfileTitle} Title of the profile used to process the presentation.

{s:PublishDestinationTitle} Title of the publish destination of the presentation.

{s:PublishFileDuration} The duration of the published presentation, in milliseconds.

{s:PublishFileName} File name of the presentation.

{s:PublishFilePath} The output path of the published presentation.

{s:PublishFileSize} The file size of the published presentation.

{s:RecordDateTime} Date and time the presentation was recorded.

{s:RecorderComputerName} Name of the computer that recorded the presentation.

{s:RecorderIpAddress} IP address of the computer that recorded the presentation.

{s:RecordSettingTitle} Title of the record setting used to record the presentation.

{s:ServerUrl} URL of the server that processed the presentation.

{s:SourceFileSize} Size of the original recording of the presentation.

{s:StartProcessingDateTime} Date and time the presentation started processing.

Example Uses

Use the variable for the presenter’s username in a publish destination file path such as:

\media.company.com\presentations\{s:PresenterUserName}

When the presentation is published, the presenter’s username is substituted in the file path and places
the presentation in that presenter’s network folder.

Use the variable for the presenter’s email, {s:PresenterEmailAddress}, in theRecipient email
field of an email notification. This notification is always sent to the presenter of the presentation, with-
out having to create a notification for each user.
Use the variable for the presentation title in theSubject field of an email notification. Use something
like “Presentation Ready for Viewing: {s:PresentationTitle}” to let the recipients know what pre-
sentation is ready from just the subject of the email.
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See also

Where and How to Use Variables
Global Variables
Profile Variables

Global Variables

Global variables are static strings defined by an administrator. Changes made to the values of these variables
are instantly reflected wherever they are used in Camtasia Relay.

Create and use a global variable when you have a value that is used across multiple profiles and needs to
change at some point.

Example Uses

Create a variable forSemester and add it to a file system publish destination path, such as:

\\media.company.com\presentations\{g:Semester}

You can use this publish destination for multiple profiles. When the semester is over, change the value
on theProfiles > Variables > Global Variables tab and all profiles are automatically adjusted to
reflect the change.

Create a variable for the person to contact if a presenter needs assistance with editing a CAMREC file.

Use the variable in the email notification to the presenter.

When the responsibility to help presenters passes to a new person, you can easily change the variable
value on theProfiles > Variables > Global Variables tab.

See also

Where and How to Use Variables
System Variables
Profile Variables

Profile Variables

Profile variables have dynamic values that are profile specific. These variables can be used inmultiple profiles
but the value is defined per profile.

To fill in the value for a profile variable, go toProfiles > [Select a Profile] > Variable Definition tab.
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Example Use

Your organization’s network folder structure contains a “department” value. If you want a profile for each
department, create a variable for Department. Use this variable in a publish destination such as \\media.-
company.com\presentations\{p:Department}\{s:PresenterUserName}.

When you create a profile, you are prompted to define the value of the profile variable. In this case, the depart-
ment name that is also found in the network folder structure.

See also

Where and How to Use Variables
System Variables
Global Variables

Users Menu
The Users menu allows you tomanage Camtasia Relay users and related settings. The following pages are
available in this menu:

Users
LDAP Import
LDAP Configuration
User Account Security Settings

Users
The Users page contains a list of the current users in the Camtasia Relay system. On this page you can:

Review the users in the system. At a glance, you can see:
Usernames
Name (user’s “real” name)
Email Address
User Type (created in Camtasia Relay or imported from LDAP)
Access Level (Administrator, Presenter, Globlal Caption Editor, No Access)

Click a user to edit user information (Camtasia Relay-created users only)
Username
Name
Access level
Email address
Password
Modify a presenter’s available profiles

Delete a user
Add a Camtasia Relay user
LDAP Import

More than One Kind of User

Camtasia Relay allows you to use both LDAP users and Camtasia Relay created users.

Some examples of why youmay want to use both LDAP and Camtasia Relay managed users:
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You use LDAP and need a temporary account for a visiting presenter.
You use LDAP and need a presenter account for someone already in the system as an administrator.

Manually Add Camtasia Relay Users

If you do not use LDAP for authentication, you can create users manually in Camtasia Relay.

You can have both LDAP and Camtasia Relay created users.

To Create a New User

1. Go to theUsers page.
2. Click theNew User link.

3. Enter a username.

This is the username the presenter uses to log in to the Camtasia Relay website and recorder.

4. Enter the name (given name). This is associated with the recordings.
5. Select Presenter orGlobal Caption Editor in the Access Level dropdown list.

No Access restricts the user from logging into the website and Recorder. For example,
you can use it to turn off a presenter’s privileges at the end of a semester/term.

6. Enter an email address.
7. Enter and confirm a password.
8. Click Save orSave & Add.
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LDAP Import
Add LDAP Users

If your organization uses LDAP, first you need toConfigure Relay to Use LDAP. After LDAP is configured,
then you can either set up Camtasia Relay to automatically add LDAP users or you canmanually add LDAP
users.

You can have both LDAP and Camtasia Relay created users.

Manually Add LDAP Users

Camtasia Relay can reference an LDAP directory to populate the user database. There are two ways to
import users into the Camtasia Relay database.

At the end of the LDAP setup wizard, click Manually import Users to import users immediately.
When LDAP is enabled you can also import users from theUsers > LDAP Import page.

You can use search criteria, such as username, name, email, or LDAP attributes, to find users to add to Cam-
tasia Relay.

Automatically Add LDAP Users

To ease administration of Camtasia Relay, you can enable a system option to import an LDAP user when
they log into Camtasia Relay (website or recorder) with valid LDAP credentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.

To automatically add users with LDAP:

1. Go toSystem > System Options > Auto Import Users.
2. Enable the option toAutomatically import users with valid LDAP credentials.
3. Click Save.

As presenters successfully log in to either the Camtasia Relay website or the Camtasia Relay recorder with
LDAP usernames and passwords, they are automatically added to Camtasia Relay. If you enabledAuto
Associate Profiles, presenters can access the selected profiles immediately. This is a great way to reduce
the amount of administration work for getting new users started with Camtasia Relay.

This is not done on the User page, but to ease administration of Camtasia Relay, you can enable a system
option that imports a LDAP user when they log into Camtasia Relay (website or recorder) with valid LDAP cre-
dentials.

Use this option in conjunction with automatically assigning profiles for the easiest way to
get Camtasia Relay set up when you use LDAP authentication.

LDAP Configuration
To configure LDAP, you should first set up a RelayPresenter Service Account.
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RelayPresenter Service Account

Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, Camtasia Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. Camtasia Relay ceases to
function for all users if the password of the service account in LDAP is not the same as the
password stored in the Camtasia Relay database.

Configure Relay to Use LDAP

1. Go toUsers > LDAP Configuration.
2. Click Configure LDAP.
3. Enter server information:

Server address
Port

Use secure authentication: Select if you want to connect to the LDAP server over SSL.
Trust all certificates: Enable if you cannot connect over SSL due to an invalid certificate.
If you have a valid self-signed certificate, import the signing certificate into the Trusted
Root Certificate Authority on the Camtasia Relay Server for better security.

Authenticationmethod (Basic or Negotiate)
Username & password to authenticate

4. Click Next.
5. Select the returned base distinguished name or enter another.

Camtasia Relay returns the root of the LDAP directory, and pre-fills the Base distinguished name field.
Or, if you know exactly where your users reside in the LDAP directory, you canmanually enter the
Base DN.

6. Click Next.
7. Select the “RelayPresenter” service account as the representative user with the following attributes:

Full name
Username
Email address

8. Click Next.
9. Map the attributes from the selected user to the fields Camtasia Relay requires.

You can choose from the dropdown list of attributes returned from LDAP or type in an attribute if it is
not found in the dropdown list.

10. Click Next.
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11. Review the configuration information.
12. Enter a valid username and password into the Test Authentication fields and click Test.
13. Click Finish.

You can now configure Camtasia Relay toAutomatically Import Users with LDAP orManually
Add LDAP Users.

If you disable LDAP, users remain in the Camtasia Relay database. However, since Camtasia
Relay never stores LDAP-associated passwords, users cannot access the Camtasia Relay
website or make recordings.

To re-enable users, select a user then click theConvert to Relay link. The user is emailed a
randomly generated password. The user must access the Camtasia Relay website and
change their random password.

User Account Security Settings
To help secure Camtasia Relay, you can set the following:

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
Password Complexity

Recorder Security Settings

Tomanage the security of the Camtasia Relay recorders, you can choose to enable or disable the following
options.

Ignore Server Certificate Errors

If your server certificate is invalid, Camtasia Relay notifies you on theDashboard and the Recorder Security
settings page.

Enable this option if you need to let the recorder connect to the server even if the server has an invalid
server certificate. When enabled, the Camtasia Relay recorders ignore all server (SSL) certificate
errors when connecting to the Camtasia Relay server.

This option should be used as a temporary solution as it reduces the security of the
Camtasia Relay server.

Disable this option if you have security concerns and want to be sure that recorders only connect
when there are no SSL certificate errors.

More information about certificate errors:

When you change this option, Camtasia Relay recorders will be unavailable until they are rebuilt to
reflect this security change.
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It may take several minutes before the Camtasia Relay recorders are again available for download.
Allow about fiveminutes for the updated recorders to be available on theSystem > Download
Recorders page.

Recorders downloaded before changing this option cannot connect to the server andmust be updated.
Please inform presenters that they must download and install a new recorder from the Camtasia Relay
website. Presenters are not informed automatically.

Expire Recorder Authentication Codes

Enable this option to have presenter authentication codes expire. This can prevent an attacker from learning a
presenter’s code, posing as the presenter, and sending requests to the server.

This may affect presenters that select Remember me in the recorder. When the authen-
tication code expires, the presenters need to log in again.

See also

Forgot Password Settings
Account Lockout Settings
Password Complexity

Forgot Password Settings

You can allow users to change forgotten passwords. Set the amount of time (in minutes) that a change pass-
word link is active and how often users can request a new password.

See also

Recorder Security Settings
Account Lockout Settings
Password Complexity

Account Lockout Settings

You can allow accounts to lock after a given number of failed logins. Also set the length of time to lock an
account, how often to reset login attempts, and whether users can unlock accounts using CAPTCHA.

CAPTCHA Option to Unlock Accounts

CAPTCHA uses distorted text in an image to help protect websites frommalicious computer programs.
CAPTCHA helps tomake sure a person trying to access the website, not a computer program.

Enable this option to allow users to unlock their accounts by typing in the distorted text shown in the image.
Using this option should help to cut down on emails to administrators by users locked out of accounts.

See also

Recorder Security Settings
Forgot Password Settings
Password Complexity
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Password Complexity

Create rules for password complexity that adhere to organization standards. You can set the following pass-
word attributes:

Password character length
Uppercase and lowercase character requirements
Letters and numbers requirements
Special character (~!@#$%^&*.-_+?;) requirements

See also

Recorder Security Settings
Forgot Password Settings
Account Lockout Settings
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Need More Help
In addition to the in-product help files, there are several different ways to get help for using Camtasia Relay.

Camtasia Relay Learning Center

Looking for “How to…?” or “How do I…?” information? In the Camtasia Relay section of the Tech-
Smith.com Learning Center you can find themost up to date tutorials and product information.

TechSmith Technical Support

Having a technical issue? In the TechSmith Support Center you can search for answers to technical
issues and contact support. SeeWorking with Technical Support for more information about how to
contact TechSmith’s Technical Support team.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
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Working with Technical Support
In the event you have an issue that cannot be answered with the Camtasia Relay Help and documentation,
please follow the steps below when working with TechSmith Technical Support.

Step 1: Knowledge Base Search
Before contacting TechSmith for Technical Support, pleasemake sure to search the Knowledge Base on the
Support Center (http://support.techsmith.com). It is possible that the issue is a known issue and there is
already an answer available.

Before running a search, select Camtasia Relay and the version number in the dropdown lists.

Step 2: Submit a Question
If you are unable to find an answer to your issue, send a question to Tech Support.

1. On the Support Center page (http://support.techsmith.com), click Ask aQuestion.

2. Fill in the requested information, making sure to select your current Product Version, Operating Sys-
tem, and Problem Type.

For a question regarding a program error, please select Other under Problem Type.

3. If you are a first-time user, you are prompted to create a user account.
Tips for Submitting a Question

When opening a support ticket, please include as much information regarding the nature of the problem
as possible.
To speed up the debugging process, attach one or more of the following to the support ticket:

Screenshots
Application logs

http://support.techsmith.com/
http://support.techsmith.com/
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Other diagnostic information
Event Viewer logs

These are particularly useful. The steps inHow to Export Event Viewer Logs explain how to
export the logs for Camtasia Relay components.

Step 3: Call Tech Support
The Camtasia Relay Tech Support team is ready and waiting for your questions. Should you have problems
that you cannot solve using the resources provided, please give us a call and wewill be happy to assist.

The following information is available on the TechSmith website by clickingCompany > Con-
tact Us. Always refer to that location for latest, most accurate information.

Phone: +1.517.381.2300 (ext. 784)
Toll Free in the U.S. & Canada: +1.800.517.3001 (ext. 784)
Tech Support Website: http://support.techsmith.com

How to Export Event Viewer Logs
The following information explains how to export the event viewer logs for the components of Camtasia
Relay.

If the TechSmith node is not present on a server where Camtasia Relay Server has been
installed, this means that the Relay Manager Service never started on that server. If the server
isn’t running and you there isn’t a TechSmith node in the Event Viewer, try the Restart Cam-
tasia Relay Server shortcut on the desktop, it may solve the problem.

Camtasia Relay Recorder

Windows XP

1. Go toStart > Run > eventvwr.
2. Right-click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click Application and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click System and select Save Log Files As.
7. Save the log in the EVT format.

Windows Vista and Windows 7

1. Open the Start menu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.

http://support.techsmith.com/
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6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.

Windows 8

1. Open the Start menu and search for “event viewer.”
2. Click Settings. On the left, click Event Viewer.
3. When the Event Viewer opens, expandApplications and Services Logs.
4. Right-click TechSmith and select Save Events As.
5. Save the log in the EVTX format.
6. ExpandWindows Logs.
7. Right-click Application and select Save Events As.
8. Save the log in the EVTX format.
9. ExpandWindows Logs.
10. Right-click System and select Save Events As.
11. Save the log in the EVTX format.

Mac OS X

1. i. Open Finder and go to /Library/Logs/TechSmith/.
2. ii. Right-click Camtasia Relay and select Compress Camtasia Relay to create a ZIP file of the log

files on the desktop.

Camtasia Relay Server

Windows Server 2003

1. Go toStart > Administrative Tools > Event Viewer.
2. Right click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click TechSmith and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click Application and select Save Log Files As.
7. Save the log in the EVT format.
8. Right-click System and select Save Log Files As.
9. Save the log in the EVT format.

Windows Server 2008 and Greater

1. Open theStartmenu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.
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7. Save the log in the EVTX format.
8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.
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This manual, as well as the software described in it, is furnished under license andmay be used or copied only
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Camtasia Relay Overview
With Camtasia Relay, capture and publish your lecture or presentation anytime, anywhere -- in the classroom,
in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video formats
allowing any lecture or presentation to be viewed by your audience onmultiple playback devices including port-
able media devices such as the Apple iPod and via iTunes U.

There are two parts to Camtasia Relay--the recorder, which runs on your computer, and the server, which proc-
esses and publishes all presentations. Watch a short overview video on the TechSmith website.

Here are two key concepts to consider:

Make a Test Recording. These 10-second practice recordings can help you verify that you are record-
ing from the correct display and audio device.
When you click theSubmit button, your presentation starts to upload. If you aren’t connected to the
Internet, it’s not a problem; Camtasia Relay automatically starts or resumes uploading when you next
connect. Learn more.

Why Camtasia Relay?
Youmight be wondering why your organization decided to use Camtasia Relay to record presentations. Here
are a few of the key benefits of Camtasia Relay:

Personalized profiles automate recording and publishing

Profiles are created by the Camtasia Relay administrator and specify the final format(s) of the pre-
sentation and where presentations are published.

Hotkeys to start, pause and stop recording

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
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Hotkeys aremore than just convenient. Presenters can start, stop, and pause recordings without
viewers seeing any interaction with the Camtasia Relay recorder.

Record offline

Presenters do not have to be online tomake a recording. Record as normal and Camtasia Relay auto-
matically uploads the presentation the next time the computer connects to the Internet, without having
to launch Camtasia Relay or click any buttons.

If your connection is lost while uploading a presentation, Camtasia Relay automatically resumes from
where it left off the next time you are connected.

Guests can record on behalf of presenters

People can record presentations and submit them for presenter approval. Once the presentation is
uploaded, the associated presenter receives an email with a link to authorize processing and publishing
the presentation. This is a great way to allow people to contribute presentations without sharing user-
names and passwords.

See also

Record a Presentation
Record a PowerPoint Presentation
Log In to Camtasia Relay
Profiles in Camtasia Relay
Record When Not Online
After Recording
Camtasia Relay Portable Recorder
The Camtasia Relay Website
FAQs
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Record a Presentation
Learn how to record a presentation and submit it to the Camtasia Relay server for processing.

Want to seemore?Watch an overview video. (2 minutes)

If you are recording aMicrosoft Office PowerPoint presentation, you can use theCamtasia Relay Add-In for
PowerPoint.

SeeRecord for Someone Else if you do not have a Camtasia Relay account and are record-
ing a presentation on behalf of a Camtasia Relay presenter.

1. Launch Camtasia Relay.
2. Log inwith your username and password, or identify yourself as a guest recording for someone

else.

You do not have to log in prior to recording, but youmust log in as a presenter or identify
yourself as a guest before you can upload or save your presentation.

3. Select a profile. If you do not know what profile to select, chooseUpload and Decide Later.

http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=introductoryvideo&product=relay&ver=4.3.0&lang=enu&os=NA
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4. Click theAudio button and select an audio device in theSelect Audio Device dialog.

Select Record System Audio to include the sound you hear from your speakers in the recording.

5. Select which display to record if using a projector displaying a different screen or multiple displays.
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6. Click theCamera button to select a camera to record along with your presentation. This camera is dis-
played in the lower right corner of your presentation in a picture-in-picture format.

7. Enter a presentation title and description.

8. Make a test recording to verify that you are recording from the correct display, camera, and audio
device.
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9. Click the Record button. The recorder is minimized to the system tray.

10. Give your presentation. Camtasia Relay records everything on your screen, selected camera, and the
selected audio device.

11. Stop the recording using a hotkey or right-click the icon in the system tray. Theremay be a delay as
the recording is finalized. The recording opens in theCamtasia Relay Reviewwindow.

12. If needed, click Trimming to set trim points to cut out extra video at the beginning and end of the pre-
sentation.

13. Click theSubmit button.

If you are connected to the Internet, the presentation starts uploading to the Camtasia Relay
server.

If you are not connected to the Internet, the recording automatically starts uploading when you
connect to the Internet. You do not receive notice when your presentation begins uploading.
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After you submit a presentation for upload, you cannot access it or view its status on
your computer. Instead, you canCheck the Status of Your Presentation on the Cam-
tasia Relay website.
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Record a PowerPoint Presentation

This option is not available when using the Camtasia Relay portable recorder.

To record a PowerPoint Presentation with the Camtasia Relay Add-In:

1. Open PowerPoint.

After you install Camtasia Relay, it automatically prompts you to record when you start
a PowerPoint slide show. You can change this and other default settings in the record-
ing options.

2. Start a slideshow.

A prompt asks if you want to record.

3. Verify the audio selection and level.
4. Click Record Slide Show.

5. Give your presentation as normal.

When you finish the slide show, you can end the recording or continue recording.

6. When prompted, click Stop Recording to end the presentation.
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7. The presentation is shown in the Camtasia Relay Review dialog. You can review, trim, edit Pre-
sentation Details, log in (if needed), and submit your presentation for processing. SeeAfter Record-
ing for more information.
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See also

Camtasia Relay Add-In Toolbar
Camtasia Relay Add-In Recording Options
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Camtasia Relay Add-In Toolbar
Use the add-in toolbar to adjust the available options.

Auto record prompts you to start recording whenever and however you start a slide show.

See also

Record a PowerPoint Presentation
Camtasia Relay Add-In Recording Options
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Camtasia Relay Add-In Recording
Options
To change the recording settings, click the Recording options button .

See also

Record a PowerPoint Presentation
Camtasia Relay Add-In Toolbar
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Log In to Camtasia Relay
When you open Camtasia Relay, it prompts you to log in.

The following are some FAQs about logging in:

Why log in?
Do I have to log in before recording?
I don’t know my username or password. What should I do?
I am recording a presentation for someone else. How should I log in?
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Why Log In?

Youmust log in as a presenter or identify yourself as a guest before you can submit or save
your presentation.

When you log in to Camtasia Relay, you do the following:

Identify yourself as a presenter

Log in to gain access to your profiles and identify yourself as the presenter. You can log in before or
after recording.

Gain access to profiles

A profile consists of settings that determine how a presentation is recorded, what kind of file is
produced, and where it is published. An administrator sets up profiles and assigns them based on pre-
senter needs.

Save settings

When you select an audio device or set hotkeys while logged in, the audio device and hotkeys are
stored and available the next time you log in.

If you enable theRemember Me option, you do not see the Camtasia Relay Login dialog box
each time you open Camtasia Relay. All of your settings are saved and you can immediately
access your profiles. Depending on the administrator’s choice of security settings,
Remember Memay occasionally be reset. You just need to log in again and enable
Remember Me.

See also

Log In to Camtasia Relay
Do I Have to Log in Before Recording?
Don't Know Your Username or Password?
Record for Someone Else
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Do I Have to Log in Before Recording?
Running late for your presentation? Can’t remember your password?

For these and other reasons, you are not required to log in before recording. If you are not logged in, the
Upload and Decide Later profile is selected when you begin recording.

Although you can record without logging in, youmust log in as a presenter or identify yourself
as a guest before you can submit or save your presentation. If you try to submit or save a pre-
sentation without logging in, you are prompted to do so.

Once you log in as a presenter, either before or after recording, you can access and select from your assigned
profiles.

See also

Log In to Camtasia Relay
Why Log In?
Don't Know Your Username or Password?
Record for Someone Else
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Don't Know Your Username or Password?
Here are a few things to try if you don’t know your username or password:

If you were not given a username or password, you can try logging in with your network username and
password. Some organizations set up Camtasia Relay to use these network credentials.
In the Camtasia Relay Login dialog box, click Forgot password. In some cases, you can reset your
password on the Camtasia Relay website.
Log in as a Guest Presenter. You can still record even if you do not know your username or forgot
your password.

Keep inmind that when recording as a guest, either you (once you find your password)
or the administrator must authorize the presentation before it can process. To authorize
a presentation, log into the Camtasia Relay website, find the presentation, and choose
a profile.

If you can’t remember your username or password and none of the above work for you, contact your
Camtasia Relay administrator.

To Log In As a Guest Because You Forgot Your Username or Password
1. Click Log In.
2. Click Guest.
3. Enter your name.
4. Enter your email in the Guest of field.
5. Click Submit.
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See also

Log In to Camtasia Relay
Why Log In?
Do I Have to Log in Before Recording?
Record for Someone Else
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Record for Someone Else
Guests can record presentations on behalf of a Camtasia Relay presenter.

To record as a guest:

1. Click Log In.
2. Click Guest.
3. Enter your name and the email address of the Camtasia Relay presenter you are presenting on behalf

of. If you do not know the email address, leave the Guest of field empty.
4. Click Submit.

When you identify yourself as a guest, the Upload and Decide Later profile is the only
available profile.

5. Click theAudio Device button and select the audio device in theSelect Audio Device dialog box.
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Select Record System Audio to include the sound you hear from your speakers in the recording.

6. Select which display to record if using a projector displaying a different screen or multiple displays.

7. Click theCamera button to select a camera to record along with your presentation. This camera is dis-
played in the lower right corner of your presentation in a picture-in-picture format.

8. Enter a presentation title and description.
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9. Make a test recording to verify that you are recording from the correct display and audio device.
10. Click theRecord button. The recorder is minimized to the system tray.

11. Give your presentation. Camtasia Relay records everything on your screen and the selected audio
device.

12. Stop the recording using a hotkey or right-click the icon in the system tray. Theremay be a delay as
the recording is finalized. The recording opens in the Camtasia Relay Review window.

13. If needed, click Trimming to set trim points to cut out extra video at the beginning and end of the pre-
sentation.
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14. Click theSubmit button.

If you are connected to the Internet, the presentation starts uploading to the Camtasia Relay
server. You receive an email when your presentation is published.
If you are not connected to the Internet, the recording automatically starts uploading when you
connect to the Internet. You do not receive notice when your presentation begins uploading.

While you cannot access your presentations on your computer, Camtasia Relay presenters can Check the
Status of Your Presentation on the Camtasia Relay website. The email entered in the Guest of field also
receives an email when your presentation is uploaded to the Camtasia Relay server.

Keep inmind that when recording as a guest, either the presenter you are the guest of or an
administrator must authorize the presentation before it can be produced.

See also

Log In to Camtasia Relay
Why Log In?
Do I Have to Log in Before Recording?
Don't Know Your Username or Password?
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Profiles in Camtasia Relay
A profile consists of settings that determine how a presentation is recorded, processed, and presented.

To access information on profiles available to you, log in to the Camtasia Relay website, click Profiles, and
then click a profile in the table.

Settings included in a profile:

Description: What should you use this profile for? The description is entered by an admin-
istrator to help you to choose the correct profile for your needs.

Publish destinations: Where the produced files go. Presentations can be published to
one or more destinations. Examples include an FTP server, a network drive, Screen-
cast.com, or iTunes U.

Encode settings: What kinds of files are produced. The original recording is encoded into
one or more formats. Examples include an audio only (MP3) encoding, an iPod-compatible
encoding, orWindows Media format. Encoding can reduce the frame rate and audio quality,
but can never improve the original recording.

Publish accounts: How to access the publish destinations. These accounts contain spe-
cific information used to place processed presentations in a publish destination, such as
authentication information, folder selection, etc.

Notifications: How people are informed when presentations are published. Notifications
are sent per profile and can include information about multiple encodings of the same pre-
sentation.

Only Camtasia Relay administrators can create or modify profiles.
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If you are not satisfied with existing profile options, you can select the Upload and Decide
Later Profile. This sends the recording to the server where it remains until you contact your
Camtasia Relay administrator to create or modify a profile.

See also

Which Profile Should I Choose?
Can I Change My Profiles?
Upload and Decide Later Profile
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Which Profile Should I Choose?
Your administrator assigns profiles to you based on presenter needs. When you log into Camtasia Relay, you
can view your assigned profiles by clicking on the profile dropdown list.

In the list, you only see the names of your available profiles. If you needmore information on the profiles:

1. Log in to the Camtasia Relay website.
2. Click Profiles. A list of your available profiles is shown.
3. Click a profile in the list and then click Overview to see the profile’s description and settings.

Only Camtasia Relay administrators can create or modify profiles. If you are not satisfied with
existing profile options, select theUpload and Decide Later Profile. This sends the record-
ing to the server where it remains until you contact your Camtasia Relay administrator to
create or modify a profile.



www.techsmith.com - 25 -

See also

Profiles in Camtasia Relay
Can I Change My Profiles?
Upload and Decide Later Profile
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Can I Change My Profiles?
Only Camtasia Relay administrators can create or modify profiles. If you are not satisfied with your existing
profile options, contact your Camtasia Relay administrator. Consider the following questions before con-
tacting your administrator.

What kind of recording do you want to make:
Will there be a lot of movement, such as video, in your presentations?
Are you going to record PowerPoint presentations?
Anything else the administrator should know about what you are recording?
Are you planning on editing presentations in Camtasia Studio?

What kind of files do you want to produce:
Do you needmultiple file types for the same presentation?
Is there a certain kind of file you need?
Do you want an audio-only file?
Should the produced presentations be certain dimensions?

Where do you want the produced files to end up:
Do you have a file folder location for the produced files?
Do you have an account on Screencast.com that you want to use?
Do you want to send your presentations to a website via an FTP server?
Do you want to send your presentations to iTunes U?

Some of the options mentioned abovemay not be available for your use.

See also

Profiles in Camtasia Relay
Which Profile Should I Choose?
Upload and Decide Later Profile
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Upload and Decide Later Profile
The Upload and Decide Later profile uploads the recorded presentation to the Camtasia Relay server but the
recording is not encoded or published. An authorized presenter or administrator must assign a different profile
and submit the recording for publishing via theCamtasia Relay website.

Why Use the Upload and Decide Later Profile?
For guest presenters, it is the only profile available.
Youmake a presentation in advance, but do not want it published until later.
You are not satisfied with existing profile options and you wish to hold the recording on the server until
you can contact your Camtasia Relay administrator to create or modify a profile.

See also

Record for Someone Else
Record When Not Online
Profiles in Camtasia Relay
Which Profile Should I Choose?
Can I Change My Profiles?
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Make a Test Recording
Few things are worse than recording an important presentation only to find out later there was no audio or you
were recording the wrong screen. It is important to make a test recording—especially when new to Camtasia
Relay.

Tomake a test recording:

1. Prepare your computer exactly as if you were presenting:
If you will use a projector, connect the projector.
If using a specific microphone, make sure it is connected and selected.

2. Click the blue Test button to initiate a 10-second test recording.

During the test recording, speak in your presentation voice and launch your PowerPoint or Keynote pre-
sentation, or whatever will be on your screen during your recording.

3. At the conclusion of the test recording, the video opens in a review window.

Click thePlay button to review the recording. Verify the audio is acceptable and the correct screen con-
tent was recorded. Adjust as necessary.

4. Click Close.

See also

Record a Presentation
Audio Devices
More Than One Display
Record with a Camera
Record When Not Online
Available Disk Space
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Hotkeys
In Camtasia Relay, hotkeys are for more than just convenience.

While they do save time, they also allow you to start, pause, and stop your recording without the audience see-
ing the Camtasia Relay recorder during the presentation.

To set hotkeys:

1. ChooseSettings > Hotkeys.
2. Select a key combination for each hotkey.

3. Click OK.

See also

Record a Presentation
Audio Devices
More Than One Display
Record with a Camera
Record When Not Online
Available Disk Space
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Audio Devices
Camtasia Relay records audio from the system as well as a single audio device, such as:

Built-in microphones
Standardmicrophones
USB microphones
Webcams
Device line-in connected to a soundmixer

You cannot change the audio device selection once a recording is started.

Select an Audio Device
1. Connect your audio device to the computer before launching Camtasia Relay.
2. Click theAudio Device button.

The Select Audio Device dialog opens.

The Select Audio Device dialog shows the levels of all audio devices connected to the
computer.

3. Click your audio device to select it.

4. Click OK to close the dialog.

Record System Audio
To record the audio that plays on your system (the audio that you hear played back by your computer):
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1. Click theAudio Device button.

The Select Audio Device dialog opens.

2. Enable the Record System Audio checkbox. (This option is enabled by default.)

The option to record system audio is not available for users of theMicrosoft Windows
XP operating system.

See also

Auto Adjust Audio Level
Audio Tips
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Auto Adjust Audio Level
If the audio levels are too high when recording, the quality of your processed presentation is poor. Pre-
sentations recorded with poor audio also have a low level of accuracy in captions and full audio search (when
transcription is provided by the profile).

By default, Camtasia Relay automatically adjusts the input level of the selected audio device to provide the
best possible audio for your presentation. As the volume of the audio changes, the slider moves automatically
to adjust the level of the recorded audio.

There are some cases when youmay want to disable the auto adjust option:

You use a soundmixer to combine and control the levels of multiple devices into a single audio input.
You want moremanual control of your audio input levels.

To disable the auto adjust feature, click theAuto Adjust button.

See also

Audio Devices
Audio Tips
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Audio Tips
Use the following tips to help you get the best audio in your presentation.

Verify you are recording the correct audio input.
Make sure you click theAudio Device button, view all available devices while speaking into
your microphone, and click the device based on the input levels. The names of devices can be
deceiving and viewing the levels of all the connected devices helps you choose the correct
device.
Make a test recording. Speak in your presentation voice and volume.
If you are using an external microphone, move away from the computer and speak to ensure
you record the external microphone and not a potential built-in microphone on the computer.
Use theWindows Control Panel to verify desired audio input devices are enabled and working
properly.

Use auto adjust or manually adjust the input level.
If the audio levels are too high and “clip” when recording, the quality of your processed presentation is
poor. Presentations recorded with poor audio also have a low level of accuracy in captions and full
audio search (when transcription is provided by the profile.)

If you are not using the option to automatically adjust the audio input levels, make sure to adjust the
audio level appropriately. Speak in your presentation voice and adjust the audio input slider so the indi-
cator peaks near the end of the green bars and is not consistently showing red bars. You can adjust the
audio input level before and after you start recording.
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If you see the followingmessage, enable the auto adjust option or move the audio slider
to the left to decrease the input level.

Obtain a good external microphone.

Some computers have decent built-in microphones. Some do not. It might be worth investing in a USB
or line-in microphone.

Verify audio inputs are enabled.

Click Start > Control Panel > Sound (Sound and Audio Devices on theMicrosoft Windows XP oper-
ating system). Verify that audio inputs are enabled.

If necessary, use a powered audio input.

Some laptops do not have powered audio input ports. This means you need to use a poweredmicro-
phone or a USB microphone.

Make a test recording to check system audio levels.

If you plan on recording system audio with your presentation, check tomake sure it is recording at an
appropriate volume level. For instance, if you plan on playingmusic during your presentation, play that
music during your test recording. The volume level of system audio is recorded before volume adjust-
ments from your laptop or the presentation room's audio system affect the signal, so the volume heard
from your speakers or the room's sound systemmay not match the volume of the system audio in the
recording.

If you lose audio during a presentation, a notification appears on screen

If the batteries in your microphone die, or themicrophone becomes unplugged, a warning notification
will appear to let you know that the Camtasia Relay recorder is no longer recording audio.

See also

Audio Devices
Auto Adjust Audio Level
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More Than One Display
Camtasia Relay records one entire display. If your computer has multiple monitors or is connected to a
projector, you need to specify which display to record.

Camtasia Relay displays a small window on the display not selected for recording. You can
leave this up to help show how long you’ve been recording, or if you prefer, minimize it to the
taskbar.

To select a display:

1. Click in theRecording Preview.

Depending on whether you have previously selected a display, you will see either a
message to select a display or the currently selected display.

2. When you see the display selector, click the display you want to record.

As you hover over a display in the selector, there is a red outline shown on the actual
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display to help you identify the different displays.

If you click the Test button or the Record button prior to selecting a display to record, you are
prompted tomake a selection before recording starts.

When using PowerPoint with multiple monitors or a projector, make a test recording while run-
ning the presentation as a slide show to verify you record the correct screen. PowerPoint set-
tingmay affect which display slide shows display on.
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Record with a Camera
Before recording, select a camera to record with your presentation. The camera video appears in the lower
right corner of your produced presentation. During your presentation, the camera is not displayed on your
screen.

Currently, there are no options to change the position or size of the picture-in-picture camera video.

Camera video is only included in profiles that use encode settings for Adobe Flash or Microsoft
Silverlight formats.

Camtasia Relay only supports recording video from webcam-type cameras. It does not sup-
port DV camera input.

Select a Camera
To select a camera to record with your presentations:

1. Click theCamera button in the recorder toolbar.



www.techsmith.com - 38 -

2. The camera selection window appears. Select from available cameras to record that camera video with
your presentation. Select "Do not record camera" to turn off camera video recording.

If another application is using the camera, Camtasia Relay may be unable to record the cam-
era during a presentation.
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Record When Not Online
You do not have to be connected to the Internet to record your presentation. If you are not connected to the
Camtasia Relay server, the server icon at the bottom of the recorder has a red X.

If you have previously logged in to Camtasia Relay, you can still login if you are offline. You
can still access your profiles once you log in.

1. Record your presentation as normal.
2. Click theSubmit button when finished.
3. The presentation is submitted for uploading. Because you are not connected to the Internet, the pre-

sentation becomes “queued” for upload. The presentation starts to upload automatically when the com-
puter next connects to the Internet.

Presentations only upload when you are connected to the server. After you click Sub-
mit, you do not see any information when your presentation is uploading. If you’d like to
check the status of your presentation, seeCheck the Status of a Presentation.

4. Depending on the profile, youmay receive notification when the presentation is published.
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Available Disk Space
While recording, at the bottom of Camtasia Relay is a disk spacemonitor. This monitor shows how much disk
space is available to record.

If you are running the Camtasia Relay portable recorder, Camtasia Relay first records to a tem-
porary location on the computer before saving the presentation to themobile storage device.
Themonitor shows either the space available on themobile storage device or the space avail-
able on the computer, whichever has less space.

If you run out of space during a recording, the recording is paused. You canmakemore room on the computer
by removing other files.

To avoid interrupting you during a presentation, you are not notified when a recording is paused
due to low disk space.
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After Recording
After you finish recording, the presentation is finalized and opens in the Camtasia Relay Review window.
Here, you can do the following:

Preview and Submit the Presentation
Trim the Presentation

See also

What Happens After I Submit a Presentation
Check the Status of a Presentation
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Preview and Submit the Presentation
After you finish recording your presentation, it opens in the Camtasia Relay Review window.

1. Preview your presentation.
2. If you did not do so prior to recording, log in, select a profile, and enter a title and description.
3. If you need to, trim the beginning and end of the presentation.



www.techsmith.com - 43 -

See also

Trim the Presentation
What Happens After I Submit a Presentation
Check the Status of a Presentation
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Trim the Presentation
With Camtasia Relay, you can edit your presentation to remove extra video at the beginning or end. Trim your
presentation to remove any extra audio and video you do not want in your published presentation.

To trim a presentation:

1. After you finish recording, click Trimming to access the trimming tools.

2. Move the playhead to the location you want to set as the beginning of the presentation and click theSet
presentation start button.

3. Move the playhead to the location you want to set as the end of the presentation and click theSet pre-
sentation end button.

The red area of the timeline is cut from the presentation. Once you submit or save the recording, you
permanently lose this part of the recording.

If you want to remove the trim points, click Cancel trim (the red X button.) This removes
the trim points and closes the trimming tools.

See also

Preview and Submit the Presentation
What Happens After I Submit a Presentation
Check the Status of a Presentation
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What Happens After I Submit a Pre-
sentation
After you click Submit, your presentation is readied for upload to the server.

If you are connected to the Internet, the presentation starts uploading to the Camtasia Relay server.
You receive an email when your presentation is published.
If you are not connected to the Internet, the recording automatically starts uploading when you connect
to the Internet. You do not receive notice when your presentation begins uploading.

You canCheck the Status of Your Presentation on the Camtasia Relay website. You also receive an email
when your presentation is produced and published.

After you submit your presentation, you cannot access or view your presentation or the status
of the upload in the Camtasia Relay recorder.

If you lose or close your connection while the presentation is uploading, the process is paused
and continues when the computer next connects to the Internet.

See also

Preview and Submit the Presentation
Trim the Presentation
Check the Status of a Presentation
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Check the Status of a Presentation
There are a couple of ways to learn the status of your presentation.

Wait for an email notification indicating the presentation is published or the presentation needs atten-
tion.
Log in to the Camtasia Relay website.

Check the Status of a Presentation
1. Go to the Camtasia Relay website.

If you do not know the URL (web address) of your Camtasia Relay server, launch the Camtasia Relay
recorder and click the server URL at the bottom of the application. Youmust be connected to the Inter-
net to access the website.

2. Log in to theCamtasia Relay website using your presenter username and password.

3. Click thePresentationsmenu.

Here you can view your presentation status and take action if needed.

See also

Preview and Submit the Presentation
Trim the Presentation
What Happens After I Submit a Presentation



www.techsmith.com - 47 -

Camtasia Relay Portable Recorder
Run the Camtasia Relay portable recorder from amobile storage device if there is any reason you cannot (or
should not) record and upload directly from the presentation computer.

Examples of When to Use the Portable Recorder
You need to record on a computer where you do not have permission to install applications.
You need to record on a computer with limited or no network access.
You want to record several presentations and upload them collectively at a later time.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

See also

Download the Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder



www.techsmith.com - 48 -

Download the Portable Recorder
If you need a portable version of Camtasia Relay, use the following process to install the portable recorder on
amobile storage device, such as a USB flash drive.

1. Log in to theCamtasia Relay website.
2. Click Recorder Download.
3. Plug in amobile storage device and format the device as FAT32.
4. If available, click Download Portable Recorder and save the .zip file to your computer.

Youmay have to request the portable recorder. Click the button to send a request to your administrator.

5. Locate and open PortableCamtasiaRelay.zip.
6. Copy all files from the .zip file onto themobile storage device. All files from the .zip folder need to be

copied to the root of the device.

Depending on your organization, the portable recorder may or may not be available. Contact
your administrator for more information.

See also

Camtasia Relay Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder
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Run the Portable Recorder
Depending on the operating system and security settings of a computer, you can start the portable recorder in
one of the following ways.

Windows Operating System with AutoPlay Enabled
Under certain conditions, when you connect amobile storage device that contains the portable recorder with a
computer, you are presented with the option to immediately start the application.

Click Start Camtasia Relay to run the portable recorder.

Windows Operating System with AutoPlay Disabled
If AutoPlay is disabled, to run the recorder:

1. OpenWindows Explorer (Right-click Start and select Explore.)
2. Navigate to themobile storage device.
3. Double-click PC Relay Recorder.exe.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Log In to the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder



www.techsmith.com - 50 -

Log In to the Portable Recorder
There are some considerations to keep inmind when you attempt to log in to the Camtasia Relay portable
recorder.

To log in on the portable recorder, youmust first run the portable recorder on a computer that can con-
nect to the Camtasia Relay server.

To do this, connect themobile storage device to a computer with the "regular" Camtasia Relay
recorder installed on it. Open the portable recorder and log in. This saves your presenter information on
the portable recorder and allows you to access your profiles when you are not connected to the server.

If you run the portable recorder without previously logging in while connected to the server, you are not
able to log in. Identify yourself as a guest to use the Upload and Decide Later profile.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
Record with the Portable Recorder
Upload Presentations from the Portable Recorder
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Record with the Portable Recorder
Youmay notice a few differences when running Camtasia Relay from amobile storage device, but generally,
the process of recording is the same. SeeRecord a Presentation for more information.

Differences when Recording with Portable Recorder

Click theView Presentations button to see and upload the presentations saved to the
mobile storage device.

In most cases, you will not be connected to the server. When you see this icon , you are not con-
nected to the server.
After you finish recording, youmust save your file to themobile storage device running the Camtasia
Relay portable recorder. You cannot submit it for upload from the computer you are using.
Youmay not be able to log in. See Log In to the Portable Recorder for more information.
When you finish your recording, click Save to save the presentation to themobile storage device.
If you are running the portable recorder on a computer with Camtasia Relay installed, you can choose
to save your presentation or submit it for upload to the server.
To upload saved presentations, connect themobile storage device to a computer with Camtasia Relay
installed on it. You can thenUpload Presentations from the Portable Recorder.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
Log In to the Portable Recorder
Upload Presentations from the Portable Recorder
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Upload Presentations from the Portable
Recorder
To upload saved presentations from amobile storage device, youmust connect themobile storage device to a
computer with Camtasia Relay recorder installed on it.

You can submit saved presentations at any time. If you are not connected to the Internet, the
presentations upload to the server when your computer is next connected.

To submit saved presentations for upload:

1. Click theView Saved Presentations button.

2. The Saved Presentations dialog opens.
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3. Click Submit All to submit all of the presentations for upload or click to submit individual pre-
sentations.

If you are online and connected to the server, your presentation starts to upload.
If you are offline, your presentation is stored on the computer and automatically uploaded to the
server once you are online and connected.

After you upload saved presentations, you cannot access or view your presentation or the
status of the upload in the Camtasia Relay recorder.

You canCheck the Status of a Presentation on the Camtasia Relay website. You also receive an email
when your presentation is produced and published.

See also

Camtasia Relay Portable Recorder
Download the Portable Recorder
Run the Portable Recorder
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Log In to the Portable Recorder
Record with the Portable Recorder
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Update Camtasia Relay
When a new version of the Camtasia Relay recorder is available, an update notification appears in the upper
right of the recorder window.

Update the Recorder
1. Click theUpdate button. (This button only appears when an update for Camtasia Relay recorder is

available.)

2. Click Get update. The Camtasia Relay website is launched in your default browser.
3. Log in to the Camtasia Relay website.
4. The Camtasia Relay Recorder Download page appears. Download the correct recorder for your oper-

ating system.
5. Run the downloaded recorder installer.
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The Camtasia Relay Website
There are two parts to Camtasia Relay--the recorder, which runs on your computer, and the server, which proc-
esses and publishes all presentations. The way that presenters can interact with the server is through the
Camtasia Relay website. The website is specific to and run by your organization.

Presenters use the same username and password to log in to both the recorder and the website.

Go to the website to:

Check on presentations
Learn about your profiles
Specify publish destinations (available only for some profiles)
Enter account information that may be required for some of your publish destinations

If you do not know the URL (web address) of your Camtasia Relay server, you can launch the Camtasia
Relay recorder and click the server icon at the top right of the application. Youmust be connected to the Inter-
net to access the website.
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FAQs
Have a question about Camtasia Relay? The following questions and answers might help.

What is Camtasia Relay?
How do I know that Camtasia Relay is recording?
Can I edit my recording?
Are there things I should do before I start recording?
I’m not currently online. Do I wait to submit my recording?
What is the portable recorder?Why can’t I find it to download?
Where can I findmore help?

What is Camtasia Relay?
Camtasia Relay lets you easily create a video and audio account of your lecture, presentation, or meeting. It
captures all on-screen activity and audio on computers running on bothWindows andMac operating systems.

How do I know that Camtasia Relay is recording?
There are a couple of visual signals to help you know that Camtasia Relay is recording:

Can I edit my recording?
The Camtasia Relay recorder supports only trimming the beginning and end of your presentation. See Trim
the Presentation for more information.

If you are interested in more serious editing capabilities, Camtasia Relay can produce files for editing in Cam-
tasia Studio and Camtasia for Mac. This requires access to Camtasia software and profiles to produce these
files to be set up by the administrator. Please contact your administrator to find out if this is available in your
organization.

You can findmore information about Camtasia Studio and how it works with Camtasia Relay on the Tech-
Smith website.

Are there things I should do before I start recording?
Camtasia Relay records everything on your screen and all audio picked up on your selectedmicro-
phone. To avoid interruptions during the presentations, youmay want to shut down other programs,

http://www.techsmith.com/camtasia
http://www.techsmith.com/camtasia
http://www.techsmith.com/
http://www.techsmith.com/
http://www.techsmith.com/
http://www.techsmith.com/
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such as email, calendar reminders, instant messaging application, etc.
You should do a test recording to verify Camtasia Relay is recording what you think it is recording and
that your audio levels are appropriate. SeeMake a Test Recording for more information.
Make sure you have enough disk space for recording. Check yourAvailable Disk Space and remove
any unnecessary files from your computer or portable storage device.

I’m not currently online. Do I wait to submit my recording?
No, you do not need to wait. After you finish recording, you should submit the presentation, whether you are
online or not. When you submit, the presentation is “readied” for upload. If you are not online, the presentation
is saved to your computer and automatically starts uploading the next time your computer is online. It uploads
“behind the scenes” and you will not see any visible cues on your computer. You canCheck the Status of a
Presentation on the Camtasia Relay website.

What is the portable recorder? Why can’t I find it to download?
The Camtasia Relay portable recorder is an optional component andmay not be available in your organization.
You should contact your administrator for additional information.

Where can I find more help?
For general Camtasia Relay resources from TechSmith, themakers of Camtasia Relay, seeNeed
More Help?
Please contact your administrator for organization-specific information such as the final location of
your presentations, login or password issues, microphone issues, etc.



www.techsmith.com - 59 -

Need More Help?
In addition to the in-product help files, there are several different ways to get help for using Camtasia Relay.

Camtasia Relay Learning Center

If you're looking for answers to How to…? or How do I…? questions, you can find themost up to date
tutorials and product information in the Camtasia Relay section of the TechSmith.com Learning
Center.

TechSmith Support Center

Having a technical issue? In the TechSmith Support Center you can search for answers to technical
issues and contact support.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.3.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
http://www.techsmith.com/redirect.asp?target=rightnow&product=relay&ver=4.3.0&lang=enu
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Introduction
Camtasia Relay provides an excellent way to capture lectures and presentations. It was designed to be easy
to use, easy to administer, and easy on the budget. To implement Camtasia Relay successfully, it is helpful
to understand the architecture of the product and ways tomake it as effective as possible.

This Document
The purpose of this document is to provide amore in-depth examination of Camtasia Relay, including the
overall architecture, planning information, sizing and performance considerations, security principles, tips on
integrating Camtasia Relay with other products, and general best practices.

Use this guide as a reference, as a how-tomanual, and as a resource to help you successfully implement
lecture capture.

The Camtasia Relay team plans to update this document as needed. You can always access the latest PDF
on the Camtasia Relay documentation page :

http://www.-
techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA

Additional information about Camtasia Relay can be found at these locations:

For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website Help. This
help is available after logging into the Camtasia Relay website as an administrator or as a PDF online.
For help with the Camtasia Relay recorder, please see help in the recorder or visit the tutorials on the
TechSmith website.
For installation and upgrade information and documentation, see the Camtasia Relay documentation
page in the support section of the TechSmith website.
For technical support, please refer to the section TechSmith Tech Support.
For sales information or to request a trial, please contact Sales at http://www.-
techsmith.com/company/contact/salescontact.asp

Feedback
If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia Relay
documentation, please send an email to relayhelp@techsmith.com.

Camtasia Relay Overview
With Camtasia Relay, you can capture and publish your lecture or presentation anytime, anywhere -- in the
classroom, in the conference room, at your desk, or at home. Camtasia Relay supports a wide variety of video
formats allowing any lecture or presentation to be viewed by your audience onmultiple playback devices
including portable media devices such as the Apple iPod and via iTunes U.

Camtasia Relay processing involves two different computers --the recorder, which runs on a presenter’s
computer (or mobile device using TechSmith Fuse® for Camtasia Relay), and the server which processes
and publishes all presentations.

The presenter presses theRecord button on a PC, Mac, or mobile device and gives a presentation. When
done, the presenter presses Stop to end the recording, optionally trims the beginning and end of the recording,
and then presses Submit to upload the recorded presentation to the Camtasia Relay server. At this point, the
presenter is done with their part of the process.

http://www.techsmith.com/redirect.asp?target=learningcenter&amp;product=relay&amp;ver=4.1.0&amp;lang=enu&amp;os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&amp;product=relay&amp;ver=4.1.0&amp;lang=enu&amp;os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&amp;product=relay&amp;ver=4.1.0&amp;lang=enu&amp;os=NA
http://www.techsmith.com/company/contact/salescontact.asp
http://www.techsmith.com/company/contact/salescontact.asp
http://www.techsmith.com/company/contact/salescontact.asp
mailto:relayhelp@techsmith.com
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At the server, submitted recordings arrive from different presenters. Each is processed according to a
selected profile. The profile determines how the presentation is encoded for playback. A profile could, for
example, indicate that a presentation is to be encoded for playback on the web, on an iPod, or various other
locations.

Once a presentation is encoded, it is published according to what was specified in the profile. Once published,
the process is complete and the presentation is ready for viewing.

System Architecture
Themain components of the Camtasia Relay system are the server, which can run on a server or multiple
servers, and the recorders, which run on the presenter’s computer, from a portable media device, or amobile
device. They are available on theMicrosoft Windows andMac desktop operating systems and iOS and
Android mobile operating systems.

The Camtasia Relay server has multiple functions including acting as awebsite, a transcoding server, and
a publishing agent. The Camtasia Relay server does not host themedia it produces but can push it out to
various destinations including (but not limited to ) iTunes U, Screencast.com, YouTube, FTP/sFTP
destinations, Windows File Shares, andWebDAV enabled destinations.

The following diagram relates the basic architecture of the Camtasia Relay system. It shows both themain
components described above and the supporting components of Camtasia Relay.
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Planning, Installation, and Initial Con-
figuration
Before installing your Camtasia Relay server, consider the following planning, installation, and initial
configuration steps.

Site Planning
Installation
Set Up a Testing / Practice Server
Activate / Deactivate Camtasia Relay Server
Post-Install Configuration
Roll Out Camtasia Relay to Presenters

Site Planning
When planning for installation, the following diagrams can help give you an idea of the setup of the Camtasia
Relay system for a few different environments.
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If the SQL Server, LDAP server, and file system servers are in a publicly accessible network, then the
connection to these servers should be encrypted using SSL or IPSec.

Camtasia Relay Server should be deployed in a demilitarized zone (DMZ) in your network and this DMZ
should be physically or logically segmented from the internal network by a stateful packet inspection (SPI)
firewall or other network security device. The point-to-point communication between any Camtasia Relay
Servers and the remote SQL / LDAP (andmaybe file system) server should not be across any public network.
The remote server should be placed in amore secure portion of your network than the DMZ and should not be
publicly accessible, if possible.

Installation
The installation of Camtasia Relay is important enough to have its own document. A link to the Installation
guide and other resources can be found in theAppendix A: Additional Help and Related Documentation.

Set Up a Testing / Practice Server
When you purchase Camtasia Relay, your activation code allows you to have one separate server you can
use for testing. The following procedure describes how to create a test server and populate it with current data
from your production server.

Before beginning, you should have SQL Server Management Studio installed on both servers.

On the Current Production Server

1. Log in to the Camtasia Relay website as an administrator.
2. Go System > Activation and write down your license key. You will use this same license key on the

test server.
3. Back up the Camtasia Relay database.
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For more instructions on how to back up the Camtasia Relay database, please refer to sectionBack
Up the Camtasia Relay Database.

4. Copy the backup file to the new test server.
5. Copy the contents of themedia directory from the production server to the test server.

Themedia directory on the new server must be the same as the old server.

On the New Test Server

1. Install Camtasia Relay on the test server. Make sure to set themedia directory the same as what it is
on the production server.

2. Go to System > Activation and enter your license key.
3. Stop the Relay Manager Service and IIS.
4. To stop the Relay Manager Service, open a command prompt and type:

net stop "Relay Manager Service"

5. To stop IIS, type:

iisreset /stop

6. Restore the Relay database.

For more instructions on how to restore the Camtasia Relay database please refer to the section
Restore the Camtasia Relay Database.

7. In the Object Explorer pane of SQL Server Management Studio, go to Relay Database Instance >Dat-
abases > Relay > Security > Users.

8. Right-click the relay user and select Delete.
9. In the Object Explorer pane, go to Relay Database Instance > Security > Logins.
10. Right-click the relay user and select Properties.
11. In the Login Properties window, select the User Mapping page.
12. Assign the relay user within SQL Server to theRelay user inside of the Relay database.

The user must have db_datawriter, db_datareader, and sql_dependency_subscriber
permissions.
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13. Assign the proper roles to theRelayCache user within SQL Server.

The user must have sql_dependency_starter permissions.
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14. In the Object Explorer pane, go to Relay Database Instance>Databases > Relay > Tables.
15. Right-click dbo.tblEndpoint and select Open table.
16. The data from the table is shown in the right pane. Update the edptUrl field to be the proper URL of the

new server.

This is the sameURL that you entered into the installer for their SSL certificate, but here you need the
full URL. For example, if you used relay.example.com, here you need to enter:
https://relay.example.com/relay/rest.ashx.

17. Click off the row or press the down arrow key to confirm and save the change.
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18. To restart the Relay Manager Service, in the command prompt, type:

net start "Relay Manager Service"

19. To restart IIS, type:

iisreset /start

20. Log into the website as an administrator and go to System > Servers.
21. If needed, select the server and click Bring Server Online.

Activate / Deactivate Camtasia Relay Server
Activate Camtasia Relay server to remove the trial period and activate the correct number of encoding
processors. It is important to deactivate Camtasia Relay server before you uninstall the server so you can
install Camtasia Relay on a different server.

To communicate with the activation server through a firewall, port 80must be open. Please
refer to the Firewall Rules section of theCamtasia Relay Server Security Administration
Guide referenced inAppendix A: Additional Help and Related Documentation.

Activate the Camtasia Relay Server
1. Click System > Activation.
2. Enter your License code and click Activate.

Obtaining More Activations

If you find that you need additional activations for your server, please contact a sales associate; we will walk
you through the process of updating your license.

Please refer to TechSmith Sales Support.
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Offline Activation / Deactivation
If Camtasia Relay is installed on a private network, offline activation/deactivation allows you to deactivate
without connecting to the Internet.

To activate when offline:

1. Log in to the Camtasia Relay website as an admin and go to System > Activation.
2. Click Offline Activation.
3. A window opens and contains an Installation ID number.
4. Contact a TechSmith sales associate.

Please refer to section TechSmith Sales Support.

5. Provide the Installation ID and License code to the sales associate. The sales associate gives you an
Unlock Code.

Your license code was emailed in the Camtasia Relay purchase receipt.

6. Enter the code into the field provided. Camtasia Relay is now activated.

To deactivate when offline:

1. Log in to the Camtasia Relay website as an admin and go to System > Activation.
2. Click Offline Activation.
3. A window opens. Click Deactivate to deactivate the server.
4. The window closes and you return to page. The server is now shown in an Expired state.
5. Contact a TechSmith sales associate.

Please refer to section TechSmith Sales Support.

6. Provide the Proof of Removal code and the Installation ID to the sales associate. This will decrement
the number of activations on your license code in the event that you want to activate a different server.

Problems with Activation / Deactivation
In the event of hardware failure or problems, please contact TechSmith Tech Support.

Please refer to section TechSmith Sales Support.

Please be ready with your Installation ID, License code (orProof of removal code in the case of deactivation).
Your license code was emailed in the Camtasia Relay purchase receipt.

Post-Install Configuration
When the install completes, log in to the Camtasia Relay website with the relayadmin account. You now need
to configure the server.

Email Server Configuration
When you first log in, you are directed to a page to configure the email server. Camtasia Relay uses the email
server to notify designated Camtasia Relay Administrators of server and presentation problems. Camtasia
Relay also emails presenters when their presentations are published.
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If you do not know the email server address, you can skip this step and enter it after Camtasia
Relay is completely installed. (System > Email Server Configuration).

The configuration includes:

The SMTP email server address. (Required)
The SMTP email server port.
The email address that shows in theReply To field of email notifications.
The email address of the Relay Administrator user. This email address receives notifications from the
server when action is needed from an administrator. (Required)

If you change the email address in theRelay Admin user email field, the email address
associated with the Relay Administrator user will also be changed. Likewise, if you edit the
email address of the Relay Administrator on the Users page, this email address will also
change.

Configuration Steps
Next, you will see the Server Dashboard page. This page shows themajor steps to configure Camtasia
Relay. Full configuration instructions are provided in the Camtasia Relay AdministratorWebsite Help, which
can also be downloaded as a PDF. For more information on how to access this help file, seeAppendix A:
Additional Help and Related Documentation.

Roll Out Camtasia Relay to Presenters
The best way to cut down on administration time with Camtasia Relay is to help the presenters learn how to
help themselves. One good way to do this is to have a good plan of how to introduce them to Camtasia Relay.

Here’s a checklist of suggested steps when introducing Camtasia Relay to presenters.

Verify all presenters have valid profiles associated with their accounts.
Youmight wish to roll out Camtasia Relay in stages. For example, start with one department instead of
the whole company or campus.
What training will presenters require? You can direct presenters to the overview video launched from
the helpmenu of the recorder and the videos located in the Help section of the Camtasia Relay web-
site. (Administrators see a different help page.)
Decide if you will install the Camtasia Relay recorder on user computers or if you will direct users to
obtain and install the recorder on their own. The recorder has the Camtasia Relay server URL “baked-
in” based on the server from which it was downloaded. If you put a copy of the Camtasia Relay
recorder on a website or network drivemake sure you got it from the server you want people to use.
Establish a clear policy for how presenters should do things like request new profiles or profile changes
or request a new password.
Prepare an introduction email for presenters. We have created a few samples you canmodify. You can
find these samples by logging in to the Camtasia Relay website as an administrator, click Help to open
the Help File, and search for “sample email”.
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What Presenters Need to Know Most
You need to communicate the following to presenters. You can use this information in an email introducing
Camtasia Relay to your presenters.

There are helpful videos

Get presenters to watch the overview accessible from the login screen of the recorder and in the Help section
on the Camtasia Relay website. Youmay want to send presenters directly to the video at the following URL
so they can review Camtasia Relay before accessing the Recorder or having to sign in to the Camtasia Relay
website:

http://www.techsmith.com/redirect.asp?product=relay&ver=4.1.0&lang=enu&target=getting-started-
recorder

Make a test recording

There is a blue TEST button in the Camtasia Relay recorder presenters can use to verify that they are
recording the correct screen and that the audio is recording properly.

How uploading works

As soon as the presenter clicks theSubmit button in the recorder, Camtasia Relay prepares the recording for
uploading in the background.

There is no visual indication of the progress of the upload to the submitter.
If the recorder is offline (or loses Internet access), the recording automatically uploads (or resumes
uploading) as soon as the computer gains Internet access.
Presenters receive an email when the presentation is published.
Presenters can check the upload, encoding and publishing progress if they log in to the Camtasia
Relay website.

http://www.techsmith.com/redirect.asp?product=relay&amp;ver=4.1.0&amp;lang=enu&amp;target=getting-started-recorder.
http://www.techsmith.com/redirect.asp?product=relay&amp;ver=4.1.0&amp;lang=enu&amp;target=getting-started-recorder.
http://www.techsmith.com/redirect.asp?product=relay&amp;ver=4.1.0&amp;lang=enu&amp;target=getting-started-recorder.
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Profiles
All presenters must select a Profile before they can upload their presentations to the server. Profiles
determine record quality, encoding formats and publish destinations. Only Camtasia Relay Administrators
can create andmodify profiles.

Good Profile Naming

Before naming profiles, remember that presenters choose which profile to use by title only. You will want to
consider carefully how you will name profiles. The profile title is the only thing presenters can see in the
recorder. The profile description is only visible on the website.

Good example names: CHM-141, BIO-101, Quarterly reports, Personal Recordings
Not-so-good example names: MP4 output, John Presenter, 10142

The Sample Profile
Upon completing a new install of Camtasia Relay, a new sample profile called "Sample Profile" is created.
The sample profile produces one flash output published to Screencast.com, using the default account
specified on the Profiles > Publish Account Setup page.

The profile's description explains its usage:

This sample profile publishes to Screencast.com using the default account. You canmake it func-
tional, use it for reference purposes, or delete it.
Tomake it functional: verify the Notification Email Server configuration is correct and associate a pre-
senter user to this profile. Before the presentation can publish, you need to provide valid Screen-
cast.com account credentials.

If the sample profile is tested before the administrator has supplied credentials for the default Screencast.com
account, an error is displayed saying "The profile is missing account information."

To remedy this, go to the Profiles > Publish Account Setup and enter credentials for a default Screencast.com
account. Save and try testing the sample profile again.

The Upload and Decide Later Profile
The Camtasia Relay recorder comes with an Upload and Decide Later Profile. This profile sends the recording
to the Camtasia Relay server, but the recording is not processed in any way. It stays in theNeeds Attention
state on the server until an authorized presenter or Camtasia Relay administrator assigns a different profile
and submits the recording for publishing via the Camtasia Relay website.

The Upload and Decide Later profile is primarily used by guest presenters and authorized presenters who do
not know their password.

Why Use the Upload and Decide Later Profile?

For guest presenters, it is the only profile available.
Youmake a presentation in advance, but do not want it published until later.
You are not satisfied with existing profile options and wish to hold the recording on the server until you
can contact your Camtasia Relay administrator to create or modify a profile.
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For additional information on setting up profiles, please log into the Camtasia Relay website as an
administrator and click Help.

The Profile Test
TheProfile Test is enabled for a profile when the profile is valid (i.e., the profile has no red-coded items).

When you click the Test Profile button, a sample presentation is created and processed for a built-in sample
video. Any credentials and profile variables needed by profile are based on the specified Test Presenter.

If any credentials or variables cannot be resolved based on the specified user, the presentation fails and an
error message is displayed.

The test presentation is prepared like regularly uploaded presentations. This includes the creation of encoding,
transcription (if selected in the profile), publishing, and notification (if selected on the Profile Test page) jobs.

These jobs can bemonitored from the Presentations page. The Profile Test page is automatically redirected to
the Presentations page after the test presentation successfully begins.
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Search in Flash and Silverlight Encodings
In the Flash and Silverlight encodings, the players include a Table of Contents based from slide titles and a
Search field.

The table of contents is available when the presentation is recorded from a PowerPoint or Keynote slide show.

Viewers can enter search terms that check through the following:

Presentation audio

If the profile used to process the recording was enabled to use the Transcribe presentation audio for full
audio search option, a full transcription of the presentation audio is included in the searchable text.

Text

The presentationmust be playing (in slide show mode) in order for slide content to be captured. The
following text is captured from a slide show:

Keynote ’08 and ‘09
Slide title
Slide body which includes text such as in paragraphs, text boxes, and bulleted lists.
Presenter notes

PowerPoint 2004, 2008, and 2011 (Mac)
Slide title
Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art,
and table data.
SmartArt shapes and chart data are not captured.
Alternate text for images is not captured.
Presenter notes

There is a known issue in PowerPoint 2004 (Mac) in that Camtasia Relay
Recorder can only capture the first 255 characters of each shape on a
slide

PowerPoint 2003, 2007, and 2010 (Windows)
Slide title
Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art,
table data, and alternate text for images.
Some SmartArt and chart data can be captured (2007 and later only).
Text which is not visible on the screen is not captured.
Presenter notes

In general, skipped or hidden slides are not captured.

The Camtasia Relay XML File
Camtasia Relay provides XML files with the encodings for published presentations. The XML data contains
information about the encoding such as the title, length, format, resolution, andmore.
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Uses

Customers may use the XML file with existingmedia-hosting solutions, content delivery methods such as
RSS feeders, etc. TechSmith provides the XML data as a service, but does not support how the institution
uses the XML file.

Information Included in the XML File
Presentation information: title, description, date, duration, and resolution
Profile used to create presentation
Presenter name
Client (computer used tomake the recording) IP address, and computer name
Server namewhere recording was processed
Encoding preset used
Length of time the presentation was in the queue for processing
Length of time it took to encode the presentation
Destination URL of published presentation
Total duration of the presentation before trimming inmilliseconds
Duration of the presentation after trimming was applied in milliseconds.
Time of the start trim point in milliseconds.
Time of the end trim point in milliseconds.
The time inmilliseconds and text of the table of contents entries.
The time inmilliseconds and text of the body text of all slides captured.
The time inmilliseconds, duration in milliseconds, probability, and word for all the generated speech to
text for full audio search.
Transcribed presentation audio or captions

If the profile used to process the recording was enabled to use transcription option, a transcription of
the presentation audio or the captions are included.

Slide show text

The presentationmust be playing (in slide show mode) in order for slide content to be captured. The
following text is captured from a slide show:

Keynote ’08 and ‘09
Slide title
Slide body which includes text such as in paragraphs, text boxes, and bulleted lists.
Presenter notes

PowerPoint 2004, 2008, and 2011 (Mac)
Slide title
Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art,
and table data.
SmartArt shapes and chart data are not captured.
Alternate text for images is not captured.
Presenter notes
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There is a known issue in PowerPoint 2004 (Mac) in that Camtasia Relay
Recorder can only capture the first 255 characters of each shape on a
slide.

PowerPoint 2003, 2007, and 2010 (Windows)
Slide title
Slide body which includes text such as in paragraphs, text boxes, bulleted lists, word art,
table data, and alternate text for images.
Some SmartArt and chart data can be captured (2007 and later only).
Text which is not visible on the screen is not captured.
Presenter notes

In general, skipped or hidden slides are not captured.

Considerations
Deprecated Items

The duration element of the sourceRecording element is deprecated and will be removed in
a future release.
The duration element of the encodeFiles element is deprecated and will be removed in a
future release.
The duration element of the outputFiles element is deprecated and will be removed in a
future release.

XML data is available for all encode types and all supported publish destinations with the following
exceptions:

XML is not included with presentations published to iTunes U.
XML data is parsed into fields (as opposed to a single XML file) for presentations published to
Screencast.com. Themetadata can be found under the Details section when viewing a pre-
sentation on Screencast.com.
Certain elements of the XML data are optional depending on the recording and the profile con-
figuration.
For instance, if PowerPoint or KeyNote presentations were not captured at record time, then
there will be no table of contents or screen text information.
Also, if the “Transcribe presentation audio for full audio search” option is turned off, then the pre-
sentation audio transcription will not be present in themetadata.
Flash and Silverlight encodings produce an XML file as well that will end with the text “_
xmp.xml” that should not be confused with themetadata .xml file.

Example Metadata XML File

The following is an example XML file.

<?xml version="1.0" encoding="utf-8"?>

<presentation relayVersion="2.0.0">
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<title>Sea Turtles</title>

<description>A very interesting and engaging presentation on sea

turtles.</description>

<date>6/28/2010 3:31:05 PM</date>

<profile>Biology 101</profile>

<destinationUrl>media.university.edu\bio101\Sea_Turtles_-_Flash_

(Medium)_-_20100628_03.32.49PM.swf</destinationUrl>

<totalDuration>60600</totalDuration>

<trimmedDuration>60600</trimmedDuration>

<startTrimTime>0</startTrimTime>

<endTrimTime>60600</endTrimTime>

<recordedBy>

<displayName>Jane Doe</displayName>

<email>j.doe@techsmith.com</email>

</recordedBy>

<presenter>

<displayName>Jane Doe</displayName>

<userName>j.doe</userName>

<email>j.doe@techsmith.com</email>

</presenter>

<clientInfo>

<clientIP>192.168.0.1</clientIP>

<clientComputerName>desktop101.techsmith.com</clientComputerName>

</clientInfo>

<serverInfo>
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rHost-

name>https:-

//relayserver.techsmith.com/relay/rest.ashx</serverHostname>

<encodingPreset>Flash (Medium)</encodingPreset>

<timeToEncode>46157</timeToEncode>

<timeInQueue>500</timeInQueue>

</serverInfo>

<sourceRecording>

<resolution>1600x1200</resolution>

<!--duration is deprecated and will be removed in a future

release.-->

<duration>60</duration>

<fileList>

<file clientPath="C:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\REC_197d189.avi"

serverPath="E:\Media\450\SourceFiles\8725.avi" size="22392320"

sequence="0" type="ScreenRecordingFile" duration="60600" />

<file clientPath="C:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\PPT_197d13b.xml"

serverPath="E:\Media\450\SourceFiles\8726.xml" size="1536"

sequence="0" type="TableOfContentsFile" duration="0" />

</fileList>

</sourceRecording>

<encodeFiles>

<!--duration is deprecated and will be removed in a future

release.-->

<duration>60</duration>

<fileList>

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.mp4"

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_
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(Medium)_-_20100628_03.32.49PM.mp4" size="1830977"

resolution="800x600" duration="60600" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_

03.32.49PM.html" serverPath="E:\Media\450\EncodeFiles\2515\Sea_

Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.html" size="10017"

/>

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

xmp.xml" serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_

Flash_(Medium)_-_20100628_03.32.49PM_xmp.xml" size="46954" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

thumb.jpg" serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_

Flash_(Medium)_-_20100628_03.32.49PM_thumb.jpg" size="64358" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

thumbnails.jpg" serverPath="E:\Media\450\EncodeFiles\2515\Sea_

Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumbnails.jpg"

size="14404" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.swf"

serverPath="E:\Media\450\EncodeFiles\2515\Sea_Turtles_-_Flash_

(Medium)_-_20100628_03.32.49PM.swf" size="457576" resolution="-1x-

1" duration="60600" />

</fileList>

</encodeFiles>

<outputFiles>

<!--duration is deprecated and will be removed in a future

release.-->

<duration>60</duration>

<fileList>

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.mp4"

destinationPath=" media.university.edu\bio101\Sea_Turtles_-_Flash_

(Medium)_-_20100628_03.32.49PM.mp4" size="1830977" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_

03.32.49PM.html" destinationPath="http://
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media.university.edu\bio101/Sea_Turtles_-_Flash_(Medium)_-_

20100628_03.32.49PM.html" size="10017" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

xmp.xml" destinationPath=" media.university.edu\bio101\Sea_Turtles_

-_Flash_(Medium)_-_20100628_03.32.49PM_xmp.xml" size="46954" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

thumb.jpg" destinationPath=" media.university.edu\bio101\Sea_

Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumb.jpg"

size="64358" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_

thumbnails.jpg" destinationPath="media.university.edu\bio101\Sea_

Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM_thumbnails.jpg"

size="14404" />

<file name="Sea_Turtles_-_Flash_(Medium)_-_20100628_03.32.49PM.swf"

destinationPath=" media.university.edu\bio101\Sea_Turtles_-_Flash_

(Medium)_-_20100628_03.32.49PM.swf" size="457576" />

</fileList>

</outputFiles>

<metaData type="TableOfContents">

<item startTime="300" text="Sea Turtles" />

<item startTime="16900" text="Green Sea Turtles" />

<item startTime="33900" text="Sea Turtles" />

<item startTime="39800" text="Long living" />

<item startTime="44600" text="Turtles in the wild" />

</metaData>

<metaData type="ScreenText">

<item startTime="300" text="Sea Turtles Green sea turtles are

reptiles whose ancestors evolved on land and returned to the sea to

live about 150 million years ago." />



Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 23 -

<item startTime="16900" text="Green Sea Turtles Green sea turtles

are reptiles whose ancestors evolved on land and returned to the

sea to live about 150 million years ago." />

<item startTime="33900" text="Sea Turtles Found in warm seas

worldwide" />

<item startTime="39800" text="Long living. Green sea turtles Are

reptiles whose ancestors evolved on land and Returned to the sea to

Live about 150 million years ago." />

<item startTime="44600" text="Turtles in the wild. Breeding Grounds

Food Supply Protected Areas" />

</metaData>

<metaData type="Speech">

<!—

Additional items removed for brevity

-->

<item startTime="12390" duration="370" probability="0.491"

text="sea" />

<item startTime="12760" duration="460" probability="0.617"

text="turtles" />

<item startTime="13220" duration="60" probability="0.223"

text="are" />

<item startTime="13280" duration="470" probability="0.548"

text="beautiful" />

<item startTime="13750" duration="720" probability="0.469"

text="creatures" />

<item startTime="14500" duration="140" probability="0.393"

text="that" />

<item startTime="14640" duration="70" probability="0.779"

text="are" />
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<item startTime="14710" duration="390" probability="0.347"

text="found" />

<item startTime="15100" duration="170" probability="0.340"

text="in" />

<item startTime="15270" duration="270" probability="0.587"

text="warm" />

<item startTime="15540" duration="650" probability="0.699"

text="seas" />

<item startTime="16190" duration="1200" probability="0.572"

text="." />

<!—

Additional items removed for brevity

-->

</metaData>

</presentation>
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Publish Destinations
Completed presentations should not be published (hosted) on the Camtasia Relay server. Instead,
Camtasia Relay can publish presentations tomany kinds of media servers including FTP servers, network
drives (file system), YouTube, iTunes U, WebDAV, and TechSmith’s media-hosting site, Screencast.com.

If the publish destination you would like to use is not available in the list of publish
destinations, youmay have to install the appropriate plug-in before you can use it. SeePlug-
Ins in the AdministratorWebsite Help for more information.

Camtasia Relay can publish presentations to one or more of the following locations.

File System (Network drives, etc)
FTP Server (FTP & sFTP)
Screencast.com (TechSmith’s media-hosting service)

Original Recording (Backup), Camtasia Studio Recording, and all the Real Media
encoding options will not be embedded on SC.com

WebDAV
Microsoft Windows SharePoint
YouTube
iTunes U (Camtasia Relay formats supported by iTunes U includeMP4 andMP3)
Mediasite
Drupal
Kaltura
Amazon S3

General Considerations
Camtasia Relay will attempt to create directories when using file system, FTP, sFTP, andWebDAV publish
destinations. If you are receivingmessages that you cannot create directories, make sure the user has
permission to create them (this is essential if you are going to use variables in your paths). If you do not want
users to have the ability to create folders, setup the folders ahead of time andmake sure the user has
permission to create files within those directories.

If you see Test Document.txt in your folders after setting up Relay, you can safely delete them. Relay will
attempt to delete them, but if the user that’s publishing doesn’t have permission wewill not be able to
successfully clean up after the test. You can give the user in question permission to delete files to prevent
these from sticking around in the future.

Currently, it’s a known issue that you cannot use spaces in URL fields when setting up
publishing destinations. Instead, use %20.

FTP Servers
Some things to keep inmind when using an FTP or sFTP publish destination:
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Ensure the host is specified as a fully qualified domain name the host name is pingable.
We recommend that when setting up the FTP / sFTP publishing destination that you provide the host
and only the host in the Host field.

You should specify the folder structure within the Path field. The Path field requires \ to be used. This is
intentional. When publishing, we use that as the separator and send change directory commands to the
ftp / sftp server. This way we can support windows and unix based ftp servers.

Theremay be cases where a domain is needed depending on how the FTP / sFTP server is setup. If
you are getting user permission or invalid user errors, try adding the domain.
Ensure the correct Protocol is selected (FTP vs sFTP).
Use an FTP client to log into the FTP server. Verify the specified Path is accessible and files can be
created there.
The URL entry for file system publishing and FTP publishing attempts tomap a URL to the destination
where themedia is published. If there are variables in the path, Camtasia Relay may not be able to
verify that themapping is correct. Make sure to use the Profile Test option to produce a test
presentation to verify that themapping works as expected. If there are no variables, Camtasia Relay
attempts to publish and retrieve a test file to the destination path. If this is unsuccessful, the
destination is marked as having an error.

It is possible to completely override the destination level URL at the account level.

File System
Some things to keep inmind when using a file system publish destination:

File System Publish Destinations without a specified URLwill limit content accessibility to only those
users who have direct access to the file system.
A Publish Destination URLwill allow users to access files on a limited access file system. Access will
be controlled by the hosting web server. Depending on the way the file system is hosted, users may be
able to see and access non-sequitor files (e.g., XML, thumbnails, etc.) in addition to the video files. An
IIS Virtual Directory can provide URL based access to files in a file system.
Not all encodings will be directly viewable in a browser accessed from a file system URL. Camtasia
Relay will generate HTMLwrappers for Flash and Silverlight videos making them viewable on those
user's computers having the respective players installed. The ability to view other files (mp4, swf, avi,
rmvb, wmv, etc.) will depend on what viewers are available on each user's computer.
In many cases, a share needs to specified using a fully qualified domain name. For example, instead of
using \\presentations, use \\presentations.yourOrganization.edu.
Verify the Path field is accessible usingWindows Explorer on the server running the Relay Manager
service. Copy and paste the Path from your browser into the address field of Windows Explorer and
confirm the file share is accessible. Also confirm that files can be created in this location. This can be
done simply by right-clicking inWindows Explorer and selecting to create a new document in the share
location.
The URL should be verified by entering it into a browser. If it is an IIS Virtual Directory, check its con-
figuration using IIS Manager. Ensure that Directory Browsing is enabled under the Features section.
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Side note: you will probably want to make the web.config file in this directory hidden so it is not seen
in the directory browsed from the URL.
File system supports UNC paths to remote servers.
Variables used in paths should be as simple as possible. There is a hard limit of 260 characters for a
file name and path. It’s possible to easily overflow this limit by using variables like profile title or pre-
sentation title. It’s also possible that using variables like profile title and presentation title can introduce
characters that are not valid folder names.
If you are receivingmessages that your user is unable to publish to a destination, pleasemake sure to
fill out the domain field. If there is not explicit domain, put the name of themachine that the destination
points to.
The URL entry for file system publishing and ftp publishing will attempt to map a url to the destination
where themedia is being published. It’s possible that we would be unable to verify that themapping
works if there are variables in the path. We recommend that you use the test profile portion of the pro-
file creation pages in order to verify that you are able tomap the urls correctly. If there are no variables,
we will attempt to download the test file that we publish to the destination path. If we are unable to do
so, wemark the destination as incorrect.
It is possible to completely override the destination level URL at the account level.

NTFS File Permissions

Camtasia Relay can send data to various file shares that exist on your network. While we cannot give
instructions on how to create file shares in every environment, we have included some links to information
about creating and debugging a file share onWindows Servers.

How to Share Files and Folder over the Network in aWindows Server 2003 Domain Environment:

http://support.microsoft.com/kb/324267

Shared Folders forWindows Server 2008:

http://technet.microsoft.com/en-us/library/cc770406.aspx

Enable or Disable Sharing and Discovery:

http://technet.microsoft.com/en-us/library/cc753176%28WS.10%29.aspx

WebDAV
With Camtasia Relay’s WebDAV publishing protocol a variety of different publishing destinations are opened
up for use with the system. The following briefly describes some of the locations that can be used with
WebDAV. This is by nomeans an exhaustive list.

Xythos

http://www.blackboard.com/Platforms/Learn/Products/Blackboard-Learn/Blackboard-Xythos.aspx

Xythos Software is a developer of content management software solutions for the enterprise and a subsidiary
of Blackboard Inc. Xythos products include theWebFile content management platform and a family of
applications for essential document and file management. Xythos' WebDAV-compliant solutions are licensed
to commercial, education and government organizations around the world.

http://support.microsoft.com/kb/324267
http://technet.microsoft.com/en-us/library/cc770406.aspx
http://technet.microsoft.com/en-us/library/cc770406.aspx
http://technet.microsoft.com/en-us/library/cc753176(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc753176(WS.10).aspx
http://www.blackboard.com/Platforms/Learn/Products/Blackboard-Learn/Blackboard-Xythos.aspx
http://www.blackboard.com/Platforms/Learn/Products/Blackboard-Learn/Blackboard-Xythos.aspx
http://www.blackboard.com/Platforms/Learn/Products/Blackboard-Learn/Blackboard-Xythos.aspx
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Other WebDAV Publish Destinations

The following location also contains a list of products that support WebDAV publishing

http://www.webdav.org/projects/

Considerations

If you have a problem, try the following:
Ping theWebDAV server (e.g., media.company.com) from the Relay server machine and con-
firm it is reachable.
Enter theWebDAV URL into a browser and confirm theWebDAV site can be accessed.

WebDAV is a protocol that is found in HTTP v1.1. We follow the standard for making directories and
publishing files toWebDAV URLs. We do not manage any of the versioning or editing capabilities of
the protocol as we are content creators at this time.
The Trust All Certificates option will tell WebDAV to accept any SSL certificate it receives from the
destination. This is to help out those who are rolling this out in environments where they may be using
self-signed certificates or trust that the destination server is a legit server.
Authentication types are as follows:

Basic – this is unencrypted. Use this if you aren’t concerned about the username and password
being sent in plain text.
Database – this is used primarily on Unix based setups of WebDAV. Apache has the ability to
hook up its authentication to a database. If your setup uses that method of authentication, use
this type.
Digest – this is more secure than Basic.
NTML – this is integrated windows authentication. This can be enabled in the IIS setup for a
WebDAV destination.

In order for theWebDAV server to play media, the server needs to have themedia's MIME type set in
IIS. For example, theMP4 file created by Camtasia Relay isn't included in the default MIME types in
IIS.

Microsoft SharePoint: You cannot useWebDAV to publish to SharePoint. Microsoft uses a
specialized version of WebDAV that is not standard. In order to publish to SharePoint, please
use Camtasia Relay’s SharePoint publishing destination.

YouTube
Camtasia Relay can publish presentations directly to YouTube, but there are a few things to keep inmind
when doing so.

Unverified YouTube accounts have a video length restriction. If the presentation from Camtasia Relay
is longer than this limit, the video will be rejected by YouTube after upload. The Camtasia Relay server
has no way to know if the presentation is accepted, as this step occurs after upload.

http://www.webdav.org/projects/
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For this reason, we suggest you also use the original backup encoding to create a backup of the
presentation for profiles that use YouTube publish destinations. This way if the presentation video is
rejected by YouTube after upload, there is another copy of the presentation and no data is lost.

For information on how to verify a YouTube account, see the YouTube website. As of November 2011,
the process for verifying a YouTube account involves sending a text message to amobile phone with a
confirmation code.
YouTube often updates or upgrades their business processes, so the account limits and verification
process may change. See the YouTube website for the latest information on account limits and ver-
ification.

iTunes U Information
Camtasia Relay can publish presentations directly to iTunes U provided the following conditions are satisfied:

Your institution has an iTunes U account. TechSmith is not affiliated with iTunes U.
The published presentations are encoded into a file type supported by iTunes U. Camtasia Relay
offers: MP3, IPod, and YouTube.. (iTunes U supports M4A, MP3, MP4, M4V, MOV, and PDF.)
You know the Shared Secret code provided to your school by Apple. This is a 32 character alpha-
numeric code.
You have access to desiredMedia Group ID codes. These are 10-digit numbers that direct the
producedmedia into a specific instructor’s class.
Viewers need iTunes on their computers.
If you have a problem, try the following:

Double check the fields are entered correctly.
Ping the Site URL from the Relay server machine and confirm it is reachable.
Confirm the account is usable using the iTunes U desktop application.

The Relay server must be synced with a time server in order to ensure that the time does not get out of
sync with what Apple expects. If the server is out of sync, you will get authentication errors as the sig-
nature of the request is invalid.

What is my Media Group ID?

1. Click on a class in iTunes U.
2. Right click the Videos tab and select Copy iTunes Store URL.

3. Paste the URL into a document. It will look similar to: https://-
dei-

mos.apple.com/WebObjects/Core.woa/BrowsePrivately/example.com.1927435401.01099125312

4. TheGroup ID is the last 10 digits in the URL following the period 0: (1099125312).



Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 30 -

Screencast.com Information
Screencast.com is the place to share your high-quality videos, documents, presentations, and images—
simply and professionally. We never compress or alter your content...so what you upload is what viewers
see. And with four levels of privacy controls, you get to decide who sees what.

Screencast.commay occasionally scale large content to fit the viewer’s browser window. In these cases, a
button with appear above the content to allow the viewers to view such content in its original size.

Benefits of publishing to Screencast.com

Presenters can easily manage, organize, and delete their presentations.
Presenters can attach additional materials to the video. For example, a viewer can download notes, the
actual presentation slides, etc. This is not directly accessible from Camtasia Relay; presenters will
have to log onto Screencast.com and use that interface to do this.
Screencast.com is hosted by TechSmith and is helpful for customers with limited bandwidth and
media storage space.
Presenters can exercise individual control over how their content is protected.
Presenters can allow viewers to comment on their presentations. Please visit the following URL for
more information: http://www.screencast.com/answers
Free Screencast.com accounts are available to everyone. Paid accounts may be purchased and offer
extra benefits like extra storage space andmonthly bandwidth, as well as custom templates.

Considerations

Every Camtasia Relay presenter (end user) needs a Screencast.com account. These accounts are not
created via Camtasia Relay. To obtain Screencast.com accounts, please visit http://www.screencast.com.

By default, presentations are stored in the Camtasia Relay folder on Screencast.com. Camtasia Relay
Administrators can createmultiple Screencast.com destinations for organizational purposes, and can also
createmultiple folders for Presenters. Presenters may also create their own folders on Screencast.com and
assign them to their profile.

The Camtasia Relay folder created on Screencast.com is marked as a hidden folder by default. This means
that the content within can be shared via URL links by the presenter, but the contents of the folder are not
publicly browsable on Screencast.com. It also contains a custom template to show it was created with
Camtasia Relay. Presenters can use the Screencast.com website to change the viewing permissions on this
folder if they like, or they can create their own tailored to their needs.

Inform Presenters of Required Account Information

Presentations will not be published until presenters sign in to the Camtasia Relay website and enter their
account information. Ideally, introduce presenters to the Camtasia Relay website and have them enter their
Screencast.com information beforemaking recordings.

Presenters that make a recording and upload a presentation before the information is entered receive an email
with a hyperlink and instructions to solve the problem. The presenter must enter their Screencast.com
account information on the Camtasia Relay website and then the presentation will be able to finish process
via the website.

http://www.screencast.com/answers
http://www.screencast.com/


Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 31 -

Server Troubleshooting
Server Debugging
The following are some tips for figuring out server issues.

Publishing Failures

Open the job status page and provide us with the error message reported.

WebDAV

If you get a 404 error fromWebDAV after it’s been working, this usually is indicative of the hard drive not
having enough space left to accept the file.

ITunes U

Authentication errors are also sometimes the result of the server not having it’s time updated by a central time
server like time.microsoft.com. If it was working and it’s not now, then that is usually the case.

The other instance that is pretty common is when you have used the Course Id instead of theMedia Group Id
for publishing.

Camtasia Relay Server Event Viewer
Your server’s Event Viewer can potentially provide a rich source of information regarding what’s happening on
the server when problems occur.

Once theManager Service starts on a server, it creates a TechSmith node in the Event Viewer which
captures important information about when services start and stop. It also captures error information when
errors occur. The events in the TechSmith event log are of use when contacting Technical Support.

How to Export Event Viewer Logs
The following information explains how to export the event viewer logs for the components of Camtasia
Relay. For information on how to share these with TechSmith Technical Support, please see TechSmith
Tech Support.

If the TechSmith node is not present on a server where Camtasia Relay Server has been
installed, this means that the Relay Manager Service never started on that server. If the server
isn’t running and there isn’t a TechSmith node in the Event Viewer, try the Restart Camtasia
Relay Server shortcut on the desktop, it may solve the problem.

Camtasia Relay Recorder
Windows XP

1. Go to Start > Run > eventvwr.
2. Right-click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click Application and select Save Log Files As.
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5. Save the log in the EVT format.
6. Right-click System and select Save Log Files As.
7. Save the log in the EVT format.

Windows 7 and Windows Vista

1. Open the Start menu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.

Windows 8

1. Open the Start menu and search for “event viewer.”
2. Click Settings. On the left, click Event Viewer.
3. When the Event Viewer opens, expand Applications and Services Logs.
4. Right-click TechSmith and select Save Events As.
5. Save the log in the EVTX format.
6. ExpandWindows Logs.
7. Right-click Application and select Save Events As.
8. Save the log in the EVTX format.
9. ExpandWindows Logs.
10. Right-click System and select Save Events As.
11. Save the log in the EVTX format.

Mac OSX

1. Open Finder and go to /Library/Logs/TechSmith/.
2. Right-click Camtasia Relay and select CompressCamtasiaRelay to create a ZIP file of the log files

on the desktop.

Camtasia Relay Server
Windows Server 2008

1. Open the Start menu and in the search box, type “event viewer” and press Enter.
2. When the Event Viewer opens, expandApplications and Services Logs.
3. Right-click TechSmith and select Save Events As.
4. Save the log in the EVTX format.
5. ExpandWindows Logs.
6. Right-click Application and select Save Events As.
7. Save the log in the EVTX format.
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8. ExpandWindows Logs.
9. Right-click System and select Save Events As.
10. Save the log in the EVTX format.

Windows Server 2003

1. Go to Start > Administrative Tools > Event Viewer.
2. Right-click TechSmith and select Save Log Files As.
3. Save the log in the EVT format.
4. Right-click Application and select Save Log Files As.
5. Save the log in the EVT format.
6. Right-click System and select Save Log Files As.
7. Save the log in the EVT format.

The Manager Debug Log
TheManagerDebug.log files can be viewed to gainmore knowledge as to what is occurring with theManager
Service on the Camtasia Relay server. For these files to be written on the server a line in the following file
must be uncommented:

c:\Program Files\TechSmith\Relay

Server\Manager\manager.log4net.config

1. 1. Remove the comments in the following line if any exist:

<!--<appender-ref ref="DebugAppender"/>-->

so that it looks like this:

<appender-ref ref="DebugAppender"/>

The appender-ref element can be found near the bottom of the file in the root
element.

Inversely, youmay comment out the previous line in the file if everything is behaving
properly and you do not require these log files.

2. Then restart theManager service.
3. You can then look for errors in the following file:

C:\Program Files\TechSmith\Relay Server\Logs\ManagerDebug.log

The information in this file may be beneficial when working with TechSmith if certain errors
occur on the server.
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Camtasia Relay Recorder Details
The following information deals with technical aspects of the Camtasia Relay recorder and the recording
process.

Recorder Installation Builds

The information in this topic involves changing configuration settings. This is something that
should only be done when trying to remedy an existing problem. This process has the potential
to cause problems with Camtasia Relay.

Both theMac and the PC recorders build on the server each time the server is initialized. The reason for this
build is that each recorder points to a Camtasia Relay server team. In other words, a recorder cannot
communicate with both a server from Organization A andOrganization B at the same time. It must know
whether to chooseOrganization A or Organization B. The file that gets set is the UploaderService.config file
on the PC or the Uploader.plist file in the Camtasia Relay.app on theMac.

%PROGRAMFILES%\TechSmith\Camtasia

Relay\Uploader\UploaderService.config

Camtasia Relay.app/Contents/Resources/Uploader.plist

On the PC the DefaultEndpoint and TeamId are the values that get modified while on theMac the
defaultServer and teamId get modified.

PC Configuration

<DefaultEndpoint>https://relayserver.techsmith.com/relay/rest.ashx

</DefaultEndpoint>

<TeamId>6f2fc485-7084-46bc-ae9f-9463d99b0587</TeamId>

Mac Configuration

<key>defaultServer</key>

<string>relayserver.techsmith.com/relay/rest.ashx</string>

<key>teamId</key>

<string>6f2fc485-7084-46bc-ae9f-9463d99b0587</string>
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If the name of the DNS entry for the server must change, each recorder must then be changed
to reflect the new server. This can be done by either having the presenters download and
install the new recorder when the server is rebooted or by updating these files accordingly. A
recorder that cannot find the server to which it is designated will appear in offlinemode.

The Camtasia Relay server automatically assigns a TeamId while the EndpointURL is specified during
install. This information can be gathered from the Relay database server by running the following SQL
statement:

SELECT LOWER(edptUrl) as EndpointURL, confValue as TeamId

FROM Relay.dbo.tblEndpoint

INNER JOIN Relay.dbo.tblConfig ON confName = 'TeamId'

These are some sample results of the query when it is run against the Relay database instance.

The TeamId is only necessary for Relay server communication for the Portable client
recorder. Portable client recorders cannot communicate with other recorders outside of their
own team. An invalid TeamId will not affect communication between uploaders and the
server.

Deploy the Recorder with a System Image
When distributing the Camtasia Relay to a large network of Windows basedmachines, it is often desirable to
include the Camtasia Relay recorder as part of a system image that is deployed to all of themachines in your
network.

When setting up the system image that will be deployed, there is an important step that must be done. During
the install process of Camtasia Relay recorder, the installer will generate a unique ClientID that is used by
the Camtasia Relay website to manage different computers that have the recorder installed.

If a single installation of the Camtasia Relay recorder is loaded onmultiple machines, the website will report
Client Machines inaccurately.

If you want to include the Relay Recorder in a system image, it is recommended that you zero out the
ClientId GUID. This can be located in theWindows Registry at:

HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay\
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When the ClientId is set to all zeros and the Relay Uploader Service starts (during the boot process of
Windows), the Relay Uploader Service will generate a new unique ClientId. Once the image is distributed,
eachmachine will properly generate their GUID.

Detailed Steps

The following steps provide a good system image for the Camtasia Relay recorder:

1. Install the Camtasia Relay recorder on to the system that the image will be taken from.
2. Stop the “Relay Uploader Service” from the “Services” in Control Panel (UploaderService.exe).
3. Change the value of the ClientId key to

00000000-0000-0000-0000-000000000000

The key is located at:

HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay\

4. Take an image of the system while the Relay Uploader Service is stopped and ClientId GUID is all
zeros.

DO NOT reboot themachine after you change the ClientId key to all zeros before
you take the image of themachine. If you do the Relay Uploader Service will start up
and put in a non-zeroedGUID, thus invalidating the change to all zeros and giving you
an image where all installs will look the same to the Camtasia Relay server.

Microsoft Windows Directories
The following directories all useWindows Environment variables to establish the full path. You can find what
this path is mapped to on the local machine by going to a DOS prompt and by typing:

c:\set VARIABLENAME

All of the examples in the following pages useMicrosoft Vista’s environment variables.

To see all of the variables mapped on a particular machine open a DOS prompt and type:
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c:\set

Environment Variables Used for Camtasia Relay Recorder
Windows 8, Windows 7, Windows Vista, and Windows XP

%ALLUSERSPROFILE%

%PROGRAMFILES%

%TEMP%

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%



Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 38 -

Windows XP

%USERPROFILE%

Camtasia Relay Service Directories
The Camtasia Relay uploader service runs in the background periodically looking for XML files in the following
directories:

Windows 8, Windows 7, and Windows Vista

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\QueuedPresentations\

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\

Windows XP

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\QueuedPresentations\

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\ProcessingPresentations\

Uploader Sleep Times
While there are no errors, the uploader will sleep for 60 seconds between checking for jobs. If the uploader
does detect an error when it wakes up, it will double the last sleep time before it wakes up with an upper limit
of an hour. For example, once an error is detected, the uploader will sleep for 120 seconds, then 240, then 480,
up to an hour as long as there are no communication errors. The uploader will refresh its server availability
cache once per hour, as long as the client isn’t running. The server availability caches are updatedmore
frequently when the recorder is running. SSL errors cause the uploader to sleep for 30minutes and block all
server calls from the recorder during that time.

Launching the Recorder and Logging In
When the user first launches the recorder a connection to the server is attempted. The recorder looks for the
DefaultEndpoint listed in the file:

%PROGRAMFILES%\TechSmith\Camtasia

Relay\Uploader\UploaderService.config

Example contents of the file are shown below.
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<UploaderService>

<DefaultEndpoint>https://RELAYDEV02.TECHSMITH.COM/relay/

rest.ashx</DefaultEndpoint>

<TeamId>6390a2e2-1187-4287-aaf2-c239a06ada29</TeamId>

<NumberOfAttemptsPerChunk>5</NumberOfAttemptsPerChunk>

<DefaultChunkSize>8192</DefaultChunkSize>

<Work-

erThreadWakeupInterval>20</WorkerThreadWakeupInterval>

<!--

Logging level for communications:

0 = No logging

1 = Errors only

2 = Verbose (only turn on to debug problems)

-->

<LogLevel>2</LogLevel>

</UploaderService>

After reading the endpoint the recorder attempts to connect rest.ashx on the server over port 443 using
HTTPS (HTTP over Secure Sockets Layer).

If the connection to the server fails the recorder will indicate that it is in “OfflineMode” by showing the Offline
icon:

When the user logs into the system in offlinemode, the recorder will attempt to validate the user against
cached information. These XML files give users access to their profiles even when using the system offline.
This information exists as XML files which reside in the following folders:

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%\TechSmith\Camtasia Relay\CachedRequests

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\CachedRequests
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Windows XP

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\CachedRequests

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\CachedRequests

An example of one of the files is shown below. (All data is shown on one line. Line wrapping is displayed
below.)

Files and Directories Used for Test Recordings
While Recording

When creating a test recording, both aWAV file and an AVI are created in a directory which has a random ID
appended to the end of it:

%TEMP%\RelayTest_RANDOMID\

Example:

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67

The files are stored in this directory and also have a random ID appended to the end of them:
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%TEMP%\RelayTest_7a6f67\RelayTest__captureRANDOMID.avi

%TEMP%\RelayTest_7a6f67\RelayTest__captureRANDOMID.wav

Examples:

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67\RelayTest__

capture7a6f86.wav

c:\Users\j.doe\AppData\Local\Temp\RelayTest_7a6f67\RelayTest__

capture7a6f86.avi

After Recording

When the recording has completed, the audio and video are interleaved and the recording is moved to:

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\TESTRANDOMID.avi

Windows XP

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\Recordings\TESTRANDOMID.avi

Example:

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\TEST7a6f77.avi

When the user clicks Close, the recording is deleted.

Files and Directories Used for Recording a Presentation
Default Locations

When the user clicks Record both aWAV file and an AVI are created in a directory which has a random ID
appended to the end of it:
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%TEMP%\Relay_RANDOMID\

Example:

c:\Users\j.doe\AppData\Local\Temp\Relay_7d8612\

If PowerPoint is being recorded than an additional XML file is also created.

Example:

Example:

c:\Users\j.doe\AppData\Local\Temp\Relay_7d8612\

The recording files are stored in this the recording directory and also have a random ID appended to the end of
them:

%TEMP%\Relay_9417f5\Relay__captureRANDOMID.wav

%TEMP%\Relay_9417f5\Relay__captureRANDOMID.avi

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\REC_RANDOMID.avi

Windows XP
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%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\Recordings\PPT__RANDOMID.avi

Examples:

c:\Users\j.doe\AppData\Local\Temp\Relay_9417f5\Relay__

capture941824.wav

c:\Users\j.doe\AppData\Local\Temp\Relay_9417f5\Relay__

capture941824.avi

C:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\PPT_941824.xml

After Recording

When the recording has completed, the audio and video are interleaved and the recording is moved to the
following directory. If a PowerPoint XML file exists, it remains in this location:

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\REC_RANDOMID.avi

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\PPT_RANDOMID.avi

Windows XP

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\Recordings\ REC_RANDOMID.avi

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\Recordings\PPT_RANDOMID.avi

Example:

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\REC_9417f5.avi

c:\Users\j.doe\AppData\Local\TechSmith\Camtasia

Relay\Recordings\PPT_9417f5.avi
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An XML file for processing the video is created and placed in the folder:

Windows 8, Windows 7, and Windows Vista

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\QueuedPresentations\

Windows XP

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\QueuedPresentations\

Example:

c:\ProgramData\TechSmith\Camtasia Relay\QueuedPresentations\5_

1225817404.xml

(The _# is based on the time of the presentation. Later presentations will have a higher number.)

After the Camtasia Relay uploader service chooses and completely uploads all the files for a presentation to
the server, the XML file is edited and is moved to the directory:

Windows 8, Windows 7, and Windows Vista

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\

Windows XP

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\ProcessingPresentations\

Example:

c:\ProgramData\TechSmith\Camtasia

Relay\ProcessingPresentations\125.xml

An example of the file’s contents is shown below:
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File Deletion and Cleanup

When the presentation is fully complete, that is that all encodings and publishings have completed, the next
time the uploader service communicates with the server and polls the XML directory, if the presentation is
deemed to be complete, the presentation and its associated XML are deleted from both:

Windows 8, Windows 7, and Windows Vista

%LOCALAPPDATA%\TechSmith\Camtasia Relay\Recordings\
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%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\ProcessingPresentations\

Windows XP

%USERPROFILE%\Local Settings\Application Data\TechSmith\Camtasia

Relay\Recordings\

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia

Relay\ProcessingPresentations\

Specify an Alternative Directory for Files Used to Record a Presentation

Certain user account or computer configurations may interfere with the Camtasia Relay recorder forWindows
operating systems reliably submitting recordings to the Camtasia Relay Server. This happens in the following
cases:

Roaming profiles

User accounts configured with roaming profiles may lose their recent recordings if they log out before
the presentation has completed uploading to the server. This happens when roaming profiles remove
the user’s AppData folder (%LOCALAPPDATA\TechSmith\Camtasia Relay\%USERNAME%) before
the recording files finish uploading.

Deep Freeze

Computers that use Deep Freeze or similar products may erase or reset the user’s AppData folder
before the recording files finish uploading.

To accommodate Camtasia Relay customers who use roaming profiles or products like Deep Freeze, the
Camtasia Relay recorder forWindows provides the ability to specify an alternative directory for recording
files. This alternative directory can be specified in the registry or in an XML file.

For more information seeProtection from Configuration Management Software (Deep Freeze).

If you specify an alternative directory, it must be on a local drive. Due to issues with
permission levels on network folders, presentation files cannot upload to the Camtasia Relay
server.

The Camtasia Relay recorder first looks for an alternative directory in the registry. If a value is not found there,
the XML file is checked. If a value is not there, the default directory
(%LOCALAPPDATA\TechSmith\Camtasia Relay) is used. In addition, if the specified alternative
directory cannot be written to by the user, the default directory is used.

Specify in Registry

The registry location for specifying the recording files location is based on the operating system:
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32-bit operating system:

[HKEY_LOCAL_MACHINE\SOFTWARE\TechSmith\Camtasia Relay]]

64-bit operating system:

[HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\TechSmith\Camtasia Relay]

with “String value” RecorderFilesDirectory. Example values for RecorderFilesDirectory:

%PROGRAMDATA%\TechSmith\Camtasia Relay\%USERNAME%

:D\Thaw\Camtasia Relay Recorder Files\%USERNAME%

Specify with XML File

The XML file for specifying the Recorder files location is

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\RelayRecorder.xmll

In this file, set element recorderFilesDirectory to the desired directory.

An example RelayRecorder.xml file might be:

<?xml version="1.0" encoding="UTF-8" ?>

<camtasiaRelay>

<recorderFilesDirectory> D:\Thaw\Camtasia Relay Recorder

Files</recorderFilesDirectory>

</camtasiaRelay>

The following environment variables may be used when specifying the recorder files directory:

ALLUSERSPROFILE
LOCALAPPDATA
APPDATA
HOMEPATH
PROGRAMDATA
USERPROFILE
USERNAME

These variables must be in all capital letters and surrounded by percent symbols. For example:
%PROGRAMDATA%\TechSmith\Camtasia Relay\%USERNAME%

Troubleshooting

If the alternative directory is inaccessible by the Camtasia Relay uploader, an error message is placed in the
event log notifying that a Camtasia Relay job file could not be read / saved.

Common reasons why the directory is inaccessible to the Camtasia Relay uploader include:
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The directory requires access permissions greater than Local System.
The directory is located on a network drive that requires domain permissions. Use of a network drive is
not a supported location for presentation files.
The directory is misspelled or invalid.

Mac OS X Directories

If you remove any folders related to Camtasia Relay or if you alter the uploader.plist file, the
next time you run Camtasia Relay, a presenter will be prompted to install missing
components.

Uploader Daemon
The Camtasia Relay’s uploader runs as a launch daemon. It is configured to wake when files are placed into
the Queued and Processing directories in

/Users/Shared/TechSmith/Camtasia Relay/

About the Daemon’s Configuration

The daemon is configured to launch the RelayUploader executable found in

/Library/Application Support/TechSmith/Camtasia Relay/

The daemon runs under the nobody user and group.

Uploader Sleep Time

TheMac uploader will sleep for 5 seconds by default. Like the PC uploader, it doubles its wakeup time each
time an error is found, including SSL errors. It will sleep for up to 2 hours. Upload jobs are detected
immediately.

About the Files Found in

/Library/Application Support/TechSmith/Camtasia Relay/Controllers

The Uploader.plist file is the uploader’s primary configuration file. Themost significant piece of infor-
mation is the default server.
The controllers.plist is a cached list of all the servers found in a team. If the uploader cannot talk to the
default server, it will choose one of the other servers from this list.
The uploadercache.db file is the uploader’s cache of user data. The data is stored in a flat file relational
database format.
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Data Files and Directories
~/Library/Preferences/com.TechSmith.CamtasiaRelay.plist

Contains all of the application specific preferences.
~/Library/Application Support/TechSmith/Camtasia Relay

Contains the disaster recovery data file and a cache of user login information.
~/Library/Logs/TechSmith/Camtasia Relay

Contains all of the log files for Camtasia Relay.
/Users/Shared/TechSmith/Camtasia Relay

Contains all of the data files generated by the recorder. Both the recorder and uploader utilize
this directory.

/Users/Shared/TechSmith/Camtasia Relay/Capturing

Contains all data files for a presentation that is currently being recorded.
/Users/Shared/TechSmith/Camtasia Relay/Queued

Contains xml files describing presentations currently in queue to be uploaded to the server.
/Users/Shared/TechSmith/Camtasia Relay/Processing

Contains xml files describing presentations that are currently being processed on the server.
The uploader periodically checks with the server for the state of the presentations found in this
directory. When the server reports that these presentations have been successfully processed,
the uploader will delete the corresponding files from the system.

/Users/Shared/TechSmith/Camtasia Relay/Recordings

Contains all data files for recorded presentations. When a user hits submit, the uploader copies
the data files from the capturing directory to this directory.

/Users/Shared/TechSmith/Camtasia Relay/Saved

A temporary directory where presentations from the portable recorder are copied.
/Library/Logs/TechSmith/Camtasia Relay

Contains all of the logs from the Camtasia Relay uploader. Since the uploader runs as a dae-
mon service, it places its logs in the system’s log folder.

/Library/Application Support/TechSmith/Camtasia Relay

Contains the uploader executable and configuration files for the uploader.
/Library/LaunchDaemons/com.techsmith.camtasiarelay.uploader.plist

The configuration file that informs the operating system how to launch the uploader as a dae-
mon.

/Library/Application Sup-

port/TechSmith/Camtasia/Plugins/CamtasiaRelay.tscshareplugin

Contains the plug-in used by Camtasia for Mac to share presentations to a Camtasia Relay
server.

Launching the Mac OS X Recorder and Logging In
When the recorder launches, it attempts to establish a connection to the server. If a connection could not be
established, the recorder goes into an offlinemode. While in offlinemode the recorder will validate
authentication requests against cached data stores. If the recorder can establish communication with the
uploader daemon, the uploader daemonwill use its cache. If the recorder cannot establish communication
with the uploader daemon, it has its own cache found in
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~/Library/Application Support/TechSmith/Camtasia Relay.

Recording
While Recording

While a presentation is being recorded, files will be put in the following directories:

Capturing Directory

/Users/Shared/TechSmith/Camtasia Relay/Capturing/

*.mov

Themovie files are the recordings generated by Camtasia Relay.

*.tscbif

These are binary files that allow disaster recovery to heal themovie files if they are
corrupted.

*.xml

The table of contents file for the presentation is stored as XML. This file also contains
text captured from recorded slides.

Presentations Directory

~/Library/Application Support/TechSmith/Camtasia

Relay/Presentations/

RecordingSession.plist

This file stores meta-data for the presentation and the paths to all the files (MOV,
TSCBIF, XML) that make up the presentation. Disaster recovery utilizes this file to help
restore a presentation in the event that Camtasia Relay crashes.

After Recording

When a user submits a presentation, the uploader will create an XML file with details about the presentation to
be uploaded in /Users/Shared/TechSmith/Camtasia Relay/Queued. It will also copy all of the data
files found in /Users/Shared/TechSmith/Camtasia Relay/Capturing to
/Users/Shared/TechSmith/Camtasia Relay/Recordings.

Once the recorder is informed that the uploader has successfully created its job file and copied all of the data
files, it will delete the data files found in /Users/Shared/TechSmith/Camtasia Relay/Capturing
and clear the RecordingSession.plist file.

Once the uploader successfully uploads a presentation to the server, it will move the job file from theQueued
directory to the Processing directory which is also found in
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/Users/Shared/TechSmith/Camtasia Relay/

Once the uploader receives confirmation from the server that the presentation has been successfully
processed, it will delete the job file and the corresponding data files from the Recordings directory.

Share Plug-in

The Camtasia Relay share plug-in is used by Camtasia for Mac to share presentations to a Camtasia Relay
server. When the recorder is installed, the plug-in is placed in /Library/Application
Support/TechSmith/Camtasia/Plugins/ regardless of whether Camtasia for Mac is installed.

When a user shares a presentation to Camtasia Relay from Camtasia for Mac, the presentation files are
copied to

/Users/Shared/TechSmith/Camtasia Relay/Capturing/

The share plug-in then notifies the uploader to upload the presentation. The uploader follows the same steps
mentioned in "After Recording" for uploading a Camtasia:mac recording to a Camtasia Relay server.

Uninstall Camtasia Relay
1. Delete Camtasia Relay.app
2. Uninstall the uploader daemon.

a. Open Terminal. (/Applications/Utilities/Terminal.app)
b. Execute the following commands

sudo launchctl unload /Library/LaunchDaemons

com.techsmith.camtasiarelay.uploader.plist

sudo rm /Library/LaunchDaemons

com.techsmith.camtasiarelay.uploader.plist

3. Delete all files and folders mentioned in the Data Files & Folders section. The file Libra-
ry/LaunchDaemons com.techsmith.camtasiarelay.uploader.plist was already
deleted in step 2.
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Change the Server to Which the Recorder Con-
nects
On the PC Client

1. Go to: Control Panel > Administrative Tools > Services.

2. Find the Relay Uploader Service. Right-click and select Stop.
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3. Open the following file in a text editor as an administrator :

C:\%PROGRAMFILES%\TechSmith\Camtasia

Relay\Uploader\UploaderService.config

4. Edit the element content of the DefaultEndpoint element to point to a different server.

<UploaderService>

<DefaultEndpoint>https://relayserver.techsmith.com/

relay/rest.ashx</DefaultEndpoint>

<TeamId>6f2fc485-7084-46ba-ae9f-

9465e99b0587</TeamId>

<Num-

berOfAttemptsPerChunk>5</NumberOfAttemptsPerChunk>

<DefaultChunkSize>8192</DefaultChunkSize>

</UploaderService>

5. Delete the EndpointList section of the code to remove all the old server data.
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<UploaderService>

<Defaul-

tEndpoint>https://relayserver.techsmith.com/relay/

rest.ashx</DefaultEndpoint>

<TeamId>6f2fc485-7084-46ba-ae9f-

9465e99b0587</TeamId>

<Num-

ber-

OfAttemptsPerChunk>5</NumberOfAttemptsPerChunk>

<DefaultChunkSize>8192</DefaultChunkSize>

<Work-

erThread-

WakeupInterval>20</WorkerThreadWakeupInterval>

<!--

Logging level for

communications:

0 = No logging

1 = Errors only

2 = Verbose (only turn on to

debug problems)

-->

<LogLevel>2</LogLevel>

<EndpointList>

<End-

point>https:-

//relayserver.techsmith.com/relay/

rest.ashx</Endpoint>

</EndpointList>

</UploaderService>

6. Save the file.
7. Right-click the Relay Uploader Service and by select Start to restart the Uploader service.
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8. Start the Camtasia Relay recorder. You should now be connected to a different server.

On the Mac Client
1. We highly recommend deleting all files and folders associated with Camtasia Relay except the appli-

cation itself and the preferences plist.
2. Right click the Camtasia Relay application and click Show Package Contents.
3. Navigate to: Contents > Resources.
4. Open the uploader.plist file.
5. Change the value of the defaultServer to the URL that you wish to connect to. Make sure the

URL ends in relay/rest.ashx.
6. Save the file.
7. Launch Camtasia Relay.
8. Follow the prompts for the automatic install.

Recorder Debugging
To expedite the handling of a recorder issue, you can help the TechSmith team by submitting pertinent
information with your support request.

The following sections outline and explain the information that you can provide to TechSmith.
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Failed Upload
If an upload fails from the recordingmachine it will be important to get to that recordingmachine to check its
settings. The communication from the recordingmachine to the server is one-directional, that is to say, the
recordingmachine can communicate with the Camtasia Relay server via the uploader service/daemon, but
the Camtasia Relay server cannot and does not initiate communication back to the recordingmachine. In that
way, it is necessary to go to the recordingmachine to investigate any problems with uploads.

1. When you load the Camtasia Relay Recorder, can it find its connection to the server? Does a green
checkmark show to indicate that it is connected?

a. If no, to which server address is it attempting to connect? This can be found by hovering over
the icon or by looking at either of the two files:

PC – Look at the content of the “DefaultEndpoint” element.

(For more information about this functionality please refer to Launching the Recorder
and Logging In.

%PROGRAMFILES%\TechSmith\Camtasia

Relay\Uploader\UploaderService.config

<Defaul-

tEndpoint>https://server.domain.com/relay/rest.ashx

</DefaultEndpoint>

Mac – Look at the “defaultServer” key in a plist editor.

(For more information about this functionality please refer to Launching the Mac OS X
Recorder and Logging In.

/Library/Application Support/TechSmith/Camtasia

Relay/Controller/Uploader.plist

b. Is the server’s fully qualified domain name absolutely correct?
If no, refer to sectionChange the Server to Which the Recorder Connects to change
the server.
If yes, continue with the questions in step 2 below.

2. Do the clients respect SSLCertificate errors? Is it possible that something is wrong with the certificate
on the server?

The following two locations on the client show this setting.

PC - Refer to the UploaderService.config file referenced above. Look at the content of
the “IgnoreSslCertificateErrors” element. If it reads “False” then any problem with
the certificate can cause problems with the communication.
Mac – Refer to the Uploader.plist file referenced above. Look at the “Igno-
reSslCertificateErrors” key. If it reads “No” or “False” then any problem with the cer-
tificate can cause problems with the communication.
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To investigate problems with SSL please refer to the Camtasia Relay Server Security Administrator
Guide. To find our how to obtain this document, seeAppendix A: Additional Help and Related
Documentation.

3. Is the uploader running?
PC –Open “Administrative Tools”, “Services” and check to see if the “Relay Uploader Service”
is running. If it is not, start it. If it crashes for any reason send the following items to TechSmith
Support.

Windows 7 & Windows Vista

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\

Windows XP

%ALLUSERSPROFILE%\Application

Data\TechSmith\Camtasia Relay\

4. If you continue to experience issues with uploading presentations on the PC, open the Upload-
erService.config file mentioned above and change the LogLevel to "2", which causes the
Uploader to bemore verbose in its logging.

5. After making this change, go to the Services window and restart the "Relay Uploader Service".

Once the service is restarted, the verbose logs will be visible through Event Viewer under the
Applications and Services Logs > TechSmith node.

This should help our technical support team in debugging your issue.

Add-In for Microsoft PowerPoint Issues
If you have issues with the Camtasia Relay PowerPoint Add-In, go through the following questions to try to
isolate the issue.

Initial Questions

1. Is the Camtasia Relay Recorder working even if PowerPoint Add-in is not?
2. How many audio input devices do you have on the box where the PowerPoint Add-in is not working?
3. Have you tried installing the recorder on a computer that does not have any other PowerPoint Add-ins?

Further Debugging and Checks

The following information about the Camtasia Relay PowerPoint Add-in applies to Camtasia
Relay onWindows XP or, Windows Vista, andWindows 7 running PowerPoint 2003, 2007, or
2010. The PowerPoint Add-in does not install on 64-bit versions of Microsoft Office.

Usually, PowerPoint Add-In issues are due to conflicts betweenmultiple PowerPoint Add-ins. Please attempt
to provide answers to these questions to help TechSmith Support to look at the issue further:
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1. The version of Windows being used.

InWindows, hit “Start”, “Run”, type “winver” and hit OK.

2. The version of PowerPoint being used.
3. Steps to reproduce the problem.
4. How many displays (monitors) are being used.
5. Does Recorder still work?
6. What other PowerPoint Add-ins are installed.

To see the installed Add-ins with PowerPoint 2010:
Click the Options button under the File tab.
Click the Add-ins choice in the left pane of the Options window.

To see the installed Add-Ins with PowerPoint 2007:
Click the PowerPoint Options button under the roundOffice button.
Click the Add-ins choice in the left pane of the Options window.

To see the installed Add-Ins with PowerPoint 2003:
Select the Add-ins choice under the Tools menu.
Also note any toolbars that may constitute an Add-In.

Disabling the Camtasia Relay PowerPoint Add-In

Often, PowerPoint automatically asks you if you want to disable the offending add-in. You can accept this as
a temporary work around. Below are additional options.

If PowerPoint has multiple add-ins installed, you can try disabling the ones currently not needed. Instructions
for disabling/enabling add-ins are as follows:

PowerPoint 2010:

1. Click theOptions button under the File tab.
2. Click theAdd-Ins choice in the left pane of the Options window.
3. Click theCamtasia Relay Add-in line and click theGo button.
4. Check or uncheck the box next to Camtasia Relay Add-in to enable or disable the Add-In, and click

OK.

Additional information about how to enable and disable add-ins is available here:

http://office.microsoft.com/en-us/powerpoint-help/HA010354315.aspx

PowerPoint 2007:

1. Click thePowerPoint Options button under the roundOffice button.
2. Click theAdd-Ins choice in the left pane of the Options window.
3. Click theCamtasia Relay Add-in line and click theGo button.
4. Check or uncheck the box next to Camtasia Relay Add-in to enable or disable the Add-In, and click

OK.

http://office.microsoft.com/en-us/powerpoint-help/HA010354315.aspx
http://office.microsoft.com/en-us/powerpoint-help/HA010354315.aspx
http://office.microsoft.com/en-us/powerpoint-help/HA010354315.aspx
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Additional information about how to enable and disable add-ins is available here:

http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx

PowerPoint 2003:

PowerPoint 2003 has no good way to disable the Camtasia Relay Add-in. Uninstall it instead – see the
directions below.

Uninstalling the Camtasia Relay Add-In

If PowerPoint is crashing before you can use it to disable any add-ins, it will be necessary to uninstall the
Camtasia Relay Add-in or other possibly conflicting Add-Ins.

The Camtasia Relay PowerPoint Add-in can be uninstalled without uninstalling the Camtasia Relay recorder
program.

If PowerPoint has crashed, before proceeding, youmay want to reboot your computer to be sure there are no
hidden PowerPoint, Camtasia Relay recorder, or other processes inmemory.

1. Start uninstalling the Camtasia Relay PowerPoint Add-in by running the Camtasia Relay recorder
installer.

2. Select theModify choice and click Next.
3. On the following window, click the little button to the left of Microsoft Office PowerPoint Add-in and

select the red X (Entire feature will be unavailable), and proceed with the un-installation.

It is also possible to initially install Camtasia Relay without the PowerPoint Add-in, if desired.

Click the Options button on the initial installing window, disable Install the Camtasia Relay
Add-in for Microsoft PowerPoint, and proceed with the installation.

Files to Include with a Support Request
Please include the following files when submitting a support request for the Camtasia Relay recorder.

Windows Client

Log Files

Locate the “UploaderService.log” file from C:\Program Files (x86)\TechSmith\Camtasia
Relay\Uploader.

Please also send any relevant messages from theWindows Event log.

To enable client logging on the PC, create a text file that matches the name of the application and place it in
the same directory as the application. In most cases, this file will be named "RelayRecorder.log." Please
create this file, reproduce the error, and send it to TechSmith.

http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx
http://office.microsoft.com/en-us/powerpoint/HA100341271033.aspx
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Mac Client

Crash Logs

Crash Logs do themost to help TechSmith diagnose a problem should a crash occur. Send any file with the
word “Uploader” or "Relay" in its name that is in the following two directories:

~/Library/Logs/CrashReporter/

/Library/Logs/CrashReporter/

Log Files

Send any files from the following directories to TechSmith when reporting an issue:

/Library/Logs/TechSmith/Camtasia Relay

~/Library/Logs/TechSmith/Camtasia Relay

Stalled Mac Recorder

If you have a stalledMac recorder:

1. Open the Activity Monitor application from /Applications/Utilities.
2. Choose the CamtasiaRelay process and select Sample Process from the View menu.
3. Send this text to TechSmith.

Clearing Jobs

Delete the contents of the following folders:

/Users/Shared/TechSmith/Camtasia Relay/Queued

/Users/Shared/TechSmith/Camtasia Relay/Processing

/Users/Shared/TechSmith/Camtasia Relay/Recordings

After clearing all jobs, youmust also restart the uploader.

1. Open Activity Monitor and switch to All Processes.
2. Locate the Camtasia Relay uploader process and click Quit Process.
3. Restart the Camtasia Relay recorder.
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Protection from Configuration Management
Software (Deep Freeze)
The use of configurationmanagement software such as Faronics’ Deep Freeze is possible withWindows and
Mac Camtasia Relay recorders. However, certain additional considerations are necessary for both the
installation and regular use of the Relay client in order to ensure an optimal experience for users of the
software.

The use of configurationmanagement software such as Faronics’ Deep Freeze on a Camtasia
Relay Server is not recommended.

Recorder Installation and Upgrade

For the initial installation and periodic upgrades of the Camtasia Relay recorder, it is highly recommended that
the full system be unfrozen to allow for successful installation of all required components.

Daily Use

For regular use of a frozen computer, system administrators that implement Deep Freeze or similar software
on clients should carefully consider the configurationmanagement application’s handling of persistent data on
disk. Deep Freeze allows the designation of disk locations as “ThawSpace” in order to retain data across
sessions when the computer is in a frozen state.

The following locations are used for storage of Camtasia Relay user data and should therefore be considered
for designation as ThawSpace.

Windows (all versions)

%TEMP%

This system path is only used by the Relay recorder to store data until the user chooses
to submit or discard a presentation.

Windows 8, Windows 7, andWindows Vista

%ALLUSERSPROFILE%\TechSmith\Camtasia Relay\

%LOCALAPPDATA%\TechSmith\Camtasia Relay\

Windows XP

%ALLUSERSPROFILE%\Application Data\TechSmith\Camtasia Relay\

%USERPROFILE%\Local Settings\Application

Data\TechSmith\Camtasia Relay\
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OS X 10.6 and later

/Users/Shared/TechSmith/Camtasia Relay/

More information on Deep Freeze, including User Guides and FAQs, can be found at:
http://www.faronics.com/support

Formore information, seeSpecify an Alternative Directory for Files Used to Record a Presentation.

http://www.faronics.com/support
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Include Webcam Video in a Presentation
Camtasia Relay provides powerful tools for recording, processing, and distributing presentations. It is
important to keep inmind that Camtasia Relay records whatever is displayed on the screen of your PC or
Mac. In some cases, youmay be recording a demonstration of a piece of software, while in others you are
recording a presentationmade usingMicrosoft’s PowerPoint.

But what if you want to include video from awebcam in your presentation? Youmay, for example, want to
show the face of a professor as they give a lecture or include a video of someone drawing on a whiteboard.

Fortunately, there are amultiple ways to accomplish this, three of which we discuss in this document. The
primary way is to select a camera in the recorder, which will include webcam video in a picture-in-picture (PiP)
on the presentation video. Another way is to use Camtasia Relay in conjunction with Camtasia Studio; while
yet another is to use the software that comes with a webcam to show (and then capture) the video right on
your desktop.

Record Webcam Video in Camtasia Relay
Recorder
The Camera button in the recorder opens a camera selection window. Select a camera based on the preview
shown in the selection window. This process is very similar to selecting a display whenmultiple displays are
available.

Camtasia Relay supports record webcam video with presentations. It does not support digital
video (DV) cameras at this time.

For more information on selecting a camera to record with a presentation, see the Camtasia Relay recorder
help.

Record with Camtasia Studio

The following process involves using Camtasia Studio, which you can purchase from
TechSmith and use in conjunction with Camtasia Relay. This integration allows for more
robust recording and editing features, while still providing the ease of automatic processing
and publishing with Camtasia Relay.

Themost flexible way to include a webcam video in your presentation is to record with Camtasia Studio and
then produce and publish with Camtasia Relay. Because Camtasia Studio records the webcam video
separately from the presentation, you can runMicrosoft PowerPoint as you normally do, without making any
special size adjustments. In Camtasia Studio, you can also change the location of the webcam video in your
presentation before sending it to Camtasia Relay for processing and publishing

To record your presentation and webcam video with Camtasia Studio:

1. Launch Camtasia Studio and click Record the Screen.
2. When the recorder opens, select Full screen.
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3. Click theWebcam button to enable webcam recording.

A live preview of the webcam appears to the right of theWebcam option.

4. Open PowerPoint and start your slideshow.
5. Click theRecord button.

6. Record and edit your presentation with Camtasia Studio, including adjusting the location of the
webcam video in your presentation.

For more information about working with and options for including a webcam video, open the Camtasia
Studio Help and go to Edit and Add Effects to Your Video > Video Effects > Picture-in-Picture (PIP).

7. Produce and share the presentation to the Camtasia Relay server for final processing and publishing.

8. Log in to Camtasia Relay, choose a profile, add a title and description for the presentation, and click
Submit.

The presentation uploads to the Camtasia Relay server and, when processing and publishing are
complete, the presentation is published showing the presentation and the webcam video.
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Record Video Playing on the Desktop
With a small amount of setup and a little practice, you can record webcam video using Camtasia Relay and a
webcam. This is a goodmethod to try if you do not ownCamtasia Studio.

For the following example, we are recording aMicrosoft PowerPoint presentation while also including a video
of a presenter at a whiteboard.

Setup needed

Computer: PC orMac.
A webcam: For our example, we used a Logitech 1.3Megapixel webcam but most standard webcams
work.
Webcam software: Software that shows the live image through your camera. For our example, we
used the Logitech Quickcam for Enterprise software that camewith our webcam, but you can use
other software products as well. You do not actually need to record anything using the webcam soft-
ware, but you do need it to control your camera.

Setting up PowerPoint

If you useMicrosoft PowerPoint, a couple of steps during setupmake it easier to create the kind of recording
that you want.

For this example, we usedMicrosoft PowerPoint 2007. With PowerPoint, when you run a slide show, by
default, the slide show takes up the entire display. Since the entire display is used for the slide show, you
cannot see your toolbar andmay not have a way to start or select your webcam software. With the default
settings, the video from your webcam does not appear on the display and is not recorded.

To run your slide show in a smaller window:
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1. In PowerPoint, go to Slide Show > Set Up Slide Show.

2. Change the Show type to Browsed by an individual (window). This runs your slide show in a window
that does not take up the entire screen.

3. Start the software for your webcam.
4. If possible, set the size of the window that you want for your video. With the Logitech Quickcam for

Enterprise software that we used for our example, we chose 640 x 480.

Somewebcam softwaremay not let you choose the size for your video.
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5. Move the webcam video next to your PowerPoint slide show.

6. Once you have your webcam set up, do a few practice recordings tomake sure that it is working the
way you like.

Considerations
While including webcam videomay be necessary for you, keep inmind that it makes your recording
files much larger than they would be with just slides – perhaps as much as 10 times larger. This results
in slower uploading and encoding, as well as usingmore room for file storage.
For Release 3.1 and later, Camtasia Relay records at amaximum of 15 frames per second (fps). This
couldmake videos that contain a high amount of motion appear choppy. Do a test recording tomake
sure that the published presentation quality is acceptable for your needs.
If the quality does not meet your needs, recording with Camtasia Studio may be a better option for you.
When recording with Camtasia Studio, you can define recording options such as the frames per sec-
ond to record and other settings to allow for higher quality webcam video in your final presentation.
If your recording is played back on iPods or other handheld devices, make sure that the window for
your video is large enough so that viewer can see enough detail.
There is no way tomove or remove the webcam video after recording.
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Camtasia Relay Portable Recorder
Provide the portable recorder to presenters if there is any reason that presenters cannot (or should not) record
and upload directly from the presentation computer. For example:

Presenters record on computers where they do not have permission to install applications.
Presenters record on computers that have limited or no network access.
You want to collect the presentations and upload them collectively at a later time.

You can select how you want presenters to access the portable recorder on the System > System Options
page.

If you choose to have presenters contact an administrator to receive a portable recorder, you will want to
install the Camtasia Relay portable recorder on amobile storage device and distribute to presenters. Use the
following process to install the portable recorder on amobile storage device, such as a USB flash drive.

1. Plug in amobile storage device and format the device as FAT32.
2. Click Download Portable Recorder and save the ZIP file to your computer.
3. Locate and open PortableCamtasiaRelay.zip.
4. Copy all files from the .zip file onto themobile storage device.

All files from the ZIP archive need to be copied to the root of the device for the Camtasia Relay
portable recorder to autorun onMicrosoft Windows. (Autorun is not available for theWindows 7
or Mac operating systems.)

Administrators can decide how they would like presenters to access the portable recorder. Choose from the
following:

Option Description

Available
by Down-
load only

The portable recorder is available on the website. Presenters can log in to the
website and download the portable recorder and transfer it to amobile storage
device, such as a USB.

Youmay want to use this option if you feel presenters are reasonably “technical”
and understand downloading and unzipping files.

Available
by Email
Request
only

There is a button available on the website to request a portable recorder.
Presenters can log in to the website and click this link to send an email request to
the administrator.

Youmay want to use this option if you feel presenters are very “not technical” and
may not understand downloading and unzipping files. The administrator will
receive an email that the user requested a portable recorder. You can put the
portable recorder on amobile storage device and give it to the presenter.

Not Avail-
able

There is no way for a presenter to download or request a portable recorder.

Youmay want to use this option if you will handle distributing all portable
recorders.
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Option Description

Even if they do not have access to the portable recorder,
presenters will still be able to find information about it in the Help
and other locations.

Special Files on the Portable Recorder

In the following section “PortableRoot:” refers to the drive letter that the Relay Portable
Recorder is mapped to. “SystemRoot:” refers to the drive letter that the operating system is
installed on.

Files
PortableRoot:/Camtasia Relay/USBConfig.xml

Contains the Team ID – this is used tomatch a portable recorder to its parent Camtasia Relay
server.

The Team ID allows the portable recorder to know that the Camtasia Relay
Uploader is part of the same installation as the portable recorder. If the Team
IDs do not match, then the Portable Recorder will remain offline. This is
designed to protect a user from sending their presentation to the wrong
Camtasia Relay server.

Example:

<?xml version="1.0" encoding="utf-8"?>

<usbconfig>

<teamid>24bca0cd-7c5d-4f8a-a854-

db7838240c74</teamid>

</usbconfig>

PortableRoot:/Camtasia Relay/ProfileCache.xml

This is the cached login file. It stores usernames and encoded passwords for offline authen-
tication.
Example:

<?xml version="1.0" encoding="UTF-8" ?>

<relay Version="2.0.0">
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<rememberMe isGuest="0"

email="s.smalls@example.com">Scotty

Smalls</rememberMe>

<presenter name="s.smalls" fullName="Scotty

Smalls" email="s.smalls@example.com"

phash="e9f2c7f d25e1b3a fad3e85a 0bd17d9b

100db4b3" authCode="d87c46ed-31a8-45a6-8a10-

22e207374751">

<profileList />

</presenter>

<presenter name="b.rodriguez"

fullName="Benjamin Franklin Rodriguez"

email=”b.rodriguez@example.com" phash="e9f2c7f

d25e1b3a fad3e85a 0bd17d9b 100db4b3"

authCode="e33101a8-f39e-4f64-8de0-

462af7d83d48">

<profileList>

<profile title="HIST 320:

The African Diaspora"

id="3" />

<profile title="CSE 480:

Computer Databases" id="4"

/>

</profileList>

</presenter>

</relay>

PortableRoot:/Camtasia Relay/Recordings/recordings.xml

Contains the info for the presentations located on the portable drive.
Example:

<?xml version="1.0" encoding="UTF-8" ?>

<relay Version="2.0.0">
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<presenter>

<presentations />

</presenter>

<presenter username=""

fullname="Hamilton Porter" email=""

authCode="">

<presentations>

<presentation>

<profileId>-

1</profileId>

<title>Intro to

World

History</title>

<description>The

Nile

Delta</-

description>

<cre-

ationdate>2010-

02-15 10:14:19 -

040-

0</creationdate>

<dura-

tion>2-

200</duration>

<max-

res-

olution>1600x1200</maxresolution>
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nos-

tics><-

/diagnostics>

<trim-

start>0</-

trimstart>

<tri-

mend>22-

00</trimend>

<files>

<file

type="-

0"

order="-

0"

file-

Dura-

tion="2-

200"

file-

Width="-

1600"

file-

Height=-

"1200">-

rec_

1ea7432-

8.avi</-

file>

<file

type="-

2"
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order="-

0"

file-

Dura-

tion="-

0"

file-

Width="-

1600"

file-

Height=-

"1200">

relay-

thumb-

nail1ea-

812e5.p-

ng</fil-

e>

</files>

</presentation>

</presentations>

</presenter>

</relay>

PortableRoot:/Camtasia Relay/Recordings

Contains all of the data files for recorded presentations.

PortableRoot:\Camtasia Relay\Recordings\*.avi

Stored video files created on aWindows operating system – see recordings.xml for attributes.

PortableRoot:/Camtasia Relay/Recordings/*.mov

Stored video files created on aMac operating system – see recordings.xml for attributes.

PortableRoot:/Camtasia Relay/Recordings/*.png

Thumbnail images for use with Saved Presentations dialog.
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How it Works
The Camtasia Relay portable recorder is the same executable as the normal recorder. However, the recorder
will operate in portable mode when it detects that it is running from a Plug and Play device.

When doing a recording, the portable recorder acts like the normal recorder until you are ready to com-
plete your recording. It temporarily saves the data files to the temporary directory given below. If an
uploader is not present, the recorder will copy the entire data file to the portable storage device. If an
uploader is present, the portable recorder will give you the option to save the presentation or upload it.
The process of uploading the presentation follows the workflow of the normal recorder.

Mac operating system
Temporary capturing directory: /Users/Shared/TechSmith/Camtasia
Relay/Capturing

Saved presentation directory: /Users/Shared/TechSmith/Camtasia
Relay/Saved

Windows operating system

Temporary and saved presentation directory:

Windows 7 andWindows Vista: Sys-
temRoot:\Users\%USERPROFILE%\AppData\Local\TechSmith\Camtasia

Relay\Recordings

Windows XP: SystemRoot:\%USERPROFILE%\Local Settings\Application

Data\TechSmith\Camtasia Relay\Recordings

The Saved Presentation dialog shows all presentations that have been saved to the portable recorder.
When a presentation is submitted from the Saved Presentations dialog, the files are copied from the
portable storage device to saved presentation directory. Once the data is successfully moved to that
directory, the upload process follows the normal recorder’s upload workflow.

The Recordings.xml File
Meta data for all recordings saved to the portable storage device is found in the recordings.xml file.
Presentations are grouped on a per presenter basis. If you wish to delete a presentation by hand, youmust
delete the corresponding presentation node found under the corresponding presenter. Also, remember to
delete all associated files found in the Recordings directory. These files are listed in the files section of the
presentation node.

The Windows Portable Recorder
The following information is specific for the portable recorder that runs on theWindows operating system.

AutoPlay Capabilities on Microsoft Windows

Depending on the security settings on themachine or via the Group Policy, the Camtasia Relay portable
recorder may be able to automatically prompt the user to start the recorder when the portable recorder is
connected to themachine.

These settings may be governed by Group Policy settings which can prevent the user from
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editing these options.

This functionality is not present on theMacintosh operating systems due to security concerns,
andMicrosoft has announced that it will no longer be available in the future on theWindows
Operating Systems. This functionality is not available onWindows 7, but is still possible in
Windows XP andWindows Vista.

Windows Vista

To configure this option inWindows Vista please follow these steps:

1. Open theWindows Control Panel
2. Click Classic View option on the left.
3. Click AutoPlay.

4. Depending on the type of media that you are using for the Portable Media Device, you can then set the
default action when amedia device of that type is inserted. The “Ask me every time” option will allow



Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 76 -

the selector screen to display.

Troubleshooting options

For troubleshooting options regardingWindows Auto-Play options please refer to the following URL:

http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-
a75651c7a9451033.mspx

Running onWindows Operating System with AutoPlay Enabled

Under certain conditions, when you connect amobile storage device that contains the portable recorder with a
computer, you are presented with the option to immediately start the application.

Click “Start Camtasia Relay” to run the recorder.

Windows Operating System with AutoPlay Disabled

If AutoPlay is disabled, to run recorder:

1. OpenWindows Explorer (Right-click on Start and select Explore.)
2. Navigate to themobile storage device.
3. Double-click PC Camtasia Relay.exe.

The Mac Portable Recorder
To run the portable recorder on aMac:

1. Navigate to themobile storage device.
2. Double-click Mac Camtasia Relay.

http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
http://windowshelp.microsoft.com/Windows/en-US/Help/3ab73757-6b67-4e3c-80b1-a75651c7a9451033.mspx
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The file is actually “Mac Camtasia Relay.app”, but, depending on their system settings, Mac
users may see this file as “Mac Camtasia Relay”.
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TechSmith Fuse for Camtasia Relay
TechSmith Fuse is a camera video recorder designed for use with the Camtasia Relay server. TechSmith
Fuse records camera video and uploads it to a Camtasia Relay server for automated encoding and publishing.
TechSmith Fuse also can upload existing videos from your device to a Camtasia Relay server.

TechSmith Fuse requires a server running Camtasia Relay 3.1 or later and a device with iOS 4.0 or later or
Android 2.3.3 or later.

To download TechSmith Fuse for your device:

For iOS is available for download from the Apple App Store or by using this link: http://www.-
techsmith.com/redirect.asp?target=ios_fuse&ver=4.1.0&lang=enu&os=win&product=relay
For Android: http://www.-
techsmith.com/redirect.asp?target=androidfuse&ver=4.1.0&lang=enu&os=na&product=relay

http://www.techsmith.com/redirect.asp?target=ios_fuse&amp;ver=4.1.0&amp;lang=enu&amp;os=win&amp;product=relay
http://www.techsmith.com/redirect.asp?target=ios_fuse&amp;ver=4.1.0&amp;lang=enu&amp;os=win&amp;product=relay
http://www.techsmith.com/redirect.asp?target=ios_fuse&amp;ver=4.1.0&amp;lang=enu&amp;os=win&amp;product=relay
http://www.techsmith.com/redirect.asp?target=ios_fuse&amp;ver=4.1.0&amp;lang=enu&amp;os=win&amp;product=relay
http://www.techsmith.com/redirect.asp?target=androidfuse&amp;ver=4.1.0&amp;lang=enu&amp;os=na&amp;product=relay
http://www.techsmith.com/redirect.asp?target=androidfuse&amp;ver=4.1.0&amp;lang=enu&amp;os=na&amp;product=relay
http://www.techsmith.com/redirect.asp?target=androidfuse&amp;ver=4.1.0&amp;lang=enu&amp;os=na&amp;product=relay
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Camtasia Relay Database
A major component of the Camtasia Relay architecture is the SQL Server (Express) database component that
stores information about presentations, users, profiles, and other system settings. This section contains
information about working with this database.

Identifying the Camtasia Relay Databases
The name of the database depends on the version of Camtasia Relay.

Database Name Camtasia Relay Version

RelayRuntime 1.0

RelayMeta 1.0

Relay 1.1 or 1.2

Relay20 2.0

Relay300 3.0.0

Relay301 3.0.1

Relay302 3.0.2

Relay303 3.0.3

Relay310 3.1.0

Relay400 4.0.0

Relay401 4.0.1

Relay402 4.0.2

Relay403 4.0.3

Relay410 4.1.0

Relay411 4.1.1

Relay412 4.1.2

Relay420 4.2.0

Relay421 4.2.1

Relay430 4.3.0
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Back Up the Camtasia Relay Database
Considerations

The Camtasia Relay database contains critical information regarding the configuration and operation of the
server application. It is highly recommended that the database be backed up on a regular basis and that
restore operations are periodically tested to prevent the potential loss of data.

Database backups may be performedmanually or on a schedule. Options exist for performing backups
through SQL Server directly or with the use of third party backup applications. Users of Camtasia Relay
should select a backup regimen that best fits with their organization’s disaster recovery policies, existing
procedures, and tolerance for acceptable data loss.

By default, the Camtasia Relay database runs in Simple Recovery model. For amore fine-grained approach to
backups and restoration of the database, use of the Full Recovery or Bulk-Logged Recovery model is feasible
but should be thoroughly tested in your environment prior to implementation. The use of one of these recovery
models may adversely impact performance of the database and the consumption of server resources. More
information on SQL Server recovery models can be found at:

http://technet.microsoft.com/en-us/library/ms189275.aspx

General information regarding SQL Server backups can be found at:

http://msdn.microsoft.com/en-us/library/ms175477.aspx

Back Up Using SQL Server Management Studio
The procedure for performing a full database backup with SQL Server Management Studio or SQL Server
Management Studio Express is shown below and is essentially identical for both SQL Server 2005 and SQL
Server 2008 Express and Standard editions.

This procedure can be performed locally on the database server or from a remotemanagement workstation
with SQL Server Management Studio installed if remote access to the database server has been allowed.
However, disk locations denoted in the backup procedure will always be local to the database server.

http://technet.microsoft.com/en-us/library/ms189275.aspx
http://technet.microsoft.com/en-us/library/ms189275.aspx
http://msdn.microsoft.com/en-us/library/ms175477.aspx
http://msdn.microsoft.com/en-us/library/ms175477.aspx
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1. Right click the database to back up and select Tasks > Back Up.

2. On theGeneral tab, select backup type Full and set a location on disk for the backup file.



Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 82 -

3. Choose to backup to an existing backup set or to append to a new backup set. Selecting Verify backup
when completed is recommended. Then, click OK.

The backup is complete.

As a follow up to a successful backup, it is highly recommend that the local backup file be
copied to a location that protects it from the loss or failure of the database server.

More information on performing database backups via Management Studio may be found at:
http://msdn.microsoft.com/en-us/library/ms189621.aspx

Official Instructions regarding How to Backup a Database using SQL Server Management Studio can be
found at: http://msdn.microsoft.com/en-us/library/ms187510%28SQL.90%29.aspx

http://msdn.microsoft.com/en-us/library/ms189621.aspx
http://msdn.microsoft.com/en-us/library/ms189621.aspx
http://msdn.microsoft.com/en-us/library/ms187510(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms187510(SQL.90).aspx
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Back Up Using a SQL Script
Backups of SQL Server databases can be scripted for use in a SQL batch file, freehand execution via SQL
Query Editor or sqlcmd, or use in an external application.

The following example script performs a full database backup of the Relay300 with the same options listed in
the previous section, Back Up Using SQL Server Management Studio.

USE Relay300;

GO

BACKUP DATABASE Relay300

TO DISK = 'C:\Program Files\Microsoft SQL Server\MSSQL10_

50.RELAY\MSSQL\Backup\Relay300.bak'

WITH NOINIT,

NAME = 'Relay300-Full Database Backup',

RETAINDAYS = 0,

STOP_ON_ERROR;

GO

RESTORE VERIFYONLY

FROM DISK = 'C:\Program Files\Microsoft SQL

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak'

GO

A simpler one-time backup that does not append to an existingmedia set or use extra verification can be
performed with the following. This script will overwrite any existing backups in the backup file specified

USE Relay300;

GO

BACKUP DATABASE Relay300

TO DISK = 'C:\Program Files\Microsoft SQL

Server\MSSQL10_

50.RELAY\MSSQL\Backup\Relay300.bak'

WITH FORMAT;
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GO

More information on the BACKUP command can be found at:

http://msdn.microsoft.com/en-us/library/ms186865.aspx

Back Up Using the Command Line
SQLServer’s sqlcmd command line utility can be used to perform any task that is possible with SQL Server
Management Studio. It is installed with all editions of SQL Server 2005 and later.

By using the scripts described in the previous section, it is possible to perform database backups from the
command line with the sqlcmd utility. These commands can be entered freehand or can be added to a SQL
batch file.

The sqlcmd utility takes numerous optional arguments. At aminimum, the “-S” argument will be needed to
access the SQL Server instance for Camtasia Relay. Without any additional arguments, this will log you into
the Relay instance with the current user’s Windows credentials. The optional “-U” and “-P” arguments can be
added to the command line in order to provide SQL user credentials.

An example of freehand backup via the command line

An example of a backup performed using a SQL command file

More information on the sqlcmd utility can be found at: http://msdn.microsoft.com/en-
us/library/ms162773.aspx

Schedule an Automated Database Back Up
Scheduled automated backups of the Camtasia Relay database can be performed in at least three ways:

http://msdn.microsoft.com/en-us/library/ms186865.aspx
http://msdn.microsoft.com/en-us/library/ms186865.aspx
http://msdn.microsoft.com/en-us/library/ms162773.aspx
http://msdn.microsoft.com/en-us/library/ms162773.aspx
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Third-party backup utilities
SQL Server Automated Administration
Windows Scheduled Task

Third-Party Backup Utilities

If your organization has implemented a third-party backup system such as Symantec Backup Exec then you
may have the option of integrating SQL Server backups of your Camtasia Relay database into that system.
The use of such a systemmay incur additional licensing costs for the software to perform this type of backup.
Performing backups in this manner will not be covered in the document but information on what databases to
include can be found in the Backing Up Your Camtasia Relay Database section of this document.

SQL Server Automated Administration

Configuring automated backups via SQL Server Automated Administration is an option for all editions of
Microsoft SQL Server except Express Edition due to its reliance on the SQL Server Agent service. Camtasia
Relay is distributed with SQL Server Express Edition for its standalone install.

Scheduled backups on those editions of SQL Server supporting this capability can be created by building and
scheduling a DatabaseMaintenance Plan.

Information on using Automated Administration for SQL Server can be found here:
http://msdn.microsoft.com/en-us/library/ms189880.aspx

Information on creating a SQL Server Maintenance Plan can be found here: http://msdn.microsoft.com/en-
us/library/ms189953.aspx

Windows Scheduled Task

For installations of Microsoft SQL Server Express Edition, the preferredmethod of performing an automated
database backup is to utilize theWindows Task Scheduler. One or more scheduled tasks can be configured
to run the sqlcmd utility with a SQL command file as explained in the Backup Using the Command Line
section of Backing Up the Camtasia Relay Database in this document.

In order to run a SQL Server database backup via theWindows Task Scheduler, considerationmust bemade
for whom to run the task as and what access this user has to the installed SQL Server instance. If the sqlcmd
utility is run without defining the SQL login username (-U) and password (-P) arguments, the scheduled task
must be configured to run under aWindows account with permissions to run tasks onWindows and with
access to back up the SQL Server database.

http://msdn.microsoft.com/en-us/library/ms189880.aspx
http://msdn.microsoft.com/en-us/library/ms189880.aspx
http://msdn.microsoft.com/en-us/library/ms189953.aspx
http://msdn.microsoft.com/en-us/library/ms189953.aspx
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To access Task Scheduler:

Using theWindows interface:

1. Click theStart button.
2. Click Control Panel.
3. Click System and Maintenance.
4. Click Administrative Tools.
5. Double-click Task Scheduler.

From the Command Line:

1. Open a command prompt. (To open a command prompt, go to Start > All Programs > Accessories>
Command Prompt.)

2. At the command prompt, type Taskschd.msc.
For information on setting up a scheduled task inWindows Server, open the Task Scheduler Help.

Restore the Camtasia Relay Database
The Camtasia Relay database can be restored from a backup that was created using any of themethods
described in theBack Up the Camtasia Relay Database section of this document. Users of a third-party
backup application will need to consult their backup software’s documentation for restore procedures.

The procedures that follow describe a database restore to a SQL Server that previously contained the
Camtasia Relay database. Restoring to a new server installation requires additional steps to generate logins
for the database. If restoring to a new server, please first run a new installation of Camtasia Relay before
restoring the database backup file or contact Customer Support for additional assistance.
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If a functioning database exists on the SQL Server but you wish to overwrite this database, it is generally a
good practice to back up the existing database prior to overwriting it with a restore. Directions on performing
the backup can be found in theBack Up the Camtasia Relay Database section of this document.

Restore Using SQL Server Management Studio
To restore a database backup file using SQL Server Management Studio:

1. Place the backup file in a folder on the database server that can be locally accessed by SQL Server.
2. Open SQL Server Management Studio.
3. Right-click the existing database or Databases (if restoring to a new database) and select Tasks >

Restore > Database.

4. Set the database name to restore. Select From Device and click… to select the backup file.
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5. Click Add to select the location of your database backup file. Click OK.

6. Set Restore options to overwrite the database (if applicable), restore files to correct path, and Leave
the database ready to use. Click OK.
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The database has been successfully restored.

More information on restoring databases from SQLServer Management Studio can be found here:
http://msdn.microsoft.com/en-us/library/ms177429.aspx

More information on how to Create a New Database From an Existing Database Backup can be found at:
http://msdn.microsoft.com/en-us/library/ms186390%28SQL.90%29.aspx

http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms177429.aspx
http://msdn.microsoft.com/en-us/library/ms186390(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms186390(SQL.90).aspx
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Restore Using a SQL Script
A restore from a backup file can be scripted for use in a SQL batch file, freehand execution via SQLQuery
Editor or sqlcmd, or use in an external application.

The following example script performs a database restore from a full backup of the Relay20 with the same
options listed in the previous sectionRestore Using SQL Server Management Studio.

RESTORE DATABASE Relay300

FROM DISK = 'C:\Program Files\Microsoft SQL

Server\MSSQL10_50.RELAY\MSSQL\Backup\Relay300.bak'

WITH REPLACE,

RECOVERY;

GO

Please refer to the earlier sectionBack Up Using the Command Line for more information on executing this
script with the sqlcmd utility.

More information on the RESTORE command can be found here: http://msdn.microsoft.com/en-
us/library/ms186858.aspx

Clean Up Old Databases
Before attempting the following procedure, SQL Server Management Studio should be installed on your
machine.

If you installed the Express Edition (default with the Camtasia Relay install), you can find this by vis-
iting the following URL and searching for “SQL Server Management Studio Express Edition”: http://ww-
w.microsoft.com
If you have a full version of SQL Server 2005 or 2008, you can install SQL Server Management Studio
from your SQL Server installation disc.

To clean up old databases

1. Back Up the Camtasia Relay Database.
2. Right-click the database you want to remove and chooseDelete.

http://msdn.microsoft.com/en-us/library/ms186858.aspx
http://msdn.microsoft.com/en-us/library/ms186858.aspx
http://www.microsoft.com/
http://www.microsoft.com/
http://www.microsoft.com/
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3. Make sure that Close existing connections is enabled and click OK.
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You do not receive a confirmation if the deletion succeeds.

Troubleshooting

On rare occasions, enabling Close existing connections does not close all of the open connections to the
database and the deletion fails. If this happens, the database shows in the list with (Single User) next to it.

When this happens, it’s because the Camtasia Relay website is holding a connection to the SQL Server in
order to help it cache data.

If this occurs, stop the website in IIS. Doing so closes the open connection, and you can then delete the
database.

Encodings
Each encoding type specifies a file format and aspect ratio that the presentation is encoded to on the
Camtasia Relay server.

See also:
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Encoding Types
Encoding Sizes and Aspect Ratios

Encoding Types

Preset Format
Includes
Camera
PIP?

Description

AVI (Original
Size) AVI Yes

This encode setting produces a single AVI file
with the same resolution as the original record-
ing. Use this file if you want to perform your own
video processing and encoding. Note that AVI
files usually have a larger file size than pre-
sentations encoded in other formats.

Camtasia Studio
Recording

(Original size)
CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio versions 5.1 to
7.1. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia Studio
8.0 and Later
Recording

(Original size)

CAMREC Yes

This encode setting generates a CAMREC file
for use with Camtasia Studio version 8.0 and
later. The CAMREC file contains PowerPoint
and Keynote slide and title clip markers. This
encoding should only be given to presenters
with access to Camtasia Studio.

When publishing a CAMREC file to a location
with a valid web URL, the resulting notification
includes a “View” link. Because web servers do
not have aMIME type set up for CAMREC
files, the link leads to a 404 error page.

Camtasia for
Mac Recording

ZIP >
CMPROJ No

This encode setting generates a lossless video
file for editing within Camtasia for Mac. This
encoding should only be given to presenters
with access to Camtasia for Mac.

The resulting file is a ZIP file that, when opened
on aMac, automatically unzips into a directory.
The user can double-click that directory to
launch the CMPROJ in Camtasia for Mac.

iPad MP4 Yes This encode setting creates video files with var-
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Preset Format
Includes
Camera
PIP?

Description

ied final resolutions to provide the best viewing
experience for a given video on an iPad. The res-
olution is calculated to provide the best res-
olution to view the video at 10 frames per
second.

iPod and iPhone MP4 Yes

This encode setting works on all iPods and
iPhones that support video of any kind. The final
resolution of the video is fixed at 640 x 480.
Video looks good on all iPods and iPhones, but
does not look good if played in QuickTime on a
desktop computer.

MP3 MP3 No

This is an audio-only encode setting. The server
can process this encoding extremely fast, and
the resulting file size is small. This is a good
encode setting for those whomay want an
audio-only version of their presentation.

MP4with Smart
Player

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

MP4 Yes

This encode setting creates anMP4 video file
that is displayed in a Flash controller file (SWF)
called the TechSmith Smart Player. Additional
files are created to provide an HTML5 fallback
player in cases where Flash is not available.

The Smart Player plays great on desktop
browsers, on iPhones and iPads, and onmany
other mobile devices that support MP4 video.
The Smart Player supports a table of contents
based on the titles of slides in a PowerPoint or
Keynote presentation, as well as slide text, full
audio search, and captions (if enabled).

MP4 (Original
Size) MP4 Yes

This encode setting creates anMP4 video file
with no additional files. The file is the same
dimensions as the original recording.

Original Record-
ing (Backup)

AVI
(Windows)

MOV
(Macintosh)

Recording
and cam-
era video
are save
as two
separate
files

This encode setting does not modify the original
recorded file in any way. The file size is enor-
mous and usually not considered viewer-
friendly. Use this setting if you need a copy of
original files for backup purposes or trou-
bleshooting.

Real Media RMVB No Generates a Real Media file. Can be used in
conjunction with Real Media servers, such as a
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Preset Format
Includes
Camera
PIP?

Description

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

Helix Server.

Silverlight

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

XAP Yes

This encode setting creates video files that play
in Microsoft Silverlight. The controller supports
a table of contents based on the titles of slides
in a PowerPoint or Keynote presentation.

Also supports searching slide text, full audio
search, and captions, if enabled.

Windows Media

(Small)
640x480
(Medium)
800x600
(Large)
1024x768

(Original
Size)

WMV Yes

This encode setting creates video files that play
inWindows Media Player. The video files tend
to be larger than the Flash and Silverlight encod-
ings, but may be preferred by Windows users
with high speed internet access.

Windows Port-
able Media
Device

WMV No
This encoding is designed to provide the best
solution forWindows Mobile Devices (Pocket
PCs) and someWindows-based Smartphones.

YouTube MP4 Yes

This encoding is only available
for the YouTube publish
destination.

This is used for publishing directly to YouTube
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Preset Format
Includes
Camera
PIP?

Description

using the YouTube publishing plug-in.

The video is subject to YouTube's restrictions.

Encoding Sizes and Aspect Ratios
What Do Small, Medium, and Large Really Mean?

The Flash, Silverlight, Windows Media, and Real Media output have various resolutions available to each of
them that are labeled Small, Medium, and Large. What do these resolutions mean? These resolutions are
adaptive in that they will automatically adjust to the aspect ratio of the recorded resolution.

The following images show examples of each of these aspect ratios.

Example Resolution Examples

640x480
800x600
1024x768
1152x864
1280x960
1600x1200

1280x800
1440x900
1680x1050
1920x1200
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Example Resolution Examples

1280x720
1360x768
1600x900
1920x1080

1280x768

1280x1024

The output resolutions match the aspect ratios of incoming video when using these Small, Medium, and Large
adaptive resolutions. Not all resolutions can be adaptive. The following encodings must be formatted with
specific aspect ratios: iPod and iPhone output, Windows Portable Media output, and the YouTube output. For
the adaptive ratios the following resolutions are used.
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Recorded Aspect Ratio Encoding Type Output Size

4x3 Small 640x480

Medium 800x600

Large 1024x768

16x10 Small 640x400

Medium 800x500

Large 1024x640

15x9 Small 640x384

Medium 800x480

Large 1024x616

5x4 Small 640x512

Medium 800x640

Large 1024x820
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Camtasia Relay Integrations
The following subsections outline the various integrations that can bemade with Camtasia Relay.

Camtasia Studio and Camtasia for Mac Inte-
gration
See the Camtasia Integration PDF found on the Camtasia Relay documentation page on the TechSmith
website (http://www.techsmith.com/tutorials-camtasia-relay-documentation.html).

LDAP Integration
This section describes how Camtasia Relay works with LDAP.

Camtasia Relay LDAP Background
Camtasia Relay has the ability to use LDAP, Lightweight Directory Access Protocol, for authentication of its
users. The implementation within Camtasia Relay tries to follow the LDAPv3 standard as close as possible.

There are a few ways that the Camtasia Relay server can connect to an LDAP server. We allow basic
authentication andMicrosoft Negotiate authentication. When connecting with basic authentication,
credentials are sent over the network as clear text. Connections using Negotiate are both signed and sealed
by default, providing an SSL-like connection without the use of certificates. There currently is no way to turn
off the signing and sealing of a Negotiate connection. Both connection types can be used with SSL
certificates if your LDAP server supports LDAPS, also known as LDAP over SSL. When LDAPS is used, no
credentials are ever sent over the network as clear text.

In most cases, Negotiate will be the authenticationmethod of choice for organizations that use Active
Directory, whereas Basic authentication applies mostly to servers running OpenLDAP, Novell eDirectory, and
more.

Most LDAP setups will use one of two ports for connections: 389 for the default; 636 if SSL is used.

Connections aremade to the LDAP server within your network (example: ldap.example.com). A sample Base
Distinguished Name for this organization wouldmight be DC=example,DC=com. Connections aremade to
the Base Distinguished Name on the LDAP server that you are connecting to.

LDAP uses the analogy of forests and trees. When you are connecting to your Base Distinguished Name, you
can imagine you are connecting to one tree within the forest. Therefore, all users and objects that you query
will have to live within that tree.

Authentication Method and Workflow
Camtasia Relay’s LDAP support was designed to reduce the amount of work for administrators and
presenters. When using Camtasia Relay to authenticate with your LDAP store, there are two connections
made. The first connectionmade to the LDAP server is to ask for the user’s distinguished name. A
distinguished name is a unique namewithin the LDAP server that represents the user/object. The
distinguished name is then used in combination with the provided password to authenticate against the LDAP
store.

In themajority of cases with Negotiate authentication, the distinguished name is the same as the username
that is provided. In this case, Camtasia Relay still makes a connection to search for the user before
authenticating to determine if the user exists within the LDAP store before authenticating. This is done to

http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
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provide better error messages for the administrator. The presenter will not see a different message whether
their account exists or not.

Once a distinguished name for a user is retrieved from the LDAP server, it is saved locally in the Camtasia
Relay database. This reduces the need to search for the user’s distinguished name at every subsequent
authentication request. In the event that a user’s distinguished name changes, Camtasia Relay will update its
local copy of the distinguished namewhen the next authentication request is processed.

After an authentication request is complete, the connection to the LDAP server is closed.

Certificate Handling
When setting up Camtasia Relay, there is the option to use secure authentication (SSL) for securing the
connection between the Camtasia Relay server and the LDAP server, often called LDAPS. SSL certificates
provide two basic functions for securing a connection. First, the LDAP server can be authenticated and
trusted to be the LDAP server that the Camtasia Relay was expecting to communicate with. Second, the
communication between the Camtasia Relay server and the LDAP server will be encrypted and only these
two servers can understand themessages sent back and forth.

When using LDAPS, the certificate is verified before a successful connection can bemade. In the event that
the certificate could not be verified, a detailed error message will be shown explaining what may be causing
the certificate handshake to fail.

One of themost common error messages seen will be that of a root certificate that is not trusted, most likely
stemming from the use of a self-signed certificate. To solve this, the root certificate can be imported to the
Camtasia Relay server’s computer account Certificate Store in the Trusted Root Certificate Authority. The
public certificate of the LDAP server may need to be obtained from your organizations LDAP administrator to
perform this step.

If the errors found during verification of the certificate cannot be fixed, then the Camtasia Relay administrator
may elect to “Trust all certificates”. This feature removes one of the two functions of SSL authentication.
Communication between the two servers will stay encrypted but it will no longer be guaranteed that you are
communicating with the LDAP server you intended.

Adjust Search Depth Scope
Depending on your LDAP tree, youmay find it useful to limit how Camtasia Relay searches you LDAP tree for
users. By default, Camtasia Relay will search the entire tree starting at and including the specified Base DN.
Alternatively, Camtasia Relay can limit its search to searching one level deep into the Base DN, but not the
Base DN itself. In order to change the search scope:

1. Go to RelayConfig.aspx.
2. Locate the LDAP Configuration section.
3. Select the appropriate LDAP Search Depth Scope value from the dropdown list:

Subtree: Search the Base DN and all child objects.
One Level Deep: Search the child objects of the Basn DN, but not the Base DN itself.

Error Message Details
There are two times that LDAP errors may be seen: during the configuration of Camtasia Relay LDAP
authentication and post-configuration. Most errors messages are written to provide enough help within the
actual error message to provide a way for the Camtasia Relay administrator to repair the error. The following
are error messages that may be seen and require longer explanation for causes.

Invalid username and/or password. Please correct the credentials, verify the selected authentication
method is correct, and try again.
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If this error text is seen on the first step of the LDAP setup wizard, the user that is specified by the user-
name/distinguished name field may not have been found. If there is no username/distinguished name
entered in those fields, theremay be one required by the LDAP server in order to connect. This is com-
monly referred to as an LDAP server that does not allow anonymous connections/queries.
The system was unable to verify your credentials with the authentication system. Please try again.
If this error text is seen on the login page for the Camtasia Relay website, then there was a problem
connecting from the Camtasia Relay server to the LDAP server. This does not mean that the user-
name/password combination is invalid. The LDAP configuration within Camtasia Relay may have not
been configured correctly, or the LDAP server may be offline.
There was a problem browsing the directory tree. Youmay continue to import Users by searching for
them.
If this error text is seen on the Import LDAP User page, then there was a problem connecting to, or trav-
ersing the LDAP tree. The LDAP configuration within Camtasia Relay may have not been configured
correctly, or the LDAP server may be offline.

RelayPresenter Service Account
Prior to configuring Camtasia Relay to work with LDAP, we recommend creating a “RelayPresenter” service
account in your LDAP directory and associate this account when you bind credentials in LDAP. Use this
account to perform the initial step in authenticating users.

When a user tries to authenticate over LDAP, Camtasia Relay uses this “RelayPresenter” user to search the
LDAP directory and retrieve the user’s qualified domain name. The user’s qualified domain name is given to
the LDAP directory along with their password for authentication.

Camtasia Relay never stores LDAP passwords with the exception of the password of this service account.

The service account should have a password that does not expire. Camtasia Relay
authentication will cease to function for all LDAP users, if the password of the service account
in LDAP is not the same as the password stored in the Camtasia Relay database.
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Advanced Configuration

The configuration options and tips and tricks found in this section are not officially supported
by TechSmith Corporation. These configuration options are provided to give some added
flexibility to customers but are NOT features of Camtasia Relay and therefore are not
supported by TechSmith. Before youmodify any website files, make a backup of the originals
as indicated. The TechSmith support staff cannot provide assistance with these procedures.
Also, the Camtasia Relay server website can and will likely change in upcoming versions.
Make sure to backup your customizations before applying any updates to your Camtasia
Relay system.

More Accurate Transcription
This section contains information on how to help the accuracy of the transcription of presentation audio for use
in full audio search of Flash and Silverlight encodings and XML files.

Audio Quality Considerations
Our testing has shown that the best transcriptions occur when:

The presenter speaks naturally
The signal quality is good (i.e. the recording is not overly noisy)
The recording is not overly loud to the point of distortion

The last point is particularly important.

The transcriber can transcribe quiet audio with only a small decrease in accuracy, but if the recording distorts
because it is too loud (i.e. the audiometer in the Camtasia Relay recorder is in the red), transcription accuracy
drops dramatically.

Language Models
When transcribing, Camtasia Relay uses a “base languagemodel” which was created using news
broadcasts. As it transcribes new audio files, it compares the sounds in the audio file against the phrases that
it knows in the base languagemodel. It uses those comparisons to create the transcribed text.

Custom Language Models

Since the base languagemodel does not anticipate phrases that are not typically used in a news broadcast,
Camtasia Relay also builds a custom languagemodel for each presenter.

These custom languagemodels come from the slide content sent alongside presentations. If a presenter
plays a slideshow in Powerpoint or Keynote while recording their presentation, the text on the slides (including
the invisible “notes” on the slides) will be used to build the custom languagemodel. This means that
presenters with slides that contain the samewords that they speak in their presentation enjoy increased
transcription accuracy.

Captions edited and saved though Relay's caption editor are also saved on the server to help aid future
transcriptions.

Camtasia Relay also keeps the custom languagemodel for a presenter on its server so that subsequent
presentations also gain the benefits of the slides sent with prior presentations.
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How Presenters Can Help

A presenter – if they want to go that far - can build a custom languagemodel for themselves by typing up a
literal transcription of a presentation that they have previously done and sending it to Camtasia Relay in the
form of slideshow text. Camtasia Relay will then have amodel of their speech patterns for subsequent
presentations.

The transcriber works based on predicting the phrases that a presenter is likely to say.
“Teaching” the transcriber by having presenters read a canned presentation only serves to
increase the likelihood that the phrases in the canned presentation are transcribed accurately.

How Administrators Can Help

Administrators can assist the transcription process on a per-user basis by copying files into the users’
directories in the server’s LanguageModelCache directory, which resides inside the server’s Media directory.
Camtasia Relay stores the text that assists the languagemodel builder in this directory.

Administrators with access to the server canmove an ASCII or UTF-8 encoded text file into a user’s
subdirectory within the LanguageModelCache directory and the languagemodel builder will consume that text
when it transcribes presentations for that user. To seed all of the users at once, files may be placed in the
AllUsers directory which is locacted under the LanguageModelCache directory.

If you havemultiple Relay Servers in a teamed configuration, this step needs to be performed
on each of the servers separately.

The users’ subdirectories do not have to be created by the transcription process. If you know
what a user’s ID is, you can assist their presentation transcriptions “in advance” by creating a
subdirectory for them andmoving text files with pertinent text into it.

Configuring Automatic Redirects to the Cam-
tasia Relay Website
WhenCamtasia Relay is installed on a server, it is strongly encouraged that it be the only website on the
server. If it is the only website on a server, you can configure the server so that the user may visit the site
URL and be redirected to the Camtasia Relay website.

Example

On the TechSmith RelayDev05 server1, visiting http://relaydev05.techsmith.com with a web browser shows
the following page:

1This server is not available outside of the TechSmith network.
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Making the changes shown in the following instructions results in a URL like http://relaydev05.techsmith.com
being automatically redirected to http://relaydev05.techsmith.com/Relay to show the Camtasia Relay
website.

IIS 7 Instructions (Windows Server 2008)
Official instructions for creating a website redirection in IIS7 can be found at:
http://technet.microsoft.com/en-us/library/cc732930%28WS.10%29.aspx

Official instructions for enabling HTTP Redirection capability in IIS7 can be found at:
http://www.iis.net/ConfigReference/system.webServer/httpRedirect

The ability to create an HTTP Redirection is not installed by default for IIS7. If you do not see the option
available in the IIS Manager, follow the instructions in the link shown above.

1. Open the IIS Manager.
2. Select the website that contains the Camtasia Relay virtual directory.
3. Click HTTP Redirect.

http://technet.microsoft.com/en-us/library/cc732930(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc732930(WS.10).aspx
http://www.iis.net/ConfigReference/system.webServer/httpRedirect
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4. Click Redirect requests to this destination.
5. Type the name of the Camtasia Relay virtual directory subdirectory: /Relay
6. Click Only redirect requests to content in this directory (not subdirectories).
7. Click Apply.
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8. Test the redirect in a web-browser after making these changes by visiting the Fully Qualified Domain
Name of the system.

IIS 6 Instructions (Windows Server 2003)
Official instructions for creating a website redirection in IIS6 can be found at:
http://technet.microsoft.com/en-us/library/cc736641%28WS.10%29.aspx

Instructions

1. Open the IIS Manager.
2. Right-click the website that contains the Camtasia Relay virtual directory.
3. Click Properties.

http://technet.microsoft.com/en-us/library/cc736641(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc736641(WS.10).aspx
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4. Click A redirection to a URL.
5. Type the name of the Camtasia Relay virtual directory (/Relay) into the Redirect to textbox.
6. Click A directory below URL entered.
7. Click theOK button.
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8. Test the redirect in a web-browser after making these changes by visiting the Fully Qualified Domain
Name of the system.

Custom Bumper Videos
During the Camtasia Relay trial, a 5-second “bumper video” is added to both the beginning and end of the
presentations to indicate the server is in a trial mode.

Some customers have requested the ability to append their own videos to the beginning and end of
presentations after purchase. While this is currently not a supported feature, you can add bumper videos,
provided that the following conditions are acknowledged:

The video will be added at both the beginning AND end of all presentations.
Only one video can be used for ALL presentations sent through the system.
The bumpers are ALWAYS applied. There is no option to not apply the bumper video.
Bumper videos should be at least 5 seconds long.

If all of those options are acceptable and you wish to “brand” your videos with a bumper video:

1. Create a bumper video that uses TechSmith TSC2 codec. The videomust be 15fps and be in AVI
format.

You can use Camtasia Studio from TechSmith to create and export in this format.
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2. Export the video into 4 different resolutions: 320x240, 640x480, 800x600, and 1024x768.
3. Go to [install dir]\TechSmith\Relay Server\Manager\ and create a new folder called bumpervideos.
4. Copy the following default bumper videos into the new folder:

320trialmode.avi

640trialmode.avi

800trialmode.avi

1024trialmode.avi

5. Copy your videos over the bumper videos using the respective naming.
6. Run the following SQL statement against the Relay database.

INSERT INTO Relay412.dbo.tblConfig (confName, confValue,

createdOn, createdByUser, modifiedOn, modifiedByUser,

modifiedByModule, modificationCount)

VALUES('UseBumperVideos', 'True', GETDATE(), 'Original

Record', GETDATE(), 'Original Record', 'Original Record', 0)

Formore information, seeRunning SQL Statements .

7. Send a sample presentation through the system to ensure the bumper videos are added correctly.

HTML Container Customizations

Be sure tomake backups of all files before youmake any edits. If these files are corrupted in
any way, this can cause yourWebOutputs to fail. Also take special care whenmodifying the
Flash or Silverlight object code in the html.

The following files are the HTML containers for both the Silverlight/WMV output and the Flash/MP4 output.
These HTML containers can bemodified if there is a consistent look and feel that you want to follow with
these containers.

[installdir]\TechSmith\Relay Server\Manager\Media\silverlight_

index.html

[installdir]\TechSmith\Relay Server\Manager\Media\swf_flv_

index.html

HTML Container Variables
In the files mentioned above, there are a few variables that get used to refer to some strings that the server
uses whenmaking replacements in the code. It replaces these variables with their string equivalents:

$MovieName is replaced with themovie name
$MovieWidth is replaced with themovie width
$MovieHeight is replaced with themovie height
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Example
If you wanted to provide a download link at the bottom of the page to the source video you could include the
following code before the </body> tag:

Flash

<div><a href="$MovieName.mp4" style=”color: #fff;”>Click here to

download this video.</a></div>

Silverlight

<div><a href="$MovieName.wmv" style=”color: #fff;”>Click here to

download this video.</a></div>

Branding the Camtasia Relay Website
Branding the Camtasia Relay website requires some basic knowledge of Cascading Style Sheets. This
document outlines some of themost important styles that can be overwritten for the website to be branded
according to your needs.

The Process
Re-branding the Camtasia Relay involves the following steps.

1. Create the following directory and copy the graphics you would like to use into the directory.

[install dir]\TechSmith\Relay Server\Web\App_

Themes\Standard\8_CustomStyles\images

2. Make a copy of the following file and directory andmove the file copy to the directory.

[install dir]\TechSmith\Relay Server\Web\App_

Themes\Standard\8_CustomStyles\custom.css

[install dir]\TechSmith\Relay Server\backups\

3. Edit the following file to point to the new graphics.

[install dir]\TechSmith\Relay Server\Web\App_

Themes\Standard\8_CustomStyles\custom.css

4. Review the changes.

The CSS Properties
The following properties are those that you will likely need or want to change tomake thesemodifications.
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background-image: url(‘images/image.png’);

background-position: top left;

background-color: #eee;

width: 200px;

height: 50px;

top: 5px;

right: 10px;

bottom: 0px;

left: 20px;

The Styles
Header Logo

The logo in the header can bemodified to include your own logo.

#layout_logo

{

width: 229px;

height: 44px;

position: absolute;

background: url('../images/sprites/relay.sprite.1.2.0.png') no-

repeat -36px -2px;

left: 0px;
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top: 13px;

}

It is recommended that you keep the image height of 55 pixels or

less so as not to stretch out the header.

Footer

The footer can bemodified to include additional content. TechSmith does however highly recommend that you
not change or affect the product information in the lower right corner.

#footer

{

color: #777777;

font-size: 0.75em;

height: 40px;

line-height: 0.8em;

margin-bottom: 15px;

padding-right: 5px;

padding-top: 9px;

text-align: right;

}

It is recommended that you keep footer graphics under 30 pixels tall.
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Login Page

The login page is primarily one large background graphic. To change the look of this page youmay wish to
start with the graphic andmake necessary modifications to it, and then save a copy of it into your images
directory as a replacement.

#login_area

{

background-image: url(../Images/Layout/login_page.png);

background-position: left top;

background-repeat: no-repeat;

height: 400px;

position: relative;

width: 980px;

}

The #greenbar element may also require modification.
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Recorder Download Page

.largeRelayText

{

background-image: url(../images/layout/large_relay_text.png);

background-repeat: no-repeat;

height: 77px;

margin-left: 20px;

margin-right: 50px;

width: 409px;

}

CSS Resources and Tools

W3Schools.com

http://www.w3schools.com/default.asp

Free resource that can help you learn various web programming languages
like CSS. To better understand the properties listed in the “CSS Properties”
section, please refer to this website.

Firebug Add-on
for Firefox

http://getfirebug.com/

Can help you easily determine which of the stylesheets that Camtasia Relay
uses, or which style, is causing the behavior you view in the website. It allows
you view overriding CSS values without actually modifying the files.

http://www.w3schools.com/default.asp
http://getfirebug.com/
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Sample Configuration CSS File

/*

All of the following styles were created for the purposes of

branding the Camtasia Relay website. The images for these styles

are stored in the following directory...

c:\Program Files\TechSmith\Relay Server\Web\App_Themes\Standard\8_

CustomStyles\images

*/

/* Replace the Logo in the header with one that fits the

institution */

#layout_logo

{

background-image: url('images/logo.png');

background-position: top left;

width: 350px;

height: 55px;

top: 8px;

}

/* Make some small changes on the login page to add recognizable

institution graphics */

#login_area

{

background-image: url('images/login.png');*/

}

/* Make a change to the graphic on the recorders download

page */

.largeRelayText

{
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background-image: url('images/largelogo.png');

background-repeat: no-repeat;

width: 335px;

height: 520px;

margin-left: 20px;

margin-right: 50px;

}

/* Add a small graphic to the footer */

#footer

{

background-image: url('images/smalllogo.png');

background-position: top left;

background-repeat: no-repeat;

height: 30px;

}

MIME Types on Servers
MIME types (Internet media types) are how file formats are identified on the Internet. Your web browser uses
theseMIME types to be able to use file formats that are not HTML. A media type is has two parts: a type and
a subtype. Types can be application, audio, image, message, model, multipart, text. The Subtype are the
extensions such as for type image the subtype is jpeg (image/jpeg) or for type audio a subtype is MP4
(audio/MP4). TheMIME types that your server can provide are set by IIS or Apache not inside Relay.

List of available MIME types from IANA:

http://www.iana.org/assignments/media-types

The hosting of the Camtasia Relay generated outputs is not a function of the Camtasia Relay
server. These instructions are provided to help administrators make these changes on the
media server. This should not be the samemachine as the Camtasia Relay server.

http://www.iana.org/assignments/media-types
http://www.iana.org/assignments/media-types
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IIS

MIME types in IIS (reference list of MIME types on bottom of page):

http://technet.microsoft.com/en-us/library/bb742440.aspx

How to add aMIME type in IIS 7.0:

http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx

How to add aMIME type in IIS 6.0:

http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx

Apache

ApacheMIME Module:

http://httpd.apache.org/docs/2.2/mod/mod_mime.html

In Apache the server is based on configuration files you can either specify these in themain configuration file
or you can create a secondary file that hold all your MIME types separately by putting a “TypesConfig”
Directive in themain configuration file. The TypesConfig Directive accepts a file path which contains a
configuration file of MIME types.

To specify the file path for theMIME configuration file:

TypesConfig file-path

To addMIME types to your configuration files you need too add them in the format:

AddType [MIME-type extension] [extension]

EXAMPLE

AddType mp4 video/mp4

Once you have updated your configuration files you can check tomake sure all your configuration is working
properly before restarting apache and implementing the configuration by:

Apachectl configtest

or

httpd –t

http://technet.microsoft.com/en-us/library/bb742440.aspx
http://technet.microsoft.com/en-us/library/bb742440.aspx
http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc786786(WS.10).aspx
http://httpd.apache.org/docs/2.2/mod/mod_mime.html
http://httpd.apache.org/docs/2.2/mod/mod_mime.html
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XML and CONFIG Files on the Server
The following list shows the paths and descriptions of the .XML and .CONFIG files on the Camtasia Relay
server.

Web Log File Modifications

C:\Program Files\TechSmith\Relay Server\Web\web.log4net.config

Sets the logging levels for the Relay AdministrationWebsite. Logs, by default go to
<RelayInstallDir>\Logs but they may be configured to go to a different directory.

<file value="C:\Program Files\TechSmith\Relay

Server\Logs\WebDebug.log"/>

<file value="C:\Program Files\TechSmith\Relay

Server\Logs\WebError.log"/>

By default, 10 logfiles each aremaintained for web debugging and web errors. Each logfile can contain
up to 10Megabytes of data before a new logfile is started. Once the 11th logfile is begun, the oldest
logfile is automatically deleted from the system. To change these values and retain more or less data,
use these settings (note that the settings for debug logging and error logging can be set independently):

<maximumFileSize value="10MB"/>

<maxSizeRollBackups value="9"/>

By default debug logging is turned off, and only errors are written there. Generally, when website errors
are written to these files, they are also written to the server’s Event Log. However, these logs generally
contain more information than the terse event log entries do. Customers may opt to enable debug
logging by changing the file like so:

<appender-ref ref="DebugAppender"/>

<appender-ref ref="ErrorAppender"/>

Note that doing this has shown to degrade system performance, particularly in the area of disk I/O.
Changes to the logging settings are dynamic and take effect immediately without restart of any
services or the server.

Database Connection Information -Website

C:\Program Files\TechSmith\Relay Server\Web\web.config

Information contained in this file is pertinent to the Relay AdministrationWebsite. Generally customers
should not need tomodify this file. One piece of information that may be of interest to customers is the
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Relay Database Connection string. Please see the “Migrating from one SQL Server to Another” section
for more information:

<connectionStrings>

<add name="RelayConnectionString"

connectionString="Data Source=server\RELAY; Initial

Catalog=Relay20; User Id=Relay;

Password=RelayPassword Pooling=True;" />

</connectionStrings>

Database Connection Information –Manager Service

C:\Program Files\TechSmith\Relay Server\Manager\data.config

This file contains the database connection string that the Relay Manager Service uses to communicate
to the database. The transcriber, encoder, publisher, and notifier processes also utilize this connection
string. If the connection string is changed in this file, it must also be changed in the website’s
web.config file as well. Please see the “Migrating from one SQL Server to Another” section for more
information.

<add name="RelayConnectionString" connectionString="Data

Source=server\RELAY; Initial Catalog=Relay20; User Id=Relay;

Password=RelayPasswd Pooling=True;"/>

Server Endpoint Information

C:\Program Files\TechSmith\Relay

Server\Manager\endpoint.config

The data in this file associates a particular Camtasia Relay server instance with a row in the endpoint
table in the database. Customers typically will not need tomodify this file.

C:\Program Files\TechSmith\Relay

Server\Manager\manager.log4net.config

Sets the logging levels for the Relay Manager Service. Logs, by default go to <RelayInstallDir>\Logs
but they may be configured to go to a different directory.

<file value="C:\Program Files\TechSmith\Relay

Server\Logs\ManagerDebug.log"/>

<file value="C:\Program Files\TechSmith\Relay

Server\Logs\ManagerError.log"/>
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By default, 10 logfiles each aremaintained for manager service debugging andmanager service errors.
Each logfile can contain up to 10megabytes of data before a new logfile is started. Once the 11th
logfile is begun, the oldest logfile is automatically deleted from the system. To change these values
and retain more or less data, use these settings (note that the settings for debug logging and error
logging can be set independently):

<maximumFileSize value="10MB"/>

<maxSizeRollBackups value="9"/>

By default debug logging is turned off, and only errors are written there. Generally, whenmanager
service errors are written to these files, they are also written to the server’s Event Log. However, these
logs generally contain more information than the terse event log entries do. Customers may opt to
enable debug logging by changing the file like so:

<!--COMMENT THE FOLLOWING LINE TO TURN OFF DEBUG (VERBOSE)

LOGGING-->

<appender-ref ref="DebugAppender"/>

<appender-ref ref="ErrorAppender"/>

Note that doing this has shown to degrade system performance, particularly in the area of disk I/O.
Changes to the logging settings are dynamic and take effect immediately without restart of any
services or the server.

Manager Service Configuration File

C:\Program Files\TechSmith\Relay

Server\Manager\manager.exe.config

Information contained in this file is pertinent to the Relay Manager Service. Generally customers
should not need tomodify this file.

Notification Process Configuration File

C:\Program Files\TechSmith\Relay

Server\Manager\RelayNotifier.exe.config

Information contained in this file is pertinent to the Relay Notification Process. Generally customers
should not need tomodify this file.

Encoder Process Configuration File

C:\Program Files\TechSmith\Relay

Server\Manager\RelayEncoder.exe.config
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Information contained in this file is pertinent to the Relay Encoder Process. Generally customers
should not need tomodify this file.

Publisher Process Configuration File

C:\Program Files\TechSmith\Relay

Server\Manager\RelayPublisher.exe.config

Information contained in this file is pertinent to the Relay Publisher Process. Generally customers
should not need tomodify this file.

Transcriber Process Configuration File

C:\Program Files\TechSmith\Relay

Server\Manager\RelayTranscriber.exe.config

Information contained in this file is pertinent to the Relay Transcriber Process. Generally customers
should not need tomodify this file.
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Security
The Security of the Camtasia Relay system is an important topic worthy of its own guide. TheCamtasia
Relay Server Security Administrator Guide contains a large variety of security related topics such as

SSL
Reducing Attack Surface
Segregation of Duties
Strong Passwords
Server Hardening
Firewall Rules
And the various Security Features built into Camtasia Relay itself

A link to the Security guide and other resources can be found in theAppendix A: Additional Help and
Related Documentation.
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TechSmith Sales Support
For pre-sales activities, activation information, licensing information, and other sales related questions,
please call our Sales team.

The following information is available on the TechSmith website by clickingContact in the
upper right corner. Always refer to that location for latest, most accurate information.

Sales:+ 1.517.381.5901

Toll Free in the U.S. & Canada: 888.750.0685

Sales Contact Form: http://www.techsmith.com/about/salescontact.asp

http://www.techsmith.com/about/salescontact.asp
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Appendix A: Additional Help and Related
Documentation
Wehope you have found this Technical ReferenceGuide helpful, but it is only one of many help resources
available to you as a user of Camtasia Relay. The following are some additional resources for you as use the
Camtasia Relay product.

Feedback
If you would like to offer feedback on or suggestions of topics to cover in this or any other Camtasia Relay
documentation, please send an email to relayhelp@techsmith.com.

Camtasia Relay Website and Recorder Help
For day-to-day administration of Camtasia Relay, please see the Camtasia Relay Website Help. This help is
available after logging into the Camtasia Relay website as an administrator. Just click a Help link, available
on each web page, to open the Camtasia Relay Administrator Help.

For help with the Camtasia Relay recorder, please install and open the Camtasia Relay recorder or open the
portable recorder to access help for the recorder.

Related Documentation
The following PDF documents are available for download from the TechSmith website:

Camtasia Relay Installation Guide

Learn how to install the Camtasia Relay server.

Camtasia Relay UpgradeGuide

Learn how to upgrade Camtasia Relay.

Camtasia Relay AdministratorWebsite Help

Walk through the configuration of Camtasia Relay and find administration information to help you keep
Camtasia Relay running smoothly

Camtasia Relay Server Security Administrator Guide

Learn about ways to help secure your Camtasia Relay server.

Camtasia Relay Release Notes

See a summary of the new features and updates. Learn about how those features affect current users.

mailto:relayhelp@techsmith.com
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
http://www.techsmith.com/tutorials-camtasia-relay-documentation.html
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TechSmith Learning Center
The TechSmith Learning Center contains a wealth of free resources for each one of TechSmith’s products,
including Camtasia Relay. We encourage you to visit the site, choose the section that most interests you and
then watch a video or read an article.

The Camtasia Relay Learning Center is available at:

http://www.techsmith.com/tutorial-camtasia-relay.html

http://www.techsmith.com/tutorial-camtasia-relay.html
http://www.techsmith.com/tutorial-camtasia-relay.html
http://www.techsmith.com/tutorial-camtasia-relay.html
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Appendix B: Glossary
A
AVI

Audio Video Interleave, (AVI), is amultimedia format introduced by Microsoft.

Attack Surface

In a web environment, Attack Surface refers to those components that are available to
unauthenticated users.

Authentication

In a web environment, themethod designed to allow a browser or other program to provide a
user name and password as credentials whenmaking a request.

B
Blackboard

In the context of this manual, Blackboard refers to the Blackboard Application Suite of e-
learning software products from Blackboard, Inc.

Building Blocks

In the Blackboard Application Suite of software products, an extension to the standard suite that
can be separately installed.

C
Camrec

A multimedia format developed by TechSmith Corporation.

Camtasia Relay

A software product for lecture capture from TechSmith Corporation.

Camtasia Studio

A video recording and editing software product from TechSmith Corporation.

CAPTCHA

Acronym for "Completely Automated Public Turing test to tell Computers and Humans Apart”. A
type of “challenge-response” test in which a computer asks a user question to ensure that the
response is not being generated by a computer.

Certificate Authority or Certification Authority

A trusted third party entity such as VeriSign -- that issues digital certificates to be used as part
of a security plan.
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D
DMZ

Demilitarized Zone, also called DataManagement Zone, is a part of a network that contains and
exposes an organization's external services to a larger network, usually the Internet.

DTC

TheMicrosoft Distributed Transaction Coordinator (DTC orMSDTC) service is a component of
Microsoft Windows that coordinates transactions that spanmultiple resourcemanagers, such
as databases, message queues, and file systems.

Dynamic Port

One from a set of predefined private port numbers to be used for communications between
applications using the Internet's Transmission Control Protocol (TCP) or the User Datagram
Protocol (UDP).

E
Encode

In the context of this document, the process of converting amedia recording from one format
into another.

F
Firefox

An open source browser available fromMozilla Corporation.

Firewall

That part of a computer network designed to block unauthorized access while permitting
authorized communications.

Flash

A multimedia platform from Adobe Systems, Inc, Flash is often used to add animations and
video to web pages and rich internet applications.

FTP

File Transfer Protocol is a network protocol used to exchange files between computers or over
the internet.

G
Group ID or Media Group ID

A 10-digit number used iTunes U to direct producedmedia to a specific instructor’s class.

I
IIS
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Internet Information Services fromMicrosoft, Corporation is a set of internet-based services
used within Microsoft Windows and including FTP, FTPS, SMTP, NNTP and HTTP/HTTPS.

iPod

A brand of portable media player designed andmarketed by Apple Corporation.

IPSec

Internet Protocol Security is a suite protocols for securing communications on the Internet.

J
Jing

A software product from TechSmith Corporation for capturing screen and video images.

K
Keynote

In the context of this document, a software product for creating and producing presentations
from Apple Corporation.

KMS

Key Management Service fromMicrosoft Corporation is used to activate computers running
Windows Vista, Windows 7, andWindows Server 2008.

L
LDAP

Lightweight Directory Access Protocol is an application protocol for querying andmonitoring
directory services running over TCP/IP.

LDAPS

Lightweight Directory Access Protocol implemented over a Secure Sockets Layer (SSL).

Leopard

The code name version 10.5 of the operating systemMac OS X from Apple Corporation.

M
M4A

An alternate file extension tag (to MP4) for MPEG-4 files.

M4V

An alternate file extension tag (to MP4).

Media Group ID

A 10-digit number used iTunes U to direct producedmedia to a specific instructor’s class.

Morae
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Usability testing software from TechSmith Corporation.

MOV

A multimedia format originally based on theQuickTime format from Apple Corporation.

MPEG

Moving Picture Experts Group a group formed by the International Organization for
Standardization (ISO) to set standards for audio and video compression and transmission.

MP3

A patented digital audio encoding format.

MP4 or MPEG-4

A multimedia container format originally based on theQuickTime format from Apple
Corporation.

P
PDF

A file format created by Adobe Systems for document exchange.

Port 443

The default port used by HTTPS (Hypertext Transfer Protocol Secure).

Port 80

The default port used by HTTP (Hypertext Transfer Protocol).

Portable Recorder

In the context of this document, one of the options for using the Record portion of the Camtasia
Relay lecture capture software product. Instead of installing the Record software on a
computer, it can be loaded on to a portable device, such as a thumb drive.

PowerPoint

Software for creating and producing presentations fromMicrosoft Corporation.

Presenter Account

In the context of this document, an account within the Screencast media-hosting site from
TechSmith Corporation to be used by people recording presentations using the software product
Camtasia Relay.

Production Preset

Within the lecture capture software product Camtasia Relay, the ability to specify recording
settings prior to making the recording.

Profile for Camtasia Relay

Within the lecture capture software product Camtasia Relay, a profile is used to specify
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publishing formats and destinations for presentations that are submitted for processing.

Publish Destination

Within the lecture capture software product Camtasia Relay, the destination that will hold the
processed lecture including FTP servers, network drives (File system) iTunes U, and
TechSmith’s media-hosting site, Screencast.com.

R
Real Media

A multimedia container format created by RealNetworks.

S
Safari

A web browser that runs on computers from Apple Corporation.

Screencast.com

A media hosting site owned and operated by TechSmith Corporation.

ScreenDraw

In software products from TechSmith Corporation, the feature that allows the user to use the
cursor to make freehand drawings on an image.

SCW or Security Configuration Wizard

A software component inWindows Server 2003 SP1 fromMicrosoft Corporation used to
configure server security.

Self-Signed Certificate

In computer security, an identity certificate that is signed by its own creator as being legitimate.

sFTP

In computer security, Secure File Transfer Protocol (sFTP) refers to the practice of running
normal FTP over secure shell connections.

Shared Secret

In cryptography, a piece of information known only to the two parties involved in a secure
communication.

SmartFocus

A tool within software products developed by TechSmith Corporation to intelligently zoom into
specific areas of an image during screen capture.

SMTP

SimpleMail Transfer Protocol is an Internet standard for electronic mail transmission across
Internet Protocol networks.

Snagit
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A screen capture program developed by TechSmith Corporation.

Snow Leopard

The code name for version 10.6 of the operating systemMac OS X from Apple Corporation.

SPI or Stateful Packet Inspection

A firewall that keeps track of the state of network connections traveling across it -- including as
TCP streams and UDP communication.

SQL Server

Microsoft SQL Server is a relational model database server produced by Microsoft.

SSL or Secure Sockets Layer

(Replaced by Transport Layer Security (TLS)) A cryptographic protocol that provides security
for communications over networks such as the Internet.

Stateful Packet Inspection

A firewall that keeps track of the state of network connections traveling across it -- including as
TCP streams and UDP communication.

T
TCP

Transmission Control Protocol is one of the core protocols of the Internet protocol suite.

TLS or Transport Layer Security

A cryptographic protocol that provides security for communications over networks such as the
Internet.

U
UDP

User Defined Protocol is part of the set of network protocols used to transmit information over
the internet.

Uploader

The part of Camtasia Relay that transfers a completed lecture from the recorder to the server.

W
WAF

A web application firewall (WAF) is an appliance, server plugin, or filter that applies a set of
rules to an HTTP conversation.

WebDAV or Web-based Distributed Authoring and Versioning

A set of extensions to the Hypertext Transfer Protocol (HTTP) that allows users to edit and
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manage files collaboratively on remoteWorldWideWeb servers.

Windows Media Video or WMV

A proprietary compressed video format developed by Microsoft.

Windows Portable Media Device

A class of portable media devices that integrate directly withWindows Media Player.

WMV or Windows Media Video

A proprietary compressed video format developed by Microsoft.

X
XML or Extensible Markup Language

A set of rules for encoding documents electronically.

Y
YouTube

A video sharing website where users can upload and share videos.

TechSmith Tech Support
In the event you have an issue that cannot be answered with the Camtasia Relay Help and documentation,
please follow the steps below when working with TechSmith Tech Support.

Step 1: Knowledge Base Search

Before contacting TechSmith for Technical Support, pleasemake sure to search the Knowledge Base on the
Support Center (http://support.techsmith.com). It is possible that the issue is a known issue and there is
already an answer available.

Before running a search, select Camtasia Relay and the version number in the dropdown lists.

Step 2: Submit a Question

If you are unable to find an answer to your issue, you can send a question to Tech Support.

1. On the Support Center page (http://support.techsmith.com), click Ask a Question.

2. Fill in the requested information, making sure to select your current Product Version, Operating
System, and Problem Type.

For a question regarding a program error, please select Other under Problem Type.

3. If you are a first-time user, you are prompted to create a user account.

Tips for Submitting a Question

When opening a support ticket, please include as much information regarding the nature of the problem
as possible.

http://support.techsmith.com/
http://support.techsmith.com/
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To speed up the debugging process, attach one or more of the following to the support ticket:
Screenshots
Application logs
Other diagnostic information
Event Viewer logs

These are particularly useful. The steps inHow to Export Event Viewer Logs explain how to
export the logs for Camtasia Relay components.

Step 3: Call Tech Support

The Camtasia Relay Tech Support team is ready and waiting for your questions. Should you have problems
that you cannot solve using the resources provided, please give us a call and wewill be happy to assist.

The following information is available on the TechSmith website by clicking Company >
Contact Us. Always refer to that location for latest, most accurate information.

Phone: +1.517.381.2300 (ext. 784)

Toll Free in the U.S. & Canada: 800.517.3001 (ext. 784)

Tech Support Website: http://support.techsmith.com

Running SQL Statements

During calls with TechSmith Technical Support or additional configuration of the system, it may be necessary
to run Transact SQL (T SQL) statements against this database.

To do this, we recommend the following:

1. Install SQL Server Management Studio Express.

If you installed the Express Edition (default with the Camtasia Relay install), you can find this
by visiting the following URL and searching for “SQL Server Management Studio Express
Edition”:

http://www.microsoft.com

If you have a full version of SQL Server 2005 or 2008, you can install SQL Server Management
Studio from your SQL Server installation disc.

Camtasia Relay supports SQL Server Management Studio Express 2005 SP2
or 2008 SP1. Management Studio can be setup and attached for local or remote
management (depending on network andmachine settings) of the relay
database.

2. Connect to the database either using SQL Server Authentication orWindows Authentication.

The authenticationmethod largely depends on how the SQL Server was configured. Your Relay
instance will have a login of “Relay” and a password that was supplied during the installation of
Camtasia Relay.

http://support.techsmith.com/
http://www.microsoft.com/


Camtasia Relay Technical ReferenceGuide

www.techsmith.com - 134 -

3. Click the “New Query” button to open a new query.
4. Make sure you select the correct Camtasia Relay database from the database dropdown list.

5. Type or paste the SQL statement into the window that then hit Execute or press the F5 key.
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Introduction
The purpose of this guide is to help Camtasia Relay administrators securely deploy andmanage Camtasia
Relay within their organization’s network environment. The target audience for this guide is Camtasia Relay
administrators whomanage the server environment in which Camtasia Relay is hosted but also desire some
assistance inmaking these servers more secure.

This guide provides high-level guidance for hardeningWindows Server, IIS, SQL Server, and Camtasia Relay
so the environment hosting Camtasia Relay is more secure against attacks. In many cases, the default
settings for these components will be appropriate for your organization but this guide should help those
administrators who wish to put in the extra effort to further improve their security. Please note that this
document is not an extensive guide for hardening your organization’s servers against attacks, this guide is
only intended to help you get started. Where possible, we provide links to resources to help you further secure
the environment where Camtasia Relay is hosted.

Please note that network security is outside the scope of this guide. This document does not provide any
guidance on network security issues such as designing a secure network architecture for Camtasia Relay
Server(s) (and associated components), network monitoring, or the use of network security appliances such
as firewalls, intrusion detection/prevention systems (IDS/IPS), web application firewalls (WAF), etc. This
guide is not intended to supersede your organization’s network security policies and procedures; it is meant to
complement them.

Also note this guide does not discuss several areas of server security such as setting up appropriate access
control to the physical machine, auditing policies/logmonitoring, andmaintaining server backups.
Administrators are encouraged to seek out additional resources to accomplish these tasks.

Every organization’s network, policies, and business needs are different. Administrators
should take care that any configuration changes do not conflict with your organization’s
business needs, policies, and applicable standards and regulations.

Disclaimer: TECHSMITH CORPORATION MAKES NOWARRANTIES, EXPRESS OR
IMPLIED, INCLUDINGBUT NOT LIMITED, TOANY IMPLIED WARRANTY OF
MERCHANTABILITY OR FITNESS FOR PARTICULAR PURPOSE, TITLE,
NONINFRIGEMNENT OR AS TO THE ACCURACY OF THE INFORMATION
CONTAINED IN THIS GUIDE. IN NOEVENT SHALL TECHSMITH CORPORATION BE
LIABLE FOR LOSS OF PROFITS, SPECIAL, INCIDENTALOR CONSEQUENTIAL
DAMAGES ARISINGOUTOF YOUR USE OF THE INFORMATION CONTAINED IN THIS
GUIDE. THE ENTIRE RISK OF USING THE INFORMATION CONTAINED IN THIS
GUIDE IS WITH YOUR ORGANIZATION.

Reduce Attack Surface
Themajority of recommendations in this guide deal with disabling (or not installing) services not needed by
Camtasia Relay to reduce the attack surface of your Camtasia Relay deployment. Attack surface can be
intuitively defined as the number of ways in which an attacker can enter the system and potentially cause
damage. The rationale behind reducing attack surface is simple: if a service is not needed then it should be
removed or disabled so that an attacker cannot target that service. Removing unneeded services alsomakes
hardening components easier (for example, patchmanagement is simplified as there are fewer services that
require patching.)
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There are usually multiple ways to adjust the settings for many of the components discussed
in this guide. We typically only present one set of steps for changing these settings. Please
use whatever method you feel is appropriate to manage configuration settings.

Segregation of Duties
Camtasia Relay should only be deployed on a dedicated server. Other services such as mail, DNS, or other
web applications should not be hosted on the server hosting Camtasia Relay. This simplifies configuration
and administration. Segregation of duties also helps to ensure that security weaknesses in one service do not
lead to compromises of other services hosted on the same server (since those services are instead hosted on
other servers.)

Keep Patches Up-to-Date for All Components
Update all components in your network with themost recent patches from their respective vendors, if
possible. This includes Windows Server, IIS, SQL server, Camtasia Relay, LDAP server software, email
server software, etc. Keeping all components up to date helps ensure that your network is protected against
previously discovered-and-fixed vulnerabilities; detailed information and exploit code is widely available for
many of these previously discovered-and-fixed vulnerabilities. For many components (for example, Windows
Server, SQL Server), automatic updates are available so that the system automatically detects and installs
new patches and updates.

Strong Passwords

Many of the components involved in hosting Camtasia Relay (includingWindows Server accounts, SQL
Server users, and Camtasia Relay accounts) rely on passwords for distinguishing authorized users from
everyone else. Attackers commonly attempt to guess passwords to gain access to these systems as an
authorized user. These attacks are typically executed using automated scripts that try thousands of
passwords including common passwords, dictionary words, and random combinations of characters. One of
the best defenses against password guessing attacks is the use strong, or hard-to-guess, passwords. Strong
passwords should:

Have 8 characters in length or more
Combine letters, numbers, and symbols
Not include words from the dictionary
Be different than your username or account name
Be different than passwords used for other systems

Formore suggestions and information on strong passwords, please see the article: Strong Passwords and
Password Security at http://www.microsoft.com/protect/yourself/password/create.mspx.

Know Your Servers
Security is about risk management and trade-offs; in the case of server hardening, increasing security is about
managing the risk of an attacker taking advantage of an enabled service with the trade-off of not being able to
use that service if it is disabled. An important prerequisite for server hardening is the detailed knowledge of the
purpose of the server, its services, and hosted applications and how these services and applications are used
by your organization. With this information, you canmake informed and intelligent decisions about how to
manage your servers’ configurations in order to increase security. In other words, we would like to reiterate
that every organization’s network, policies, and business needs are different. Server administrators should

http://www.microsoft.com/protect/yourself/password/create.mspx
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take care that any configuration changes made do not conflict with your organization’s business needs,
policies, and applicable standards and regulations.
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Suggested Workflow for this Guide
We suggest the following workflow for installing Camtasia Relay and server hardening.

1. Install Windows Server. Start with a fresh install to reduce the number of installed services and there-
fore reduce the server’s attack surface.

2. Install Camtasia Relay Server. To install the Camtasia Relay Server, you need to install a number of
prerequisites. This guide contains suggestions for securely configuring several of these prerequisites.

a. Enable the Application Server Role. If you are installing the Application Server Role pre-
requisite, see Installing the Application Server Role.

b. Acquire a Server SSLCertificate. If you are installing the prerequisite SSL certificate seeCon-
figure SSL.

3. Server Hardening. After installing Camtasia Relay, follow the suggestions in this guide to further
secure Camtasia Relay’s hosting environment. If you are new tomanaging Camtasia Relay and server
security seeServer Hardening Quick Start Guide. Otherwise we suggest you follow this guide in the
presented order, starting with Firewall Rules throughCamtasia Relay Security Features.



Camtasia Relay Installation Guide

www.techsmith.com - 5 -

Server Hardening Quick Start Guide
There is a lot to do when hardening your network and servers against attacks and the amount of work required
can be intimidating at first. There aremany configuration changes suggested in this guide andmany more
possible improvements that can be found in other resources.

To help you get started quickly, this section lists the five things, at minimum, you should do to improve the
security of Camtasia Relay’s environment:

Patch Your Servers.

Update all components to the latest patch level, especially Windows Server and SQL Server and
enable automatic updates if possible.

Use Restrictive Firewall Rules.

Set Firewall rules to “Deny All” and only open the ports specified in the section “Firewall Rules” for
servers hosting Camtasia Relay.

Use and Enforce Strong Passwords.

Use strong passwords for theWindows Server administrator account, SQL Server users, and
Camtasia Relay administrator accounts.

Enable Only the Application Server Role.

Enable only the Application Server role on any Windows Servers hosting Camtasia Relay. No other
roles should be enabled. See Installing the Application Server Role.

Use a Valid Server SSL Certificate.

Obtain a valid server certificate for SSL from awell-knownCertificate Authority. SeeConfigure SSL.

These five items should help you quickly get started on improving the security of the servers hosting
Camtasia Relay. Once you feel comfortable with these five items you canmove on to other items in this guide
and suggestions from other resources.
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Firewall Rules
The following ports are always required for Camtasia Relay to work properly.

Component Protocol Ports Direction

Camtasia Relay Web Application and Service TCP 80, 443 Incoming

DNS TCP/UDP 53 Outgoing

NTP UDP 123 Outgoing

Additional ports may also be required by the operating system or other software (for example, port 1663 for
Windows KMS activation.)

Ports Required by Publishing Destination
Depending upon the publishing destinations used by your Camtasia Relay profiles, youmay need to open the
following ports.

Publishing
Destination Protocol Ports Direction

Screencast.com TCP 80, 443 Outgoing

FTP TCP
Add the executables “w3wp.exe” and “Relay-
Publisher.exe” as exceptions. (See below for
more details.)

Outgoing

File System N/A Check the “File and Printer Sharing” checkbox
underWindows Firewall Exceptions. N/A

File System

(Microsoft File
Sharing SMB)

TCP/UDP 135-139 Outgoing

File System

(Direct-hosted
SMB)

TCP/UDP 445 Outgoing

ITunes U TCP 80,443 Outgoing

FTP Publishing

FTP Publishing requires you to add the following executables as outgoing exceptions toWindows Firewall:

w3wp.exe (located at C:\WINDOWS\system32\inetsrv by default)
RelayPublisher.exe (located at C:\Program Files\TechSmith\Relay Server\Ma-

nager by default)
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If configuring a network firewall, the TCP port 21 outgoing and the ephemeral port range (TCP 1024 through
4999 outgoing) should be open for FTP publishing.

Add a Windows Firewall Exception
To access a program through theWindows firewall:

1. In theWindows Firewall dialog box, on the Exceptions tab, click Add Program.
2. Click Browse, and navigate to the program executable you wish to access through the firewall, and

click Open.
3. Click OK twice to close theWindows firewall program.

Conditional Ports
Depending upon the configuration of Camtasia Relay and the features enabled, youmay need to open the
following ports.

Feature Protocol Ports Direction

Email Notification / SMTP TCP
25 (default SMTP port) or

Specified SMTP port
Outgoing

LDAP Authentication TCP

389 (default LDAP port) or

636 (default LDAP SSL) or

Specified LDAP port

Outgoing

Blackboard Notification TCP 80, 443 Outgoing

If email notification is enabled, the SMTP port specified in the SMTP configurationmust be open (out-
going) between all Camtasia Relay servers and the designated SMTP server.
If LDAP authentication is enabled, the LDAP port specified in LDAP configurationmust be open (out-
going) between all Camtasia Relay servers and the designated LDAP server.
If Blackboard notification is enabled, then ports 80 and 443must be open (outgoing) between all Cam-
tasia Relay servers and the designated Blackboard server.

Local SQL Server
You do not need to open ports if Camtasia Relay uses an instance installed on the samemachine. However,
by default, Camtasia Relay will attempt to connect using TCP/IP and if the appropriate firewall ports are not
open (seeRemote SQL Server Ports) then this connection will fail.

To enable Camtasia Relay with restrictive firewall rules, change the Camtasia Relay Server’s configuration
files:

data.config (located in theManager directory of Camtasia Relay’s installation directory, typically
C:\Program Files\TechSmith\Camtasia Relay\Manager\)
web.config (located in theWeb directory of Camtasia Relay’s installation directory, typically C:\P-
rogram Files\TechSmith\Camtasia Relay\Web\)

For each of these files, do the following:
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1. Open .config in a text editor.
2. Find the connection string for the relay instance. For example:

<add name="RelayConnectionString" connectionString="Data

Source=<servername>\RELAY; Initial Catalog=Relay; User

Id=relay; Password=<password>; Pooling=True;" />

3. Change the server name to “(local)” and save the file.
The Camtasia Relay Configuration Protection Tool can also be used to change the connection string in both
the data.config and web.config file. Please seeConfiguration Protection Tool in the Camtasia Relay
Security Features section for more information.

Remote SQL Server Ports
If Camtasia Relay is deployed in a teaming configuration or is configured to use a remote SQL server you
must choose to either:

list the SQL server executable as an exception to blocked programs or
configure the database engine to use a specific TCP/IP port and open this port on servers hosting Cam-
tasia Relay and SQL server.

We recommend listing the SQL server executable as an exception for simplicity.

Use Dynamic Ports / List SQL Server as an Exception

By default, Camtasia Relay uses dynamic ports to access the named ‘relay’ instance. To continue to use
dynamic ports you can list the SQL Server executable (Sqlservr.exe) and SQL Browser as exceptions to the
blocked programs on the server hosting the database. Please note that only one instance of SQL Server can
be accessed in this way. SeeAdd a Windows Firewall Exception to add SQL Server and SQL Browser as
exceptions toWindows Firewall rules.

By default, SQL Server (Relay) is located at C:\Program Files\Microsoft SQL
Server\MSSQL.1\MSSQL\Binn\Sqlservr.exe and SQL Browser is located at C:\Program
Files\Microsoft SQL Server\90\Shared\sqlbrowser.exe. Note that these file paths are
dependent on the SQL installation but in most cases the directory structure should be similar. For example,
SQL Server (Relay)’s location could change based on the instance identifier in the path (MSSQL.1 in the
example above.)

Note that under the Scope tab of the firewall rule, access could be restricted to only allow access from
Camtasia Relay servers for increased security.

On the application server hosting Camtasia Relay (not the SQL Server), it is easiest to create a rule that
allows full access to the remote SQL server. When using a named instance, SQL Server binds multiple
dynamic ports and it is difficult to create a set of firewall rules that will cover all of the possible ports in order to
allow the Camtasia Relay server to communicate with the remote SQL Server. Therefore it is easiest to
create a rule to allow the Camtasia Relay Server full outbound access to the remote SQL Server.

Use Static Ports

Youmay want to use static ports by configuring the database engine to use a specific TCP/IP port and then
opening this port on servers hosting Camtasia Relay and SQL server. Please see the following resources for
more information on configuring static ports.
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How to Configure a Firewall for SQL Server Access:

http://msdn.microsoft.com/en-us/library/ms175043(SQL.90).aspx

How to Configure a Server to Listen on a Specific TCP Port (SQL Server Configuration
Manager):

http://msdn.microsoft.com/en-us/library/ms177440(SQL.90).aspx

Firewall Rules Resources
Service overview and network port requirements for the Windows Server system

http://support.microsoft.com/kb/832017

Windows 2003 - Windows Firewall Technical Reference

http://technet.microsoft.com/en-us/library/cc779199.aspx

Windows Firewall Center

http://technet.microsoft.com/en-us/network/bb545423.aspx

http://msdn.microsoft.com/en-us/library/ms175043(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms175043(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms175043(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms177440(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms177440(SQL.90).aspx
http://msdn.microsoft.com/en-us/library/ms177440(SQL.90).aspx
http://support.microsoft.com/kb/832017
http://technet.microsoft.com/en-us/library/cc779199.aspx
http://technet.microsoft.com/en-us/library/cc779199.aspx
http://technet.microsoft.com/en-us/network/bb545423.aspx
http://technet.microsoft.com/en-us/network/bb545423.aspx
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Windows Server Hardening
Securing theWindows Server operating system is an important part of securing your network. A few steps
can reduce the attack surface of Windows Server. After installing Camtasia Relay, you should:

Delete or disable unused system accounts.
Disable theWindows guest account.
Rename the administrator account.
Enforce a strong password policy for all accounts. For instructions on how to configure a password pol-
icy, please see the articleEnforcing Strong Password Usage throughout Your Organization at
http://technet.microsoft.com/en-us/library/cc875814.aspx.

In addition to simple steps, properly configuring the roles and services on the server can further help secure it.

Required Server Roles
When installed onWindows Server 2003/2008, Camtasia Relay requires that the Application Server role be
enabled. No other roles are required.

Installing the Application Server Role
Windows Server 2008

Follow the directions for installing the application server role (http://technet.microsoft.com/en-
us/library/cc754684.aspx) and install only the server role services specified in step number seven below.

To install the Application Server role:

1. Select Start > Server Manager.
2. If the User Account Control dialog box appears, confirm that the action it displays is what you want,

and click Continue.
3. On the Actionmenu, select Add Roles.
4. The Add Roles Wizard appears. Click Next.
5. The Select Server Roles page appears. Select the Application Server check box and click Next. If the

Add Features Required for Application Server dialog appears, click Add Required Features.
6. Information about the Application Server role appears. Familiarize yourself with the information, and

click Next.
7. On the Select Role Services page, only install theWeb Server (IIS) support service role. Other service

roles are not required by Camtasia Relay. Select Web Server (IIS) support and click Next. If the Add
Required Services dialog appears, verify the services to be added are appropriate and click Next.

8. Click Install to begin installing the Application Server role with the options that appear on the page.
When the installation process is finished, the status of the installation appears on the Installation
Results page.

Windows Server 2003

Use the following procedure to install the application server role:

To install the Application Server role:

http://technet.microsoft.com/en-us/library/cc875814.aspx
http://technet.microsoft.com/en-us/library/cc875814.aspx
http://technet.microsoft.com/en-us/library/cc754684.aspx
http://technet.microsoft.com/en-us/library/cc754684.aspx
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1. Select Start > Server Manager.
2. Click Add or remove a role.
3. The Configure Your ServerWizard appears. Click Next.
4. Select Application server (IIS, ASP.NET) and click Next.
5. On the Application Server Options page, select the Enable ASP.NET checkbox. Click Next. (Do not

check FrontPage Server Extensions.)
6. On the Summary of Selections page, click Next.
7. TheWindows Components Wizard will appear. Insert yourWindows Server Service Pack 2 CD when

prompted.

Resources for Installing and Configuring the Application Server Role

Running IIS 6.0 as an Application Server on Windows Server 2003

http://technet.microsoft.com/en-us/library/cc756814.aspx

Installing and Configuring Application Server on Windows Server 2008

http://technet.microsoft.com/en-us/library/cc731311.aspx

Security Configuration Wizard
Disable Unnecessary Services

If you are installing Camtasia Relay on a new installation of Windows Server 2008 then the default services
installed for the operating system and the application server role aremost likely appropriate for your
organization. If you install Camtasia Relay onWindows Server 2003, especially an older installation of
Windows Server or alongside other applications (note this both violates the principle of segregation of duties
and the Camtasia Relay specifications), then it may be appropriate to disable unneeded services in order to
further harden your server.

Use the Security ConfigurationWizard to disable unneeded services and further hardenWindows Server
2003. Please see the articles (such as the SCW Quick Start Guide) underSecurity Configuration Wizard
for Windows Server 2003 at
http://www.microsoft.com/windowsserver2003/technologies/security/configwiz/default.mspx.

The Security ConfigurationWizard is also available forWindows Server 2008 and is very similar to the
Security ConfigurationWizard used forWindows Server 2003.

Windows Server Auditing

It may be useful to monitor successful/failed logons, policy changes, and resource access for theWindows
Server hosting Camtasia Relay. You can use the Security ConfigurationWizard to choose specific resources
to audit. Alternatively, you can useWindows server’s Administrative tools to edit the local security policy.
Refer to theWindows Server documentation for help using the Security ConfigurationWizard.

Security Configuration Wizard for Windows Server 2003

http://www.microsoft.com/windowsserver2003/technologies/security/configwiz/default.mspx

Security Configuration Wizard for Windows Server 2008

http://technet.microsoft.com/en-us/library/cc771492.aspx

http://technet.microsoft.com/en-us/library/cc756814.aspx
http://technet.microsoft.com/en-us/library/cc756814.aspx
http://technet.microsoft.com/en-us/library/cc731311.aspx
http://technet.microsoft.com/en-us/library/cc731311.aspx
http://www.microsoft.com/windowsserver2003/technologies/security/configwiz/default.mspx
http://www.microsoft.com/windowsserver2003/technologies/security/configwiz/default.mspx
http://technet.microsoft.com/en-us/library/cc771492.aspx
http://technet.microsoft.com/en-us/library/cc771492.aspx
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IIS Hardening
To access IIS settings for the Camtasia Relay web site: Click Start and navigate through Administrative
Tools and click Internet information Services (IIS) Manager.

Windows Server 2008 / IIS 8
Remove Unnecessary HTTP headers

Remove unneeded HTTP headers that may be configured in IIS such as “X-Powered by ASP.NET”.

1. In IIS Manager, select the server name on the left.
2. Double click onHTTP Response Headers.
3. Select any items listed in the table and click Remove.
4. The HTTP Response Headers removal confirmation dialog appears. Click Yes.

Remove Unnecessary Extensions

1. In IIS Manager, select the server name on the left.
2. Double-click onHandler Mappings.
3. Remove any entries in the table with aPath value of *.rem, *.asmx, trace.axd, andWebAdmin.axd as

well as the OPTIONS Verb Handler.
a. Select the entry you wish to remove.
b. Click Remove.
c. The Confirm Remove dialog appears. Click Yes.

Remove Unnecessary HTTP Methods

OnWindows Server 2008, we consider it unnecessary to remove any HTTP verbs. The HTTP verbs enabled
by default should be appropriate.

Windows Server 2003 / IIS 6
Remove Unnecessary HTTP Headers

Remove unneeded HTTP headers that may be configured in IIS such as “X-Powered by ASP.NET”.

1. In IIS Manager, right-click onWeb Sites and click Properties.
2. Navigate to the HTTP Headers tab.
3. Select any items in the Custom HTTP headers box and click Remove.
4. Youmay be prompted to also remove the custom header from child websites. Click Yes.

Remove Unnecessary Extensions

Camtasia Relay requires the following application extensions to be enabled: .ashx, .aspx, .axd, .config,
.jrpc, .svc, and .merge. All other extensions can be safely removed.

1. In IIS Manager, click on the plus symbol next toWeb Sites.
2. Click the plus symbol next to the website where Camtasia Relay will be installed (“Default Web Site”

for Express installation).
3. Right-click Relay and select Properties.
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4. The Relay Properties page appears. Go to the Virtual Directory tab.
5. Click on theConfiguration button on the right side of the page.
6. Remove all extensions except: .ashx, .aspx, .axd, .config, .jrpc, .svc, and .merge.

a. Select the application extension and click Remove.
b. A confirmation dialog appears. Confirm that the action it displays is what you want, and click

Yes.

Remove All HTTP Methods Except GET, POST, and HEAD

For all remaining extensions, remove all HTTP methods except GET, POST, and HEAD.

1. In IIS Manager, click on the plus symbol next toWeb Sites.
2. Click the plus symbol next to the website where Camtasia Relay will be installed (“Default Web Site”

for Express installation).
3. Right-click on Relay and select Properties.
4. The Relay Properties page appears. Go to the Virtual Directory tab.
5. Click on theConfiguration button on the right side of the page.
6. Remove all HTTP methods except GET, POST, and HEAD for the extensions: .ashx, .aspx, .axd,

.config, .svc, and .merge.
a. Select the application extension to change and click Edit.
b. In the Limit to: text box, remove any words that are not GET, HEAD, POST.

7. Remove all HTTP methods except POST for the extensions: .jrpc.
a. Select the application extension .jrpc and click Edit.
b. In the Limit to: text box, remove any words that are not POST.

Restart IIS for changes to take effect

Youmust restart IIS for the changes youmade (removing HTTP headers, removing unnecessary extensions,
removing HTTP methods) to take effect.

1. Click Start and navigate through Administrative Tools and click onServices.
2. The Services window appears. Find IIS Admin Service in the list.
3. Right-click on IIS Admin Services and click Restart.
4. You are prompted to restart other services (WorldWideWeb Publishing Services and HTTP SSL).

Click Yes.

Configure SSL
Camtasia Relay requires SSL in order to protect users’ sensitive data in-transit and to provide assurance that
users are communicating with the right server. With SSL, all data transmitted to the website is encrypted and
integrity-protected. To enable SSL, a valid SSL server certificate is needed.

There are three ways to obtain a server certificate:

Purchase a server certificate from a commercial Certificate Authority (CA).
Request a server certificate from your organization’s internal CA.
Create a self-signed server certificate for test purposes. Self-signed certificates should not be used for
any purpose other than testing.

Using a self-signed certificate will result in users’ browsers warning them about visiting the
Camtasia Relay web application and in some cases may block them from visiting Camtasia
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Relay altogether.
Using a self-signed certificate opens a web server up to certain network-level (man-in-the-
middle or server spoofing) attacks which can result in an attacker gaining access to user data
(passwords for example) as well as the ability to modify user requests.

We urge you to use a server certificate well-knownCertificate Authority, if possible.

Request a Server Certificate in Windows Server 2008
1. Click Start and navigate through Administrative Tools and then click Internet information Services

(IIS) Manager.
2. In the Connections pane, click on server name.
3. In Features View of the Relay site, double-click Server Certificates. See theMicrosoft articleCon-

figuring Server Certificates in IIS 7.0 (http://technet.microsoft.com/en-
us/library/cc732230.aspx) for further instructions on obtaining, installing, andmanaging server cer-
tificates.

Bind a Server Certificate to the Relay Web Site in Windows Server 2008

1. In IIS Manager, click the plus symbol next to server name.
2. Click the plus symbol next to Sites.
3. Click Default Web Site.
4. Click Bindings.
5. The Site Bindings page appears. Click Add.
6. The Add Site Binding page appears. Select https from the dropdownmenu.
7. Select the server certificate to add to the Relay web site from the SSL certificate dropdownmenu.
8. Click View to view the server certificate. Review the certificate information to ensure the certificate is

valid and the information is correct. Click OK when you are finished reviewing the certificate.
9. Click OK.

Request a Server Certificate in Windows Server 2003
To request a certificate in the first two situations, use theWeb Server CertificateWizard.

1. Click Start and navigate through Administrative Tools and then click Internet information Services
(IIS) Manager.

2. Click the plus symbol next toWeb Sites.
3. Right-click Default Web Site and click Properties.
4. The Default Web Site Properties page appears. Go to the Directory Security tab.
5. Click theServer Certificate button.
6. TheWeb Server CertificateWizard appears. Using theWeb Server CertificateWizard you can request

a server certificate from your organization’s internal CA or from a commercial CA.
SeeMicrosoft’s articleCertificates_IIS_SP1_Ops (http://technet.microsoft.com/en-
us/library/cc757474.aspx) article for further instructions on obtaining, installing, andmanaging server
certificates.

http://technet.microsoft.com/en-us/library/cc732230.aspx
http://technet.microsoft.com/en-us/library/cc732230.aspx
http://technet.microsoft.com/en-us/library/cc757474.aspx
http://technet.microsoft.com/en-us/library/cc757474.aspx
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Bind a Server Certificate to the Relay Web Site in Windows Server 2003

1. In IIS Manager, click the plus symbol next to the server name.
2. Click the plus symbol next toWeb Sites.
3. Right-click Default Web Site and click Properties.
4. Go to the Directory Security tab.
5. Click theServer Certificate button.
6. TheWeb Server CertificateWizard appears. Click Next.
7. Select the Assign an existing certificate radio button. Click Next.
8. Select the server certificate to install and click Next.
9. Review the certificate information to ensure the certificate is valid and the information is correct. Click

Nextwhen you are finished reviewing the certificate.
10. Click Finish.

Disable Older Versions of SSL and Weak Ciphers
Older versions of the SSL protocol have well-known vulnerabilities and should no longer be used. Certain
ciphers, used to perform encryption, are also no longer considered secure and should not be used.

OnWindows Server 2008, both SSLv2 and PCT 1.0 are disabled by default. Furthermore the ciphers enabled
by default onWindows Server 2008 are appropriate.

Windows Server 2008 SSLCiphers: http://technet.microsoft.com/en-us/library/cc766285.aspx

OnWindows Server 2003, both older versions of SSL and certain ciphers should be disabled by following the
directions below.

Disable SSLv2 and PCT 1.0 on Windows Server 2003 / IIS 6

1. Click Start, click Run, type regedt32, and click OK.
2. In Registry Editor, locate the following registry keys:

HKey_Local_Machine\Sy-

stem\Cu-

rrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\PCT

1.0\Server
HKey_Local_Machine\Sy-

stem\Cu-

rrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\SSL

2.0\Server
3. For each key, do the following:

a. On the Edit menu, select New > DWORD Value.
b. In the Value Name box, type Enabled, and then press Enter.
c. Double-click the value to edit its current value.
d. Type 00000000 in Hexadecimal Editor to set the value of the new key equal to "0".
e. Click OK. Restart the computer.

Resource: http://support.microsoft.com/kb/187498/en-us

http://technet.microsoft.com/en-us/library/cc766285.aspx
http://technet.microsoft.com/en-us/library/cc766285.aspx
http://support.microsoft.com/kb/187498/en-us
http://support.microsoft.com/kb/187498/en-us
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Disable Weak Ciphers on Windows Server 2003 / IIS 6

1. Click Start, click Run, type regedt32, and click OK.
2. In Registry Editor, locate the following registry keys:

HKey_Local_Machine\Sy-

stem\CurrentControlSet\Control\SecurityProviders \SCHA-

NNEL\Ciphers\RC2 40/128
HKey_Local_Machine\Sy-

stem\CurrentControlSet\Control\SecurityProviders \SCHA-

NNEL\Ciphers\RC4 40/128
3. For each key, do the following:

a. On the Edit menu, click New > DWORD Value.
b. In the Value Name box, type Enabled, and then press Enter.
c. Double-click the value to edit its current value.
d. Type 00000000 in Hexadecimal Editor to set the value of the new key equal to "0".
e. Click OK. Restart the computer.

Resource: http://support.microsoft.com/kb/245030

SSL Resources
Configuring Server Certificates in IIS 6.0

http://technet.microsoft.com/en-us/library/cc757474.aspx

Configuring Server Certificates in IIS 7.0

http://technet.microsoft.com/en-us/library/cc732230.aspx

TechSmith Support Center: How can I create a self signed SSL certificate for use with Relay?

http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_adp.php?p_faqid=1999

SSLDigger

http://www.foundstone.com/us/resources/proddesc/ssldigger.htm

You can use this freely available tool to check your server for weak SSL ciphers and to determine if you
have older versions of SSL installed.

Microsoft SSLDiagnostics

http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-
06c814265282&displaylang=en

You can use this freely available tool to help diagnose problems with your SSL configuration on
Windows Server 2003.

http://support.microsoft.com/kb/245030
http://technet.microsoft.com/en-us/library/cc757474.aspx
http://technet.microsoft.com/en-us/library/cc757474.aspx
http://technet.microsoft.com/en-us/library/cc732230.aspx
http://technet.microsoft.com/en-us/library/cc732230.aspx
http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_adp.php?p_faqid=1999
http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_adp.php?p_faqid=1999
http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_adp.php?p_faqid=1999
http://techsmith.custhelp.com/cgi-bin/techsmith.cfg/php/enduser/std_adp.php?p_faqid=1999
http://www.foundstone.com/us/resources/proddesc/ssldigger.htm
http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-06c814265282&amp;displaylang=en
http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-06c814265282&amp;displaylang=en
http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-06c814265282&amp;displaylang=en
http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-06c814265282&amp;displaylang=en
http://www.microsoft.com/DownLoads/details.aspx?FamilyID=cabea1d0-5a10-41bc-83d4-06c814265282&amp;displaylang=en
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SQL Server Hardening
Hardening the SQL database server helps ensure that your users’ data is protected from attackers. Similar to
securingWindows Server, several simple steps can help reduce the attack surface of SQL server. You
should:

Delete or disable unused system accounts.
Disable theWindows guest account.
Rename the administrator account.
Enforce a strong password policy for all accounts.
Ensure that SQL Server is using themost up to date Service Pack and patches. (Camtasia Relay
expects SQL Server Express 2005 Service Pack 3 or later.)

Disable Unused SQL Services
The services SQL Server (Relay) andSQL Server Browser are needed. On a new install of SQL Server
these should be the only services installed. If you configure Camtasia Relay to use a SQL Server that has
other SQL services enabled and these services are no longer needed, then youmay wish to disable them.

Restrict SQL Server Protocols
Restricting what protocols can be used to access SQL server reduces the attack surface the database.

1. Click Start and navigate to theMicrosoft SQL Server program group, through Configuration Tools to
click onSQL Server Configuration Manager.

2. Expand SQL Server 2005 Network Configuration and click Protocols for RELAY.
3. Disable SQL Server Protocols for RELAY:

a. Remote SQL Server Deployment: Make sure that TCP/IP and SharedMemory are the only
SQL Server protocols that are enabled. Right click on the protocols you wish to enable and click
Enable; right click on any protocols you wish to disable and click Disable.

b. Local SQL Server Deployment: Make sure that SharedMemory is the only SQL Server pro-
tocol enabled.

4. Expand SQLNative Client Configuration and click Client Protocols.
5. Disable Client Protocols:

a. Remote SQL Server Deployment: Make sure that TCP/IP and SharedMemory are the only
SQL Server protocols that are enabled.

b. Local SQL Server Deployment: Make sure that SharedMemory is the only SQL Server pro-
tocol enabled.

Restrict Remote Access
Restrict Remote Logons

Use the Local Security Policy tool to remove the "Access this computer from the network" user right from the
Everyone group to restrict who can log on to the server remotely.

1. Click Start and navigate through Administrative Tools and then click Local Security Policy.
2. Click the plus symbol next to Local Policies.
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3. Click User Rights Assignment.
4. Double-click theAccess this computer from the network entry in the list.
5. The Access this computer from the network Properties page appears. Select Everyone from the list

and click Remove.
6. Click OK.

Disable Null Sessions (Anonymous Logons)

Null sessions allow for anonymous access which can allow an attacker to connect to your server without
authentication.

Restrict null sessions by setting RestrictAnonymous=1 in the registry at the following location.

HKLM\System\CurrentControlSet\Control\LSA\RestrictAnonymous=1

Secure Communication Between Relay and
SQL
Youmay need to take steps to protect the communication between Camtasia Relay and a remote SQL server
(such as when using Camtasia Relay’s teaming features.) The communication should either be encrypted (for
example, by using SSL or IPSec) or the remote SQL server should be deployed such that attackers cannot
intercept traffic to and from the SQL server.

In the case of deploying the SQL server such that attackers cannot intercept traffic to and from the SQL
server, the Camtasia Relay Server should be deployed in a demilitarized zone (DMZ) in your network and this
DMZ should be physically or logically segmented from the internal network by a stateful packet inspection
(SPI) firewall or other network security device. The point-to-point communication between any Camtasia
Relay Servers and the remote SQL server should not be across any public network. The remote SQL server
should be placed in amore secure portion of your network than the DMZ and should not be publicly
accessible, if possible.

In the case of using SSL or IPSec to encrypt Camtasia Relay’s communication with a remote SQL server, the
following instructions should help you get started.

SSL
1. Obtain a valid SSLCertificate for SQL Server. SeeConfigure SSL for more information on how to

obtain and configure a server certificate. In order for SQL server to use the SSL certificate it must meet
certain requirements, which are listed here: http://technet.microsoft.com/en-us/library/ms189067
(SQL.90).aspx.

2. Configure SQL Server to use the SSL certificate.
a. Before SQL Server can be configured to use the SSL certificate, the account used to run the

SQL Server servicemust be given permission to access the SSL certificate. This account is typ-
ically the ‘NetworkService’ account. Microsoft’s freely available WinHttpCertCfg tool can be
used to grant the NetworkService access to the certificate. Please note that this tool must be
used with the sameWindows account used to install the certificate. For information on using
theWinHttpCertCfg tool see the following resources:

http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
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i. http://msdn.microsoft.com/en-us/library/aa384088(VS.85).aspx
ii. http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-

cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
b. Once the certificate has been installed in server’s certificate store and the SQL server service’s

account has access to the certificate, SQL can be configured to use this certificate. See the
instructions here on how to configure SQL to SSL: http://technet.microsoft.com/en-
us/library/ms189067(SQL.90).aspx. Alternatively:

i. Click Start, in theMicrosoft SQL Server 2005 program group, point to Configuration
Tools, and then click SQL Server Configuration Manager.

ii. Click the plus symbol next to SQL Server 2005 Network Configuration.
iii. Right click Protocols for RELAY and select Properties.
iv. On the Certificate tab, select the appropriate SSL certificate.
v. On the Flags tab, select Force Encryption: Yes.
vi. Click OK.

IPSec
Alternatively, IPSec may be used to encrypt communication between Camtasia Relay and a remote SQL
server. It should be noted though that configuring and deploying IPSec may be consideredmuchmore
complicated and heavily dependent upon your organization’s network architecture. The following resources
may help you configure IPSec.

IPSec Overview:

http://technet.microsoft.com/en-us/network/bb531150.aspx

Data Access Security – Secure Communication:

http://msdn.microsoft.com/en-us/library/aa302392.aspx#secnetch12_securecommunication

How To: Use IPSec to Provide Secure Communication Between Two Servers:

http://msdn.microsoft.com/en-us/library/aa302413.aspx

Using IPsec for Network Protection:

http://technet.microsoft.com/en-us/library/cc512617.aspx

Server Auditing
It may be useful to monitor successful/failed logons, policy changes, and resource access for theWindows
Server hosting your SQL server. SeeWindows Server Auditing for instructions on setting up auditing.

SQL Server Security
You can change or verify many advanced settings to increase the security of SQL Server. The default settings
created by the Camtasia Relay installer are appropriate in many cases. However, if you (1) are using a remote
SQL database with Camtasia Relay and (2) the remote SQL Server used by Camtasia Relay has other
database instances installed (in the past or currently), and (3) you are comfortable using SQL Server Manager
to manage SQL server configuration settings, then it may be appropriate to further secure SQL server using

http://msdn.microsoft.com/en-us/library/aa384088(VS.85).aspx
http://msdn.microsoft.com/en-us/library/aa384088(VS.85).aspx
http://msdn.microsoft.com/en-us/library/aa384088(VS.85).aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://blogs.technet.com/mscom/archive/2007/05/30/how-to-get-sql-to-accept-the-cert-or-a-day-or-two-in-the-life-of-an-mscom-debug-engineer-part-2.aspx
http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
http://technet.microsoft.com/en-us/library/ms189067(SQL.90).aspx
http://technet.microsoft.com/en-us/network/bb531150.aspx
http://technet.microsoft.com/en-us/network/bb531150.aspx
http://msdn.microsoft.com/en-us/library/aa302392.aspx#secnetch12_securecommunication
http://msdn.microsoft.com/en-us/library/aa302392.aspx#secnetch12_securecommunication
http://msdn.microsoft.com/en-us/library/aa302392.aspx#secnetch12_securecommunication
http://msdn.microsoft.com/en-us/library/aa302413.aspx
http://msdn.microsoft.com/en-us/library/aa302413.aspx
http://technet.microsoft.com/en-us/library/cc512617.aspx
http://technet.microsoft.com/en-us/library/cc512617.aspx
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these advanced settings. If so, seeAppendix A: SQL Server Security for suggestions on securely
configuring SQL server.

Resources for SQL Server Hardening
Security Considerations for SQL Server: http://msdn.microsoft.com/en-us/library/ms161948.aspx

http://msdn.microsoft.com/en-us/library/ms161948.aspx
http://msdn.microsoft.com/en-us/library/ms161948.aspx
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Camtasia Relay Security Features
Camtasia Relay includes several features you can configure to increase the security of Camtasia Relay user
accounts.

Forgotten Password Policy
You can allow users managed by Camtasia Relay to change their password if they have forgotten their
password.

When this feature is enabled, Camtasia Relay can provide a link to your organization’s forgotten password
solution and/or allow users managed by Camtasia Relay (not LDAP users) to change their forgotten
password. You can configure Camtasia Relay’s forgotten password policy on the Camtasia Relay website on
the User Account Security Settings page (/Relay/SecuritySettings.aspx.)

The table below describes the behavior of the forgotten password feature for each possible configuration.

Configuration User
Type Behavior

LDAP
Forgotten

Password Link

Enabled Only

Users
managed
by LDAP

Users
managed
by Relay

Users who follow the forgotten password link on the website will
be redirected to the specified URL for your LDAP system’s for-
gotten password solution. Users who follow the forgotten pass-
word link on the recorder will be redirected to
~/Relay/ContactAdmin.aspx which will include a link to the
specified URL.

Camtasia
Relay For-
gotten Pass-
word Enabled
Only

Users
managed
by LDAP

Users who follow the forgotten password link on the website and
recorder will be sent to ~/Relay/ForgotPassword.aspx
where the user can submit a CAPTCHA-protected form to
request that a unique link be sent to the email address stored for
their account.

The email sent to users managed by LDAP will instruct them to
contact their administrator.

Users
managed
by Relay

Users who follow the forgotten password link on the website and
recorder will be sent to ~/Relay/ForgotPassword.aspx
where the user can submit a CAPTCHA-protected form to
request that a unique link be sent to the email address stored for
their account.

The email sent to users managed by Camtasia Relay will contain
a unique link that is active for a short amount of time. The
forgotten-password link leads to a second CAPTCHA-protected
form (~/Relay/NewPassword.aspx) that users can use to
change their password.
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About Forgotten Password for Users Managed by Relay

Enabling this feature increases the attack surface of Camtasia Relay.

When this feature is enabled, users managed by Camtasia Relay can submit a CAPTCHA-protected form to
request that a unique link be sent to the email address stored for their account. This unique link is active for a
short amount of time; this duration is configured by the Camtasia Relay administrator using the User Account
Security Settings at ~/Relay/SecuritySettings.aspx. The forgotten-password link leads to a second
CAPTCHA-protected form (~/Relay/NewPassword.aspx) that users can use to change their password.

An attacker may attack this feature by attempting to guess the unique link and if successful, changing a
user’s password. Therefore the form employs a number of defenses. CAPTCHA should help to prevent brute-
force guessing. The link’s short duration also limits the number of guesses an attacker can possibly try during
the link’s lifetime. Lastly, the password change form reports the same results for valid links and invalid links.

To help prevent an attacker from using Camtasia Relay to send unwanted email to users, the forgotten
password feature restricts how often a forgotten password email will be sent to users. If a user (or attacker)
requests a forgotten password email for a user and the link from this email is not successfully used to change
the user’s password then Camtasia Relay will not send the user another forgotten password email for an
admin-specified time.

Account Lockout
To prevent an attacker from using a brute-force attack to guess users’ passwords, you can enable account
lockout. With account lockout enabled, both users managed by Camtasia Relay and users who authenticate
via LDAP can be locked out of Camtasia Relay after a number of failed login attempts.

Note that account lockout applies equally to presenters and administrators, including the “relayadmin”
account. If your organization intends to use account lockout then additional Camtasia Relay administrator
accounts should be created to help prevent a denial-of-service attack against administrators. In a denial-of-
service lockout attack, an attacker would use a script to continually attempt to login as an administrator
account with bad passwords, causing the account to be locked out so that Camtasia Relay administrators
could never log in to that account.

Also note there is not currently a way for administrators to unlock user accounts using the web application.
Users must either wait for admin-specified duration for their account to be unlocked or if the “Enable
CAPTCHA to unlock” option is enabled, the user can unlock their account and login if they successfully
complete the CAPTCHA challenge and provide the correct username and password.

There are a number of settings that must be configured for account lockout.

Setting Description

Lock
account
after _____
failed login
attempts

Determines how many times a user can attempt to login within a short time period
(also specified by the administrator) before their account is locked.

Lock
account for

Determines how long a user’s account will be locked. After this time period has
passed the user will be able to log-in (by providing the correct password)
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Setting Description

_____min-
utes

assuming that the user does not fail to log-in again (by providing an incorrect
password) within the short time period whichmay result in the user’s account
being locked again.

If the forgotten password feature is enabled, a user’s account will be unlocked
when a user changes their forgotten password using the feature.

Reset login
attempts
after _____
minutes

Determines the short time period in which a number of login attempts will lock out
a user.

Enable
CAPTCHA
to unlock

If a user attempts to log-in to the website using a locked out account, they will be
redirected to a CAPTCHA-protected log-in form. If a user provides the correct
username, password, and solution to the CAPTCHA challenge, their account will
be unlocked and the user will be logged in.

Password Complexity Rules
If password complexity rules are enabled then users managed by Camtasia Relay will be required to provide
strong passwords. It is very important to enable this feature to help protect Camtasia Relay users against
password guessing attacks. If this feature is not enabled then user passwords are not subjected to any
standard of quality.

Please note that users who have set their password prior to enabling this featuremay have passwords that do
not meet the password complexity rules. Camtasia Relay currently does not warn users or force a password
change if their current password does not meet the standard of the password complexity rules. Also note that
passwords set for users by an administrator are not subject to password complexity rules. It is the
administrator’s responsibility to ensure that any administrator-set user passwords are strong passwords.

Password complexity rules are enforced when a logged-in presenter changes their password using the
Camtasia Relay web application. If the forgotten password feature is enabled then password complexity rules
are also enforced when a user changes their forgotten password using the unique link.

Recorders Ignore SSL Certificate Errors
The Recorder Security tab of the User Account Security Settings page (~
/Relay/SecuritySettings.aspx) includes the option having Camtasia Relay recorders ignore server
certificate errors. By default, Camtasia Relay recorders will not connect to a Camtasia Relay server with an
invalid server certificate. When “Ignore Server Certificate Errors” is enabled, the Camtasia Relay recorder
ignores all server certificate errors when connecting to a Camtasia Relay server.

After the "Ignore Server Certificate Errors" has changed, the Camtasia Relay recorders will be
unavailable for several minutes until they are rebuilt to reflect the security change. All
Recorders installed before changing this optionmust be updated or they may fail to connect to
the Camtasia Relay server. Presenters must download and install the new recorder.
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Alternatively, for presenters using the PC recorder, a change can bemade to the Recorder’s
UploaderService.config file rather than having presenters download and install the new recorder.
Follow these instructions to edit the UploaderService.config file on amachine where the PC Recorder
is installed:

1. Navigate to the uploader directory of the PC recorder’s installation directory (C:\Program
Files\TechSmith\Camtasia Relay\Uploader\ by default.)

2. Open the UploaderService.config file in a text editor.
3. Change the value of the following line in the file:

True indicates that the Recorder should ignore certificate errors when connecting to the Camtasia
Relay server. False indicates that the Recorder will fail to connect if the Camtasia Relay server has an
invalid server certificate.

<IgnoreSslCertificateErrors>True</IgnoreSslCertificateErrors>

4. Restart the Uploader Service by executing (double-click) the “RestartUploader.cmd” command (in
the uploader directory). This command requires Administrative privileges on themachine.

For presenters using theMac recorder a change can bemade to theMac recorder’s Uploader.plist file
rather than having presenters download and install a new recorder. Follow these instructions to edit the
Uploader.plist file:

1. Navigate to the Content\Resources directory of theMac recorder’s installation directory.
2. Open the Uploader.plist file in a text editor.
3. Change the value of IgnoreSslCertificateErrors to true or false accordingly.
4. Restart the Uploader service.

The Camtasia Relay Recorder’s “Ignore Certificate Errors” feature should only be used for testing purposes
(for example, when using a self-signed server certificate when you are unable to or do not wish to add the self-
signed certificate to the trusted certificate store.) If possible a valid server certificate should be obtained from
awell-knownCertificate Authority.

Please note that using an invalid server certificate makes certain network-level (man-in-the-middle or server
spoofing) attacks which can result in an attacker learning user passwords or modifying user requests before
they reach the Camtasia Relay server. We urge you to use a server certificate from awell-knownCertificate
Authority, if possible.

Expire Recorder Authentication Codes
The Recorder Security tab of the User Account Security Settings page (~
/Relay/SecuritySettings.aspx) includes the option having the authentication codes used by
Camtasia Relay recorders expire. By default, authentication codes never expire. Authentication codes
uniquely identify presenters. When a presenter authenticates using the Camtasia Relay recorder, the
Camtasia Relay server assigns that presenter an authentication code. The Camtasia Relay recorder uses this
authentication code when communicating with the server to associate presentations with the authenticated
presenter; the Camtasia Relay server verifies this authentication code before allowing a recorder to upload a
presentation.

If an attacker were able to learn a presenter’s authentication code, that attacker could potentially upload
presentations as that presenter. By specifying a lifetime for authentication codes, administrators can limit the
window when an attacker (who has learned a presenter’s authentication code) can upload presentations as
that presenter.
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Note that presenters using the “RememberMe” functionality on the PC recorder will need to log out and log in
again once their authentication code has expired. Otherwise their presentations will upload as a guest
presentation.

Presenters using theMac recorder’s “RememberMe” feature do not have to log out and log in again; theMac
recorder securely stores the presenter’s password using Keychain and uses the stored password to obtain a
fresh authentication code whenever the recorder is started.

Using a Self-Signed Server Certificate with
Camtasia Relay Recorders
The Camtasia Relay Recorders will fail to connect to a Camtasia Relay Server with an invalid server
certificate by default. If your organization is using a self-signed server certificate on the Camtasia Relay
server then you have several options to allow recorders to connect to the server.

Add the self-signed server certificate to clients’ trusted certificate stores, or
Modify the recorder’s configuration to ignore all server certificate errors.

Please note that if the self-signed server certificate is added to a client’s trusted certificate store then users on
that client machine should be able to use a web browser to connect to the Camtasia Relay server website
without having to click through a server certificate warning.

PC - Adding Self-Signed Certificate to Trusted Store
On individual client machines, the “Certificate Manager” snap-in for theMicrosoft Management Console
(MMC) can be used to install the certificate to the client machine’s trusted certificate store.

Alternatively, Windows features such as Active Directory Group Policy (see
http://technet.microsoft.com/en-us/library/cc725911%28WS.10%29.aspx for more information) can be
usedmanage certificate settings on client machines. Using Group Policy, the self-signed server certificate
could be pushed to the certificate stores of clients on the domain, allowing Recorders installed on those client
machines to connect to the Camtasia Relay server. (Of course, if your organization is capable of using Group
Policy to manage certificate settings it is likely you are also capable of setting up an internal Certificate
Authority and obtaining a server certificate for Camtasia Relay from this internal CA; this scenario is
preferable to using a self-signed certificate.)

Using MMC Certificate Manager Snap-in to Export a Server Certificate from Server

Follow these instructions to export the server’s certificate to a file which can then be copied to PC client
machines and imported in order to allow the Camtasia Relay recorder installed on these clients to connect to a
server with a self-signed certificate.

1. LaunchMMC. Windows Start > Run and type inmmc.
2. In MMC, under the File menu select Add / Remove Snap-in.
3. In the left hand pane, select Certificates and click Add. When prompted, select ‘Computer Account’

and click Next.
4. When prompted to select a computer, make sure that Local Computer is selected and click Finish.
5. Click OK.
6. Expand the Certificates. Several different types of certificate stores should be displayed (Personal,

Trusted Root Certificates, etc.)
7. Expand the Personal certificate store.
8. Click “Certificates”

http://technet.microsoft.com/en-us/library/cc725911(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc725911(WS.10).aspx
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9. Right click on the self-signed certificate used by the Camtasia Relay server. Select All Tasks and
click onExport. The Certificate Export Wizard appears.

10. Click Next.
11. Select “No, do not export the private key.” Click Next.
12. Select the format you wish export the certificate in (DER encoded binary X.509 should be selected by

default and should be suitable.)
13. Provide a location and name for the certificate export file to be saved to. Click Next.
14. Click Finish.
15. Copy the exported certificate file to clients.

Using MMC Certificate Manager Snap-in to Import a Server Certificate to a Client

Follow these instructions to import a server certificate to a PC client’s certificate store.

1. Copy the exported certificate file to the client machine.
2. LaunchMMC. Windows Start > Run and type inmmc.
3. In MMC, under the File menu select Add / Remove Snap-in.
4. In the left hand pane, select Certificates and click Add. When prompted, select ‘Computer Account’

and click Next.
5. When prompted to select a computer, make sure that Local Computer is selected and click Finish.
6. Click OK.
7. Expand the Certificates. Several different types of certificate stores should be displayed (Personal,

Trusted Root Certificates, etc.)
8. Expand the Personal certificate store.
9. Right click on “Certificates”. Select All Tasks and click on Import. The Certificate Import Wizard

appears.
10. Click Next.
11. Browse to the certificate file to be imported (from step 1.) Click Next.
12. Verify that the Personal certificate store is selected for “Place all certificates in the following store”

option and click Next.
13. Click Finish.
14. In Internet Explorer, open the Tools > Internet Options menu. Click on the Content tab. Click ‘Clear

SSL state’.
15. The recorder should now be able to connect to the server. If the recorder is unable to connect, close the

recorder, restart the Uploader service and open the recorder again.

Mac - Adding Self-Signed Certificate to Trusted Store
Follow these instructions to add a server certificate to aMac client’s certificate store.

1. Copy the exported certificate file to the client machine.
2. If using OSX 10.6, open the certificate file. Expand the Trust node and set Secure Socket Layer (SSL)

toAlways Trust.
3. Launch Keychain.
4. On Keychain’s File menu, select Import Items. A file browse dialog appears.
5. Select the exported certificate file (from step 1.)
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6. On the Destination Keychain dropdown, select the option appropriate for your operating system ver-
sion:

OSX 10.6, 10.7: Select System
7. Click Open. A confirmation dialog appears.
8. Review the details of the certificate and verify they are correct for the Camtasia Relay server. Click

Always Trust. An administrator username/password dialog appears.
9. Type an administrator’s name and password and click OK.
10. Select the System Keychain and verify that the imported certificate appears in the list.
11. The Recorder should now be able to connect to the server. If the Recorder is unable to connect, restart

the Recorder and it should be able to connect.

Modifying Uploader Configuration to Ignore Server Certificate Errors
The configuration file for bothMac and PC Recorder’s Uploader service can bemodified to

Follow these instructions to edit the UploaderService.config file on amachine where the PC recorder is
installed:

1. Navigate to the Uploader directory of the PC recorder’s installation directory (C:\Program
Files\TechSmith\Camtasia Relay\Uploader\ by default.)

2. Open the UploaderService.config file in a text editor.
3. Change the value of the following line in the file:

True indicates that the recorder should ignore certificate errors when connecting to the Camtasia
Relay server. False indicates that the recorder will fail to connect if the Camtasia Relay server has an
invalid server certificate.

<IgnoreSslCertificateErrors>True</IgnoreSslCertificateErrors>

4. Restart the Uploader Service by executing (double-click) the “RestartUploader.cmd” command (in
the Uploader directory). This command requires Administrative privileges on themachine.

For presenters using theMac recorder a change can bemade to theMac recorder’s Uploader.plist file.
Follow these instructions to edit the Uploader.plist file:

1. Navigate to the Content\Resources directory of theMac recorder’s installation directory.
2. Open the Uploader.plist file in a text editor.
3. Change the value of IgnoreSslCertificateErrors to true or false accordingly.
4. Restart the Uploader service.

This option can also be enabled for clients downloaded from the server in the future using the Recorder
Security tab of the User Account Security Settings page (~/Relay/SecuritySettings.aspx) of the
Camtasia Relay website. See theRecorders Ignore SSL Certificate Errors.

LDAP over SSL
If your organization’s LDAP server is deployed in such a way that an attacker may intercept the traffic
between Camtasia Relay and the LDAP server then SSL should be used to protect LDAP communications. In
this case, SSL is needed to protect themaster LDAP user credentials stored and used by Camtasia Relay, as
well as the credentials of users that authenticate using LDAP, as they are transmitted to the LDAP server.
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1. During LDAP configuration, check theUse secure authentication (SSL) option.
2. For convenience and LDAP over SSL testing purposes, Camtasia Relay’s LDAP integration feature

also offers the ability to “Trust all certificates”. Only select this option for testing purposes (for example,
when using a self-signed server certificate when you are unable to or do not wish to add the self-signed
certificate to the trusted certificate store.) If possible a valid server certificate should be obtained from
awell-knownCertificate Authority.

Please note that using a self-signed certificate makes certain network-level (man-in-the-middle or server
spoofing) attacks which can result in an attacker learning LDAP passwords or modifying user requests before
they reach the LDAP server. We urge you to use a server certificate from awell-knownCertificate Authority, if
possible.

WebDAV Publishing over SSL
If your deployment of Camtasia Relay uses WebDAV publishing and network architecture is such that an
attacker may be able to intercept traffic between Camtasia Relay and theWebDAV server then SSL should
be used forWebDAV publishing.

1. When adding or configuring aWebDAV publishing destination, begin the URL of the server with
https://

2. For convenience and testing purposes, Camtasia Relay’s WebDAV publishing feature also offers the
ability to “Trust all certificates”. Only select this option for testing purposes (for example, when using a
self-signed server certificate when you are unable to or do not wish to add the self-signed certificate to
the trusted certificate store.) If possible a valid server certificate should be obtained from awell-known
Certificate Authority.

Please note that using a self-signed certificate makes certain network-level (man-in-the-middle or server
spoofing) attacks which can result in an attacker learning the password used forWebDAV server publishing.
We urge you to use a server certificate from awell-knownCertificate Authority, if possible.

Cryptography Used by Camtasia Relay
Camtasia Relay uses several forms of cryptography to protect your data while it is in transition and at rest.

SSL
SSL is used to protect communications between the recorder or browser and the Camtasia Relay server. In
this case SSL helps protect against an attacker learning usernames and passwords when an administrator or
presenters logs in (as well as other sensitive information when communicating with the Camtasia Relay
website.) Please see the SSL section below for more information.

SSL can also be used to encrypt traffic between the Camtasia Relay and LDAP server as well as between
Camtasia Relay and some types of publishing destination servers (sFTP, WebDAV over SSL,
Screencast.com, and iTunesU.)

Cryptography Used by the Recorder
The SHA512 hash algorithm is used by the Camtasia Relay Recorder in the following cases:

On the PC client, to store a hash of a presenter’s password when the presenter chooses to use the
“RememberMe” feature. (TheMac client uses the Keychain for the “RememberMe” feature.)
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On both clients, to calculate amessage digest of requests that will be sent to the server. This message
digest helps prevent message tampering and to ensure that only authorized clients use the server’s
web service to authenticate, retrieve profile information, and upload presentations.

Cryptography Used by the Server
The SHA1 hash algorithm is used by the Camtasia Relay server in the following cases:

For the server’s web service, to calculate and verify themessage digest for web service requests.
The SHA384 hash algorithm is used by the Camtasia Relay server in the following cases:

-For users managed by Camtasia Relay, users’ passwords are salted and hashedmultiple times and the
resulting hash value is stored in the database.

The Rijndael symmetric (private key) encryption algorithm is used in the following cases:

To encrypt themaster LDAP password, if provided during LDAP configuration. The encrypted pass-
word is stored in the database and is decrypted by the server when themaster LDAP password is
required for LDAP authentication (such as when Camtasia Relay must resynchronize a user managed
by LDAP.)
To encrypt publishing destination passwords (as well as iTunesU shared secrets), if provided for a pub-
lishing destination. The encrypted password is stored in the database and is decrypted by the server
when publishing.

About the Private Key Used for Symmetric Encryption

The private key used to encrypt themaster LDAP password and publishing destination passwords is stored in
theWindows registry under HKEY_LOCAL_MACHINE/SOFTWARE/TechSmith/Camtasia Relay
Server/Key. The private key is generated at random during installation of the first Camtasia Relay team
member unless an encryption key is already present in the registry.

The encryption key is not stored in plaintext form; it is protected usingWindows Data Protection API (DPAPI,
see http://msdn.microsoft.com/en-us/library/ms995355.aspx for more information.) The Camtasia Relay
server uses the DPAPI to have theWindows Local Security Authority encrypt the encryption key. Only
applications running on the sameWindows Server will be able to decrypt the value stored in the registry.
Therefore when adding a new Camtasia Relay server to an existing team, administrators must first export the
private key from an existing teammember; the configuration protection tool (see below) can be used to export
the private key to an XML file. The installer will prompt for this XML file when adding a new server to a
Camtasia Relay server.

Please note that the encryption key is strongly tied to the data stored in the database. If the encryption key is
lost, Camtasia Relay will be unable to decrypt themaster LDAP password or publishing destination
passwords. When Camtasia Relay fails to decrypt a publishing destination password, that publishing
destination will be put into an error state (as well as any profiles that use that publishing destination.)

In order to determine whether or not a Camtasia Relay server has the same encryption key as other team
members, a salted SHA384 hash of each server’s plaintext encryption key is stored the database as well as a
hash of the team’s correct key. If a server’s hash does not match the correct key’s hash, the server will be put
into an “Encryption Key Error” state. The configuration protection tool can be used to repair this error.

Configuration Protection Tool
The Camtasia Relay Configuration Protection Tool can be used to:

http://msdn.microsoft.com/en-us/library/ms995355.aspx
http://msdn.microsoft.com/en-us/library/ms995355.aspx
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Export the private key used to encrypt publishing destination credentials to an XML file. This XML file
is required when adding a new server to a Camtasia Relay team.
Manage the private key

Install a new private key on a server
Change the key used by a team
Override (reset) the key used by a team

Manage the connection string used by Camtasia Relay
Change the connection string in Camtasia Relay’s CONFIG files in one place
Encrypt the connection string in Camtasia Relay’s CONFIG files.

The configuration protection tool (ConfigurationProtectionTool.exe) is located in the Utilities
directory of the Camtasia Relay installation directory (C:\Program Files\TechSmith\Camtasia
Relay\Utilities by default.)

Launch the configuration protection tool by double-clicking on the ConfigurationProtectionTool.exe.

When starting, the configuration protection tool (CPT) attempts to find Camtasia Relay’s CONFIG files in the
specified installation directory (initially based on where the tool was launched from.) The status window will be
updated with an error message if CPT is unable to find the .config files. The installation directory must be
corrected before any other action can be taken. If the installation directory is correct, the “Load Current Server
Settings” button will check the registry and several database values to determine whether or not the server
has the correct encryption key.

The status icons (below the “Load Current Server Settings” button) will be updated.

Icon Description

Able to
Connect
to SQL

Indicates whether or not CPT can connect to the Relay database, using the con-
nection string in the SQLConnection tab. “Load Current Server Settings” initial-
izes the connection string using the connection string stored in the web.config
file.

Database
has an
encryption
key con-
figured

A yellow questionmark (unknown) is shownwhen CPT is unable to connect to
SQL.

A red X indicates that there is no record in the database for the hash of the team’s
correct encryption key (see theAbout the Private Key Used for Symmetric
Encryption section above.)

A green checkmark indicates that there is a hash of the team’s correct encryption
key in the database.

Server has
an encryp-
tion key

A red X indicates that there is no value for the encryption key in the registry.

A green checkmark indicates that the server has an encryption key stored in the
registry under HKEY_LOCAL_MACHINE/SOFTWARE/TechSmith/Camtasia
Relay Server/Key.

Encryption
key is cor-
rect

A yellow questionmark (unknown) is shownwhen CPT is unable to connect to
SQL.

A red X indicates that the hash of the server’s encryption key stored in the
database does NOTmatch the team’s correct encryption key. A red X can also
indicate that there is no record in the database for the hash of the server’s
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Icon Description

encryption key (see theAbout the Private Key Used for Symmetric Encryption
section above.)

A green checkmark indicates that the hash of the server’s encryption key stored in
the databasematches the team’s correct encryption key.

After connecting to the Camtasia Relay database, the configuration protection tool retrieves the status of
each endpoint in the team and determines whether or not each endpoint has the correct encryption key.

The key status tab shows the condition of each server: the server’s status (Online, Offline, Error, Encryption
Key Error, etc.), whether the server has the correct key (a check indicates that the server does have the
correct key), and the last error message saved for that endpoint. You can use CPT’s key status tab to quickly
determine which endpoints have the correct encryption key; this can be useful when changing a team’s
encryption key or when troubleshooting encryption key errors.

Exporting Camtasia Relay's Private Key
The configuration protection tool can be used to export a server’s encryption key and connection string to an
XML file. The configuration protection tool can also import these settings from the XML file, which can then be
installed to the server using the SQLConnection and Encryption tabs.

There are a number of scenarios in which you will need to export a server’s encryption key:

Adding a new server to a Camtasia Relay team
Backing up the database
Changing the encryption key for a team of servers
Repairing an encryption key error for a team of servers

How to Create a Relay Team Exported Settings XML File

1. Access a Camtasia Relay server that has the correct encryption key installed.
2. Launch the configuration protection tool (in the Utilities directory of the Camtasia Relay installation

directory)
3. Browse to the correct installation directory of Camtasia Relay, if necessary.
4. Click the “Load Current Server Settings” button. All status icons should be green for the existing

server.
5. On the Import / Export tab, click the “Export Settings to File” button. Choose a location and filename for

the file.
6. Move the XML file to the server that needs to use it. Be sure to delete the XML file from all Camtasia

Relay servers when you are finished using the XML file.

Add a New Server to a Camtasia Relay Team

When installing a new server that will be added to an existing team of Camtasia Relay servers, the installer
will prompt for a “Relay Team Exported Settings” XML file. This XML can be created using the configuration
protection tool:

1. Create a Relay Team Exported Settings XML File using the directions above.
2. Copy the XML file produced by CPT to the local file system of the new server.
3. Browse to the XML file when prompted during the install process.
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The installer will set the encryption key in the registry so the Camtasia Relay server can encrypt and
decrypt publishing credentials.

4. Once the installer has finished, delete the XML file.

Backing up Camtasia Relay’s Database

Since some records in Camtasia Relay’s database are encrypted using the private key if a database is going
to be backed up and later restored on amachine that does not have the encryption key installed in the registry
(or the same key installed in the registry) then a “Relay Team Exported Settings” file is necessary.

1. Create a Relay Team Exported Settings XML File using the directions above.
2. Store the XML file with the database backup.

If restoring the database to a server that does not have the encryption key installed in the registry (or the same
key installed in the registry) then you will need to use the configuration protection tool to install the encryption
key to that server. See “Install a New Private Key” below.

Changing the encryption key for a Team of Servers

After you’ve changed a team’s private key on one server (See “Changing a Team’s Private Key” below), you’ll
need to export the encryption key to the XML file, copy the XML file to other teammembers, and use the
configuration protection to install the encryption key on those servers (See “Install a New Private Key” below.)

Repairing an Encryption Key Error for a Team of Servers

If you need to override (reset) a team’s private key (see “Overriding a Team’s Private Key” below), you’ll need
to export the encryption key to each other server on the team. Once you’ve overridden the team’s private key
on one server, you’ll need to export the encryption key to the XML file, copy the XML file to other team
members, and use the configuration protection to install the encryption key on those servers (See “Install a
New Private Key” below.)

Managing Camtasia Relay's Private Key
The Camtasia Relay Configuration Protection Tool can be used tomanage the private key for a single server
or a team of servers. Youmay wish to use the configuration protection tool’s key management features when:

Changing the encryption key for a team of servers
Importing an encryption key from a teamed server
Repairing an encryption key error for a team of servers

After pressing the “Load Current Server Settings” or The “Load Current Key” button, your server’s current
encryption key will appear in the “Current encryption key:” text field if an encryption key is installed in the
expected location of the registry.

The “Generate New Key” button generates a new encryption key that can be to either install, change, or
override Camtasia Relay’s encryption key. The generated key appears in the “New encryption key” text field.

The “Load Relay 1.0-1.2 Key” button loads the encryption key that was used for all Camtasia Relay 1.0, 1.1,
and 1.2 installations.

All installations of Camtasia Relay 1.0, 1.1, and 1.2 used the same encryption key. If you
installed Camtasia Relay 2.0 as an upgrade to Camtasia Relay version 1.0, 1.1, or 1.2 then
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your server/team uses this same key. Press the “Load Relay 1.0-1.2 Key” button and compare
the version of the “New encryption key” and “Current encryption key” fields, if they match then
your team is using the same encryption used by any deployment of Camtasia Relay versions
1.0, 1.1, or 1.2.

For security reasons, if your server/team is using the 1.0/1.1/1.2 encryption key, youmay wish
to change your server/team to using a random encryption. Please see “Changing a Team’s
Private Key” below.

Install a New Private Key

The “Install New Key” button takes the value in the “New encryption key” text field and installs it as the
encryption key for the server where the configuration protection tool is running.

The value of the “New encryption key” text field is encrypted usingWindows Data Protection API and then
stored in the registry under HKEY_LOCAL_MACHINE/SOFTWARE/TechSmith/Camtasia Relay
Server/Key. A salted SHA384 hash of the encryption key is also stored in the database.

Installing a new private encryption key on server using “Install New Key” does not change the encryp-
tion key on other servers in a team and does not change the encryption key used to encrypt publishing
destination credentials.
If the hash of the server’s encryption key does not match the hash of team’s correct encryption key,
the server will be put into an “Encryption Key Error” state and will not accept uploads of any new pre-
sentations. This encryption key error can be repaired by installing the team’s correct encryption key to
the server (see “Importing a Private Key from a Teamed Server” below.)

Changing a Team’s Private Key

The “Change Key” button can only be used if the server has correct encryption key installed. “Change Key”
takes the value in the “New encryption key” text field and installs it as the encryption key for the server where
the configuration protection tool is running.

The value of the “New encryption key” text field is encrypted usingWindows Data Protection API and then
stored in the registry under HKEY_LOCAL_MACHINE/SOFTWARE/TechSmith/Camtasia Relay
Server/Key. A salted SHA384 hash of the encryption key is also stored in the database for both the server
and as the team’s correct encryption key.

The previous correct encryption key is used to decrypt all publishing destination with passwords (and the
master LDAP password) and then the new correct encryption key is used to encrypt these credentials again
before they are updated in the database. If the configuration protection tool fails to decrypt and re-encrypt all
publishing destinations you will be given the choice of committing or reverting the changes; if the changes are
committed any publishing destinations (and corresponding profiles) where the password was not decrypted
and re-encrypted successfully will be put into an error state. This error state can be repaired by accessing the
publishing destination on the Camtasia Relay website, entering the correct password, and saving the
publishing destination.

“Change Key” only installs the new encryption key to the server on which the configuration
protection tool is running. All other teammembers will be put into an “Encryption Key Error”
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state and will not accept uploads of any new presentation. This encryption key error can be
repaired by creating a Relay Team Exported Settings XML File using the directions above
(under “How to Create a Relay Team Exported Settings XML File”), copying this file to each
teamed server, importing the private key (follow the direction under Importing a Private Key
from a Teamed Server below.)

Importing a Private Key from a Teamed Server

When changing or overriding a team’s encryption key, it is necessary to export the new encryption key to
other teamed servers.

1. On the server where the key was changed or overridden (and the server’s encryption key is now the cor-
rect key), create a Relay Team Exported Settings XML File using the directions above.

2. For each teamed servers that does not have the correct encryption key installed (or is in the “Encryp-
tion Key Error” state.)

a. Copy the XML file (from step 1) to the local file system.
b. Launch the configuration protection tool.
c. Browse to the correct installation directory of Camtasia Relay, if necessary.
d. Click “Load Current Server Settings”.
e. On the Import/Export tab, click “Browse” and select the XML file (from step a) on the local file

system
f. On the Encryption tab, click the “Install New Key” button. The server should now have the

correct encryption key and no longer be in the Encryption Key Error state.

g. Delete the XML file from the local file system.

Overriding a Team’s Private Key

Whenworking with a Camtasia Relay database that has publishing destinations that have been encrypted
with an encryption key that has been lost (that is, no servers have the same encryption key installed and there
are no Relay Team Exported Settings XML files that contain the same encryption key as the database), the
team’s encryption key will need to be overridden. Overriding a team’s encryption key is intended to be a last
resort, when there is no other way to repair an encryption key error.

The value of the “New encryption key” text field is encrypted usingWindows Data Protection API and then
stored in the registry under HKEY_LOCAL_MACHINE/SOFTWARE/TechSmith/Camtasia Relay
Server/Key. A salted SHA384 hash of the encryption key is also stored in the database for both the server
and as the team’s correct encryption key.

After overriding a team’s encryption key, all servers in the team will be unable to decrypt
existing publishing destinations’ passwords for since these credentials were encrypted using a
different encryption key. When Camtasia Relay processes a presentation and attempts to
publish to one of these publishing destinations, the publishing will fail and the publishing
destination (and corresponding profiles) will be put into an error state. This error state can be
prevented (or repaired) by accessing the publishing destination on the Camtasia Relay website
(on a server with the correct encryption key), entering the correct password, and saving the
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publishing destination.

Managing Camtasia Relay's Connection String
The connection string used to connect to Relay’s SQL database is stored in two different CONFIG files
located within Camtasia Relay’s installation directory:

data.config (located in theManager directory of Camtasia Relay’s installation directory, typically
C:\Program Files\TechSmith\Camtasia Relay\Manager\)
web.config (located in theWeb directory of Camtasia Relay’s installation directory, typically C:\P-
rogram Files\TechSmith\Camtasia Relay\Web\)

The configuration protection tool can be used to update the connection string in both files, allowing the admin
to edit the connection string in one place. The configuration protection tool can also be used to easily encrypt
the connection string information in each CONFIG file.

The “Load Current Connection String” button (and “Load Current Server Settings”) initializes the connection
string fields using the connection string stored in the web.config file.

The “Test Connection” button uses the connection string in the “Connection String:” text field to connect to
Camtasia Relay’s SQL database. The configuration protection tool’s status icons will be updated
appropriately depending on the result of the connection test.

Changing a Server’s Connection String

After loading the server’s current connection string, make changes using the “Integrated Security” checkbox
and Data Source, Initial Catalog, SQLUser Name, and Password fields.

After changing and testing the connection string, use the “Install” button to update Camtasia Relay’s CONFIG
files with the new connection string.

Encrypting the Connection String in CONFIG Files

If the “Encrypt Connection String on Install” checkbox is checked when the “Install” button is pressed, the
connection string will be encrypted using theWindows Data Protection API. An example of a encrypted
connection string appears below:

<connectionStrings

configProtectionProvider="DataProtectionConfigurationProvider">

<EncryptedData>

<CipherData>
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Value>AQA-

AANCMnd8BFdERjHoAwE/Cl+sBA-

AAAMmjWWyn5RE+

a5cEL5aJt3QQAAAACAAAAAAADZgAAw

AAAA-

BAAA-

ADIc5eCCQn5GDI78nq6fZOuAAAAAASAAACgAAAAEAAAABw/

c0XaxibkDLrdwBAb+ZVwAQAAaOeuPfy5m5p

dr3HLeKpBG/+XFe/5YcM3vwg72kZueevwJ+/-

FB+04Qwc17FHYnYphLY

IcvIJnulMQAstRNbRNxDn+QdGVn6m7LYwSI

A/W+rLtdi/DCWD21heYG2kB3yPQ3TFnB8JUjn-

3avl7Pfmzn

49DT-

oksYfXZbS3jaN3aD/2FdtSZO947c5mqlCCl6Y-

ri

NcEbCs+8tv36YKF1Dt9Q-

Z/O67duWMaQkSggu7RP7mX8FV3+gKX5VOzH

RMGwpNSYUWxdaYrQHhfsEF902xHdNssgalZ

FVIJ3NqEI-

UZaIW4yuEl3NWuOiSr/-

zonizAvW2TKqmkMnokHOjoVz+3P

Z3rCXRcpReO8ujB4TGQXrfpmJGqtRu2qq1O

vwJtzop-

DaWQky-

eYDMXWc1GmZL4xToS0Ft1T/cCnOPy8bsCzSFVQ9447

9yo0bIqeYKG+xOUidH0UZfJ0nCk062Qf1BC

jiQa-

Aur2g//Bkm-

2haLcYomvjYjo8KUUAAAA95vU+wanIWur+udyeFnb

/2ZSdHs=</CipherValue>

</CipherData>

</EncryptedData>

</connectionStrings>
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The .NET framework will automatically decrypt the connection string for use by Camtasia Relay but if an
attacker was able to somehow read the web.config file over the Internet, they would not be able to read the
connection string information.
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Tools
Network/Server Security Assessment
Administrators should regularly run network security assessment tools such as Nessus, Nikto, and Nmap
against their servers to identify known vulnerabilities. These tools aren't perfect but they are freely available
(and attackers will be running them against your server). Because these vulnerabilities are publicly known and
can be easily identified using these tools, it is especially important to patch your servers and protect against
these vulnerabilities. Of course, these tools cannot replace the security assessment of a network security
specialist but they should help administrators identify and eliminate somewell-known vulnerabilities.

http://www.nessus.org/download/
http://www.cirt.net/nikto2
http://nmap.org/

http://www.nessus.org/download/
http://www.cirt.net/nikto2
http://nmap.org/
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General Server Security Resources
Windows Server 2003

http://technet.microsoft.com/en-us/library/cc706993.aspx

Windows Server 2008

http://technet.microsoft.com/en-us/library/dd349801.aspx

Windows Server 2003 Security Guide

http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-
521ea6c7b4db&DisplayLang=en

Windows Server 2008 Security Guide

http://technet.microsoft.com/en-us/library/cc264463.aspx
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-
A44B-B115696A80AC&displaylang=en

Windows Server 2003 Security ComplianceManagement Toolkit

http://technet.microsoft.com/en-us/library/cc163140.aspx

Windows Server 2008 Security ComplianceManagement Toolkit

http://technet.microsoft.com/en-us/library/cc514539.aspx

http://technet.microsoft.com/en-us/library/cc706993.aspx
http://technet.microsoft.com/en-us/library/cc706993.aspx
http://technet.microsoft.com/en-us/library/dd349801.aspx
http://technet.microsoft.com/en-us/library/dd349801.aspx
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=8a2643c1-0685-4d89-b655-521ea6c7b4db&amp;DisplayLang=en
http://technet.microsoft.com/en-us/library/cc264463.aspx
http://technet.microsoft.com/en-us/library/cc264463.aspx
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=FB8B981F-227C-4AF6-A44B-B115696A80AC&amp;displaylang=en
http://technet.microsoft.com/en-us/library/cc163140.aspx
http://technet.microsoft.com/en-us/library/cc163140.aspx
http://technet.microsoft.com/en-us/library/cc514539.aspx
http://technet.microsoft.com/en-us/library/cc514539.aspx
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Appendix A: SQL Server Security
You can change or very many advanced settings to increase the security of SQL Server. The default settings
created by the Camtasia Relay installer are appropriate in many cases. However, if you (1) are using a remote
SQL database with Camtasia Relay and (2) the remote SQL Server used by Camtasia Relay has had other
databases installed in the past or currently, and (3) you are comfortable using SQL Server Manager to manage
SQL server configuration settings, then it may be appropriate to further secure SQL server using these
advanced settings.

The settings below are typically accessed using SQL Server Manager.

SQL Authentication

Camtasia Relay requires SQL authentication be enabled in order to connect to a remote SQL server. Many
resources on securing SQL server may advise you to disable SQL authentication; do not disable SQL
authentication as Camtasia Relay will no longer be able to connect to the remote SQL server.

Delete or Disabled Unused SQL Users

Unused accounts should be deleted to prevent an attacker using them and their privileges in the event that the
attacker gains access to the server.

Relay uses the SQL users “relay”. All other SQLUsers should be deleted or disabled from the Relay instance
with the exception of the following default required users: “dbo”, “guest”, “sys”, and “INFORMATION_
SCHEMA”.

Least Privilege SQL User

The Camtasia Relay SQL user “relay” requires the following SQL service privileges: datareader and
datawriter. No other permissions should be granted. The Camtasia Relay installer should configure the SQL
server with least privilege but you should verify that the SQL user has only the privileges listed above and no
other.

Use a Strong sa (System Administrator) password

The default system administrator (sa) account has been the subject of countless attacks. It is the default
member of the SQL Server administration fixed server role sysadmin. Make sure you use a strong password
for this account.

Do not grant permissions for the public role

All databases contain a public database role. Every other user, group, and role is amember of the public role.
You cannot removemembers of the public role. Instead, do not grant the permissions for the public role that
grant access to your application's database tables, stored procedures, and other objects. Otherwise, you
cannot get the authorization that you want using user-defined database roles because the public role grants
default permissions for users in a database.

Remove the sample databases

Any sample databases, if present, (for example, Pubs and Northwind) should be removed using SQL Server
Manager.
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Camtasia Relay and Camtasia Studio
Harness the editing power of Camtasia Studio in Camtasia Relay!

Edit Camtasia Relay videos in Camtasia Studio, and then send back to Camtasia Relay for distribution. They
play nicely together so your content flows seamlessly from one Camtasia to another.

There are several ways to use Camtasia Studio with Camtasia Relay, depending on what you are trying to do.
Find which option will work best for you:

Automatically Produce Multiple Formats and Destinations
Full Editing Capability with Ease of Camtasia Relay Recording
Record with Camtasia Relay, Edit with Camtasia Studio, Publish with Camtasia Relay

The procedures that follow assume that you are already familiar with Camtasia Studio and
Camtasia Relay. To learn about Camtasia Studio or Camtasia Relay, please refer to the in-
product help or the TechSmith Learning Center.

The Basics
The Camtasia Relay recorder must be installed on the same computer as Camtasia Studio in order for
the Camtasia Relay production preset to appear in the Camtasia Studio ProductionWizard.
Camtasia Relay profile settings take precedence over Camtasia Studio Presets. When processing and
publishing presentations with Camtasia Relay, the final formats and publish locations are dictated by
profile settings.
The CAMPROJ file used in Camtasia Studio is rendered to AVI before it uploads to Camtasia Relay for
processing; some features available when working in Camtasia Studio are disregarded when producing
through Camtasia Relay because they are not compatible with the AVI file type.

Automatically Produce Multiple Formats and
Destinations
Summary

1. Record: Camtasia Studio
2. Edit: Camtasia Studio
3. Produce: Camtasia Relay

When to Use

You are familiar with Camtasia Studio and its recording and editing fea-
tures.
You would like to use Camtasia Relay to efficiently publish a variety of
video formats and/or to multiple locations.
You are familiar with Camtasia Studio and your workplace requires all
videos to be published to locations under the control of a network admin-
istrator (via a Camtasia Relay profile).

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
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Advantages

Ability to use ScreenDraw and other Camtasia recording effects.
Ability to use SmartFocus (not available in Camtasia Relay recordings).
Recording file (CAMREC) is saved locally and ready for immediate edit-
ing in Camtasia Studio.
Camtasia Relay production saves the person editing from having to
make processing and publishing decisions.
Camtasia Relay production saves time if you want multiple video for-
mats and automated publishing tomultiple destinations.

Considerations

When recording, select Full Screen as the recording dimensions.
In Camtasia Studio, choose dimensions that match your largest Cam-
tasia Relay profile. If you are uncertain, select Recording Dimensions as
the preset (in Project Settings). Later, Camtasia Relay will use your pro-
file to determine final dimensions and formats.
Cannot use Flash hotspots, quizzes, survey, end actions (lose when
converted to AVI).
Closed captions are available when producing with Camtasia Relay only
when the selected profile supports captions (Flash and Silverlight
encode settings).
Camtasia Studio first produces an AVI file and then sends it to Camtasia
Relay, where it is processed and published as dictated in the selected
profile.

How To

1. Open Camtasia Studio. In theWelcome dialog box, click Record the screen.
2. Click Full Screen in the Camtasia Recorder.
3. Click theRecord button.
4. Give your presentation. When finished, click Stop.
5. In the Preview window, click Save and Edit.
6. When prompted, select Recording Dimensions in the Dimensions dropdown list and click OK.
7. Edit the presentation with Camtasia Studio.

Note: Do not add Flash hotspots, quizzes, surveys, or end actions; these items are not supported.

8. From the Produce and share dropdown list, select Share to Camtasia Relay.
9. Log in with a Camtasia Relay presenter username and password.
10. Select a profile. Enter a title and description. Click Submit.

See the Camtasia Relay recorder help orCamtasia Relay Learning Center for more information about what
happens after a presentation is submitted.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA


Camtasia Relay Installation Guide

www.techsmith.com - 3 -

Full Editing Capability with Camtasia Relay
Recording
Summary

1. Record: Camtasia Relay
2. Edit: Camtasia Studio
3. Produce: Camtasia Studio

When to Use

Multiple presenters record and one or more experienced Camtasia Stu-
dio users do the editing.
Since the presenters just record, submit the presentation, and walk
away, this option works great for conferences or quality control.
This workflow can come in handy when presenting on a computer that
does not have Camtasia Studio, but you want to edit and produce with
Camtasia Studio.

Advantages

Presenters use the simple Camtasia Relay recorder and others can edit
with Camtasia Studio.
Can record on bothMac andWindows operating systems and then edit
and produce the presentation on a computer running on aWindows oper-
ating system.
Full editing capabilities of Camtasia Studio.

Considerations

Cannot use SmartFocus, ScreenDraw, or other Camtasia Recorder fea-
tures (not available in Camtasia Relay recordings).
Each video format must be produced individually; no automatic pro-
duction and publishing as when using Camtasia Studio for production.
Profile required: A profile that generates a Camtasia Studio recording
(CAMREC) and publishes to a location where the person doing the edit-
ing can retrieve it.

How To

1. Open the Camtasia Relay recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a CAMREC.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the CAMREC is ready, locate the file and copy it to your computer.
9. Open Camtasia Studio. In theWelcome dialog box, click Import media.
10. Locate the CAMREC file and click Open.



Camtasia Relay Installation Guide

www.techsmith.com - 4 -

11. Drag the capture to the timeline and select Recording Dimensions in the Dimensions dropdown list and
click OK.

12. Edit and produce the presentation with Camtasia Studio.
See the Camtasia Studio help or the Camtasia Studio Learning Center for information about editing and
producing.

Record with Camtasia Relay, Edit with Cam-
tasia Studio, Publish with Camtasia Relay
Summary

1. Record: Camtasia Relay
2. Edit: Camtasia Studio
3. Produce: Camtasia Relay

When to Use

The ease of the recording and publishing with Camtasia Relay is
needed, but there is also a need for editing beyond just trimming the
beginning and ending of the presentation.
A designated editor receives a CAMREC of the presentation and pub-
lishes back to Camtasia Relay because there is a need for multiple for-
mats and/or publish destinations.
A presentation recorded with Camtasia Relay unexpectedly needs a
more involved edit than available with Camtasia Relay.

Advantages

Presenters use the simple Camtasia Relay recorder.
Presentations are processed and published automatically based on the
selected profile.
Video can undergo advanced editing and still be efficiently produced in
numerous formats and locations.

Considerations

When recording, select Full Screen as the recording dimensions.
Camera video from Camtasia Relay recorder is not included in the file
sent to Camtasia Studio.
In Camtasia Studio, choose dimensions that match your largest Cam-
tasia Relay profile. If you are uncertain, select Recording Dimensions as
the preset (in Project Settings). Later, Camtasia Relay will use your pro-
file to determine final dimensions and formats.
Cannot use Flash hotspots, quizzes, survey, end actions (lose when
converted to AVI).
Cannot use SmartFocus (not available when recording with Camtasia
Relay).
Camtasia Studio first produces a n AVI file and then sends it to Cam-
tasia Relay, where it is processed and published as dictated in the
selected profile.
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Profiles required: One profile that generates a Camtasia Studio record-
ing (CAMREC) and publishes to a location where the person doing the
editing can retrieve it; a second profile to designate the formats and pub-
lishing destinations for the final presentations.

How To

1. Open the Camtasia Relay recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a CAMREC.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the CAMREC is ready, locate the file and copy it to your computer.
9. Open Camtasia Studio. In theWelcome dialog box, click Import media.
10. Locate the CAMREC file and click Open.
11. Drag the capture to the timeline and select Recording Dimensions in the Dimensions dropdown list and

click OK.
12. Edit and produce the presentation with Camtasia Studio.

Note: Do not add Flash hotspots, quizzes, surveys, or end actions; these items are not supported.

See the Camtasia Studio help or Camtasia Studio Learning Center for information about editing with
Camtasia Studio.

13. From the Produce and share dropdown list, select Share to Camtasia Relay.
14. Log in with a Camtasia Relay presenter username and password.
15. Select a profile. Enter a title and description. Click Submit.

See the Camtasia Relay recorder help orCamtasia Relay Learning Center for more information about what
happens after a presentation is submitted.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
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Camtasia Relay and Camtasia for Mac
Harness the editing power of Camtasia for Mac in Camtasia Relay!

Edit Camtasia Relay videos in Camtasia for Mac, and then send back to Camtasia Relay for distribution.
They play nicely together so your content flows seamlessly from one Camtasia to another.

There are several ways to use Camtasia for Mac with Camtasia Relay, depending on what you are trying to
do. Find which option will work best for you:

Automatically Produce Multiple Formats and Destinations
Full Editing Capability with Ease of Camtasia Relay Recording
Record with Camtasia Relay, Edit with Camtasia for Mac, Publish with Camtasia Relay

Note: The procedures that follow assume that you are already familiar with Camtasia for Mac and Camtasia
Relay. To learn about Camtasia for Mac or Camtasia Relay, please refer to the in-product help or the
TechSmith Learning Center.

The Basics
The Camtasia Relay recorder must be installed on the same computer as Camtasia for Mac in order for
the Share to Camtasia Relay option to appear.
Camtasia Relay profile settings take precedence over Camtasia for Mac production options. When
processing and publishing presentations with Camtasia Relay, the final formats and publish locations
are dictated by profile settings.
Some features available when working in Camtasia for Mac are disregarded when producing through
Camtasia Relay. Only markers and closed captions are passed through and only when the selected
profile supports these options (Flash or Silverlight encoding types only).

Automatically Produce Multiple Formats and
Destinations
Summary

1. Record: Camtasia for Mac
2. Edit: Camtasia for Mac
3. Produce: Camtasia Relay

When to Use

You are familiar with Camtasia for Mac and its recording and editing fea-
tures.
You would like to use Camtasia Relay to efficiently publish a variety of
video formats and/or to multiple locations.
You are familiar with Camtasia for Mac and your workplace requires all
videos to be published to locations under the control of a network admin-
istrator (via a Camtasia Relay profile).

Advantages
Ability to use SmartFocus (not available in Camtasia Relay recordings).
Recording file (CMREC) is saved locally and ready for immediate editing

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
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in Camtasia for Mac.
Camtasia Relay production saves the person editing from having to
make processing and publishing decisions.
Camtasia Relay production saves time if you want multiple video for-
mats and automated publishing tomultiple destinations.

Considerations

When recording, select Full Screen as the recording dimensions.
Camera video recorded in Camtasia Relay recorder is not included with
the file sent to Camtasia for Mac.
In Camtasia for Mac, choose canvas dimensions that match your larg-
est Camtasia Relay profile. If you are uncertain, select the same dimen-
sions that were used during recording. Later, Camtasia Relay will use
your profile to determine final dimensions and formats.
Closed captions andmarkers are available when producing with Cam-
tasia Relay only when the selected profile supports captions (Flash and
Silverlight encoding types only).
Camtasia for Mac first produces a video file and then sends it to Cam-
tasia Relay, where it is processed and published as dictated in the
selected profile.

How To

1. Open Camtasia for Mac.
2. Select to record the Full Screen.
3. Click theRecord button.
4. Give your presentation. When finished, click Stop.
5. Camtasia for Mac adds the recording file (CMREC) into theMedia Bin and on the timeline

By default, full screen recordings appear at 50% of their original size on the canvas. Adjust this size as
needed.

6. Edit the presentation with Camtasia for Mac.
7. Select the option to share to Camtasia Relay.
8. Log in with a Camtasia Relay presenter username and password.
9. Select a profile. Enter a title and description. Click Share.

See the Camtasia Relay recorder help orCamtasia Relay Learning Center for more information about what
happens after a presentation is submitted.

Full Editing Capability with Camtasia Relay
Recording
Summary

1. Record: Camtasia Relay
2. Edit: Camtasia for Mac

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.0.0&lang=enu&os=NA
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3. Produce: Camtasia for Mac

When to Use

Multiple presenters record and one or more experienced Camtasia for Mac
users do the editing.
Since the presenters just record, submit the presentation, and walk away,
this option works great for conferences or quality control.
This workflow can come in handy when presenting on a computer that
does not have Camtasia for Mac, but you want to edit and produce with
Camtasia for Mac.

Advantages

Presenters use the simple Camtasia Relay recorder and others can edit
with Camtasia for Mac.
Can record on bothMac andWindows operating systems and then edit
and produce the presentation on a computer running on aMac operating
system.
Full editing capabilities of Camtasia for Mac.

Considerations

Cannot use SmartFocus (not available in Camtasia Relay recordings).
Camera video recorded in Camtasia Relay recorder is not included with
the file sent to Camtasia for Mac.
Each video format must be shared individually; no automatic production
and publishing as when using Camtasia for Mac for production.
Profile required: A profile that generates a Camtasia for Mac recording and
publishes to a location where the person doing the editing can retrieve it.

Camtasia Relay produces a ZIP file for the Camtasia for
Mac recording files. The ZIP file, when opened on aMac,
automatically unzips into a directory.

How To

1. Open the Camtasia Relay recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a Camtasia for Mac recording.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the Camtasia for Mac recording is ready, locate the file and copy it to your computer.
9. Open the ZIP folder.
10. Double-click to launch the CMPROJ in Camtasia for Mac.
11. Edit and produce the presentation with Camtasia for Mac.

See the Camtasia for Mac help or Camtasia for Mac Learning Center for information about editing and
producing.
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Record with Camtasia Relay, Edit with Cam-
tasia for Mac, Publish with Camtasia Relay
Summary

1. Record: Camtasia Relay
2. Edit: Camtasia for Mac
3. Produce: Camtasia Relay

When to Use

The ease of the recording and publishing with Camtasia Relay is needed,
but there is also a need for editing beyond just trimming the beginning and
ending of the presentation.
A designated editor receives a Camtasia for Mac recording of the pre-
sentation and publishes back to Camtasia Relay because there is a need
for multiple formats and/or publish destinations.
A presentation recorded with Camtasia Relay unexpectedly needs amore
involved edit than available with Camtasia Relay.

Advantages

Presenters use the simple Camtasia Relay recorder.
Presentations are processed and published automatically based on the
selected profile.
Video can undergo advanced editing and still be efficiently produced in
numerous formats and locations.

Considerations

When recording, select Full Screen as the recording dimensions.
In Camtasia for Mac, choose canvas dimensions that match your largest
Camtasia Relay profile. If you are uncertain, select the same dimensions
that were used during recording. Later, Camtasia Relay will use your pro-
file to determine final dimensions and formats.
Cannot use SmartFocus (not available when recording with Camtasia
Relay).
Closed captions andmarkers are available when producing with Camtasia
Relay only when the selected profile supports captions (Flash and Sil-
verlight encoding types only).
Camtasia for Mac first produces a video file and then sends it to Camtasia
Relay, where it is processed and published as dictated in the selected pro-
file.
Profiles required: One profile that generates a Camtasia for Mac recording
and publishes to a location where the person doing the editing can retrieve
it: a second profile to designate the formats and publishing destinations for
the final presentations.

Camtasia Relay produces a ZIP file for the Camtasia for
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Mac recording files. The ZIP file, when opened on aMac,
automatically unzips into a directory.

How To

1. Open the Camtasia Relay recorder.
2. Log in with a presenter username and password.
3. Select a profile. Make sure to choose one that creates a Camtasia for Mac recording.
4. Enter a title and description.
5. Click theRecord button.
6. Give your presentation. When finished, click Stop.
7. Review the presentation and click Submit.
8. When the Camtasia for Mac recording is ready, locate the file and copy it to your computer.
9. Open the ZIP folder.
10. Double-click to launch the CMPROJ in Camtasia for Mac.
11. Edit the presentation with Camtasia for Mac.

See the Camtasia for Mac help or Camtasia for Mac Learning Center for information about with
Camtasia for Mac.

12. Select the option to share to Camtasia Relay.
13. Log in with a Camtasia Relay presenter username and password.
14. Select a profile. Enter a title and description. Click Share.

See the Camtasia Relay recorder help orCamtasia Relay Learning Center for more information about what
happens after a presentation is submitted.

http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
http://www.techsmith.com/redirect.asp?target=learningcenter&product=relay&ver=4.1.0&lang=enu&os=NA
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An Overview of Teaming
Teaming is the process of linking together multiple Camtasia Relay servers together for more processing
power and server redundancy. Teaming allows an organization to grow beyond a seven-simultaneous-
encoding server for a tremendous amount of video processing power from Camtasia Relay.

Teaming Benefits
Adding new servers to a Camtasia Relay deployment can provide the following benefits.

More processing power

Teaming allows more presentations to be processed than ever before. Adding a three-encoding server to an
existing seven-encoding server allows your Camtasia Relay Server team to transcode up to 10 different
media formats at any given time. The Camtasia Relay solution works to intelligently determine which server is
least busy when a new presentation is ready to be uploaded and processed.

Servers do not have to be of the same encoding level. One-encoding, three-encoding, and seven-encoding
servers are interchangeable in a team environment. As usual, servers with more encoding levels can process
more presentations in a given day than their lower encoding counterparts.

Easy deployment

Connecting another server to the team is easy. Simply go through theAdvanced Installation of Camtasia
Relay and during the install process on the new server indicate that it is part of a team. Include the information
necessary to connect it to the existing server or team of servers and the new server is made known to the
clients that are already connected to Camtasia Relay.
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How Teaming Works
When two or more servers are teamed together, the recorders communicate with one of the servers which
then communicates to the database to determine which server in the team is the least busy based on the
processing power of each server (in terms of simultaneous encodings) and the number of presentations
currently in each server’s queue. The presentation is assigned to the server that is determined to be “least
busy.” A basic algorithm is used to determine how much processing is in the queue, which takes into account
factors like it taking far less time to transcode to anMP3 file than anMP4 orWMV file.
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Setting Up Teaming
For instructions on how to enable teaming for Camtasia Relay please refer to the sectionAdd a Server to the
Team in the Camtasia Relay Installation Guide, available by clicking theHelp button during installation, or
from the documentation page on theCamtasia Relay tutorials section of the TechSmith website.

http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
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Teaming Configurations
When setting up a teamed server environment, it is highly suggested that you use the preferred configuration
in which the database server is placed on an external server.

Traditional Configuration

Preferred Configuration
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Teaming FAQ
Are there any pricing options that can be considered when purchasing multiple servers?

Yes. Please contact our sales team to discuss discounts that can be applied when purchasingmultiple
servers for a teamed environment.

Can teaming help me have geographically located Camtasia Relay servers for better
upload speeds from different regions?

No. The teaming feature does not currently have any logic to determine themost responsive server according
to geographical or bandwidth concerns. If you set up a teamed server environment with one server in the
United States and another in China, it is altogether possible that a presentation submitted in China could get
marked for upload to the United States server and vice-versa. In this situation, we would (according to current
functionality) recommend using two different Camtasia Relay installations without teaming.

If I do not have servers teamed and a server experiences a hardware failure, what will
occur?

Wehighly encourage regular/automated database backups of your Camtasia Relay server. (Please refer to
the sectionBack Up the Camtasia Relay Database in the Technical ReferenceGuide, available on the
Camtasia Relay tutorials page on the TechSmith website.) With the restore of the database backup, a
server could be returned to the processing step that it was at during themoment of the backup. Assuming that
no data was available for the “Media” destination which is configured during Camtasia Relay server
installation and is where all uploading, transcoding, and publishing is drawn from, presentations that were in
process on the previous server would have to be re-uploaded to the server for processing. The local client
machines still have the presentations on them so no source recordings are lost.

Does TechSmith recommend two three-encoding servers that are teamed together or one
7-encoding server?

It depends upon your needs. Two three-encoding servers can perform almost as well as one seven-encoding
server. If system redundancy is a concern and you plan to have an external database server configured with
your Camtasia Relay team, wewould recommend using two three-encoding servers over one seven-encoding
server. If you are concerned about overall performance, a seven-encoding server is recommended.

http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
http://www.techsmith.com/tutorial-camtasia-relay.html?requestsource=productredirect&redirlang=enu&redirproduct=relay&redirver=4.0.3&os=NA
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Camtasia Relay Integration with Kaltura
Together, Camtasia Relay, Kaltura, and KalturaMediaSpace provide a comprehensive solution for capturing
and publishing lectures and other learning content.

This document covers how to implement a Camtasia Relay and Kaltura integration. Included are:

Suggested best practices for using Camtasia Relay with Kaltura and KalturaMediaSpace
How to configure Camtasia Relay to publish presentations to Kaltura
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Configuration of Kaltura
Custom Data
Before Camtasia Relay can publish presentations to Kaltura, your Kaltura account must be set up to accept
Custom Data. Custom Data allows Kaltura to accept important presentation information from Camtasia
Relay.

To allow Camtasia Relay to publish to Kaltura, your Kaltura account must have Custom Data enabled.

To verify that this option is enabled, log in to your Kaltura administrator account and go toSettings. You
should see aCustom Data tab.

If you do not see aCustom Data tab underSettings, please contact Kaltura support.

Account Information
When setting up a Kaltura publish destination in Camtasia Relay, you need to enter your KalturaPartner ID
andAdministrator Secret.

To locate this information, log in to the KalturaManagement Console and go toSettings > Integration
Settings. The information is listed on the page. Youmay want to make a note of it, or you can leave this
window open to copy and paste the information into Camtasia Relay.

Content Categories
In the KalturaManagement Console, you can apply categories to content. Categories define where (which
tab, hierarchy, etc.) a presentation is published on a KalturaMediaSpace site and allow for filtering and
managing presentations in your Kaltura account.

When you set up a Kaltura Publish Account in Camtasia Relay, you can designate which categories are
automatically applied to presentations published with the account.
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Prior to configuring Camtasia Relay to publish to Kaltura, youmay want to take some time to figure out what
categories you want to use and add them to your account in Kaltura. Log in to the KalturaManagement
Console and go toContent. Categories are listed on the left.

For more information on configuring categories, see the Kaltura documentation or contact Kaltura support.
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Configuration of Camtasia Relay
There are several steps to configure Camtasia Relay to publish presentations to Kaltura.

Install the Kaltura Plug-In
1. Log in to the Camtasia Relay website as an administrator.
2. Go toSystem > Plug-Ins.
3. Click Verify. The Camtasia Relay server verifies that it can load the plug-in.

Once the plug-in is verified, an Install button appears.
4. Click Install.

If the plug in installs correctly, the button changes to aRemove button.

Create a Kaltura Publish Destination
1. Go toProfiles > Publish Destinations.
2. Click Kaltura on the left to create a new destination.
3. Enter a Title for the publish destination.
4. Enter theService URL.
5. Enter thePartner ID andAdministrator Secret.

To locate this information, log in to the KalturaManagement Console and go toSettings > Integration
Settings.

6. Click Save.
The publish destination is saved and you are presented with a link to the Publish Account Setup for this
destination.

Create a Kaltura Publish Account
Accounts for Kaltura publish destinations define how presentations are published to Kaltura and Kaltura
MediaSpace™.

1. Enter a Title for the publish account.
This title is meant to help administrators understand what a specific account is meant for during profile
creation. Try to use descriptive naming conventions for easy identification.

2. Enter theCreator for this account.
By default, the Creator field is filled in with the system variablePresenterUserName. This variable is
replaced with the presenter's user name associated with a presentation during publishing. This variable
is a great choice if user names are the same in both Camtasia Relay and Kaltura, as presentations will
automatically map to the correct Kaltura user.

3. Enter any Tags for this account, using commas to separate entries.
Tags are searchable in Kaltura and KalturaMediaSpace.

4. Enter any Categories associated with this account.
Categories define where (which tab, hierarchy, etc.) a presentation is published on a KalturaMedi-
aSpace site and allow for filtering andmanaging presentations in your Kaltura account.

5. Click Save.
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Create a Profile to Publish to Kaltura
Camtasia Relay uses profiles to define how presentations are processed and where they are published.

1. Go toProfiles.

2. Click theNew Profile button.
TheProfile Setup page opens.

3. Enter a title for the profile.
Remember that the profile title is the only thing presenters can see in the recorder. The profile descrip-
tion is only visible on the website. Consider carefully how you choose profile titles so that they convey
their intended use to presenters.

4. Enter a description.
5. Select the Transcription Settings.
6. Click Save.
7. Click thePublish Destinations tab.
8. Select a Kaltura publish destination from those available.
9. Click Save.
10. Click theEncode Settings tab.
11. Select the types of encodings you want to publish to Kaltura. 

XML is enabled automatically andmust be included for all presentations published to Kaltura.
12. Click thePublish Accounts tab.
13. Select an account to use for each of the encodings for the publish destination.

The account currently set as the default account for the publish destination is automatically selected.
You can:

Keep the selected account.
Select another account.
Select Use presenter account.
This option allows presenters to enter their own credentials. Presenters need to log in to the
Camtasia Relay website and enter their credentials.
Select Use default account.
This option allows the profile to access the default account information at the time of profile proc-
essing. Youmay want to use this option if the default account information changes from time to
time.

14. Click Save.
15. Click theNotification Selectiontab.
16. Select one or more notifications to use with the profile.

All configured notifications are shown for you to choose from.
17. Click Save.
18. Click theNotification Assignment tab.
19. Under each notification, all publish destination/encoding combinations for the profile are shown.

Select the encodings you want to assign to the notification.
20. Click Save.
21. Click theVariable Definition tab.
22. Enter a value for each profile variable used in this profile. 
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23. Click Save.
24. Click theAssociated Users tab.
25. In theAvailable Users list, click to select a presenter.
26. Click Add to associate the presenter(s) with the profile.
27. If you would like to have this profile automatically associated with all new presenters as they are added

to Camtasia Relay, enable theAutomatically associate this profile with new users option.
28. Click Save.
29. Click theOverview tab to review the setup of a profile.
30. Click theProfile Test tab to process a sample presentation to verify that the profile behaves as you

expect.
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Sharing Presentations with Kaltura
There are two ways to share Camtasia Relay presentations that are published to Kaltura:

With KalturaMediaSpace
Posting embed code to your website

For support and additional information on Kaltura or KalturaMediaSpace, see the Kaltura documentation or
contact Kaltura Support.

Sharing with Kaltura MediaSpace
If you have set up the Kaltura publish accounts in Camtasia Relay to use the categories in your MediaSpace
website, the presentations are automatically published to the correct location and immediately available for
viewing.

Sharing with Kaltura Embed Code
The KalturaManagement Console provides embed code to copy and paste to your website. To use this
embed code:

1. Log in to the KalturaManagement Console.
2. Click Content.
3. Locate themedia entry that you wish to use.
4. In thePublish column, click Preview & Embed.
5. When theEmbedwindow opens, copy the text in theEmbedCode field.

a. To use a Camtasia Relay themed player, the
This embed code can now be used to post on your website.
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Introduction
This document contains instructions on integrating your Camtasia Relay andMediasite servers. In order for
your Camtasia Relay server to publish presentations to aMediasite server, some setup is required on both
servers.

To prepare your Mediasite server for integration with Camtasia Relay:

Mediasite Server 6 Integration Setup
Mediasite Server 5.5 Integration Setup

For instructions on how to prepare your Camtasia Relay server for integration with aMediasite server:

Camtasia Relay Integration Setup
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Mediasite Server 6 Integration Setup
First, log in to your Mediasite Server Management Portal as an administrator.

Setup a Camtasia Relay Player
1. Navigate to the folder where you want the player to reside.
2. Select Add new > Player from themenu at the top of the page.

3. Add a Content Player with a name that provides context, such as "Camtasia Relay Content Player."
Additionally, add an alternate name, a description of the player, and then select a player layout.

Typically, you should choose theMediasite-Full Experience layout, but theMediasite-Mini Player also
works well if you plan to embed content elsewhere.
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4. If you are using the full experience player, go to the Content Layout section and select Video for pri-
mary content and Full Frame for the initial content layout.

5. Click theSave button.

.

6. The player is now available for setting up new presentations andmedia import projects.
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Setup a Presentation Template
1. Select folder where you added the player and select Add new > Template from themenu.

2.  Define themedia settings from the available options, or click theGo to Advanced Creation link.
a. Give the template a name.
b. Select your time zone.
c. Select your target audience and encoding settings.
d. Select theMediasite folder where the content is stored.

3. From themenu, choose the player that you created in the previous steps. Add at least one default
presenter to the template.

Camtasia Relay automatically associates presentations with the correct presenters in
Mediasite if the presenter exists in both Camtasia Relay andMediasite.

4. When finished, click theSave button.
5. The new Presentation Template is available for presentations andmedia import projects.
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Setup the Media Import Project
The integration between Camtasia Relay andMediasite is predicated upon the content being imported into
Mediasite via this Media Import Project. Camtasia Relay can send themedia directly to an FTP location
configured on theMediasite EX server or another location that can be accessed by theMediasite EX Server.

1. Select Publishing in themenu, and then selectMedia Import from the list of options.

2. Select Add New.
3. Give the project a suitable name, like "Camtasia Relay Media Import."
4. Select "External media import" for the type.
5. Choose an interval at which you would like the project to run.
6. Specify the location, username, and password of the content.
7. For the Presentation Template, choose the template created in the previous steps. It is recommended

that you leave the "Delete file from dropbox after successful import" checkbox enabled. This removes
the content from the temporary location after it has been imported into Mediasite.

The content that is produced by Camtasia Relay and exported to a location for
Mediasite to ingest is not instantly available when it is published by Camtasia Relay. It
must first be imported toMediasite. The import project runs on a defined update interval
of your choosing. If the content is not yet visible when your Camtasia Relay automatic
notifications are sent, you should wait until the update interval has passed until once
again checking the hyperlink for themedia.

8. When you have completed adding information for theMedia Import Project, click theSave button.
9. Your new Media Import Project is now viewable in the list and is running. When presentations are

imported, they appear in the Imported Presentations content list if you select "Show imported pre-
sentations."
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Mediasite Server 5.5 Integration Setup
1. Login to your Mediasite Server Management Portal as an administrator.

Setup a Camtasia Relay Player
2. Click “Players” from themenu, and then click the “Add Player” link.
3. Add a Content Player with a name that makes sense in this context such as “Camtasia Relay Content

Player”. Choose the “Silverlight – VideoOnly” Layout.

4. Click the “Save” button.
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5. You should now see the player in the list.

Setup a Presentation Template
6. Click “Presentations” > “Templates” from themenu.

7. Click the “Add Template” link.

8. Give the template a name, choose your time zone, specify the folder in MediaSite where you would like
the content stored, choose the player from themenu that you created in the previous steps, and then
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select which presenters you’d like to have access to this presentation template.

Camtasia Relay will automatically associate presentations with the right presenters in
Mediasite if the presenter exists in both Camtasia Relay andMediasite.

9. When done, click the “Save” button.

10. The new Presentation Template should now appear in the list.

Setup the Media Import Project
The integration between Camtasia Relay andMediasite is predicated upon the content being imported into
Mediasite via this Media Import Project. Camtasia Relay can send themedia directly to an FTP location
configured on theMediasite EX server or another location that can be accessed by theMediasite EX Server.
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11. Click “Presentations” > “Media Import” from themenu.

12. Click the “AddMedia Import Project” link.

13. Give the Project a suitable name like “Camtasia Relay Media Import” and choose an interval at which
you would like the project to run. Specify the location, username, and password of the content. For the
Presentation Template, choose the template created in the previous steps. It is recommended that you
leave the “Delete file from dropbox after success import” checkbox checked. This will remove the
content from the temporary location after it has been imported into Mediasite.

The content that is produced by Camtasia Relay and exported to a location for
Mediasite to ingest, will not instantly be available when it is published by Camtasia
Relay. It must first be imported. The import project will run on a defined “Update
Interval” of your choosing. If the content is not yet visible when your Camtasia Relay
automatic notifications are sent, you should wait at least until the update interval has
passed until once again checking the hyperlink for themedia.

While you can publish content recorded with Camtasia Relay anywhere for the
Mediasite EX server to import, it is recommended that you use an FTP location on the
EX server. This should result in faster overall turn-around times for your videos and
fewer points of failure in the file transfer process.
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14. When you have completed adding information for theMedia Import Project click the “Save” button.

15. Your new Media Import Project should appear on the list. When presentations begin getting imported
you will see them in the “Imported Presentations” content container.
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Camtasia Relay Integration Setup
1. Log in to your Camtasia Relay website as an administrator.

Enable the Mediasite Plug-In
2. Click System > Plug-Ins from themenu.

3. Look for theMediasite plug-in and click the Verify button.

4. You should see an indication that the plug-in has been successfully verified. Next click the Install
button.
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5. You should see an indication that the plug-in has been successfully installed.

Create a New Mediasite Publishing Des-
tination

6. Click Profiles > Publish Destination Setup from themenu.

7. On the left menu look for theMediasite node and click it.

8. Specify a title, hostname, path, and the viewer URL for theMediasite FTP or sFTP destination that you
have configured. This process is exactly the same as setting up an FTP or sFTP destination in
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Camtasia Relay.


	Camtasia-Relay-430-Release-Notes.pdf
	What's New in 4.3.0
	What's New in 4.2.1
	System

	What's New in 4.2.0
	System
	Server Website
	Recorder

	What's New in 4.1.2
	System
	Server Website
	Recorder

	What's New in 4.1.1
	System
	Server Website
	Recorder

	What's New in 4.1.0
	System
	Server Website
	Recorder

	What's New in 4.0.3
	System
	Server Website
	Recorder

	What's New in 4.0.2
	System
	Server Website
	Recorder

	What's New in 4.0.1
	System
	Server Website
	Recorder

	What's New in 4.0.0
	System
	Server Website
	Recorder

	Help and Support Resources

	Camtasia-Relay-430-Installation-Guide
	Installation Introduction
	Topics Included in This Document
	Setup Options

	Getting the Server Ready for Installation
	Server Planning
	Server Hardware
	Minimum Server Specifications
	Recommended Server Specifications

	Important Server Considerations
	Server Operating System
	Administrator Website Access
	Supported Versions for Plug-Ins
	Prerequisites for Installation
	Resources for Prerequisites


	Security Considerations for Installation
	Required Ports
	Conditional Ports
	Local SQL Server
	Remote SQL Server Ports
	Use Dynamic Ports / List SQL Server as an Exception
	Firewall Rules Resources
	Passwords
	Camtasia Relay Administrator Account Password
	General Password Complexity Guidelines

	General Server Security Resources

	Installation
	Install the Camtasia Relay Server
	Add a Server to the Team
	The Team Exported Settings File

	Server Configuration
	Email Server Configuration
	Skip Email Server Configuration

	Configuration Steps

	Presenter Computer Planning
	Windows-Based Computers

	Deploy Camtasia Relay Recorder
	Critical Properties
	Optional Properties
	Example
	Macintosh-Based Computers
	Presenter Website Access

	Related Documentation and Support
	Feedback

	Camtasia Relay Website and Recorder Help
	Related Documentation
	TechSmith Learning Center
	Contact TechSmith Tech Support
	Submit a Question
	Call Tech Support

	3rd Party Legal Notices
	Bookmarks
	IIS
	SSL
	QuickTim
	Desktop


	Camtasia-Relay-430-Upgrade-Guide
	Upgrade to a New Release
	Installers
	Camtasia Relay Recorders

	Upgrade from 1.x to the Current Version
	Upgrade from 1.0 to the Current Version

	Upgrade from 2.0 and Later to the Current Version
	Upgrade Recorders
	Server Certificate Errors

	Migrate Camtasia Relay to a New Server
	Important Information
	Migrate the Camtasia Relay Application and Database to a New Server
	Migrate Only the Camtasia Relay Database to a New Server
	Migrate Only the Camtasia Relay Application to a New Server
	Back Up the Database
	Restore the Camtasia Relay Database


	Camtasia-Relay-430-Presenter-Website-Help
	Introduction
	Important Camtasia Relay Concepts
	The Camtasia Relay Recorder
	Profiles
	Accounts

	Home
	Account Settings
	Help and Resources
	Presentations
	Caption Editor
	Access the Caption Editor
	Edit Presentation Captions
	Caption Editing Tips

	Profiles
	Can I Change My Profiles?

	Profile Setup
	Publish Accounts
	Profile Overview

	Publish Account Setup
	To Create a Publish Account
	Things to Consider About Publish Accounts

	Download Recorders
	Camtasia Relay Portable Recorder
	Download the Portable Recorder
	Run the Portable Recorder
	Log In to the Portable Recorder
	Record with the Portable Recorder
	Upload Presentations from the Portable Recorder


	Bookmarks
	Can


	Camtasia-Relay-430-Administrator-Website-Help
	Introduction
	Camtasia Relay Overview
	Important Camtasia Relay Concepts
	Profiles
	Variables
	Administrators Cannot Record Presentations
	Camtasia Relay Recorder

	Configuration of Camtasia Relay
	1. Define Publish Destinations
	Publish Account Setup

	2. Set Up Notifications
	Notification Setup

	3. Create Profiles
	Define Profiles Settings
	Select Publish Destinations
	Select Encode Settings
	Select Publish Accounts
	Select Notifications
	Assign Notifications
	Define Profile Variables
	Associate Users
	Review the Profile
	Test the Profile

	4. Add Users to Camtasia Relay
	Add LDAP Users to Camtasia Relay
	Manually Add Users to Camtasia Relay
	Set User Account Security Settings

	Activate / Deactivate Camtasia Relay Server
	Verify Setup
	Roll-Out Camtasia Relay
	What Presenters Need to Know Most
	Sample Emails Administrators Can Modify and Send to Presenters

	Deploy Camtasia Relay Recorder

	Camtasia Relay Administration Reference
	System Menu
	System
	Servers
	System Options
	Plug-Ins
	Activation
	Client Machines
	Event Log
	Download Recorders

	Presentations Menu
	Presentations
	Job Status
	History

	Profiles Menu
	Profiles
	Publish Destination Setup
	Publish Account Setup
	Notification Server Setup
	Install the Camtasia Relay Plug-In on the Moodle Server
	Configure the Camtasia Relay Plug-In on the Moodle Server
	Configure a Moodle 1.9.5 or 1.9.6 Server to Receive Notifications
	Configure a Moodle 1.9.7, 1.9.8, or 1.9.9 Server to Receive Notifications
	Notification Setup
	Variables

	Users Menu
	Users
	LDAP Import
	LDAP Configuration
	User Account Security Settings


	Need More Help
	Working with Technical Support
	Step 1: Knowledge Base Search
	Step 2: Submit a Question
	Step 3: Call Tech Support
	How to Export Event Viewer Logs


	Camtasia-Relay-430-Recorder-Help
	Camtasia Relay Overview
	Record a Presentation
	Record a PowerPoint Presentation
	Camtasia Relay Add-In Toolbar
	Camtasia Relay Add-In Recording Options
	Log In to Camtasia Relay
	Why Log In?
	Do I Have to Log in Before Recording?
	Don't Know Your Username or Password?
	Record for Someone Else
	Profiles in Camtasia Relay
	Which Profile Should I Choose?
	Can I Change My Profiles?
	Upload and Decide Later Profile
	Make a Test Recording
	Hotkeys
	Audio Devices
	Auto Adjust Audio Level
	Audio Tips
	More Than One Display
	Record with a Camera
	Record When Not Online
	Available Disk Space
	After Recording
	Preview and Submit the Presentation
	Trim the Presentation
	What Happens After I Submit a Presentation
	Check the Status of a Presentation
	Camtasia Relay Portable Recorder
	Download the Portable Recorder
	Run the Portable Recorder
	Log In to the Portable Recorder
	Record with the Portable Recorder
	Upload Presentations from the Portable Recorder
	Update Camtasia Relay
	The Camtasia Relay Website
	FAQs
	Need More Help?

	Camtasia-Relay-430-Technical-Reference-Guide
	Introduction
	This Document
	Feedback
	Camtasia Relay Overview
	System Architecture

	Planning, Installation, and Initial Configuration
	Site Planning
	Installation
	Set Up a Testing / Practice Server
	Activate / Deactivate Camtasia Relay Server
	Activate the Camtasia Relay Server
	Obtaining More Activations

	Offline Activation / Deactivation
	To activate when offline:
	To deactivate when offline:

	Problems with Activation / Deactivation

	Post-Install Configuration
	Email Server Configuration
	Configuration Steps

	Roll Out Camtasia Relay to Presenters
	What Presenters Need to Know Most
	There are helpful videos
	Make a test recording
	How uploading works



	Profiles
	The Sample Profile
	The Upload and Decide Later Profile
	The Profile Test

	Search in Flash and Silverlight Encodings
	The Camtasia Relay XML File
	Information Included in the XML File
	Considerations
	Example Metadata XML File



	Publish Destinations
	General Considerations
	FTP Servers
	File System
	WebDAV
	YouTube
	iTunes U Information
	Screencast.com Information

	Server Troubleshooting
	Server Debugging
	Camtasia Relay Server Event Viewer
	How to Export Event Viewer Logs
	Camtasia Relay Recorder
	Windows XP
	Windows 7 and Windows Vista
	Windows 8
	Mac OSX

	Camtasia Relay Server
	Windows Server 2008
	Windows Server 2003


	The Manager Debug Log

	Camtasia Relay Recorder Details
	Recorder Installation Builds
	Deploy the Recorder with a System Image
	Microsoft Windows Directories
	Environment Variables Used for Camtasia Relay Recorder
	Windows 8, Windows 7, Windows Vista, and Windows XP
	Windows 8, Windows 7, and Windows Vista
	Windows XP

	Camtasia Relay Service Directories
	Windows 8, Windows 7, and Windows Vista
	Windows XP

	Uploader Sleep Times
	Launching the Recorder and Logging In
	Windows 8, Windows 7, and Windows Vista
	Windows XP

	Files and Directories Used for Test Recordings
	While Recording
	After Recording

	Files and Directories Used for Recording a Presentation
	Default Locations
	After Recording
	File Deletion and Cleanup

	Specify an Alternative Directory for Files Used to Record a Presentation
	Specify in Registry
	Specify with XML File
	Troubleshooting



	Mac OS X Directories
	Uploader Daemon
	About the Daemon’s Configuration
	Uploader Sleep Time
	About the Files Found in
	/Library/Application Support/TechSmith/Camtasia Relay/Controllers

	Data Files and Directories
	Launching the Mac OS X Recorder and Logging In
	Recording
	While Recording
	After Recording
	Share Plug-in

	Uninstall Camtasia Relay

	Change the Server to Which the Recorder Connects
	On the PC Client
	On the Mac Client

	Recorder Debugging
	Failed Upload
	Add-In for Microsoft PowerPoint Issues
	Initial Questions
	Further Debugging and Checks
	Disabling the Camtasia Relay PowerPoint Add-In
	PowerPoint 2010:
	PowerPoint 2007:
	PowerPoint 2003:

	Uninstalling the Camtasia Relay Add-In

	Files to Include with a Support Request
	Log Files
	Crash Logs
	Log Files
	Stalled Mac Recorder
	Clearing Jobs


	Protection from Configuration Management Software (Deep Freeze)

	Include Webcam Video in a Presentation
	Record Webcam Video in Camtasia Relay Recorder
	Record with Camtasia Studio
	Record Video Playing on the Desktop
	Considerations

	Camtasia Relay Portable Recorder
	Special Files on the Portable Recorder
	Files
	How it Works
	The Recordings.xml File
	The Windows Portable Recorder
	Windows Vista
	Running on Windows Operating System with AutoPlay Enabled
	Windows Operating System with AutoPlay Disabled

	The Mac Portable Recorder


	TechSmith Fuse for Camtasia Relay
	Camtasia Relay Database
	Identifying the Camtasia Relay Databases
	Back Up the Camtasia Relay Database
	Back Up Using SQL Server Management Studio
	Back Up Using a SQL Script
	Back Up Using the Command Line
	Schedule an Automated Database Back Up
	Third-Party Backup Utilities
	SQL Server Automated Administration
	Windows Scheduled Task
	To access Task Scheduler:



	Restore the Camtasia Relay Database
	Restore Using SQL Server Management Studio
	Restore Using a SQL Script

	Clean Up Old Databases
	Encodings
	Encoding Types
	Encoding Sizes and Aspect Ratios
	What Do Small, Medium, and Large Really Mean?



	Camtasia Relay Integrations
	Camtasia Studio and Camtasia for Mac Integration
	LDAP Integration
	Camtasia Relay LDAP Background
	Authentication Method and Workflow
	Certificate Handling
	Adjust Search Depth Scope
	Error Message Details
	RelayPresenter Service Account


	Advanced Configuration
	More Accurate Transcription
	Audio Quality Considerations
	Language Models
	Custom Language Models
	How Presenters Can Help
	How Administrators Can Help



	Configuring Automatic Redirects to the Camtasia Relay Website
	Example
	IIS 7 Instructions (Windows Server 2008)
	IIS 6 Instructions (Windows Server 2003)
	Instructions


	Custom Bumper Videos
	HTML Container Customizations
	HTML Container Variables
	Example

	Branding the Camtasia Relay Website
	The Process
	The CSS Properties
	The Styles
	Header Logo
	Footer
	Login Page
	Recorder Download Page

	CSS Resources and Tools
	Sample Configuration CSS File

	MIME Types on Servers
	IIS
	Apache

	XML and CONFIG Files on the Server

	Security
	TechSmith Sales Support
	Appendix A: Additional Help and Related Documentation
	Feedback
	Camtasia Relay Website and Recorder Help
	Related Documentation
	TechSmith Learning Center

	Appendix B: Glossary
	TechSmith Tech Support
	Tips for Submitting a Question


	Bookmarks
	Specify
	Running


	Camtasia-Relay-430-Server-Security-Administrator
	Introduction
	Reduce Attack Surface
	Segregation of Duties
	Keep Patches Up-to-Date for All Components
	Know Your Servers

	Suggested Workflow for this Guide
	Server Hardening Quick Start Guide
	Firewall Rules
	Ports Required by Publishing Destination
	Add a Windows Firewall Exception

	Conditional Ports
	Local SQL Server
	Remote SQL Server Ports
	Use Dynamic Ports / List SQL Server as an Exception
	Use Static Ports

	Firewall Rules Resources

	Windows Server Hardening
	Required Server Roles
	Installing the Application Server Role
	Resources for Installing and Configuring the Application Server Role

	Security Configuration Wizard

	IIS Hardening
	Windows Server 2008 / IIS 8
	Remove Unnecessary HTTP headers
	Remove Unnecessary Extensions
	Remove Unnecessary HTTP Methods

	Windows Server 2003 / IIS 6
	Configure SSL
	Request a Server Certificate in Windows Server 2008
	Bind a Server Certificate to the Relay Web Site in Windows Server 2008

	Request a Server Certificate in Windows Server 2003
	Bind a Server Certificate to the Relay Web Site in Windows Server 2003

	Disable Older Versions of SSL and Weak Ciphers
	Disable SSLv2 and PCT 1.0 on Windows Server 2003 / IIS 6
	Disable Weak Ciphers on Windows Server 2003 / IIS 6

	SSL Resources


	SQL Server Hardening
	Disable Unused SQL Services
	Restrict SQL Server Protocols
	Restrict Remote Access
	Restrict Remote Logons
	Disable Null Sessions (Anonymous Logons)

	Secure Communication Between Relay and SQL
	SSL
	IPSec

	Server Auditing
	SQL Server Security
	Resources for SQL Server Hardening

	Camtasia Relay Security Features
	Forgotten Password Policy
	About Forgotten Password for Users Managed by Relay

	Account Lockout
	Password Complexity Rules
	Recorders Ignore SSL Certificate Errors
	Expire Recorder Authentication Codes
	Using a Self-Signed Server Certificate with Camtasia Relay Recorders
	PC - Adding Self-Signed Certificate to Trusted Store
	Using MMC Certificate Manager Snap-in to Export a Server Certificate from Server
	Using MMC Certificate Manager Snap-in to Import a Server Certificate to a Client

	Mac - Adding Self-Signed Certificate to Trusted Store
	Modifying Uploader Configuration to Ignore Server Certificate Errors

	LDAP over SSL
	WebDAV Publishing over SSL
	Cryptography Used by Camtasia Relay
	SSL
	Cryptography Used by the Recorder
	Cryptography Used by the Server
	About the Private Key Used for Symmetric Encryption


	Configuration Protection Tool
	Exporting Camtasia Relay's Private Key
	How to Create a Relay Team Exported Settings XML File
	Add a New Server to a Camtasia Relay Team
	Backing up Camtasia Relay’s Database
	Changing the encryption key for a Team of Servers
	Repairing an Encryption Key Error for a Team of Servers

	Managing Camtasia Relay's Private Key
	Install a New Private Key
	Changing a Team’s Private Key
	Importing a Private Key from a Teamed Server
	Overriding a Team’s Private Key

	Managing Camtasia Relay's Connection String
	Changing a Server’s Connection String
	Encrypting the Connection String in CONFIG Files



	Tools
	Network/Server Security Assessment

	General Server Security Resources
	Appendix A: SQL Server Security
	Bookmarks
	Windows


	Camtasia-Relay-430-Camtasia-Integration
	Camtasia Relay and Camtasia Studio
	The Basics
	Automatically Produce Multiple Formats and Destinations
	Full Editing Capability with Camtasia Relay Recording
	Record with Camtasia Relay, Edit with Camtasia Studio, Publish with Camtasia ...

	Camtasia Relay and Camtasia for Mac
	Automatically Produce Multiple Formats and Destinations
	Full Editing Capability with Camtasia Relay Recording
	Record with Camtasia Relay, Edit with Camtasia for Mac, Publish with Camtasia...


	Teaming-Servers-with-Camtasia-Relay-430
	An Overview of Teaming
	Teaming Benefits
	How Teaming Works
	Setting Up Teaming
	Teaming Configurations
	Teaming FAQ

	Camtasia-Relay-430-Kaltura-Integration
	Camtasia Relay Integration with Kaltura
	Configuration of Kaltura
	Custom Data
	Account Information
	Content Categories

	Configuration of Camtasia Relay
	Install the Kaltura Plug-In
	Create a Kaltura Publish Destination
	Create a Kaltura Publish Account
	Create a Profile to Publish to Kaltura

	Sharing Presentations with Kaltura
	Sharing with Kaltura MediaSpace
	Sharing with Kaltura Embed Code


	Camtasia-Relay-430-Mediasite-Server-Integration
	Introduction
	Mediasite Server 6 Integration Setup
	Setup a Camtasia Relay Player
	Setup a Presentation Template
	Setup the Media Import Project

	Mediasite Server 5.5 Integration Setup
	Setup a Camtasia Relay Player
	Setup a Presentation Template
	Setup the Media Import Project

	Camtasia Relay Integration Setup
	Enable the Mediasite Plug-In
	Create a New Mediasite Publishing Destination



